Paris IT Asset Management

Last updated: December 17, 2020
Some examples and graphics depicted herein are provided for illustration only. No real association or connection to ServiceNow products or services is intended or should be inferred.

If you have comments about this documentation, submit your feedback to: docfeedback@servicenow.com
# Table of Contents

**IT Asset Management**

Software Asset Management .................................................................................................................. 4
  - Software Asset Management overview .................................................................................. 11
  - Setting up Software Asset Management ........................................................................ 14
  - Software asset connections ............................................................................................. 29
  - Configuring Software Asset Management ..................................................................... 43
  - Software reconciliation for compliance ......................................................................... 92
  - Software installation optimization and removal .............................................................. 109
  - Analytics and Reporting Solutions for Software Asset Management Professional .... 130
  - Supported software publisher licenses .......................................................................... 156
  - SaaS License Management .............................................................................................. 220
  - Software Spend Detection ............................................................................................. 294
  - Software Asset Management administration .................................................................. 309
  - Software Asset Management references ....................................................................... 317
  - Domain separation and Software Asset Management ................................................... 350
  - Quick start tests for Software Asset Management ......................................................... 352

Hardware Asset Management .................................................................................................................. 356
  - Mobile for IT Asset Management ..................................................................................... 356
  - Asset and CI management ............................................................................................... 361
  - Asset life cycle automation ............................................................................................ 371
  - Audit your asset inventory .............................................................................................. 372
  - Asset classes .................................................................................................................... 375
  - Create fixed assets .......................................................................................................... 378
  - Consumables life cycle .................................................................................................... 380
  - Create pre-allocated assets ............................................................................................. 384
  - Stockrooms ...................................................................................................................... 387
  - Create an inventory stock order request ......................................................................... 391
  - Transfer orders for Asset Management .......................................................................... 394
  - Create a transfer order for Asset Management .............................................................. 398
  - Transfer order line asset tracking .................................................................................. 401
  - Create disposal orders for assets ..................................................................................... 402
  - Use a hardware asset request flow ................................................................................ 405
  - Hardware Model Normalization ...................................................................................... 407
  - Example Asset Management process ............................................................................. 431
  - Analytics and Reporting Solutions for Hardware Asset Management ....................... 431
  - Organization Management .............................................................................................. 439
  - Installed with Model Management .................................................................................. 440
  - Installed with Asset Management ................................................................................... 445
  - Domain separation and Hardware Asset Management .................................................. 455
  - Quick start tests for Hardware Asset Management ......................................................... 458
  - Contract Management .................................................................................................... 458
  - Procurement .................................................................................................................... 485
  - Product Catalog ............................................................................................................... 509

Index ...................................................................................................................................................... 532
IT Asset Management

Manage your software licenses and hardware assets with intuitive work flows and life cycle visibility.
Gartner, Inc. states that organizations often face three or more software audits a year. The number of audits and lack of a consolidated asset management platform can create challenges for an organization to control and optimize software spend. Use ServiceNow® Software Asset Management to take command of your software assets.

Businesses need to know the assets they own, where are they located, who is using them, how often they are used, when they are being configured, their cost, and the value they deliver. Use ServiceNow® Hardware Asset Management application to provide increased visibility of the asset estate and automate the IT life cycle from procurement to disposal.

**View and download the full infocard** for a highlight of Software Asset Management and Hardware Asset Management features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Normalize software assets</strong></td>
<td>Automatically normalize your software assets with updates from the Software Asset Management content service.</td>
</tr>
<tr>
<td><strong>Leverage Publisher Packs</strong></td>
<td>Dedicated dashboards for complex publisher specific licensing and consumption.</td>
</tr>
<tr>
<td><strong>Take action on your license position</strong></td>
<td>Use the License Workbench to easily take action on your license compliance position and remediate potential issues.</td>
</tr>
<tr>
<td><strong>Automate your asset life cycle</strong></td>
<td>Leverage the Flow Designer to configure asset life cycle workflows. With asset tasks, eliminate the risk of data inaccuracy caused by manual entry. Asset tasks automate manual processes with workflows for bulk stock orders, disposal orders, and for deploying, swapping, and retiring assets.</td>
</tr>
<tr>
<td><strong>Audit your mobile asset inventory</strong></td>
<td>Manage assets across locations and stockrooms with simplified inventory processes for mobile.</td>
</tr>
</tbody>
</table>
After you enable a discovery source, the Software Asset Management application normalizes software installation data. Weekly content updates such as publisher names, product names, and software life cycle dates, are made available. Use the updated content to normalize the discovered data in your environment to keep your software installation data current. You can opt in to securely and anonymously send your unnormalized content to the ServiceNow for research, validation, and updates.
Leverage Publisher Packs
Software publishers use different licensing models, which can make tracking license compliance difficult. In addition to the thousands of software publishers in the Content Library, the Software Asset Management application offers publisher packs for specific licenses from your top software and SaaS publishers.
Take action on your license position
The License Workbench offers you the ability to easily view your license compliance position. If any of your licenses are out of compliance, drill-down into the product and review the remediation suggestions provided by the License Workbench. Select an option to efficiently bring your license position back into compliance.

**Automate your asset life cycle**

Use the Hardware Asset Management application to control the entire life cycle of your hardware assets from procurement to disposal. The Hardware Asset Management application automates each stage of the asset life cycle by tracking the financial, contractual, and inventory details of your hardware assets. Asset tasks are provided for deploy, replace or swap, or retirement operations for your assets. Asset managers can assign Asset Tasks to Incident, Change, and Work orders, reducing effort on ticket resolution and delivering faster services. The asset tasks automatically update the CI and the asset record and help eliminate the risk of data inaccuracy caused by manual processes.

**Audit your mobile asset inventory**

The Hardware Asset Management application provides the capability to capture asset inventory located in a specific stockroom or location using the ServiceNow mobile agent and mobile scanning capabilities. You can compare the scanned results to what is stored in ServiceNow, driving improved data quality and inventory process compliance.

**Get started**

- Work with an implementation specialist to streamline your Software Asset Management setup process. To learn more or view a demo, see the Customer Success Center.
- Sign up for the ServiceNow Software Asset Management fundamentals training program and certification to learn about core Software Asset Management functionality and release-specific features.
- Sign up for the Software Asset Management (SAM) Getting Started course to learn the basic concepts and terminology of the Software Asset Management application.
- For information on how to request Software Asset Management and to begin setup, see Setting up Software Asset Management.

**Applications and features**

- Software Asset Management
- Hardware Asset Management

**Software Asset Management**

The ServiceNow® Software Asset Management (SAM) application systematically tracks, evaluates, and manages software licenses, compliance, and optimization. You can reclaim unused software rights, purchase new software rights, and manage allocations for entitlements.

For the ITSM Software Asset Management feature of Asset Management, see ITSM Software Asset Management.
Watch this short video for an introduction to the Software Asset Management application.

**Explore**
- Software Asset Management overview
- Request Software Asset Management
- Domain separation and Software Asset Management

**Set up**
- Set up Software Asset Management
- Record product details
- Track software rights and user allocations
- Discovery models and software installations
- Software Asset Management content service

**Administer**
- Software Asset Management administration
- Software Asset Management properties
- Add a software pattern normalization rule
- Add a software reclamation rule

**Use**
- Software reconciliation for compliance
- Software license usage
- Software installation optimization and removal
- Software license maintenance
- Software Asset Analytics dashboard
- Engineering License Overview dashboard
- SaaS License Management
- Software Spend Detection

**Migrate**
- Software Asset Management migration

**Troubleshoot and get help**
- Ask or answer questions in the Software Asset Management community
- Search the HI Knowledge Base for known error articles
- Contact ServiceNow Technical Support

**Software Asset Management overview**

New functionality, roles, tables, scripts, UI policies, and business rules are added with this application.

Software Asset Management functionality consists of these main features.
<table>
<thead>
<tr>
<th>Feature area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboards</td>
<td>These dashboards show software installation results for your environment in the form of statistics and charts.</td>
</tr>
<tr>
<td></td>
<td>- Software Asset Analytics: Overview, License Summary, Compliance Summary, and Removal Summary</td>
</tr>
<tr>
<td></td>
<td>- Normalization and Content Service: Normalization trend charts</td>
</tr>
<tr>
<td></td>
<td>- Software Publisher Analytics: Citrix, IBM, Microsoft, Oracle, SAP, and VMware.</td>
</tr>
<tr>
<td></td>
<td>Note: The publisher pack add-on must be activated to see the Software Publisher Analytics dashboard.</td>
</tr>
<tr>
<td></td>
<td>- Office 365 and Adobe Cloud</td>
</tr>
<tr>
<td></td>
<td>Note: The publisher pack add-on must be activated to see the Office 365 and Adobe Cloud dashboard.</td>
</tr>
<tr>
<td></td>
<td>- Software Asset Management: Overview, Optimization, Compliance Analysis</td>
</tr>
<tr>
<td>Licensing</td>
<td>Software models created for all installed software products are used to tie software installations (software being used) with entitlements (software owned). Entitlements define license details and are assigned to software models.</td>
</tr>
<tr>
<td></td>
<td>Features include publisher part number lookup, common per core and per processor license metrics, entitlement discovery maps, blacklisting, client access, license change projection, entitlement import, and entitlement import error results list.</td>
</tr>
<tr>
<td>Discovery and normalization</td>
<td>A discovery process, such as ServiceNow Discovery or Microsoft SCCM (2012 v2 or 2016), can be used to discover the software installed in your environment.</td>
</tr>
<tr>
<td></td>
<td>The normalization process compares the discovered publisher, discovered product, and discovered version values against the ServiceNow repository of normalized equivalents</td>
</tr>
<tr>
<td></td>
<td>An OOB Normalization library contains all content except publisher and product. Custom products can be created if a software product does not exist in the Software Library. Discovered software can also be manually normalized for reconciliation. A software discovery model is then matched to discovered software installations.</td>
</tr>
<tr>
<td></td>
<td>Features include partial, full, and publisher normalization, License Workbench, License Position report, custom pattern normalization rules, normalization suggestions, on-premise customer support, and an optional Software Asset Management content service to update the Normalization Library with pattern normalization rules.</td>
</tr>
<tr>
<td></td>
<td>Note: The Integration — Microsoft SCCM 2016 plugin is compatible with SCCM version 1606, 1906, 1910, and 2002.</td>
</tr>
</tbody>
</table>
### Setting up Software Asset Management

Before you can begin using Software Asset Management, complete the setup process.

You’ll need to request the Software Asset Management plugin. Then, integrate your discovery software so your software installation data can be pulled into your instance. Lastly, opt-in to the Software Asset Management Content Service Library to securely send your data back to ServiceNow. The data is used to help build the content service to automatically normalize your data.

### Request Software Asset Management

The Software Asset Management Professional (com.snc.samp) plugin requires a separate subscription and ServiceNow personnel must activate it. This plugin includes demo data. Depending on your environment, you may choose to request one or more related plugins which ServiceNow must also activate.

To purchase a subscription or load demo data after activation, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated, or demo data loaded, on the production and sub-production instances of your organization within a few days.

If you do not have an account manager, decide to delay activation after purchase, or want to evaluate the product on a sub-production instance without charge, you can use this procedure to submit a plugin activation request through the HI Service Portal.

**Warning:** If you upgrade to the Software Asset Management Professional (com.snc.samp) plugin from the Software Asset Management plugin (com.snc.software_asset_management), you cannot revert to the Software Asset Management plugin (com.snc.software_asset_management).

---

### Feature area | Description
--- | ---
Reconciliation | The reconciliation process calculates the compliance status of software products regarding discovery and entitlements. Removal candidates are generated for unused software that can be used to reclaim software rights. Features include reconciliation grouping, and remediation actions for resolving compliance issues.

Optimization | The reclamation process remediates non-compliance by uninstalling software from devices and reclaiming those software rights. The reclamation process can be automated using Client Software Distribution (CSD). Features include removal candidate and workflows, reclamation rule creation, software usage listing, and support for creating a purchase order directly using Procurement integration. For more information, see the Procurement.

Downgrade Rights | The concept of downgrading licenses is built into the Software Asset Management plugin feature. Downgrade rights is the process of having acquired the rights to the latest version of software but using the rights to license earlier versions of the same software. For more information, see Downgrade Rights.
Role required: admin

Depending on your environment, you may choose to request one or more related plugins with the Software Asset Management Professional (com.snc.samp) plugin. These optional plugins can be requested individually through the HI Service Portal as well.

**Note:** Only ServiceNow personnel can activate Software Asset Management Professional (com.snc.samp) and related plugins. The plugins are not visible in the plugin list, even after activation.

**Warning:** After installing Software Asset Management for the first time, or upgrading from the Software Asset Management Foundation plugin, you need to revert customizations for all features work. The Revert Customizations module in Software Asset Management can revert customized files related to Software Asset Management back to the base configurations that were skipped during the installation or upgrade process. See Revert Software Asset Management customizations.

### Optional related plugins (request individually through the HI Service Portal)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate all Software Asset Management Professional plugins (com.sn_samp_master)</td>
<td>Loads these Software Asset Management Professional plugins in one step.</td>
</tr>
<tr>
<td></td>
<td>- Software Asset Management Professional (com.snc.samp) plugin</td>
</tr>
<tr>
<td></td>
<td>- SaaS License Management (com.sn_sam_saas) and SaaS License Management Integrations (com.sn_sam_saas_int)</td>
</tr>
<tr>
<td></td>
<td>- All publisher pack add-on plugins</td>
</tr>
<tr>
<td></td>
<td>- Software Asset Management UI Components (com.sn_samp_workbench)</td>
</tr>
<tr>
<td>Integration — MicrosoftSCCM 2012 v2 Software Usage (com.snc.samp_usage_sccm)</td>
<td>Required to gather software usage data from Microsoft SCCM (System Center Configuration Manager) 2012 v2.</td>
</tr>
<tr>
<td></td>
<td>Automatically activates the Integration — Microsoft SCCM 2012 v2 (com.snc.integration.sccm2012v2) plugin if not already active.</td>
</tr>
<tr>
<td>Integration — MicrosoftSCCM 2016 Software Usage (com.snc.samp.usage_sccm_2016)</td>
<td>Required to gather software usage data from Microsoft SCCM (System Center Configuration Manager) 2016.</td>
</tr>
<tr>
<td></td>
<td>Automatically activates the Integration — MicrosoftSCCM 2016 (com.snc.integration.sccm2016) plugin if not already active.</td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Orchestration — Client Software Distribution (com.snc.orchestrationsf_distribution)</td>
<td>Required to activate ServiceNow Orchestration application, which enables install and uninstall functionality of software on devices.</td>
</tr>
<tr>
<td>Note: Users who purchase the Software Asset Management Professional (com.snc.samp) plugin are licensed for software uninstall functionality only, also called software reclamation. Additional licensing is required for software install functionality.</td>
<td></td>
</tr>
<tr>
<td>Software Asset Management — SaaS License Management (com.sn_sam_sasaas)</td>
<td>Requires the Software Asset Management Professional (com.snc.samp) plugin. Provides core capabilities to manage licenses for SaaS products. Gives visibility to your subscription spend and how to optimize it.</td>
</tr>
<tr>
<td>Software Asset Management — SaaS License Management Integrations (com.sn_sam_saas_int)</td>
<td>Requires the Software Asset Management — SaaS License Management (com.sn_sam_sasaas) plugin. Provides integrations to manage licenses for SaaS products.</td>
</tr>
<tr>
<td>Software Asset Management — Spend Detection (com.sn_sam_spend)</td>
<td>Requires the Software Asset Management Professional (com.snc.samp) plugin. Provides core capabilities to detect software spend from financial transaction data.</td>
</tr>
<tr>
<td>Software Asset Management Spoke (com.sn_sam_spoke)</td>
<td>Requires Software Asset Management Core. Provides actions in Flow Designer for Software Asset Management activities.</td>
</tr>
<tr>
<td>File Signature Normalization (com.snc.file_signature_normalization)</td>
<td>Required to normalize discovered file signatures while creating installed software records. This plugin also gets activated with File-based Discovery.</td>
</tr>
<tr>
<td>Mobile Employee Experience My Asset (com.glide.mobile-employee.myassets)</td>
<td>Provides the capabilities needed for end users to view assigned assets on a mobile device and create incidents to request service for these assets.</td>
</tr>
<tr>
<td>IT Asset Management Mobile (com.sn_itam_mobile)</td>
<td>Provides the capabilities for receiving personnel to receive purchased assets on a mobile device.</td>
</tr>
<tr>
<td>Publisher pack add-on plugins</td>
<td></td>
</tr>
<tr>
<td>Software Asset Management Professional for Adobe (com.sn_samp_adobe)</td>
<td>Provides additional capabilities to reconcile Adobe subscription software.</td>
</tr>
<tr>
<td>Software Asset Management Professional for Citrix (com.snc.samp_citrix)</td>
<td>Provides additional capabilities to reconcile Citrix software, such as XenApp, Xen Server.</td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Software Asset Management Professional for IBM (com.sn_samp.ibm)</td>
<td>Provides additional capabilities to reconcile IBM products using PVU and RVU license metrics.</td>
</tr>
<tr>
<td>Software Asset Management Professional for Microsoft (com.snc.samp.microsoft)</td>
<td>Provides additional capabilities to reconcile Microsoft software such as Microsoft SQL Server.</td>
</tr>
<tr>
<td>Software Asset Management Professional for Oracle (com.snc.samp.oracle)</td>
<td>Provides additional capabilities to reconcile Oracle software, such as Oracle DB Server.</td>
</tr>
<tr>
<td>Software Asset Management Professional for SAP (com.sn_samp.sap)</td>
<td>Provides additional capabilities to reconcile SAP named user compliance and optimization.</td>
</tr>
<tr>
<td>Software Asset Management Professional for VMware (com.sn_samp_vmware)</td>
<td>Provides additional capabilities to reconcile VMware software such as vCenter and vSphere.</td>
</tr>
<tr>
<td>Software Asset Management Professional for Engineering Applications (com.sn_samp_eng_app)</td>
<td>Requires the Software Asset Management Professional (com.snc.samp) plugin. Provides additional capabilities to reconcile engineering applications such as AutoCAD.</td>
</tr>
</tbody>
</table>

1. Navigate to **System Applications > All Available Applications > All.**
2. On the All Applications page, click **Request Plugin** to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.
4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>like this plugin to be enabled</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click **Submit**.

**Set up Software Asset Management**

Set up Software Asset Management after you have received your subscription and before configuration. Once you've requested and obtained your Software Asset Management subscription from ServiceNow personnel, set up Software Asset Management to use it.

Role required: sam_admin

1. Review the plugin list to see if you are running the *ITSM Software Asset Management feature of Asset Management* and complete the *Software Asset Management migration procedure*, if necessary.
2. Activate a discovery source to identify software installations in your environment.
   - *ServiceNow Discovery*
• **Microsoft System Center Configuration Manager (SCCM)**

If you’ve activated Discovery, run the `migrate software installs` script.

3. **Activate and configure the Normalization Data Services plugin.**

4. **Opt-in to the Software Asset Management Content Service** to securely send unnormalized software installation data to ServiceNow. For more information, see Software Asset Management Content Service.

5. If necessary, determine if you need to **exclude any software assets on configuration items** that you manage.

Now that you’ve completed setup, begin configuring Software Asset Management.

**Software Asset Management migration**

Migrate from the Software Asset Management plugin (ITSM Software Asset Management feature of Asset Management) to the Software Asset Management application to take advantage of more powerful features. Manual actions by the customer are required after plugin activation.

After automatic changes are performed during plugin activation, successful migration from the Software Asset Management (com.snc.software_asset_management) plugin to the Software Asset Management Professional (com.snc.samp) plugin requires a manual procedure to be performed by the customer.

Customizations to forms and lists may need to be manually overwritten by the customer after plugin activation. In addition, certain fields in software models, software entitlements, user/device allocations forms require manual configuration by the customer after plugin activation.

**Automatic changes**

The Software Asset Management Professional (com.snc.samp) plugin performs these automatic changes:

- **Tables**
  - **Table labels renamed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Original Label</th>
<th>New Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>(alm_license)</td>
<td>Software License</td>
<td>Software Entitlement</td>
</tr>
<tr>
<td>(alm_entitlement_user)</td>
<td>User Entitlement</td>
<td>User Allocations</td>
</tr>
<tr>
<td>(alm_entitlement_asset)</td>
<td>Device Entitlement</td>
<td>Device Allocations</td>
</tr>
</tbody>
</table>

- **Adds new tables and script includes.**
- **Adds any string value in the Software Entitlements License key** field to the License Key (samp_sw_license_key) table

- **Field names and values**
  - **Inference mandatory** field
    For software models that have suite components (to bundle software models), the **Inference mandatory** field value in the Software Suite (cmdb_m2m_suite_model) table is transferred to a new **Mandatory** field
  - **Rights** field
The Software Entitlements (formerly Software Licenses) **Rights** field value in the License Entitlements (alm_entitlement) table is transferred to a new **Purchased rights** field, and name changed from **Rights** to **Active rights**

- The **Software model** field for a software entitlement allocation (Software Entitlements (alm_license) table) is automatically set to the software model on the entitlement (License Entitlements (alm_entitlement) table)
- The quantity for a software entitlement allocation (License Entitlements (alm_entitlement) table) is set to 1 unless there are multiple allocations

If there are multiple software entitlement allocations for the same user or device, the allocations are aggregated into one record, the quantity is set to the count of aggregated records, and duplicate allocations are not allowed

- **Forms and lists**

  Software Models, Entitlements (formerly Software License), Discovery Models, and Software Installations form and list layouts are modified to fit the new application

  **Note:** Any customizations to these forms and lists must be manually overwritten after plugin activation.

- **Functionality**

  **Functionality disabled**

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License and software counters</td>
<td>The scheduled job trigger for SAM License Counters is changed to None so that it is deactivated, and software counters are disabled.</td>
</tr>
<tr>
<td>Auto-match functionality</td>
<td>The auto-match functionality, which attempts to match a discovery model to a corresponding software model, is deactivated.</td>
</tr>
<tr>
<td>Navigation menu</td>
<td>The navigation menu for the Software Asset Management (com.snc.software_asset_management) plugin is deactivated and renamed.</td>
</tr>
<tr>
<td>Business rules</td>
<td>Legacy business rules applied to discovery models are disabled.</td>
</tr>
</tbody>
</table>

**Overwrite customizations for Software Asset Management migration**

When migrating from the Software Asset Management plugin (ITSM Software Asset Management feature of Asset Management) to the Software Asset Management application, further actions are required by the customer after plugin activation to ensure successful migration of customized forms and lists.

Role required: admin

If these lists and forms have been customized before the migration, they may have been skipped during plugin activation and, in that case, require further action.

- Software Entitlements (formerly Software Licenses)
- Software Allocations (formerly Software Entitlements)
You can review plugin activation changes in the Upgrade History module to determine what changes have automatically been skipped so you can resolve the skipped update, if needed. Certain fields added by the migration also must be configured to take advantage of the new features offered.

1. Navigate to System Diagnostics > Upgrade History.
2. Identify the records that correspond to the upgrade history for the activation of the Software Asset Management Professional (com.snc.samp) plugin. The records in System Upgrades list that represent plugin activation contain the value n/a in the From field, and plugin name in the To field (such as com.snc.samp, com.snc.samp.core, com.snc.sam.core, com.glide.data_services_canonicalization.client, com.snc.asset_management, com.snc.model, com.snc.procurement).
3. Open a Software Asset Management upgrade record that has changes skipped.
4. In the Upgrade Details related list, open an Upgraded Details record, and then click Resolve Conflicts to view a side-by-side comparison of the base system file with the customized file.
5. Click Revert to Base System to overwrite the skipped change if it applies to form or list customization, and note down the changes. Repeat these steps for all upgrade entries with skipped changes relating to customizations.
6. In the Software Asset Management application, manually reconfigure your original form and list customizations.
7. In the Software Asset Management application, set new field values (added as part of the automatic changes performed by plugin activation) to take advantage of the new features offered.
   a) Navigate to Software Asset > Licensing > Software Models.
      • Select the software product in the Product reference field.
      • Select a discovery map, or clear the Discovery Map field and set the discovery conditions to find all discovery models that correspond to the software model.
   b) Navigate to Software Asset > Licensing > Software Entitlements (formerly Software Licenses).
      • Navigate to Software Asset > Licensing > Software Entitlements (formerly Software Licenses).
      • Select the License Metric that the software license is counted against when reconciliation is run.
      • Define the upgrade and downgrade scenarios covered by certain rights.
   c) In the User Allocations and Device Allocations related lists (formerly User/Device Entitlements), verify that the number of allocated rights are not more than rights owned. If so, delete allocations so that the number of allocations does not exceed the number of rights owned.
8. If you have entitlements that require management of license keys, you can create multiple license keys associated to the same entitlement, as well as allocate these license keys to a user or device.
Configure SCCM for Software Asset Management

Set up Microsoft SCCM for Software Asset Management to populate the Software Installation (crmdb_sam_sw_install) table with client software found in your environment. You can also set up SCCM for Client Software Distribution to reclaim unused and underused software.

Role required: sn_client_sf_dist.csd_admin or admin

Tip: Sign up for the Software Asset Management: Integration with SCCM for Reclamation and Distribution course to learn about SCCM setup, reclamation, and more.

1. **Activate the SCCM integration plugin** for your version of SCCM.
   - Integration — Microsoft SCCM 2012 v2 (com.snc.integration.sccm2012v2)
   - Integration — Microsoft SCCM 2016 (com.snc.integration.sccm2016)

   If you want to pull software usage data from SCCM, activate the software usage plugin for your version of SCCM.
   - Integration — Microsoft SCCM 2012 v2 Software Usage (com.snc.samp_usage_sccm) plugin
   - Integration — Microsoft SCCM 2016 Software Usage (com.snc.samp.usage_sccm_2016) plugin

2. Optional: If you want to reclaim unused and underused software, set up SCCM for Client Software Distribution (CSD).
   a) Request the **Client Software Distribution** (com.snc.orchestration.client_sf_distribution) plugin.
      Client Software Distribution requires a subscription to Orchestration.
   b) In SCCM, create an application, install collection, and uninstall collection for any software that you have not already created these items for. Then, deploy the application for both the install and uninstall collection. For detailed instructions, see Create and deploy an application with SCCM and Create collections in SCCM from the Microsoft SCCM product documentation.
      To reclaim software, an application, install collection, and uninstall collection must exist for the software. If you installed software manually or using an SCCM legacy package, you must still create these items so that you can reclaim the software.

   Note: If you installed software using an SCCM legacy package, you can use Microsoft Package Conversion Manager to create the application.

3. **Setup the MID Server.**
4. **Configure SCCM and the Now Platform.**
5. To offer an application from the Service Catalog, create a catalog item.

Once you’ve configured SCCM and discovered your software applications, you can create reclamation rules to identify unused or underused software, view software usage, and reclaim software.

**Software Asset Management Content Service**

Opt in to the Software Asset Management Content Service to share unnormalized software installation data from your organization with ServiceNow to improve the normalization process.
The Software Asset Management Content Service is an IT asset management (ITAM) shared service that provides users with continual software recognition improvements. By sharing unnormalized software installation data with ServiceNow, you receive automatic content updates based on your unique software installation footprint.

Data shared using the Software Asset Management Content Service remains anonymous and secure, following ServiceNow privacy policies, and is properly disposed of after review.

This new content improves your normalization hit ratios, which enables you to better manage your software assets. By default, you are not opted in to the content service. For information on how to opt-in, see [Enable the Software Asset Management content service](#).

If you want to exclude any specific software discovery models, custom software products, or custom publisher part numbers from being shared with ServiceNow, select the **Exclude from content service** check box on the **Software Discovery Model**, **Custom Software Product**, or **Custom Part Number** form.

The normalization process acts only on active publishers, products, and rules. Obsolete rules are not used. You can deactivate any Normalization Library content version at any time.

Data sharing for Software Discovery Models, Software Model Lifecycles, Part Numbers and Discovery Maps, and Processor Names is automatically enabled after opting in. If you don't want to share a specific type of asset data, click the toggle button next to the type of data on the **Content Service Setup** page and then click **Save**.

### Software Asset Management content service asset data types

<table>
<thead>
<tr>
<th>Software asset data</th>
<th>Definition</th>
<th>Details transferred</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Software Discovery Models</strong></td>
<td>Model created to classify and reduce duplication of software installs when new installs are identified. Only software discovery models with this status are transferred:</td>
<td>• Discovered publisher&lt;br&gt;• Discovered product&lt;br&gt;• Discovered version&lt;br&gt;• Normalized publisher&lt;br&gt;• Normalized product&lt;br&gt;• Normalized version&lt;br&gt;• Edition&lt;br&gt;• Language&lt;br&gt;• Platform&lt;br&gt;• Rule table&lt;br&gt;• Rule ID</td>
</tr>
<tr>
<td></td>
<td>• Match not found&lt;br&gt;• Publisher normalized&lt;br&gt;• Partially normalized&lt;br&gt;• Manually normalized</td>
<td></td>
</tr>
<tr>
<td><strong>Software Model Lifecycles</strong></td>
<td>Represent the externally defined or publisher-defined lifecycle of the software product. Only software model lifecycles not created by ServiceNow and where the lifecycle type is not internal are transferred.</td>
<td>• Publisher&lt;br&gt;• Product&lt;br&gt;• Discovery map&lt;br&gt;• Version condition&lt;br&gt;• Version&lt;br&gt;• Edition condition&lt;br&gt;• Edition&lt;br&gt;• Platform&lt;br&gt;• Language&lt;br&gt;• Lifecycle phase&lt;br&gt;• Phase start date&lt;br&gt;• Phase end date</td>
</tr>
<tr>
<td>Software asset data</td>
<td>Definition</td>
<td>Details transferred</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>Part Numbers and Discovery Maps</td>
<td>Custom part numbers and custom discovery maps manually created to represent the publisher part number and the corresponding version and edition of the software product.</td>
<td>• Publisher part number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• License type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Publisher</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Product</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Discovery map</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Edition condition</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Edition</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Platform</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Platform condition</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Language</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Language condition</td>
</tr>
<tr>
<td>Processor Names</td>
<td>Processor identified on a configuration item (CI).</td>
<td>• CPU type</td>
</tr>
<tr>
<td></td>
<td>Only processors mapped to the default processor factor are transferred.</td>
<td>• Core count</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Speed</td>
</tr>
<tr>
<td>File signatures</td>
<td>Signature that identifies software packages discovered on CIs. Software packages are discovered based on the attributes of the file, such as file name or file size. Only file signatures that are manually normalized will be transferred.</td>
<td>• File name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• File size</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Publisher</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Product</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Edition</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Platform</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Language</td>
</tr>
<tr>
<td>Software Spend Transactions</td>
<td>Software Spend Transaction records that were imported for Software Spend Detection. Only the vendor name, transaction description, general ledger account, and prediction results are transferred.</td>
<td>• Vendor name</td>
</tr>
<tr>
<td>Note: Only displays if Software</td>
<td></td>
<td>• Description</td>
</tr>
<tr>
<td>Spend Detection is installed.</td>
<td></td>
<td>• GL account</td>
</tr>
<tr>
<td>Data sharing for Software</td>
<td></td>
<td>• Is software</td>
</tr>
<tr>
<td>Spend Transactions is disabled by</td>
<td></td>
<td>• Publisher ID</td>
</tr>
<tr>
<td>default.</td>
<td></td>
<td>• Product ID</td>
</tr>
</tbody>
</table>

**Opting out**

You can opt out at any time from the Content Service Setup page.

When you opt out, your company no longer contributes to the improvement of the normalization process. You still receive content updates, but the updates may be less applicable because they aren’t informed by your company’s unique software installation footprint that exists within your environment and CMDB.

Your company can rejoin the Software Asset Management Content Service at any time.
Enable the Software Asset Management content service

Opt in to participate in Software Asset Management content service. However, you can opt out at any time.

Role required: sam_admin

1. Navigate to Software Asset > Administration > Content Service Setup.
2. Click Opt-In Agreement to read the agreement. After reading the agreement, click Done.
3. Select the Yes, I have read and accept the Opt-In Agreement check box, and then click Opt-In.

The Software Discovery Models, Software Model Lifecycles, Part Numbers and Discovery Maps, and Processor Names KPIs are automatically enabled after you have opted in.

4. To disable a KPI, click the toggle button next to the KPI and then click Save.
5. To opt out, click I would like to opt my company out of the Software Asset Management Content Service Program and then click Opt-Out.

The Software Discovery Models, Software Models, Software Model Lifecycles, Product and Entitlement Definitions, and Processor Names KPIs are disabled and your unique normalization content is no longer provided to the Software Asset Management content service.

Exclude software assets on CIs

You may want to manage software assets installed on a subset of your configuration items in the Software Asset Management application.
Role required: sam_admin

For example, some of your devices may be leased from a third party and you are not responsible for license compliance for the software on those devices. Or, you may want to start with managing software installed on devices only at a specific location (for example the New York office). Then, you can expand to managing software on devices in other locations. Convey to the Software Asset Management application which devices you want to exclude. The system excludes any software installed on these devices in license compliance calculations.

1. In the Hardware (cmdb_ci_hardware) table, add a true/false column, for example, Exclude from SAM (u_exclude_from_sam).
2. Set the value of the Exclude from SAM column to true for devices you don’t want to manage installed software for in the application.

   **Note:** The default value of the Exclude from SAM column is false. By default, the system manages installed software on all devices.

3. Navigate to **Software Asset > Administration > Properties**. Enter the column name, (u_exclude_from_sam), in the field next to the property **Enter the name of the true/false field added to cmdb_ci_hardware table to exclude software installed on selected devices from Software Asset Management**. Ensure that you enter the column name without the brackets. Once the scheduled job (SAM — Adjust Installs for excluded CIs) runs, the software installed on devices with the Exclude from SAM column set to true are excluded from the application.

4. To start managing software installs on previously excluded devices in the application, set the value of the Exclude from SAM column for the device to false. Once the scheduled job (SAM — Adjust Installs for excluded CIs) runs, the system starts managing software installs on these devices.

5. Complete the following steps to start managing the software installs on all previously excluded devices.
   a) Navigate to **Software Asset > Administration > Properties**.
   b) Delete the column name (u_exclude_from_sam) from the property
   c) Click **Save**. Once the scheduled job (SAM — Adjust Installs for excluded CIs) runs, the system starts managing the software installed on all previously excluded devices.

---

Get started with Software Asset Management

Get started with Software Asset Management to optimize management of software installations in your environment.

Role required: sam_admin

After you have set up **Software Asset Management**, complete the basic configuration.

   **Note:** Microsoft Office 2013 is used in the following example.

1. Navigate to **Software Asset > Licensing > Software Models** and create a software model for common software (see table for field descriptions).
2. Create a basic per-user or per-device entitlement for the software.
   a) Open the software model record you created.
   b) Scroll down to the Software Entitlements tab, and create a new software entitlements record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software model</td>
<td>Microsoft Office 2013 Professional Plus</td>
</tr>
<tr>
<td>License metric</td>
<td>Per User</td>
</tr>
<tr>
<td>Purchased rights</td>
<td>200</td>
</tr>
</tbody>
</table>

3. After discovery of software installed, run reconciliation to reconcile software rights owned against software installed, concerning discovery and software entitlements.
   a) Navigate to **Software Asset > Reconciliation > Run Reconciliation**.
   b) Select the publisher on which to run reconciliation, or select all publishers, and click **Proceed**.
      Allow time for the reconciliation process to complete, especially if you selected all publishers.

4. View reconciliation results that show the compliance status of your software products.
   a) Navigate to **Software Asset > Reconciliation > Historical Results**.
   b) Open the reconciliation result record to view product results.
   c) Open product result records to view compliance status of specific software models, such as number of unlicensed installs and the true-up cost to become compliant.
d) Open a software model result to view license metric compliance, such as rights owned and used.

e) Drill down further into the license metric results to view how rights are used, and software installs using the rights.

For non-compliant product results, you can execute a remediation option from the Remediation Options tab. You can also create a purchase order directly from the Remediation Option form, which is integrated with the Procurement application. The purchase order fields are automatically populated with the content from the software model result.

Depending on the compliance status of your software installations, you can choose to optimize your environment further.

For example, you can add a reclamation rule to reclaim software rights that do not meet minimum usage requirements so they can be allocated elsewhere. You can also add a pattern normalization rule to normalize specific software products in your environment.

**Software asset connections**

Use third-party discovery sources to discover the installed software data that you can integrate with the Software Asset Management application.

The discovery process is an integral part of the Software Asset Management application. The discovery process consists of discovering where the installed software in your organization is installed, who the owner of the device is, and where it's located. The discovered information is then merged into a common configuration management database such as the CMDB application.

The CMDB application enables other business applications to use the discovered information to support various business needs.
External Discovery Data Sources

Identification and Reconciliation Engine

CMDB + Software Asset Management
- Data Center Software and Servers
- End User Software and Devices
ServiceNow platform’s identification and reconciliation engine (IRE) framework enables all third-party data integrations with the CMDB application.

IRE provides a centralized framework where you can perform reconciliations and de-duplication of the data when multiple sources are ingesting data at the same time. IRE uses identification rules, reconciliation rules, and IRE data source rules to process the incoming data and then inserts the data into the corresponding CMDB tables. You can extend these rules to insert the data into tables that extend the CMDB core tables such as the Software Asset Management tables. There are two types of identification rules for IRE:

- **Independent**: If the Independent check box is selected on a CI identifier, it means that the CI is not dependent on any other CI.
- **Dependent**: If the Independent check box is not selected on a CI identifier, it implies that this CI is dependent on other CIs.

For more information on IRE, see *Identification and Reconciliation Engine*.

You should have already configured loading the CIs in the ServiceNow instance. For each CI in your environment, the Hardware (cmdb_ci_hardware) table has a corresponding CI identifier rule. When the third-party discovery application runs, the software is identified on CIs. The third-party application constructs a payload and sends the payload via the IRE REST API endpoint to the ServiceNow instance to insert or update data into the Software Asset Management tables.

A *generic payload* is used for creating installed software records. For Oracle, VMware, and Citrix, specific payloads feed additional publisher-specific data apart from software installations.

If multiple discovery sources are enabled and if the key details of the software, such as the display name and the version for all discovery sources, match, the Installation record is overwritten. If multiple discovery sources identify the same software with different field values, an entry is created in the Software Installation (cmdb_sam_sw_install) table. When the schedule job *SAM-Deduplication install table* runs and if all the normalized values of these installations match, only one record is set to active. The rest of the records are marked as inactive.

Domain separation is supported for third-party discovery with SAM with the following considerations:

- The IRE REST API stamps the domain that you are logged in to when the REST call is made.
- Log in to the domain where the CI resides and from where you run the payload.
- Don’t log in to the parent domain. Being logged in the parent domain updates the existing CI and also creates a new CI in the parent domain.
- Send the payload from the same domain where the CIs reside. For example, if you send a payload from Domain A and if the payload has CIs that belong to Domain B, a new CI gets created in Domain A.

**Configure third-party discovery sources for Software Asset Management**

Set up a third-party discovery source for Software Asset Management to populate the Software Installation (cmdb_sam_sw_install) table with software found in your environment.

To use the features of the Software Asset Management application with any third-party discovery source, you must populate the CMDB application and the related tables that reside on the ServiceNow instance. The Software Asset Management application uses the IRE API to help you populate the Software asset management tables. As the IRE API relies on the configuration item (CI) identifiers, the SAM tables require a relationship to the CI for IRE support. For more information on the IRE API, see *Identification and Reconciliation Engine*. 

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Role required: sam_developer

1. Navigate to **Software Asset > Properties**.
2. Select the **Enable scheduled jobs when using third partyDatasource Integration Framework** (com.snc.samp.ire.datasource.integration) property.
3. Run your discovery source to identify software on the CIs. The CI is used to construct a payload.
4. Send the payload to the ServiceNow instance using the IRE REST API. For information on a sample payload, see **Sample payload for generic software install records**.
   
   In the payload, make sure to send the sys_class_name of the CI, so that the CI is not reclassified when an insert or update operation is performed.
   
   An entry is created in the Software Installation (cmdb_sam_sw_install) table with a display name, publisher, and version. Reconciliation is run against the content service and a discovery model is identified for that software. If a discovery model does not exist, a discovery model is automatically created for the software. You can start using the Software Asset Management application.

**Resolve duplicate software installations in the Software Installation table**

Resolve duplicate software installation records that get created in the Software Installation (cmdb_sam_sw_install) table while running multiple discovery sources.

Role required: sam_developer

Software installations that are discovered on the same configuration item, but from different discovery sources, are considered duplicates. If you are running multiple discovery sources on CIs, duplicate software installation records get created in the Software Installation (cmdb_sam_sw_install) table from different discovery sources. You can resolve these duplicate entries by running the scheduled job **SAM- Deduplication install table**.

1. Navigate to **Software Asset > Properties**.
2. Click Yes to select the **Enable scheduled jobs when using third partyDatasource Integration Framework** (com.snc.samp.ire.datasource.integration) property.
3. Execute the scheduled job **SAM- Deduplication install table**.
   
   Based on the deduplication logic, only one software installation record is marked true and the other duplicate records are marked false. In the Software Installation (cmdb_sam_sw_install) table, the value in the Active installs column for only one of the duplicate record is true.
   
   4. Navigate to the Software Installation (cmdb_sam_sw_install) table.
   
      The value in the Active Installs column for only one of the duplicate record is set to true. The remaining duplicate entries for the software installation record is set to false.

**Delete uninstalled software from the Software Installation table**

Delete installations from the Software Installation (cmdb_sam_sw_install) table if those software installations are also uninstalled from a CI.

After the discovery process runs and you identify software installations that are uninstalled from a CI, delete those installations from the Software Installation (cmdb_sam_sw_install) table in the CMDB application.

Create a script to delete multiple software installation records from the Software Installation (cmdb_sam_sw_install) table. You can use the Table API to query the Software Installation table to get the installation list for the CI.
Role required: sam_developer

You can also delete software installation records for specific publishers like Oracle, VMware, and Citrix.

1. Use the REST Table API api/now/table/cmdb_sam_sw_install?
sysparm_query=installed_on%3D28c9c3b8c0a8000b009b2d941d7e3ee9 to query and identify the list of software installs on a specific CI.

For more information on the REST endpoint API, see Table API-GET.

a) Specify the table name, Software Installation (cmdb_sam_sw_install) table and query parameters.

For the query parameters, specify either the sys_id of the CI or a list of fields that are separated by commas such as publisher, version, and product on which you want to perform the delete operation.

b) After entering the query parameters, send the request.

You get a response in a JSON format listing of all the software installations for that specific CI. You can view the sys_id for all the software installations in the response.

2. Based on the response, identify the sys_ids of the software installations that are deleted on a CI.

Only the sys_ids of those software installations need to be passed through the Delete API.

3. Use the Delete API request.setEndpoint('http://xyz/api/now/
table/cmdb_sam_sw_install/728e87dafd841010fa9bea491bf6d1ff');
request.setHttpMethod('DELETE'); to delete the software installs from the Software Installation (cmdb_sam_sw_install) table.

xyz in the URL refers to your ServiceNow instance.

a) Specify the table name, Software Installation (cmdb_sam_sw_install) table, and the sys_ids of the software installations that are deleted on the CIs.

b) Send the request.

The software installations are deleted from the Software Installation (cmdb_sam_sw_install) table.

Sample payload for generic software install records

A sample payload that populates the Software Installation (cmdb_sam_sw_install) table in the ServiceNow instance with discovery data collected by third-party discovery sources.

The following is a sample payload for creating software install records for publishers such as Microsoft, IBM. For Oracle, VMware, and Citrix, specialized payloads are used.

In this sample payload, you are passing the information of the installed software, Microsoft Word 2016, and the related CI to inform where it is installed (on a computer CI 'SAMILMT8'). You can look up column names in the cmdb_sam_sw_install table and send information by passing the columns, value pairs in the payload. For example, in this payload you are sending the publisher, version and display_name columns. You can also send additional information such as the edition column.

```
{ 'items': [[{ 'className': 'cmdb_ci_computer',
       'related': []
```
Sample payload for Oracle software install records

A sample payload for Oracle publisher pack that populates the Oracle Instance (cmdb_ci_db_ora_instance) table with software install records from third-party discovery sources.

After you discover Oracle software installs via your discovery source, send a payload that contains the Oracle Instance and the Oracle options associated with the Oracle Instance.

Note: In the Properties page, make sure to select the Enable scheduled jobs when using third party Datasource Integration Framework (com.snc.samp.ire.datasource.integration) property.

When the schedule job, SAM- Software Asset Connections, runs, it looks for records with null software installs, populates the software install field in the Oracle Instance table and creates the software install record associated to the instance.

The following is a sample payload to create software install records for Oracle in the Oracle Instance (cmdb_ci_db_ora_instance) table. The sample input contains a list of CIs and relationships that exist between these CIs. The payload states that there is an Oracle database

<table>
<thead>
<tr>
<th>Element</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>className</td>
<td>cmdb_ci_computer</td>
<td>The class name of the CI.</td>
</tr>
<tr>
<td>className</td>
<td>cmdb_sam_sw_install</td>
<td>The name of the related table in the CMDB application where the CI is to be created.</td>
</tr>
<tr>
<td>publisher</td>
<td>Microsoft</td>
<td>The name of the publisher for whom this entry is being created in the table.</td>
</tr>
<tr>
<td>version</td>
<td>2016</td>
<td>The version of the software for which this entry is created in the table.</td>
</tr>
<tr>
<td>display name</td>
<td>Word</td>
<td>The display name for this entry in the table.</td>
</tr>
<tr>
<td>name</td>
<td>SAMILMT8</td>
<td>Unique identifier of the CI.</td>
</tr>
</tbody>
</table>
server, Dev development 1969 with a standard edition. The Oracle database server has many Oracle options enabled such as Armstrong, Aldrin, Collins and runs on a Linux server.

```json
{
  'items': [
    {
      'className': 'cmdb_ci_db_ora_instance',
      'related': [
        {
          'className': 'samp_oracle_options',
          'values': {
            "option": "Armstrong",
            "currently_used": "true"
          }
        },
        {
          'className': 'samp_oracle_options',
          'values': {
            "option": "Aldrin",
            "currently_used": "true"
          }
        },
        {
          'className': 'samp_oracle_options',
          'values': {
            "option": "Collins",
            "currently_used": "true"
          }
        }
      ],
      'values': {
        'name': 'Dev development 1969',
        'edition': 'Standard',
        'sid': '1-2-569',
        'version': '11.2'
      }
    },
    {
      'className': 'cmdb_ci_linux_server',
      'values': {
        'name': 'CI DATAI 6-002',
        'mac_address': '4653XYZAA',
        'ip_address': '10.10.10.8',
        'asset_tag': 'HWR0003',
        'assigned_to': 'a8f9bb0eb32010045e1a515206fe3a',
        'cpu_count': '16',
        'cpu_manufacturer': '820351a1c0a8018b67c73d5c074097c',
        'manufacturer': '820351a1c0a8018b67c73d5c074097c',
        'os': 'Linux Red Hat',
        'os_version': '2.6.9-22.0.1.Elsmp',
        'ram': '2014'
      }
    }
  ],
  'relations': [
    {
      'type': 'Runs on::Runs',
      'parent': 0,
      'child': 1
    }
  ]
}
```
### Sample payload for VMware software install records

A sample payload for VMware publisher pack that populates the VMware Discovered License key consumption (samp_vmware_license_key_usage) table with software install records from third-party discovery sources.

After you discover software installs via your discovery source, send a payload via the IRE REST API endpoint to the ServiceNow instance to populate the VMware Discovered License key consumption (samp_vmware_license_key_usage) table with software install records.
1. Send a payload to create a license key in the VMware Discovered License key (samp_vmware_license_key) table.

2. From the response body of the payload, copy the sys ID of the new license key and paste it in a text editor for later use.

3. Use the Enhanced IRE API to query the sys IDs of the CIs that use the new license key.

4. From the response body, copy the sys IDs of the CIs and paste them in a text editor for later use.

5. Send a payload with the sys ID of the license key and the sys ID of the CIs.

6. Run the schedule job, SAM- Update Software Usage to populate the VMware Discovered License key consumption (samp_vmware_license_key_usage) table with the software install records.

```
Request Body
{
  'items': [
    {
      'className': 'cmdb_ci_vcenter',
      'related': [
        {
          'className': 'samp_vmware_license_key',
          'values': {
            'cost_unit': 'cpuPackage',
            'edition': 'esxEnterprisePlus.vram',
            'features': 'autodeploy,das,dpvmotion',
            'license_key': 'SYDOJ-28J5Q-78X48-0NC24-REKAR',
            'product_name': 'VMware vSphere 5 Enterprise Plus',
            'product_version': '5.0',
            'rights_owned': '8',
            'rights_used': '6'
          }
        }
      ],
      'values': {
        'name': 'VCenter Ref 1A'
      }
    },
    {
      'className': 'cmdb_ci_win_server',
      'values': {
        'name': 'VirtualMachine-WS2'
      }
    }
  ],
  'relations': [{
    'type': 'Runs on::Runs',
    'parent': 0,
    'child': 1
  }]
}
```

Response Body
```json
{
    "result": {
        "items": [
            {
                "className": "cmdb_ci_vcenter",
                "operation": "INSERT",
                "sysId": "8fb47793e7cc10107aea07d8d2f6a93a",
                "relatedSysIds": [
                    "cbb47793e7cc10107aea07d8d2f6a93f"
                ],
                "relatedItems": [
                    {
                        "className": "samp_vmware_license_key",
                        "sysId": "cbb47793e7cc10107aea07d8d2f6a93f",
                        "markers": [],
                        "inputIndices": [
                            {
                                "mainIndex": 0,
                                "subIndex": 0
                            }
                        ],
                        "additionalRelatedItems": [],
                        "identifierEntrySysId": "Unknown",
                        "identificationAttempts": [
                            {
                                "attributes": [
                                    "name"
                                ],
                                "identifierName": "VMWare VCenter Ref CI",
                                "attemptResult": "NO_MATCH",
                                "searchOnTable": "cmdb_ci_vcenter",
                                "hybridEntryCiAttributes": []
                            }
                        ],
                        "errorCount": 0,
                        "markers": [],
                        "inputIndices": [0]
                    }
                ],
                "additionalRelatedItems": [],
                "identifierEntrySysId": "Unknown",
                "identificationAttempts": [
                    {
                        "attributes": [
                            "serial_number",
                            "serial_number_type"
                        ],
                        "identifierName": "Hardware Rule",
                        "attemptResult": "SKIPPED",
                        "searchOnTable": "cmdb_serial_number",
                        "hybridEntryCiAttributes": []
                    }
                ],
                "attributes": [
                    "serial_number"
                ]
            }
```
From this we get the samp_vmware_license_key sys id

-- Obtaining the CI sys id (POST)
role: sam_admin

https://k8s0057813-node1.thunder.lab3.service-now.com/api/now/
identifyreconcile/queryEnhanced?sysparm_data_source=ServiceNow

Request Body
{
  'items': [
    {
      'className': 'cmdb_ci_win_server',
      'values': {
        'name': 'Server-WS11'
      }
    }
  ]
}

Response Body
{
  "result": {
    "items": [
      {
        "className": "cmdb_ci_win_server",
        "identifierEntrySysId": "cbb47793e7cc10107ae07d8d2f6a93f"
      }
    ]
  }
}
"operation": "UPDATE",
"sysId": "99ccb31ddbe7720087b9fd441d9619da",
"identifierEntrySysId": "556eb250c3400200d8d4bea192d3ae92",
"identificationAttempts": [
  {
    "identifierName": "Hardware Rule",
    "attemptResult": "SKIPPED",
    "attributes": [
      "serial_number",
      "serial_number_type"
    ],
    "searchOnTable": "cmdb_serial_number",
    "hybridEntryCiAttributes": []
  },
  {
    "identifierName": "Hardware Rule",
    "attemptResult": "SKIPPED",
    "attributes": [
      "serial_number"
    ],
    "searchOnTable": "cmdb_ci_hardware",
    "hybridEntryCiAttributes": []
  },
  {
    "identifierName": "Hardware Rule",
    "attemptResult": "MATCHED",
    "attributes": [
      "name"
    ],
    "searchOnTable": "cmdb_ci_hardware",
    "hybridEntryCiAttributes": []
  }
],
"markers": [],
"inputIndices": [0],
"mergedPayloadIds": [],
"errorCount": 0
},
"additionalCommittedItems": [],
"relations": [],
"additionalCommittedRelations": []
}

where "sysId": "99ccb31ddbe7720087b9fd441d9619da" is the sys id of the ci/used_by

// create usage table
POST https://k8s0057813-node1.thunder.lab3.service-now.com/api/now/table/samp_vmware_license_key_usage?sysparm_fields=sys_id
{"license_key":"cbb47793e7cc10107a07d8d2f6a93f";"rights_used":"1","used_by":"99ccb31ddbe..."}
### Sample payload for Citrix software install records

A sample payload for the Citrix publisher pack that populates the Software Installation (cmdb_sam_sw__install) table with software install records from third-party discovery sources.

The Citrix publisher pack supports two products: virtual applications and virtual desktop. For these products, Citrix supports concurrent licensing and user/device licensing.

**Note:** For information on license metrics, see *Software License Metrics*

The IRE API relies on two CI identifier rules for creating Citrix software install records. The Citrix License server (cmdb_ci_appl_license_server) identifier populates the CAL entries and the Citrix Delivery Controller (cmdb_ci_appl_delivery_controller) identifier creates the software install records.

The CAL entries are used during reconciliation to compare against the purchased rights in entitlements to get the correct license position for Citrix products. The Citrix License server identifier provides information on the samp_concurrent_license_consumption and the samp_user_device_license_consumption tables. Based on your licensing entitlements, you need to populate either of these two tables.

Send a payload to populate the samp_concurrent_license_consumption or the samp_user_device_license_consumption table. Ensure that you mention the key attributes for the tables in the payload:

- samp_concurrent_license_consumption: product_code and number
- samp_user_device_license_consumption: product_code, consumer, and consumer_type

**Note:** The two tables are passed in one payload since both are related entries of the parent CI table, cmdb_ci_appl_license_server. In the payload, specify the relationship between the tables and the CI parent table.

Once you send the payload, entries are created in the samp_concurrent_license_consumption and the samp_user_device_license_consumption tables. Now execute the scheduled job, SAM-Create Citrix CAL entries, to update the Client Access (samp_sw_client_access) table. Client access records are created for each product with user/device count.
Note: Ensure that you configure the schedule job, SAM- Create Citrix CAL entries to execute after processing the payload successfully.

Using the Citrix Delivery Controller (cmd_ci_appl_delivery_controller) identifier, send a payload to populate all the 7 Citrix tables. Make sure that you mention the key attributes for the 7 tables in the payload.

Note: Click Related Entries in the Citrix Delivery Controller identifier to look up the key attributes (Criterion attributes) for the Citrix tables.

Once the entries are created in the tables, execute the scheduled job, SAM- Create Citrix Software installs. The Citrix software install records are created in the Software Installation (cmd_sam_sw_install) table.

```json
{
    'items': [{'className': 'cmd_ci_appl_license_server', 
        'related': [{'className': 'samp_concurrent_license_consumption', 
            'values': {'product_code': 'MW2ZPSE0001',
                'in_use_count': 511,
                'overdraft': 11,
                'pooled_available': 0,
                'total_count': 500}
            },
        ],
        'className': 'samp_user_device_license_consumption', 
        'values': {'product_code': 'XDT_PLT_CCS', 
            'consumer': 'consumer1',
            'consumer_type': 'user'}
    }
}
```
Configuring Software Asset Management

Now that you’ve finished setting up Software Asset Management, configure Software Asset Management.

Using the Microsoft Excel spreadsheet template provided, import all of your software entitlements at once. If you’ve included publisher part numbers (PPN) to the template, software models are automatically created and linked to your entitlements.
Your discovery source pulls in your software installation data. After the data is pulled into your system, the data is compared against the Software Asset Management Content Service library and normalized. If normalized data doesn’t exist in the content library, you can manually normalize your data. Updates to the content library occur weekly, which means that more of your data is automatically normalized.

Import software rights

If you’ve been tracking your software terms using a Microsoft Excel spreadsheet, you can import the software rights. Use the drag-and-drop import interface to import an .xlsx file and automatically manage pre-import and post-import data quality checks. After you’ve imported the rights, view the results and fix any errors.

Role required: sam_admin (read/write only)

1. Navigate to Software Asset > Licensing > Import Entitlements.
2. Click Download Template File (.xlsx).
3. Format your software rights data using Page 1 of the template file you downloaded.

**Note:** You can add software entitlement fields to the template to include additional fields in your import. Add each field as a new column in the template. The column name must match the field label exactly. You can include base system software entitlement fields as well as your custom software entitlement fields. To learn how to create a custom field, see Add and customize a field in a table.

4. Drag and drop your completed file on the Import Software Entitlements form, or click Browse files.
5. Click Upload.
6. To resolve any import errors, navigate to Software Asset > Licensing > Entitlement Import Errors. For more information about resolving import errors, see Entitlement import error actions.

If the database option is specified for Oracle database server, then while importing entitlements, an exact match is made to create an entitlement for the software model.

The Software Entitlements list is updated with the software rights you imported.

Import software rights

You’ve created a list of software rights in Microsoft Excel and you need to import them into the Now Platform. Using the import template to format your data, you fill out four of the fields and leave the rest empty.

<table>
<thead>
<tr>
<th>Publisher</th>
<th>Product</th>
<th>Version</th>
<th>Agreement type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft</td>
<td>Office 365</td>
<td>Enterprise</td>
<td>Generic</td>
</tr>
<tr>
<td>Microsoft</td>
<td>Office 365</td>
<td>Standard</td>
<td>Generic</td>
</tr>
</tbody>
</table>

Navigate to the Import Software Entitlements form and add your file.

After you’ve imported the Microsoft Excel file, you receive an error message indicating that some of your entitlements could not be created. Click View all to see the entitlements that caused import errors.
To fix the issue, open and resolve both of the entitlement import error records. The Entitlement Import Error form indicates that fields are missing and must be updated before the entitlement can be created. For each error, add the following information to the form.
Entitlement Import Error form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software model</td>
<td>For the enterprise version, enter Microsoft Office 365 Enterprise E5.</td>
</tr>
<tr>
<td></td>
<td>For the standard version, enter Microsoft Office 365 2016.</td>
</tr>
<tr>
<td>License type</td>
<td>Perpetual</td>
</tr>
<tr>
<td>License metric</td>
<td>Per User</td>
</tr>
<tr>
<td>Purchased rights</td>
<td>100</td>
</tr>
</tbody>
</table>

Click **Save**. An entitlement record is created and the error status is changed to **Fixed**.

After importing entitlements, you can begin **viewing software usage**.

**Record product details**

Create a software model to add product details that are used to connect software rights you purchased with software installations discovered on your system.

Role required: **sam_user** or **model_manager**

You can manually create a software model. However, you can leverage the Software Asset Management Content Service Library to automate the creation of software models through their relationship to software entitlements. While creating or importing a software entitlement, specifying a publisher part number automatically creates a software model (if needed) or links to an existing software model. You need to manually create a software model if a publisher part number is not available, a publisher part number does not exist in the Content Service Library, or if you are creating a software model for a custom product.

**Note:** If you have the **model_manager** role, you can navigate to **Product Catalog > Product Models > Software Models** but cannot administer all aspects of software models.

If you’ve installed the SAP publisher pack, see **Record publisher details for SAP**.

1. Navigate to **Software Asset > Licensing > Software Models**.
2. Click **New**.
3. On the Software Model form, **fill in the details** about the software publisher.
4. Right-click the form header and select **Save**.
5. Specify whether your software publisher is part of a suite.
   - To designate your software model as a suite parent, click the **Suite Parents related list** and add all software included with the suite.
   - To designate your software model as a suite component, click the **Suite Components related list** and add the parent suite.
Note: If you’ve add a discovery map to your product details, predefined suites are used and suite components are created automatically for known suite parent.

6. To include your software model in the centralized repository of model information, click the Publish to Software Catalog related link and add the publisher information.

7. To see discovery maps that have the match the software publisher and product fields of the software model, click the Show Matching Discovery Models related link.

8. To specify lifecycle information for your software model, click the Software Model Lifecycle related list and add the lifecycle information.

9. To set the attribute value, click the Metric Attributes related list and complete the form.
When you add an attribute value, entitlements with this publisher information associated with them automatically have the Metric Group field populated. Based on the metric group, only license metrics related to the publisher are available.

10. To associate your software model with a vendor, click the Vendor Catalog Item related list and complete the form.

11. To specify the number of devices or users that are accessing the software, click the Client Access related list and complete the form.

12. To create a new record for the software downgrade rights, click the Downgrade Rights related list and complete the form.

Note: If your software model has a discovery map associated with it and the discovery map has downgrade rights, the downgrade rights are populated automatically. Downgraded versions of the software appear in a hierarchical list. For more information, see Downgrade Rights.

13. Click Update.

Record product details
Create a software model to add publisher details for Microsoft Office 365 so that you can begin tracking your software rights and user allocations.

To begin recording the product information, add the following information to the Software Model form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher</td>
<td>Microsoft</td>
</tr>
<tr>
<td>Product</td>
<td>Office 365</td>
</tr>
<tr>
<td>Discovery map</td>
<td>DMAP0006292</td>
</tr>
</tbody>
</table>

The Product classification and Product type fields are generated automatically after you enter the publisher and product details.

Discovery maps are a predefined set of conditions that are related to a particular type of software. For example, a discovery map could include both a version and edition for the software you are defining publisher details for.

The Edition field is automatically populated with Enterprise E1.
Click **Save**.

Because Microsoft Office 365 is a suite of products, you can track the individual software included with the software suite.

Add Microsoft Excel.
Click **Save**.

To keep your software current and up-to-date, click the *Software Model Lifecycle related list* and add the lifecycle information.

<table>
<thead>
<tr>
<th>Software model</th>
<th>Lifecycle type</th>
<th>Lifecycle phase</th>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Office 365 Enterprise E1</td>
<td>Internal</td>
<td>General Availability</td>
<td>Internal</td>
<td>Suite of products that should be installed for all users.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><em>Phase start date</em></th>
<th>Risk</th>
</tr>
</thead>
<tbody>
<tr>
<td>2019-07-19</td>
<td>Moderate</td>
</tr>
</tbody>
</table>

Click **Submit**.

To track the vendor for your product, click the *Vendor Catalog Items related list* and complete the form.

Next, click the *Client Access related list* and complete the form to add the number of users that have access to Microsoft Office 365.

The discovery map that is associated with the software model doesn’t have downgrade rights. To add downgrade rights, click the *Downgrade Rights related list* and complete the form.
On the Software Model form, click **Update** to update the record with your changes.

Once you’ve added your software publisher information, you can record your purchased publisher rights and link them back to the publisher information.

**Record software rights and user allocations**

Record your license details and allocate purchased software rights to users or devices by adding a software entitlement.

Role required: sam_user

These instructions are for manually creating software entitlements or maintenance entitlements one at a time. If you already have software entitlements recorded in a spreadsheet, you can **import** them easily using the drag-and-drop interface.

To automate the process of creating a software entitlement, specify a publisher part number in the software entitlement form. Based on the publisher part number, the software model, metric group, agreement type, and software lifecycle data (if it exists) automatically appears in the form.

If you installed SaaS License Management, a software model is generated automatically after you create an integration profile. Create an entitlement for the software model to track software used against software owned. For more information about tracking SaaS licenses and usage, see **View software usage and cost**.

If you installed the SAP publisher pack, see **Record software rights for SAP**.

If you installed the Citrix publisher pack, see **Record software rights for Citrix**

1. Navigate to **Software Asset > Licensing > Software Entitlements**.
2. Click **New**.
3. On the form, fill in the fields to record your license information. For detailed descriptions of the fields, see Software entitlement fields.

4. Right-click the form header and select Save. Saving the form instead of submitting keeps you on the entitlement record so you can perform additional configuration.

5. To specify users and devices that have software rights allocated to them, click the User Allocations or Device Allocations section. The Device Allocations section is not visible for IBM license metrics: RVU Full Capacity and RVU Sub-capacity. The RVU license metric is licensed at the product level and so rights are not used by individual devices. When you upgrade from a prior release, that had device allocations, to the Paris release, the existing device relocations are removed.

6. To track your software downgrade rights, click the Downgrade Rights related list and specify the version. Creating a new record allows you to set an entitlement to previous versions of software. For example, the purchase of Microsoft Office Professional Plus 2016 rights entitles you to Microsoft Office Professional Plus 2013 too.

7. To track the cost of your software over its lifecycle, configure expense lines.

8. To manage license keys, click the License Keys related list and specify which licenses keys are allocated to entitlements.

9. To view the history of all maintenance entitlements that you have purchased, click the Entitlement History related list. For example, if you purchased two maintenance entitlements, M1 (which is now retired) and M2 (currently in use), the Entitlement History related link displays both M1 and M2.

10. To view the history of the newly upgraded software model related to your entitlement and the previous software model, click the Upgrade History related list.

11. Click Update.

The entitlement is added to the Software Entitlement list.

**Record software rights and user allocations**

After creating the software model for Microsoft Office 365, record the 100 software rights you have associated with the software product.

Add the following information to the Software Entitlement form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software model</td>
<td>Microsoft Office 365 Enterprise E1</td>
</tr>
<tr>
<td>Agreement type</td>
<td>Generic</td>
</tr>
<tr>
<td>License type</td>
<td>Perpetual</td>
</tr>
<tr>
<td>License metric</td>
<td>Per User</td>
</tr>
<tr>
<td>Purchased rights</td>
<td>100</td>
</tr>
<tr>
<td>Unit cost</td>
<td>25.00</td>
</tr>
<tr>
<td>Owned by</td>
<td>Abel Tuter</td>
</tr>
<tr>
<td>Serial number</td>
<td>12345</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Safe</td>
<td>In-use</td>
</tr>
<tr>
<td>Company</td>
<td>Microsoft</td>
</tr>
<tr>
<td>Location</td>
<td>3260 Jay Street, Santa Clara, CA</td>
</tr>
<tr>
<td>Department</td>
<td>IT</td>
</tr>
</tbody>
</table>

Click **Save**.
### Software Entitlement

**Microsoft Office 365 Enterprise E1**

<table>
<thead>
<tr>
<th>Display name</th>
<th>Microsoft Office 365 Enterprise E1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset tag</td>
<td></td>
</tr>
<tr>
<td>Publisher part number</td>
<td></td>
</tr>
<tr>
<td>Software model</td>
<td>Microsoft Office 365 Enterprise E1</td>
</tr>
<tr>
<td>Agreement type</td>
<td>Generic</td>
</tr>
<tr>
<td>Reserve entitlement</td>
<td></td>
</tr>
<tr>
<td>License type</td>
<td>Perpetual</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**License metrics**

- **Metric group**: Microsoft
- **License metric**: Per User
- **Purchased rights**: 100
- **Active rights**: 100
- **Allocations available**: 100
- **Unit cost**: $25.00
- **Total cost**: $3,360.00

**Source entitlement**

<table>
<thead>
<tr>
<th>General</th>
<th>Financial</th>
<th>Contracts</th>
<th>User Allocations</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Serial number</td>
<td>12345</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Owned by</td>
<td>Abe Tuter</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>In use</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substate</td>
<td>--None--</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maintenance</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Company**: Microsoft

**Location**: 3260 Jay Street, Santa Clara, CA

**Department**: IT
After you’ve entered the purchased rights and unit costs, the **Purchased rights**, **Active rights**, **Allocations available**, and **Total cost** fields are generated automatically.

Next, click the **User Allocations** section to record which users are consuming the software rights. Add Abraham Lincoln as a user.
Track your software downgrade rights by clicking the Downgrade Rights related list and completing the form.

The Expense Lines related list displays the total cost calculated when you entered the entitlement information.

To add a license key, click the License Keys related list.

Because there are no additional entitlements associated with the one you created, the Entitlement Histories and Upgrade Histories related list don’t display any additional information.

Click Update.

After you’ve created an entitlement, you can begin viewing software usage.

**Software license metrics**

License metrics are set in software entitlements and are used for reconciliation (metric group, license metric, and software model combination).

Each metric group has a set of license metrics that are specific to the publisher.

You can view the Metric Attributes related list in software models to set the attribute value.

You can also add custom license metrics.

Adobe, Citrix, IBM, Microsoft, Oracle, SAP, and VMware publisher packs are available as add-ons that provide the capability to manage software licensed under the publisher licensing models.
Installing SaaS License Management adds the Subscription metric group.

You can view descriptions of the license metric by pointing to the reference field icon (i) in the License metric field in the software entitlement.

### License metrics

<table>
<thead>
<tr>
<th>Metric group</th>
<th>License metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe (Add-on)</td>
<td>• Per Device: Licenses a device for the number of installations of software.</td>
</tr>
<tr>
<td></td>
<td>• Per User: Licenses a user for the number of installations of software.</td>
</tr>
<tr>
<td></td>
<td>• User Subscription: Licenses a user for the number of activated software</td>
</tr>
<tr>
<td></td>
<td>subscriptions.</td>
</tr>
</tbody>
</table>

When reconciliation is run for a software model that has one or more entitlements with the User Subscription license metric, a right is consumed for each active unique software subscription record assigned to a user.

- A right is considered **Allocated in use** when a user has both allocation and a subscription record.
- A right is considered **Not Allocated in use** when a user does not have a user allocation but has a subscription record.
- A right is considered **Allocated not in use** when a user has a user allocation but does not have a subscription record.

If multiple rights are assigned to a user in a user allocation, then the user has the corresponding number of subscriptions for the software model. For example, if a user has a user allocation with a quantity of 2 rights, but only one subscription record related to a software model, then one right is considered **Allocated in use** and a second right is considered **Allocated not in use**.
<table>
<thead>
<tr>
<th>Metric group</th>
<th>License metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citrix (Add-on)</td>
<td>• Concurrent User: Licenses the number of simultaneous users accessing the program.</td>
</tr>
<tr>
<td></td>
<td>• Per Device: Licenses a device for the number of installations of software.</td>
</tr>
<tr>
<td></td>
<td>• Per Processor (CPU count): Licenses processors on either a physical server or virtual machine.</td>
</tr>
<tr>
<td></td>
<td>• Per User: Licenses a user for the number of installations of software.</td>
</tr>
<tr>
<td></td>
<td>• Per User/Device: License a unique user or a shared device. If the license is assigned to a user, they have unlimited connections to an unlimited number of devices. If the license is assigned to a device, an unlimited number of users can connect to a single device.</td>
</tr>
<tr>
<td></td>
<td>See for discovery pattern and tables.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The license metric is not visible unless the Citrix publisher pack is installed. A discovery process is required for Citrix data to be collected. For ServiceNow Discovery, a Discovery schedule must be created by an admin to run on the Citrix Delivery Controller for communication with the Citrix License Server.</td>
</tr>
<tr>
<td>Common</td>
<td>• Per Core: Licenses cores on a physical server or virtual machine.</td>
</tr>
<tr>
<td></td>
<td>(CPU core count * CPU count)</td>
</tr>
<tr>
<td></td>
<td>• Per Device: Licenses a device for the number of installations of software.</td>
</tr>
<tr>
<td></td>
<td>• Per Named Device: Licenses a specific device for the number of installations of software.</td>
</tr>
<tr>
<td></td>
<td>• Per Named User: Licenses a specific user for the number of installations of software.</td>
</tr>
<tr>
<td></td>
<td>• Per Processor (CPU count): Licenses processors on either a physical server or virtual machine.</td>
</tr>
<tr>
<td></td>
<td>• Per User: Licenses a user for the number of installations of software.</td>
</tr>
<tr>
<td>Metric group</td>
<td>License metric</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>IBM (Add-on)</td>
<td>• Per Device: Licenses a device for the number of installations of software.</td>
</tr>
<tr>
<td></td>
<td>• Per Named User: Licenses a specific user for the number of installations of software.</td>
</tr>
<tr>
<td></td>
<td>• Per Processor (CPU count): Licenses processors on either a physical server or virtual machine.</td>
</tr>
<tr>
<td></td>
<td>• Per User: Licenses a user for the number of installations of software.</td>
</tr>
<tr>
<td>Note:</td>
<td>• Processor Value Unit (PVU): Number of PVU entitlements required is based on the processor technology and the number of processors made available to the program.</td>
</tr>
<tr>
<td></td>
<td>• Full Capacity: License all activated processor cores in the physical hardware environment.</td>
</tr>
<tr>
<td></td>
<td>• Sub-capacity: License fewer than the full capacity of your server or group of servers.</td>
</tr>
<tr>
<td></td>
<td>• Resource Value Unit (RVU): RVU Proofs of Entitlement are based on the number of activated processor cores used or managed by a product.</td>
</tr>
<tr>
<td></td>
<td>• Full Capacity: License all activated processor cores in the physical hardware environment.</td>
</tr>
<tr>
<td></td>
<td>• Sub-capacity: License fewer than the full capacity of your server or group of servers.</td>
</tr>
</tbody>
</table>

Note: The license metric is not visible unless the IBM publisher pack is installed.
<table>
<thead>
<tr>
<th>Metric group</th>
<th>License metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft (Add-on)</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The license metric in not visible unless the Microsoft publisher pack is installed.

- **Device CAL:** Licenses the number of device client access licenses to server software.
- **Per Core:** Licenses cores on both the physical server and the virtual cores that support virtual machines and presents a cost-efficient model based on the number of rights used. For information on Per Core for Microsoft SQL Server Enterprise edition with Software Assurance, see [Record software rights for a Microsoft Software Assurance](#).

**Note:** Per Core (Physical Core) and Per Core (Virtual OSE) metrics is deprecated from the New York release. Any existing entitlements using Per Core (Physical Core) and Per Core (Virtual OSE) metrics are replaced with Per Core. You may see a change in your reconciliation results.

- **Per Core (with CAL):** Licenses physical servers. The number of licenses depends on the number of installs and Operating System Environments (OSE)s.

  Per Core (with CAL) licenses at the cluster level only when the physical server is an ESX Server and is a part of a cluster. This license metric uses all processors on every ESX Server within a cluster to determine the total number of cores/processors that need to be licensed on the cluster.

**Note:** If vMotion/DRS is enabled on a cluster, any virtual machine can move to any ESX Server within that cluster. The peak capacity of the cores on all the ESX Servers is taken into consideration for rights needed to license the cluster.

- **Per Device:** Licenses a device for the number of installations of software.
- **Per Processor:** Licenses a set number of processors on a physical server.
- **Per User:** Licenses a user for the number of installations of software.
- **Server (Per Instance):** Licenses a set number of software installations on either a physical server or virtual machine.
- **Server (Per Server):** Licenses all software installations on a physical server and any virtual machines hosted by the physical server.
- **User CAL:** Licenses the number of user client access licenses to server software.
- **User Subscription:** Licenses a user for the number of activated software subscriptions.

When reconciliation is run for a software model that has one or more entitlements with...
<table>
<thead>
<tr>
<th>Metric group</th>
<th>License metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concurrent Licenses (Add-on)</td>
<td>These licenses are based on the number of simultaneous users or devices accessing the software.</td>
</tr>
<tr>
<td></td>
<td>- Floating: Shares and manages a pool of software among users or devices on a network. Checks out a license when a user or device requests access to the software. If at the peak of license consumption, there is no license left, the user or device is denied access to the software. Rights consumed is based on the peak number of licenses checked out during the specified period of time.</td>
</tr>
<tr>
<td></td>
<td>- Token: Shares and manages a pool of tokens among users or devices. Checks out a token or a set of tokens when a user or device requests access to the software. If at the peak of license consumption, there are no tokens left, the user or device is denied access to the software. Rights consumed is based on the peak number of tokens checked out during the specified period of time.</td>
</tr>
<tr>
<td></td>
<td>- Network: Shares and manages a pool of licenses among users or devices within a specified TCP/IP network. Checks out a license when a user or device requests access to the software. If at the peak of license consumption, there is no license left, the user or device is denied access to the software. Rights consumed is based on the peak number of licenses checked out during the specified period of time.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Oracle (Add-on)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Named User Plus: Licenses the physical host.</td>
</tr>
<tr>
<td></td>
<td>- Per Processor: Licenses the number of cores on a processor.</td>
</tr>
</tbody>
</table>

Note: The license metric is not visible unless the Oracle publisher pack is installed.

Note: For the Oracle Per Processor license metric, enable Hyper-Threading if you are using a virtual machine (VM) running Amazon Web Services (AWS).

Note: You can select the level of aggregation for the reconciliation calculation of VMware-based Oracle instances using the `com.snc.samp.oracle.reconlevel` property. See Software Asset Management properties.
<table>
<thead>
<tr>
<th>Metric group</th>
<th>License metric</th>
</tr>
</thead>
</table>
| SAP (Add-on)       | • Named User: Licenses the number of named users that can be assigned a given Named User Type. The Named User Type is defined by the software model linked to the entitlement.  
• Engine Measurement: Licenses the amount of engine usage. |
| Note:              | The license metric is not visible unless the SAP publisher pack is installed.   |
| Subscription       | • User Subscription: License is for the number of users.  
• Envelopes: License is for the number of envelopes. Used for the DocuSign service only. |
| Note:              | The license metric is not visible unless the SaaS License Management is installed. |
| VMware (Add-on)    | • Per Application Instance: Licenses per application instance.  
Applies to VMware products: vCenter Server software.  
• Per Device: Licenses per specific device. A license can only be reused if it is completely removed from the device. The number of software users on the device is not relevant as long as the license is used on the licensed device.  
• Per Named User: Licenses per named user.  
• Per OSI: Licenses any server, virtual or physical, with an IP address that generates logs, including network devices and storage arrays.  
• Per Processor: Licenses a physical processor (CPU) in a server. A CPU requires one license per 32 cores. A **Maximum cores per processor** metric attribute with a default value of 32 is automatically created on software models for VMware per processor entitlements. This metric attribute is used during reconciliation to determine license compliance.  
Applies to VMware suite products: vSphere, vSphere with Operations Management. |
| Note:              | The license metric is not visible unless the VMware publisher pack is installed. |
Downgrade Rights

The concept of downgrading licenses is built into the Software Asset Management plugin feature. Downgrade rights is the process of having acquired the rights to the latest version of software but using the rights to license earlier versions of the same software.

The Software Asset Management content service generates downgrade rights. The downgrade rights correspond to a discovery map. A scheduled job, Download software content: Downgrade Rights triggered on a weekly basis, gets the downgrade rights from the Software Asset Management content service and pushes the data to the Downgrade Rights (samp_dmap_downgrade_model) table.

Another scheduled job, SAM- Create downgrades/upgrades for a software entitlement, picks up the information from the (samp_dmap_downgrade_model) table. The table propagates the next version and the downgrade rights on the existing software models and their corresponding entitlements (only if the entitlements are not of Generic type).

If there is no software model corresponding to a discovery map, when populating the Downgrade Rights (samp_sw_downgrade_model) table, a new software model is automatically created.

If the discovery map, corresponding to the software model, has downgrade rights, the Downgrade Rights related list is automatically populated with a hierarchical list of downgraded versions of the software.

Once downgrade rights are created and saved in the Downgrade Rights tables, (samp_sw_downgrade_model) and (samp_downgrade_model), the downgrade rights can't be deleted. However, you can deactivate the downgrade rights.

If you delete a software model, all records corresponding to the software model in the Downgrade Rights (samp_sw_downgrade_model) table are automatically deleted.

The system does not allow duplicate downgrade rights to be created; either through the scheduled job or manually in the Software Model and Entitlement form layout. If you try to create, duplicate downgrade rights on software models or on entitlements, an error message appears informing you that the downgrade model exists. If they have the same values in all the following fields, downgrade rights are considered to be duplicates.

- Publisher
- Product
- Version condition
- Version
- Edition condition
- Edition
- Platform
- Language
- Software install condition
- Named User Type- is displayed only for SAP products.

If you already have duplicate downgrade rights from previous Software Asset Management Professional releases, then those duplicate downgrade rights aren't modified or deleted.

If you try to create a duplicate downgrade right for an inactive downgrade right, an error message appears. The error message informs you that an inactive downgrade right exists and you can reactivate it.
Manage software suites

Simplify licensing and lower license cost offered by vendors on complex software suites. Get visibility to your complex suite licenses, manage compliance, and optimize your spend for these licenses.

Create a suite and add the corresponding components to the suite so the rights that your organization owns are counted accurately during reconciliation.

A software suite is a group of related software offered as one unit. An example is the Microsoft Office Professional suite of office productivity software tools that includes PowerPoint, Word, Excel, Outlook, and Access.

Another example of a server-side suite is the Microsoft Core Infrastructure Server (CIS) Suite. The CIS Suite can include the Windows Server software as well as the System Center suite, which includes Configuration Manager, Operations Manager, and other titles. CIS Suite licensed with Microsoft server metrics (Per Core, Per Core (with CAL), Per Instance, Per Processor, Per Server) are considered during reconciliation.
For any software model, you can specify whether the model is a suite (parent) or a component (child). A software model can be a component in multiple suites. For example, Microsoft Word is a component in Microsoft Office Standard and Microsoft Office Professional. Although you can set a single software model as both a suite and a component, software is not typically sold as nested suites.

If a software model is automatically created as part of a scheduled job, and if the newly created software model consists of child components, these components are automatically created and appear in the *Suite Components* section.

Use the **Inference percent** and **Mandatory** fields when the suite parent is not defined in the install table.

- **Inference percent**: Specifies what percentage of the components in the suite must be installed for the software to be identified as a suite.
- **Mandatory**: Enforces whether a specific component in a suite must be installed to infer that the suite is installed. Choices are: Optional, Always Mandatory, Mandatory Group.

**Note:** If two or more software components have been designated as belonging to a Mandatory Group, then at least one of the software components must be present for all the software components to be considered a suite. This assumes that the inference percent and other requirements are also fulfilled.

For example, say you specify the **Inference percent** as 80% and set the **Mandatory** field to **Always Mandatory** on Microsoft Access. These settings specify that Microsoft Access must be installed, along with three out of four other products (Microsoft Word, Microsoft Excel, Microsoft PowerPoint, and Microsoft Outlook) to infer that Microsoft Office Professional is installed on a device.

When a suite parent is detected during reconciliation, the suite components do not count for the individual license.

**Note:** Users with the model_manager role can navigate to *Product Catalog > Product Model > Software Models*, but cannot administer all aspects of software models.

For subscriptions, if a user has a subscription to a suite parent, any related child component installations on that device are inferred as part of the suite parent, and compliance is determined by the suite parent license. If a user has a subscription to a child component of a suite parent, the related child component installation on that device is not inferred as part of the suite parent, and compliance is determined by the child component license.

### Software models and entitlements

A software model is a profile of the software that you’ve purchased, including information about the publisher, version, and discovery map. Software entitlements are used to relate the software model to the rights that you’ve purchased.

### Software models

Software models are used to record publisher information and create a profile. You can link multiple entitlements to one software model.

If you delete a software model, all records related to the software model, in the Downgrade Rights (samp_sw_downgrade_model and samp_downgrade_model) tables, are automatically deleted.
Software Model Lifecycle Report

You can also track a software model lifecycle phase for use with the Technology Portfolio Management.

View the Software Model Lifecycle Report to be informed about the products nearing end-of-life, end-of-support, and end-of-extended support. View the report by navigating to Reports > View/Run. The report is based on the scheduled job, SAM - Get install count for software model. You can also embed this report in your dashboard.

Software entitlements

To track the software rights for your software, create a software entitlement that can be linked back to the publisher information.

A software entitlement records the terms of your software license. By using software entitlements, you can:

- Rapidly address if license allotment has been exceeded and return to compliant status by removing unauthorized software or ordering more licenses.
- If the license allotment is not being used completely, lower the number of future licenses purchased.

For example, a company purchases a software entitlement for 100 rights. From the software entitlement, 100 employee or machine allocations are created that are rightfully assigned a license. If Discovery finds the software installed on 200 machines, the software asset manager must identify the employees or machines that have the software installed without a license, and remediate the situation.

Import software entitlements

If a Publisher Part Number (PPN) is specified for the entitlements that you import, the PPN is matched to PPN in the Content Service Library and the data is used to create software model automatically.

Note: If a Publisher Part Number not found error occurs during import of the software entitlement (product, publisher, version, edition, platform, and language) but a discovery map is found, then a custom publisher part number is automatically created. If a discovery map is not found, you can create a discovery map to be associated with the publisher part number. If the import spreadsheet contains a conflicting (or missing) PPN, the PPN value is set to the value in the existing product definition, when available.

Note: If you import a batch of Microsoft entitlements and the License Duration field is set to Contractual, you must specify both a start and end date.

The step-up license type is only available if the publisher is Microsoft. If you try to specify another publisher, an error message is displayed.
**Software license maintenance**

Get visibility into your software maintenance entitlements to effectively manage these licenses throughout their life cycle.

Manage and optimize your software maintenance spend by:

- Importing, updating, and creating maintenance entitlements that specify a start and end date.
- Getting accurate true-up costs.
- Maximizing your resources by getting to know your potential savings.
- Being aware of expiring, unused, and under-used maintenance entitlements.

**Maintenance for Microsoft**

Microsoft Software Assurance (SA) is the maintenance program that Microsoft uses to provide active maintenance to its users.

If you’re covered under Microsoft Software Assurance, you can also upgrade, or step-up, a standard version of your software to an enterprise edition. Use the **Related Entitlements** tab of the Software Entitlement form to link related versions of your software under active maintenance and your upgrades.

**Note:** Step-up at any time if you have the Microsoft Open Value agreement with Software Assurance.

If you have the Microsoft SQL Server Enterprise edition with SA for the Per Core license metric, you can run unlimited virtual machines on the host machine. It doesn’t matter how many physical core licenses that you have. For example, let’s say that you have a license for running only four physical cores on a host machine. You can then run unlimited virtual machines on the host machine.

If you create a software entitlement at the same time that you receive a purchase order and SA is activated on that entitlement, the new entitlement is created with one of the following license types:

- Perpetual + SA: If all previous entitlements have the license type specified as Perpetual + SA.
- Perpetual: If the previous entitlements have a combination of license types set to Perpetual + SA and Perpetual.

**Note:** You can’t use SA entitlements to license your software. SA entitlements are not counted during reconciliation. Only perpetual license entitlements are considered.

**Maintenance for publishers other than Microsoft**

For all publishers other than Microsoft, you can create maintenance entitlements to support their software license maintenance needs.

You can associate maintenance entitlements with Perpetual, Perpetual + Maintenance, and Upgrade entitlements. Just open the maintenance entitlement form layout, click the **Related Entitlements** tab, and select the perpetual entitlement that you want to associate with.
If you create a software entitlement while you are receiving a purchase order and maintenance is activated on that entitlement, the new entitlement is created with one of the following license types:

- **Perpetual + Maintenance**: If all previous entitlements have the license type specified as Perpetual + Maintenance.
- **Perpetual**: If the previous entitlements have a combination of license types that are set to Perpetual + Maintenance and Perpetual.

## Record software rights for maintenance entitlements

Define license details, for all publishers other than Microsoft, to manage all your software license maintenance needs such as start and end dates of your contracts and software upgrades.

**Role required:** admin

1. Navigate to **Software Asset > Licensing > Software Entitlements**.
2. Click **New**.
3. On the Software Entitlement form, fill in the mandatory fields and select **Maintenance** in the **License type** field. For a detailed description of all the fields, refer to **Software entitlement fields**.

   If the **Next Version** field is populated in the software model that the maintenance entitlement is associated with and the metric group selected in the maintenance entitlement is **Common**, then the maintenance entitlement is updated with the next version of the software model. Next version is applicable only for the **Common** metric group.

4. Right-click the form header and select **Save**.

   **Note:** If you purchase a perpetual entitlement and associate only some of the rights of that entitlement with a maintenance entitlement, your perpetual entitlement is automatically split into two entitlements. For example, you purchased a perpetual entitlement with 50 active rights (E1). You associate 20 of these rights with 20 rights of a maintenance entitlement. Your E1 perpetual entitlement is now automatically split into two entitlements: one perpetual entitlement (E1) with 20 active rights (and 50 purchase rights) associated with 20 rights of the maintenance entitlement (M1) and another perpetual entitlement (E2) with 30 active rights without any maintenance association and no purchased rights.

5. You can perform additional configuration on your new maintenance entitlement record. For a detailed description, see **Software entitlement fields**.

   You can’t add user or device allocations for maintenance entitlements.
   a) Enter information pertaining to finance such as the vendor from which the asset was purchased, the invoice number, in the **Financial** tab.
   b) Enter information relating to contracts such as the lease contracts, the expiration date of the warranty in the **Contracts** tab.
   c) View the downgrade rights for the software model associated with the maintenance entitlement in the **Downgrade Rights** related list.
   d) To manage license keys, and specify which licenses keys are allocated to entitlements, click the **License Keys** related list.
   e) To track the cost of your software over its lifecycle, click the **Expense Lines** related list.
f) To view the history of all maintenance entitlements that you have purchased, click the Entitlement History related list. For example, if you purchased two maintenance entitlements, M1 (which is now retired) and M2 (currently in use), the Entitlement History related link displays both M1 and M2.

g) To view the history of the newly upgraded software model related to your entitlement and the previous software model, click the Upgrade History related list.

6. Click Update.

Record software rights for a Microsoft Software Assurance

Define license details for Microsoft Software Assurance (SA) to manage your contracts start and end dates, software upgrades, and related software entitlements.

Role required: sam_user or sam_admin

1. Navigate to Software Asset > Licensing > Software Entitlements.
2. Click New.
3. On the Software Entitlement form, fill in the details about the software publisher rights that you’ve purchased and select SA in the License type field.

   Note: Make sure that you enter the number of rights to be granted for the SA entitlement in the Active rights field.

For a detailed description of the fields related to all entitlements, see Record software rights and user allocations.

   Note: You can’t add user or device allocations for SA entitlements.

4. Right-click the form header and select Save. An entitlement appears in the Software Entitlement list.

   Note: If you purchase a perpetual entitlement and associate only some of the rights of that entitlement with a SA entitlement, your perpetual entitlement is automatically split into two entitlements. For example, you purchased a perpetual entitlement with 50 active rights (E1). You associate 20 of these rights with 20 rights of a SA entitlement. Your E1 perpetual entitlement is now automatically split into two entitlements: one perpetual entitlement (E1) with 20 active rights (and 50 purchase rights) associated with 20 rights of the SA entitlement (M1) and another perpetual entitlement (E2) with 30 active rights without any SA association and no purchased rights.

5. To perform additional configuration, select your new software entitlement record in the Software Entitlements list.
   a) To link related perpetual and SA entitlements, select the SA software entitlement record in the Software Entitlements list, and click the Related Entitlements tab.

      To remove the relationship between the perpetual and SA entitlement, remove the entitlement from the Related Entitlements related list in the SA entitlement.

      If you delete either the perpetual or SA entitlement that is linked, the other entitlement isn’t deleted.

      If the entitlement has split and you’ve deleted the SA entitlement, the perpetual entitlement is not removed.
b) To link your software to a newer version as part of your maintenance contract, click the Upgraded Entitlements related list.

**Note:** This related list is only available if you selected **Step-up** as the entitlement license type.

If the **Next Version** field is populated on the software model, entitlements with active SA are updated to the new version of the software model.

After you’ve linked your related entitlements, if there aren’t enough SA rights to cover the perpetual entitlement rights, an error message displays.

c) To view all previously related entitlements that are linked, click the Entitlement History related list.

**Note:** Validation is run against the active rights of all related entitlements automatically. If there’s an error with the calculation, a message with additional information on how to resolve the problem is displayed.

6. Click **Update**.

After you’ve created an entitlement, you can begin viewing license usage.

**Record software rights for Microsoft Software Assurance**

You have purchased 100 rights of Microsoft SQL Server 2016.
### Software Enitlement

**Microsoft SQL Server 2016 Standard Core**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Microsoft SQL Server 2016 Standard Core</td>
</tr>
<tr>
<td>Asset tag</td>
<td></td>
</tr>
<tr>
<td>Publisher part number</td>
<td></td>
</tr>
<tr>
<td>Software model</td>
<td>Microsoft SQL Server 2016 Standard Core</td>
</tr>
<tr>
<td>Agreement type</td>
<td>Generic</td>
</tr>
<tr>
<td>License type</td>
<td>Perpetual</td>
</tr>
<tr>
<td>Metric group</td>
<td>Microsoft</td>
</tr>
<tr>
<td>License metric</td>
<td>Per Core</td>
</tr>
<tr>
<td>Rights per license pack</td>
<td></td>
</tr>
<tr>
<td>Number of pools</td>
<td></td>
</tr>
<tr>
<td>Purchased rights</td>
<td>160</td>
</tr>
<tr>
<td>Active rights</td>
<td>160</td>
</tr>
<tr>
<td>Allocations available</td>
<td>160</td>
</tr>
<tr>
<td>Unit cost</td>
<td>$99.79</td>
</tr>
<tr>
<td>Total cost</td>
<td>$20,398.40</td>
</tr>
</tbody>
</table>

**General**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service number</td>
<td></td>
</tr>
<tr>
<td>Owned by</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td></td>
</tr>
<tr>
<td>Substate</td>
<td>None</td>
</tr>
<tr>
<td>Maintenance</td>
<td></td>
</tr>
</tbody>
</table>

**Financial**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td></td>
</tr>
<tr>
<td>Locations</td>
<td></td>
</tr>
<tr>
<td>Department</td>
<td></td>
</tr>
</tbody>
</table>
You have also purchased SA for your Microsoft SQL Server 2016 licenses.
To accurately track your licenses, associate your perpetual and SA entitlements.
### Software Asset Management

**Make:**

<table>
<thead>
<tr>
<th>Display name</th>
<th>Asset tag</th>
<th>Vendor group</th>
<th>License model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft SQL Server 2016 Standard Edition</td>
<td></td>
<td>Microsoft</td>
<td>Per Seat</td>
</tr>
</tbody>
</table>

- **Start date:** 2015-08-01
- **End date:** 2016-08-01

<table>
<thead>
<tr>
<th>Agreement type</th>
<th>License type</th>
<th>Purchased rights</th>
<th>Active rights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generic</td>
<td>Software Assurance</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

- **Allocations available:** 100
- **Unit cost:** $5
- **Total cost:** $500

**General**

<table>
<thead>
<tr>
<th>Serial number</th>
<th>Owned by</th>
<th>Status</th>
<th>Substate</th>
<th>Maintenance</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Active</td>
<td>New</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Company**

- **Location:**
- **Department:**

---

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
While you are under active maintenance, Microsoft releases SQL Server 2016 datacenter. Step up from your current version to the new release by creating an entitlement for your upgraded software and link the related entitlements.
<table>
<thead>
<tr>
<th>Display name</th>
<th>Microsoft SQL Server 2019 Datacenter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset tag</td>
<td></td>
</tr>
<tr>
<td>Publisher asset number</td>
<td></td>
</tr>
<tr>
<td>Software model</td>
<td>Microsoft SQL Server 2019 Datacenter</td>
</tr>
<tr>
<td>Metric group</td>
<td>Microsoft</td>
</tr>
<tr>
<td>License metric</td>
<td>Per Core</td>
</tr>
<tr>
<td>Purchased rights</td>
<td>300</td>
</tr>
<tr>
<td>Active rights</td>
<td>300</td>
</tr>
<tr>
<td>Allocations available</td>
<td>300</td>
</tr>
<tr>
<td>Start date</td>
<td>2021-06-20</td>
</tr>
<tr>
<td>End date</td>
<td>2022-06-20</td>
</tr>
<tr>
<td>Unit cost</td>
<td>$1,000.00</td>
</tr>
<tr>
<td>Total cost</td>
<td>$10,000.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General</th>
<th>Financial</th>
<th>Contracts</th>
<th>Device Allocations</th>
<th>Upgrades Entitlements</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Upgrade Entitlements

- Upgrade form
- Number of rights

Update Delete
View normalization suggestions

Normalization suggestions are created for discovery models with field values that differ from those in the package or pattern rules. You can accept or reject these suggestions.

Role required: sam_user

During the weekly normalization process, if there are differences (or updates) identified between the manually normalized value for Publisher, Product, Version, Edition, Platform, and Language, and the corresponding values in the package or pattern, a Normalization Suggestion record is created.

You can evaluate suggestions to normalize discovery models that were manually normalized incorrectly. Suggestions can either be accepted, which updates the Discovery Model with the correct values, or rejected, which does not change the manually normalized values.

The records are contained in the Normalization Suggestions (samp_normalization_suggestions) table.

If you Accept the suggestion:

- Publisher, Product, Version, Edition, Platform, and Language of the discovery model is updated with the values from the normalization rule.
- Normalization status changes from Manually Normalized to Normalized.
- Normalization Suggestion status changes to Accepted
- Normalization date on the discovery model is updated to when the suggestion was accepted.

If you Reject the suggestion:

- Discovery Model retains the manually normalized values and remains in Manually Normalized status.
- Normalization Suggestion status changes to Rejected.

1. To view a Normalization Suggestion record, navigate to Software Asset > Discovery > Normalization Suggestions (see table for field descriptions).

Note: Suggested field values that differ from actual field values are indicated by a blue dot.

Normalization Suggestions form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery model</td>
<td>Software discovery model that represents the installed software.</td>
</tr>
<tr>
<td>Suggestion status</td>
<td>Suggested status of the normalization process.</td>
</tr>
<tr>
<td>Discovered publisher</td>
<td>Discovered publisher of the software.</td>
</tr>
<tr>
<td>Discovered product</td>
<td>Discovered name of the software.</td>
</tr>
<tr>
<td>Discovered version</td>
<td>Discovered version of the software.</td>
</tr>
<tr>
<td>Suggested Normalization</td>
<td></td>
</tr>
<tr>
<td>Suggested publisher</td>
<td>Suggested publisher of the software.</td>
</tr>
<tr>
<td>Suggested product</td>
<td>Suggested name of the software.</td>
</tr>
</tbody>
</table>
2. Click **Accept** to make the suggested changes to the discovery model, or click **Reject** to keep the existing settings.

**View a software job result**

You can view the results of Software Asset Management jobs that have run to verify completion.

**Role required:** sam_admin

**Job results include:**
- Discovery Model Normalization
- Identify Blacklisted Installs
- Identify New Reclamation Candidates
- Software Usage Import
- Update Existing Reclamation Candidates
- Software Asset Management Content Service Upload/Download

All Software Asset Management scheduled jobs are listed in the **System Definition > Scheduled Jobs** navigation area. Software Asset Management scheduled job names begin with the product name (SAM).

**Note:** The default date, time, and order of Software Asset Management scheduled jobs are configured for optimal performance. Changing a scheduled job from the default run setting may not be optimal for performance or data availability.

Navigate to **Software Asset > Administration > Job Results** and open a record (see table for field descriptions).

**Software Asset Job Result form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Number of the job result that is generated when the job is run.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the job.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the job.</td>
</tr>
</tbody>
</table>
### Manually normalize a software discovery model

You can edit a software discovery model to manually normalize discovered software that has not been fully normalized (partially normalized, publisher normalized, or match not found) on the Software Discovery Models form so that it can be reconciled.

**Role required:** sam_user

If the information automatically added to the software discovery model is incomplete, you can add the missing fields to manually normalize the software discovery model.

1. Navigate to **Software Asset > Discovery > Discovery models** and open a discovery model record that has a normalization status of Partially Normalized, Publisher Normalized, or Match Not Found.
2. Fill in the **Publisher**, **Product**, and **Version** fields, as appropriate.
   - You can create a custom product from the Product lookup list, if desired.
3. Click **Normalize**.
   - The normalization status is set to Manually Normalized.
4. Optional: To revert normalization, click **Revert Normalization**.

**Note:** Discovery models with a status of Normalized, Partially Normalized, or Publisher Normalized revert to the status of Match Not Found. Discovery models with a status of Manually Normalized and discovery models that have been normalized using pattern rules cannot be reverted.

Fields are reset to their original values, and any rules associated with the software discovery model are deactivated.

### Manually override edition value

When the edition of a software install is not automatically discovered, you can specify the edition on the Software Installation form with the correct value (if known) so the software can be successfully reconciled.

**Role required:** sam_admin

For reconciliation to run successfully, the publisher, product, version, and edition fields of the software must be set. When the edition is not discovered automatically (edition value is not included as part of the **Display name** field) but you know the edition, you can manually set it to the correct value (Enterprise, for example).

Once the edition value is set, the discovery model for the software install is automatically reset. If the appropriate discovery model does not exist, a new one is created.

**Note:** Not all software products consist of an edition. Of the software products consisting of an edition, not all edition values are automatically discoverable.

1. Navigate to **Software Asset > Discovery > Software Installations** and open the software installation record for which to set the edition value.
2. Fill in the Edition override field, as appropriate.

**Note:** The Edition override field is a free-form field (no lookup list) therefore, since this field is used as a key, the value entered must be exact.

3. Click Update.

The software installation is associated to different discovery model containing the edition value as part of the primary key. If the appropriate discovery model does not exist, a new one is created.

**Add a software pattern normalization rule**

You can add a pattern normalization rule to normalize specific software products in your environment based on a common pattern.

Role required: sam_admin

**Note:** When creating a pattern normalization rule for custom products and publishers, create the custom product and company records first.

1. Navigate to Software Asset > Administration > Pattern Normalization Rules and create a new record (see table for field descriptions).

**Pattern Normalization Rule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specify a unique name for pattern normalization rule.</td>
</tr>
<tr>
<td>Discovered publisher contains</td>
<td>Specify text to search for in the software publisher field.</td>
</tr>
<tr>
<td>Discovered product contains</td>
<td>Specify text to search for in the product field.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that activates the rule.</td>
</tr>
<tr>
<td>Discovered publisher is empty</td>
<td>Option that includes products that have an empty publisher field (the rule applies to discovery models where the publisher is unknown).</td>
</tr>
</tbody>
</table>

**Normalized Attributes**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher</td>
<td>Specify the normalized name of the publisher of the software.</td>
</tr>
<tr>
<td>Product</td>
<td>Specify the normalized name of the product.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Product type</td>
<td>Choose the product type.</td>
</tr>
<tr>
<td></td>
<td>- Child: A subcomponent of main software (not licensable).</td>
</tr>
<tr>
<td></td>
<td>- Driver: Software product that controls a device.</td>
</tr>
<tr>
<td></td>
<td>- Licensable: Software product that is licensable.</td>
</tr>
<tr>
<td></td>
<td>- Not Licensable: Software product that is not licensable.</td>
</tr>
<tr>
<td></td>
<td>- Patch: Software product designed to update, fix, or improve an existing computer program.</td>
</tr>
<tr>
<td>Version</td>
<td>Specify the version of the product.</td>
</tr>
<tr>
<td>Platform</td>
<td>Choose the platform.</td>
</tr>
<tr>
<td></td>
<td>- Windows</td>
</tr>
<tr>
<td></td>
<td>- Mac</td>
</tr>
<tr>
<td></td>
<td>- UNIX</td>
</tr>
<tr>
<td>Language</td>
<td>Choose the language.</td>
</tr>
<tr>
<td></td>
<td>- Dutch</td>
</tr>
<tr>
<td></td>
<td>- English</td>
</tr>
<tr>
<td></td>
<td>- French</td>
</tr>
<tr>
<td></td>
<td>- German</td>
</tr>
<tr>
<td></td>
<td>- Italian</td>
</tr>
<tr>
<td></td>
<td>- Spanish</td>
</tr>
</tbody>
</table>

2. Once the rule is created, to apply the rule so applicable discovery models are normalized without delay, click the **Apply Rule** related link.

### Create a custom file rule to manually define file sets

Create custom rules to manually define file sets and normalize data not recognized by the SAM API. After you have created custom rules, custom file sets can be discovered with File Signature Normalization and software records can be generated.

Role required: `sam_admin`

File Signature Normalization identifies software installation packages based on file attributes in a configuration item. The input is then sent to the SAM API. If there are files properties discovered that are not associated with the File Signature Normalization rule, you can manually normalize the data and send the input to the API to create a software installation record.

**Note:** File signature rules discovered in the content service library take precedence over custom file signature rules.

1. Navigate to **Software Asset > Administration > Custom File Normalization Rules** and create a new record (see table for field descriptions).
### Unidentified File Set form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher</td>
<td>Publisher of the software. You can use the lookup list provided.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Publisher is a reference to the company (core_company) table. Only companies you are using internally are shown.</td>
</tr>
<tr>
<td>Product</td>
<td>Software product name. The same lookup list provided on the Software Discovery Models form. You can create a custom product from the lookup list, if desired.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the relationship between the software publisher (samp_sw_publisher) table and the company (core_company) table is not correct, products for that publisher may not be shown.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software product. Required if version condition value is <em>(starts with) or (is-).</em></td>
</tr>
<tr>
<td>Edition</td>
<td>Edition of the software product to use when searching for the normalized discovery model. Required if edition condition value is <em>(starts with) or (is).</em></td>
</tr>
<tr>
<td>Platform</td>
<td>Platform of the software product to use when searching for the normalized discovery model. The default is <strong>Anything</strong> for Windows, Mac, UNIX.</td>
</tr>
<tr>
<td>Language</td>
<td>Language of the software product to use when searching for the normalized discovery model, which is populated once it has been normalized or added manually. The default is <strong>Anything</strong>.</td>
</tr>
<tr>
<td>Exclude from content service</td>
<td>Option to exclude file set rule from being included in content service library.</td>
</tr>
<tr>
<td>File name</td>
<td>Name of file associated with software installation as it exists in the system.</td>
</tr>
<tr>
<td>File size</td>
<td>Size of file name file in bytes.</td>
</tr>
<tr>
<td>File version</td>
<td>Version of file name file.</td>
</tr>
</tbody>
</table>

2. Click **Submit**.
The custom rule is added to the Unidentified File Sets list.

**Content updates for ServiceNow**

ServiceNow provides content updates to your instance weekly that you can use to normalize your data.

The following types of content can be updated as part of a content update.

- Publishers
- Product names
- Product types
- Product classifications
- Discovery maps
- Suite definitions
- Categories
- Software model life cycles

The SAM - Apply latest content changes scheduled job runs and processes the content updates. After the content download is complete, the updated content is pulled into the staging columns of the Software Publishers (samp_sw_publisher), Software Products (samp_sw_product), Discovery maps (samp_sw_entitlement_definition), and Software Product Definitions (samp_sw_product_definition) tables. A query runs and identifies what transactional data in your instance must be updated with the new content. After the changes are identified, the changes are then propagated to your instance.

Another scheduled job, SAM - Create lifecycles and suites for a software model, runs and propagates suite component and lifecycle changes to your software models. If you don't want content changes applied to specific software models, you can clear the **Allow automated content updates** flag on the Software Model form. By default, the flag is selected to allow automated content updates to all software models.

**Note:** If a content update adds lifecycle data, it can't be deleted from the software model, but you can deactivate it. Any lifecycle data that is added as part of a content update will have the source set to **Servicenow**.

Use the Software Models with deactivated discovery maps report to show software models that are pointing to any deactivated discovery maps.

To see changes that have been made to the software library, review the SAM Content Audit (sam_content_audit) table.

**Note:** Content updates don't have an impact on any custom products or custom discovery maps.

For more information on how to send your content to ServiceNow and include it in the content updates, see **Enable the Software Asset Management content service**.

**Software discovery and normalization**

After you've imported your entitlements, use ServiceNow Discovery or Microsoft SCCM to discover software installations in your environment and transfer that data into the Now Platform.
Customers can integrate other sources manually or through integrations delivered in the ServiceNow store.

Initial setup

- ServiceNow Discovery
  Recommended for the Datacenter

- SCCM integration
  Recommended for end-user compute or desktop environments

Activate Discovery plugin

Run discovery
Patterns look through content on servers or clients

Store software

Normalization

Import data
Information is imported on a set schedule
While you may use Discovery Home for datacenters and Microsoft SCCM for desktop environments, you can integrate other third-party discovery solutions with CMDB to support Software Asset Management. To integrate a different discovery solution, add it manually, or you can download an application, from the ServiceNow Store. For more information about integrating a discovery source manually, see the Customer Success Center.

To learn more about collecting data after you've integrated with both Discovery and SCCM, see Collect software data with either SCCM or Discovery.

**Discovery integration**

ServiceNow Discovery is used to automatically populate the Software Installations table so the software can be normalized and reconciled.

![Note: To use Discovery, the Discovery plugin must be activated.](image)

Discovery uses patterns in the discovery process that can be created or customized. The base system contains a wide range of patterns that cover most industry standard network devices and applications. The following are some of the base system patterns used by Software Asset Management.

- Citrix XenApp
- Citrix XenDesktop,
- VMware vCenter
- Microsoft SQL Server
- Microsoft Exchange Server
- Oracle Database Server

You can also customize other patterns for Software Asset Management. For more information, see Create or modify patterns.

Discovered software is stored in the Software Installations (cmdb_sam_sw_install) table.

When software install records are written to the Software Installations table, a business rule verifies whether the unique combination of the discovered publisher, discovered product, and discovered version exist in the Discovery Model table.

- If so, the reference to the discovery model is set in the Software Installations table.
- If not, a new record is created in the Discovery Model table, and that discovery model reference is set in the Software Installations table.

After discovery, normalization is run.

For more information on Discovery, see Discovery with Software Asset Management.

**SCCM integration**

You can use SCCM by itself or with Discovery Home to identify software on your devices.

![Note: While you may use Microsoft SCCM for discovering software installations in your desktop environments, you can integrate other third-party tools.](image)
Both Microsoft SCCM 2012 v2 and 2016 plugins are certified with Software Asset Management. The corresponding Microsoft SCCM Integration plugin must be installed to integrate Microsoft SCCM with Software Asset Management.

Microsoft SCCM Integration plugins:
- Integration — Microsoft SCCM 2012 v2 (com.snc.integration.sccm2012v2) plugin
- Integration — Microsoft SCCM 2016 (com.snc.integration.sccm2016) plugin

Microsoft SCCM Software Usage plugins:
- Integration — Microsoft SCCM 2012 v2 Software Usage (com.snc.samp_usage_sccm) plugin
- Integration — Microsoft SCCM 2016 Software Usage (com.snc.samp.usage_sccm_2016) plugin

**Note:** The Integration — Microsoft SCCM 2016 plugin is compatible with SCCM versions 1606, 1906, 1910, and 2002.

For more information on SCCM and how to import your data into your instance, see Microsoft SCCM software usage.

**Normalization**

The normalization process compares the discovered publisher, discovered product, and discovered version and edition values against the ServiceNow repository of normalized equivalents. Matches are added to the corresponding normalized fields (publisher, product, version, and edition) of the Discovery Model table. The normalized fields are then used to reconcile entitlements purchased, and to compute license positions.

For example, the discovered publisher Microsoft Corp could be normalized to Microsoft for the normalized publisher field.

The normalization process also looks for pattern matches between discovered fields and normalized values, and updates the normalized fields accordingly.

A schedule job runs to pull in normalized content and pattern updates daily, but you can change the frequency that the schedule job is run. When there are changes to a normalization rule, applicable normalized and partially normalized Discovery models are renormalized with the updated values.

Evaluate suggestions to normalize discovery models that were manually normalized using the Normalization Suggestions feature. Suggestions are automatically identified if there is a difference between the updated normalization content and your content. Because the content from the updates contains the most up-to-date information, using the content provided helps to keep your software installs accurate.

You can opt in to the Software Asset Management Content Service that enables you to provide missed and not fully normalized software discovery models to ServiceNow for research. New content and rules created are provided back to customers to continually improve software normalization.

**Discovery models and software installations**

Software discovery models are automatically created during discovery to identify and normalize the software installed in your environment.

Software discovery models are stored in the Software Discovery Model (cmdb_sam_sw_discovery_model) table. The normalization process is automatically run when a
new discovery model is created. Discovery models are not created for software installations that have a name containing Security Update.

There is a difference between software models and software discovery models.

- A software model is a specific version or configuration of software that is purchased and/or available to users.
- A software discovery model is a model created when a version of software is discovered in a network environment.

Multiple software discovery models can be associated to one software model. For example, a software model can be defined as follows:

- Publisher = X
- Product = Y
- Version = Starts with 10

If there are two separate installs of this product (version 10.1 and version 10.2), two discovery models are created. One of the discovery models has the discovered version set to 10.1, and the other discovery model has the discovered version set to 10.2. The reconciliation process associates both of these discovery models to the same software model since they both meet the version criterion of Starts with 10.

Discovery Models

Software discovery models cannot be created manually. The following field combination, called the primary key, is used to match new software installations to a new or existing software discovery model.

Primary key: Publisher, Display Name, and Version

- **Note:** When analyzing version numbers, an exact match is always searched for first, but rounds down to a major version number when an exact match is not found.

  For example, if no match is found for version number 8.0.4, but version 8.0 is found, then version 8.0 is used in the Software model field.

- **Note:** If normalized field values differ from the values in the package or pattern, a caution icon is indicated next to the Normalization status field indicating that a normalization suggestion record has been created. Clicking the caution icon opens the Normalization Suggestion record for that discovery model.

  The differing values can be set by the user, or by accepting the normalization suggestion changes. Once a new value is set, the normalization status changes form Normalized to Manually Normalized.

  Under specific conditions, certain fields that are typically read-only can be edited. If edited, the status changes to Manually Normalized.

Revert normalization

Use the Revert Normalization related link to revert normalization.
Discovery models with a status of Normalized, Partially Normalized, or Publisher Normalized revert to the status of Match Not Found. Fields are reset to their original values, and any rules associated with the software discovery model are deactivated.

Software Installations

The Software Installations list contains the software installed in your organization and is populated by discovery.

Installed software is placed in the Software Installation (cmdb_sam_sw_install) table by Discovery, and a primary key is built using Publisher, Display Name, and Version fields.

Discovery automatically matches the discovered software installation with a new or existing software discovery model using the primary key.

Discovered engineering licenses

View a list of all the discovered and normalized software for your engineering applications.

Navigate to Software Asset > Discovery > Discovered Engineering Licenses

You can view a list of all the normalized publishers and products for your engineering applications. Additional information such as the version, quantity of licenses, and the type of license is also displayed.

File Signature Normalization

File-based discovery finds files on UNIX or Windows servers and processes them with an established set of rules that enhance the identification of installed software. Use the results to monitor specific file types on network servers for security purposes or to manage your software licenses with the File Signature Normalization plugin for Software Asset Management - Professional (SAMP).

For more information on the file-based discovery, see the File-based Discovery.

**Note:** The information provided in this page only covers the features available with the File Signature Normalization (com.snc.file_signature_normalization) plugin.

Required plugins

The File Signature Normalization plugin is required to allow file information to be mapped to installed software. To enable this plugin, Request Software Asset Management.

You can also enable file-based discovery with the File-Based Discovery (com.snc.discovery.file_based_discovery) plugin to filter file signatures. This plugin is included with a Discovery subscription, but you must request plugin activation. Normalization of products and publishers is available for file-based discovery with or without Software Asset Management.

How File Signature Normalization works

File Signature Normalization uses discovered files and their attributes, such as file name, file sizes, and version, to find a signature match in the Content Data Service (CDS). Then, File Signature Normalization creates a normalized software installation record.

During regularly scheduled Discovery jobs, the file information is discovered at all the specified end points in a user environment and sent to the MID Server. The information from the MID Server
is then sent back to the ServiceNow instance. Information is matched against the content library and the software installation records are created.

If a discovered file name does not match a predefined file signature rule in the CDS, an unidentified file set record is created in the unidentified file set (cmdb_unidentified_file_set) table. Users with the sam_admin role can create a custom file signature rule for the unidentified file set to normalize data manually.

If you opt in to the content service, these custom file signatures are sent back to the CDS for further analysis and inclusion in the content service for future discovery. You can also restrict some custom file signatures from being sent to the CDS by changing the value in the Exclude From CDS column to True.

**Note:** Software discovery models are stored in the Software Discovery Model (cmdb_sam_sw_discovery_model) table. Unlike pattern discovery normalization, discovery models created by File Signature Normalization do not go through the normalization process automatically and are ignored during scheduled normalization jobs.

File Signature Normalization also identifies duplicates. Software installations that are discovered on the same configuration item, but from different discovery sources, are considered duplicates. All installations that are identified are marked as inactive by default. Once the duplication has been deleted, the remaining installation is marked as active and the discovery model picks up all associated installs.

**Note:** By default, scheduled jobs are performed during specific times so they do not run heavy loads that could cause performance or stability issues. If these scheduled job times are changed, performance issues could occur.

Any software installs discovered during File-based discovery are updated to reflect any CDS changes in the software install attributes such as product or publisher name change. Stage product and Stage publisher are new columns in the File Set (samp_file_set) table.

**File Signature Normalization roles**

File Signature Normalization adds the following role.

<table>
<thead>
<tr>
<th>Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>samp_file_admin</td>
<td>Users with this role can access file attribute and unidentified file information. Required to ensure that file signature normalization supports third-party software installation discovery sources.</td>
</tr>
</tbody>
</table>

**Tables**

File Signature Normalization adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>samp_file_set</td>
<td>File set that maps to a software product. Multiple samp_file_map records can point to one samp_file_set record.</td>
</tr>
</tbody>
</table>
**Table**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>samp_file_map</td>
<td>File map record for each file hash discovered by the end-user device. The file hash is created based on the discovered file and its attributes.</td>
</tr>
<tr>
<td>samp_file_name</td>
<td>File names that are used to search on end-user devices.</td>
</tr>
<tr>
<td>samp_custom_file_name</td>
<td>File names that entered by the user that can be discovered on end-user devices.</td>
</tr>
<tr>
<td>cmdb_unidentified_file_set</td>
<td>Custom rules that are created if a software match is not found for the discovered file in the CDS.</td>
</tr>
</tbody>
</table>

**Software reconciliation for compliance**

Automated license reconciliation keeps license positions accurate and up-to-date without manual calculations. Reconciliation runs weekly or on demand.

Reconciliation is a scheduled job that is run at a specified frequency (default is weekly). It can also be run on demand for specific or all publishers, groups, and subgroups.

Group and subgroup values include country, department, company, region, or cost center. Default group and subgroup properties that apply to the weekly reconciliation run can be set in Software Asset > Administration > Properties.

When reconciliation runs, a list of reconciliation results is created that shows the compliance status of software products concerning discovery and entitlements. Users with the sam_user role can view reconciliation results.

In addition to creating a purchase order for new software licenses, additional remediation options are available in software model results. Use the results to automatically create and remove allocations, remove unallocated installs, and remove unlicensed installs.

Review reconciliation results in a simplified License Workbench view, and use the License Position report to see compliance details for each software model in a single list.

**Reconciliation results**

Reconciliation results are listed in the navigation path Software Asset > Reconciliation > Historical Results (see table for field descriptions).

**Reconciliation Results form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique identifying number that is generated during the reconciliation process.</td>
</tr>
<tr>
<td>Last reconciled</td>
<td>Date of last reconciliation run.</td>
</tr>
<tr>
<td>Ran for</td>
<td>All publishers, or specific publishers.</td>
</tr>
<tr>
<td>Publishers</td>
<td>Only shown if publishers were specified on which to run reconciliation.</td>
</tr>
</tbody>
</table>
Software product results

You can access Software Models, Unlicensed Installs, and Removal candidates related lists from a product result record.

A product result for a licensable product is generated after reconciliation even if there are no software models defined for the product.

Note: A Software Model Results record is only created when a software model or entitlement exists for the product.

For licensable products, a software model is automatically created for any unlicensed installs, subscriptions, or options in the Product Results list that do not have an entitlement by default. See properties to change the com.snc.samp.automaticsMrcreation property setting. You can also set the com.snc.samp.automaticsMrcreation property to have a software model created automatically for not-licensable products, if desired.

Software product results are listed in the navigation path Software Asset > Reconciliation > Product Results (see table for field descriptions).
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>Group to which the product result belongs.</td>
</tr>
<tr>
<td>Subgroup</td>
<td>Subgroup to which the product result belongs.</td>
</tr>
<tr>
<td>Latest</td>
<td>Indicates whether this product result is from the most recent reconciliation run.</td>
</tr>
<tr>
<td>Reconciliation result</td>
<td>Unique reconciliation result number that is generated during the reconciliation process.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the product.</td>
</tr>
<tr>
<td></td>
<td>• Compliant</td>
</tr>
<tr>
<td></td>
<td>• Not Compliant</td>
</tr>
<tr>
<td>True-up cost</td>
<td>Estimated cost of remediating non-compliance based on the least number of rights needed.</td>
</tr>
<tr>
<td>Over-licensed amount</td>
<td>Estimated cost of rights not being used. The sum of all Over Licensed amount values from every software model result.</td>
</tr>
<tr>
<td>Potential savings</td>
<td>Estimated cost of savings if software installations are reclaimed. The sum of all potential savings from all removal candidates.</td>
</tr>
<tr>
<td>Licensed installs</td>
<td>Count of the total number of installations that are licensed for the product.</td>
</tr>
<tr>
<td>Unlicensed installs</td>
<td>Count of the total number of installations that are unlicensed for the product.</td>
</tr>
<tr>
<td>Software model result</td>
<td><em>Software model result</em> for the unlicensed install.</td>
</tr>
<tr>
<td>Display name</td>
<td>Name of the unlicensed <em>software installation</em>.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher that represents the software product.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software product.</td>
</tr>
<tr>
<td>Installed on</td>
<td>Device on which the product is installed.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User to which the product is assigned.</td>
</tr>
<tr>
<td>Unlicensed Subscriptions</td>
<td>Note: This related list is only shown if the software product is a subscription.</td>
</tr>
<tr>
<td>Display name</td>
<td>Name of the unlicensed software subscription. For more information, see <em>Microsoft Office 365 integration</em> and <em>Software Asset Management publisher pack for Adobe</em>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User Principal Name</td>
<td>Publisher that represents the software product.</td>
</tr>
<tr>
<td>Last activity</td>
<td>Version of the software product.</td>
</tr>
<tr>
<td>Software model</td>
<td>Device on which the product is installed.</td>
</tr>
<tr>
<td>Unlicensed Users</td>
<td>Note: This related list contains SAP system users and is only shown for SAP publisher.</td>
</tr>
<tr>
<td>Display name</td>
<td>Unique display name.</td>
</tr>
<tr>
<td>User</td>
<td>User in the SAP system.</td>
</tr>
<tr>
<td>SAP user id</td>
<td>SAP ID of the user with access to an SAP system.</td>
</tr>
<tr>
<td>Email</td>
<td>SAP user email.</td>
</tr>
<tr>
<td>Names</td>
<td>First and last names of the SAP user.</td>
</tr>
<tr>
<td>User type</td>
<td>The type of user in the SAP system.</td>
</tr>
<tr>
<td></td>
<td>• Dialog</td>
</tr>
<tr>
<td></td>
<td>• System</td>
</tr>
<tr>
<td>License type</td>
<td>The named user type value assigned to the user in the specified SAP system.</td>
</tr>
<tr>
<td>Named user type</td>
<td>Normalized named user type assigned to the user in the specified SAP system.</td>
</tr>
<tr>
<td>SAP client</td>
<td>SAP client from which the user information was pulled.</td>
</tr>
<tr>
<td>Removal Candidates</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>Removal candidate number.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the removal candidate.</td>
</tr>
<tr>
<td>Justification</td>
<td>Justification for becoming a removal candidate.</td>
</tr>
<tr>
<td></td>
<td>• Low Usage (default)</td>
</tr>
<tr>
<td></td>
<td>• Unallocated</td>
</tr>
<tr>
<td></td>
<td>• Unlicensed</td>
</tr>
<tr>
<td></td>
<td>• Blacklisted</td>
</tr>
<tr>
<td>Product</td>
<td>Name of the product.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Name of the publisher.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>State of the removal candidate.</td>
</tr>
<tr>
<td></td>
<td>• Attention Required</td>
</tr>
<tr>
<td></td>
<td>• Ready</td>
</tr>
<tr>
<td></td>
<td>• Awaiting User</td>
</tr>
<tr>
<td></td>
<td>• Awaiting Approval</td>
</tr>
<tr>
<td></td>
<td>• Approval</td>
</tr>
<tr>
<td></td>
<td>• Awaiting Revocation</td>
</tr>
<tr>
<td></td>
<td>• Closed Complete</td>
</tr>
<tr>
<td></td>
<td>• Closed Skipped</td>
</tr>
<tr>
<td>Potential savings</td>
<td>Savings to be gained from reclaiming unused software installations.</td>
</tr>
</tbody>
</table>

The **Software Model Results** related list contains software model results from reconciliation.

**Accurately reporting your software true-up cost**

Accurately report your software true-up cost to avoid compliance issues.

Specify the license cost or the license plus maintenance cost in the software model to accurately report the true-up costs during reconciliation. If you do not specify a license cost or a license plus maintenance cost, the average software entitlement cost is used for true-up cost calculations.

If you use a license metric to create a software entitlement for a software model, an override license cost record is created if one already doesn't exist for the same license metric. The license cost record is added in the Override License Cost related list. The license cost and license plus maintenance cost is set to zero. If a maintenance license exists, you can override the license cost or the license plus maintenance cost by navigating to the override license cost record.

**Software license usage**

Review reconciliation results in a simplified workbench view.

The License Workbench lets you forecast the needs of your organization by trending the number of rights consumed against the number of active rights purchased. You can stay in compliance by purchasing additional rights before software consumption surpasses the number of rights owned.

Workbench features include:

- Color-coded compliance banner
- Financial calculations on card
- Publisher pinning functionality (user specific, saved)
- Sort card functionality
- Active filtering
- Card drill down to Product Results list
- Keyboard control
- Group and subgroup reconciliation information, if applicable
<table>
<thead>
<tr>
<th>Publisher</th>
<th>True-up Cost</th>
<th>Over Licensed Amount</th>
<th>Potential Savings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Systems</td>
<td>$15,506,789</td>
<td>$20,580,000</td>
<td>$5,073,211</td>
</tr>
<tr>
<td>Autodesk Inc.</td>
<td>$5,400,000</td>
<td>$5,500,000</td>
<td>$100,000</td>
</tr>
<tr>
<td>Citrix Systems</td>
<td>$2,000,000</td>
<td>$2,000,000</td>
<td>$0</td>
</tr>
<tr>
<td>ESI</td>
<td>$2,000,000</td>
<td>$0</td>
<td>$2,000,000</td>
</tr>
<tr>
<td>IBM</td>
<td>$799,999</td>
<td>$0</td>
<td>$799,999</td>
</tr>
<tr>
<td>Microsoft</td>
<td>$1,000,000</td>
<td>$1,000,000</td>
<td>$0</td>
</tr>
<tr>
<td>Oracle</td>
<td>$1,000,000</td>
<td>$1,000,000</td>
<td>$0</td>
</tr>
<tr>
<td>SAP</td>
<td>$7,000,000</td>
<td>$7,000,000</td>
<td>$0</td>
</tr>
<tr>
<td>VMware Inc.</td>
<td>$1,000,000</td>
<td>$1,000,000</td>
<td>$0</td>
</tr>
</tbody>
</table>
Pinned publishers are listed in the Pinned Publishers tab. The list of pinned publishers is saved on a per-user basis.

License Workbench tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Publishers</td>
<td>List of all publishers.</td>
</tr>
<tr>
<td>Publishers Out of Compliance</td>
<td>List of all publishers where status is not compliant.</td>
</tr>
<tr>
<td>Pinned Publishers</td>
<td>User-specific saved list of publishers that have been grouped.</td>
</tr>
</tbody>
</table>

Publisher workbench navigation tree

You drill down on a specific publisher, product, software model, or license metric in the workbench navigation tree to view calculation and compliance information from the latest reconciliation results.

Navigation tree features:

- Filter products (active filtering, including collapsed items)
- Compliance toggle switch
- Expand and collapse tree links
- Software model compliance icons
### Microsoft

**Filter products**

- Show Not Compliant Products Only

**Group:** None  **Subgroup:** None

<table>
<thead>
<tr>
<th>Product Results (9)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Total Spend</strong></td>
</tr>
<tr>
<td>$5,237,544.49</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Product Results</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number</strong></td>
</tr>
<tr>
<td>PM001020</td>
</tr>
<tr>
<td>PM001021</td>
</tr>
<tr>
<td>PM001022</td>
</tr>
<tr>
<td>PM001023</td>
</tr>
<tr>
<td>PM001024</td>
</tr>
<tr>
<td>PM001025</td>
</tr>
<tr>
<td>PM001026</td>
</tr>
<tr>
<td>PM001027</td>
</tr>
</tbody>
</table>
By default, the navigation tree on the publisher license overview page is collapsed. When expanded, it's grouped by publisher:

- **Publisher**
  - Related list: *Product Results*
    - Product results
      - Related lists:
        - **Software Model Results**
        - Unlicensed Installs (SAP: Unlicensed Users or Unlicensed Engines)
        - Unlicensed Subscriptions (Subscription software)
        - Removal Candidates

- **Software model results**
  - Related lists:
    - License Metric Results
    - Remediation Options: The Rights Needed By tab is not visible for IBM license metrics: Resource Value Unit (RVU) Full Capacity and RVU Sub-capacity. Rights are not used by individual devices as the RVU license metric is licensed at the product level.
    - Unlicensed Installs (SAP: Unlicensed Users)
    - Unlicensed Subscriptions (Subscription software)
    - Unlicensed Options (Oracle only)
    - Removal Candidates
    - Purchase Orders (only when the Procurement (com.snc.procurement) plugin is active)

- **License metric results**
  - Related lists:
    - Rights Used By: Not visible for IBM license metrics: RVU Full Capacity and RVU Sub-capacity. The RVU license metric is licensed at the product level; calculated based on the total consumption of the product in your enterprise.
    - Installs Used (SAP: System Users)
    - Downgrades/Upgrades
    - Subscriptions Used

**Report calculations**

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher, product, software model</td>
<td></td>
</tr>
<tr>
<td>Total Spend</td>
<td></td>
</tr>
<tr>
<td>True-up Cost</td>
<td>Estimated cost of remediating non-compliance based on the least number of rights needed (rights needed * average price per right from entitlements). The lowest cost from Purchase Rights remediation options.</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Over-licensed Amount</td>
<td>Estimated cost of rights not being used. The sum of the Over Licensed amount from the True-up value costs.</td>
</tr>
<tr>
<td>Agreement Type</td>
<td>Software license type.</td>
</tr>
<tr>
<td>License metrics</td>
<td></td>
</tr>
<tr>
<td>Rights Owned</td>
<td>Sum of all active rights from entitlements that share a license metric.</td>
</tr>
<tr>
<td>Rights Consumed</td>
<td>Sum of rights used during reconciliation (allocated + not allocated and installed).</td>
</tr>
<tr>
<td>Rights Available</td>
<td>Sum of rights not used during reconciliation (rights owned — rights used).</td>
</tr>
<tr>
<td>Over-licensed Amount</td>
<td>Estimated cost of unused rights.</td>
</tr>
</tbody>
</table>
| Right Allocations             | • Allocated in use  
    • Not allocated in use  
    • Allocated not in use  
    • Not allocated  
    • Allocations needed |

**Note:** For Microsoft Per Core and Microsoft Per Core with (CAL), you can have non-transferable rights. Non-transferable rights are any remaining rights from a core pack that cannot be used to license any additional devices.

<table>
<thead>
<tr>
<th>Rights Owned vs Rights Consumed</th>
<th>Comparison of rights owned and rights consumed.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Total Rights Consumed:</td>
</tr>
<tr>
<td></td>
<td>• If Rights Needed &gt; 0</td>
</tr>
<tr>
<td></td>
<td>Total Rights Consumed = Rights Consumed(Rights Used + Rights Needed) + Rights Available(unused_rights)</td>
</tr>
<tr>
<td></td>
<td>• If Rights Needed =0</td>
</tr>
<tr>
<td></td>
<td>Total Rights Consumed = Rights Used</td>
</tr>
<tr>
<td></td>
<td>(Rights Needed are derived from the Purchase Rights remediation option, if existing)</td>
</tr>
</tbody>
</table>

---

**Run software reconciliation**

Reconciliation is run as a scheduled job (default is weekly), but you can also run reconciliation manually to reconcile software products in your environment on demand.

Role required: sam_admin
Reconciliation is run for products that have software entitlements or software installs. Grouping and subgrouping are supported so you can narrow the compliance results.

When running reconciliation manually, allow enough time for the process to complete. For faster results, narrow the scope by selecting specific publishers.

1. Navigate to **Software Asset > Reconciliation > Run Reconciliation** and select the publishers for which compliance should be calculated, or select all publishers.
2. To narrow results further, select **Group** and **Subgroup**, if desired.
   
   Available group and subgroup values include None, Country, Department, Company, Region, and Cost Center.
3. Click **Continue**.
   
   The reconciliation process may take an extended amount of time to complete.

   The **Reconciliation Results list** is shown.

**View software model results**

View compliance information for software model results from the Product Results list after reconciliation is run.

Role required: sam_user

You can view License Metric Results, Remediation Options, Unlicensed Installs, and Removal Candidates related lists for a software model result from a Product Result record. When the **Procurement** application (com.snc.procurement) is active, you can also create and view purchase orders directly from the Remediation Options form. More remediation options include automatically create and remove allocations, remove unallocated installs, and remove unlicensed installs.

For example, if the status of a product result shows that it is not compliant, you can drill down on the product result to view software model details. These details can include the number of unlicensed installs and the true-up cost to become compliant. Further, you can drill down on the software model result to view the license metric result, which is based on the entitlements for the product.

License metric result information includes rights owned and rights used as well as the license allocation breakdown so you can determine your options to become compliant. The Remediation Options related list shows the number of rights needed and calculates the cost of those rights for you, based on the license metric.

You can use the dashboard field action (chart) icon on the Software Model Results form to view the Rights Owned vs Rights Used chart to forecast when additional licenses are needed.

1. Navigate to **Software Asset > Reconciliation > Product Results** and open a record to view product results details.
2. In the Software Model Results related list, open a record to view the details (see table for field descriptions).
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software model</td>
<td>Software model associated with the product. Drill down on the software model to see the software model result. The dashboard field action icon shows the Rights Owned vs Rights Used chart for the software model.</td>
</tr>
<tr>
<td>Product result</td>
<td>Unique product result number generated during the reconciliation process.</td>
</tr>
<tr>
<td>Group</td>
<td>Group specified on which to run reconciliation. Values include None, Country, Department, Company, Region, and Cost Center.</td>
</tr>
<tr>
<td>Subgroup</td>
<td>Subgroup specified on which to run reconciliation. Values include None, Country, Department, Company, Region, and Cost Center.</td>
</tr>
<tr>
<td>Latest</td>
<td>Indicates whether this software model result is from the most recent reconciliation run.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the software model.</td>
</tr>
<tr>
<td></td>
<td>• Compliant</td>
</tr>
<tr>
<td></td>
<td>• Not Compliant</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Agreement type</td>
<td>Agreement type is set on the software entitlement.</td>
</tr>
<tr>
<td></td>
<td>- Common: Generic, Enterprise License Agreement (ELA)</td>
</tr>
<tr>
<td></td>
<td>- IBM: Generic, Enterprise License Agreement (ELA), International Program License Agreement (IPLA), IBM Customer Agreement (ICA), Unlimited Level Agreement (ULA)</td>
</tr>
<tr>
<td></td>
<td>- Microsoft: Generic, Enterprise License Agreement (ELA)</td>
</tr>
<tr>
<td></td>
<td>- Oracle: Generic, Unlimited Level Agreement (ULA)</td>
</tr>
<tr>
<td></td>
<td>- VMware: Generic, Enterprise License Agreement (ELA), Enterprise Purchasing Program (EPP), Volume Purchasing Program (VPP)</td>
</tr>
<tr>
<td>Note:</td>
<td>If the agreement type is Enterprise Level Agreement or Unlimited Level Agreement, the Status is Compliant even if there are unlicensed installations or unlicensed subscriptions.</td>
</tr>
<tr>
<td>Unlicensed installs</td>
<td>Number of unlicensed software installations that are not covered by any entitlements.</td>
</tr>
<tr>
<td>True-up cost</td>
<td>Estimated cost of remediating non-compliance based on the least number of rights needed (rights needed * average price per right from entitlements). The lowest cost from Purchase Rights remediation options.</td>
</tr>
<tr>
<td>Over-licensed amount</td>
<td>Estimated cost of rights not being used. The sum of the Over Licensed amount from the True-up value costs.</td>
</tr>
<tr>
<td>Potential savings</td>
<td>The cost that can be saved by acting on underutilized or incorrect consumption of licenses in related removal candidates.</td>
</tr>
<tr>
<td>License Metric Results</td>
<td></td>
</tr>
<tr>
<td>License metric</td>
<td>License metric that the software license is counted against when reconciliation is run.</td>
</tr>
<tr>
<td>Software model result</td>
<td>Software model with which the result is associated.</td>
</tr>
<tr>
<td>Group</td>
<td>Group to which the product result belongs.</td>
</tr>
<tr>
<td>Subgroup</td>
<td>Subgroup to which the product result belongs.</td>
</tr>
<tr>
<td>Rights owned</td>
<td>Sum of all active rights from entitlements that share a license metric.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rights used</td>
<td>Sum of rights used during reconciliation (allocated + not allocated and installed).</td>
</tr>
<tr>
<td>Rights available</td>
<td>Sum of rights not used during reconciliation (rights owned — rights used).</td>
</tr>
<tr>
<td>Over-licensed amount</td>
<td>Estimated cost of unused rights.</td>
</tr>
<tr>
<td>Right Allocations</td>
<td>Rights that are allocated and used to license installations.</td>
</tr>
<tr>
<td>Allocated in use</td>
<td>Rights that are allocated and are used to license installations.</td>
</tr>
<tr>
<td>Not allocated in use</td>
<td>Number of rights that are used to license installations, but not allocated.</td>
</tr>
<tr>
<td></td>
<td>When this value is greater than 0, two remediation options (Create Allocations and Remove Unallocated Installs) are automatically created for each unique license metric in the software model that meets this requirement, except User CAL and Device CAL.</td>
</tr>
<tr>
<td>Allocated not in use</td>
<td>Rights that are allocated but are not being used to license any installations.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Allocated not in use reflects rights that are wasted because the user or device for which these rights have been allocated do not have the software installed.</td>
</tr>
<tr>
<td></td>
<td>When this value is greater than 0, a Remove Allocations remediation option is automatically created for each unique license metric in the software model that meets this requirement.</td>
</tr>
<tr>
<td>Not allocated</td>
<td>Number of rights that have not been allocated (rights owned — allocated regardless of whether installed or not).</td>
</tr>
<tr>
<td>Allocations needed</td>
<td>Number of allocations needed for compliance. Only used for Per Named User and Per Named Device license metrics.</td>
</tr>
<tr>
<td>Rights Used By</td>
<td>Rights used by user related list.</td>
</tr>
<tr>
<td>Installs Used</td>
<td>Product installs used related list.</td>
</tr>
<tr>
<td>Subscriptions Used</td>
<td>Subscriptions used related list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This related list is only shown if the software product is a subscription.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SAP System Users</td>
<td>SAP system user related list.</td>
</tr>
<tr>
<td></td>
<td>Note: This related list is only shown for SAP publisher.</td>
</tr>
<tr>
<td>Downgrades/Upgrades</td>
<td>Software model upgrades and downgrades related list.</td>
</tr>
<tr>
<td></td>
<td>Note: This related list is only shown if the software product is not a</td>
</tr>
<tr>
<td></td>
<td>subscription.</td>
</tr>
<tr>
<td>Remediation Options</td>
<td></td>
</tr>
<tr>
<td>Remediation action</td>
<td>Action to take to for compliance.</td>
</tr>
<tr>
<td></td>
<td>• Purchase Rights</td>
</tr>
<tr>
<td></td>
<td>• Remove Allocations</td>
</tr>
<tr>
<td></td>
<td>• Create Allocations</td>
</tr>
<tr>
<td></td>
<td>• Remove Unallocated Installs (Not available for Oracle database options)</td>
</tr>
<tr>
<td></td>
<td>• Remove Unlicensed Installs (Not available for Oracle database options)</td>
</tr>
<tr>
<td>Affects compliance</td>
<td>Specifies whether the remediation options affect compliance.</td>
</tr>
<tr>
<td>License metric</td>
<td>Specific license metric of the software model result.</td>
</tr>
<tr>
<td>Software model result</td>
<td>Specific software model result pertaining to the remediation option.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the remediation option.</td>
</tr>
<tr>
<td></td>
<td>• New (blue)</td>
</tr>
<tr>
<td></td>
<td>• Complete (green)</td>
</tr>
<tr>
<td></td>
<td>• Void (red)</td>
</tr>
<tr>
<td></td>
<td>• In Progress (yellow)</td>
</tr>
<tr>
<td></td>
<td>In Progress state indicates that removal candidates were created for the</td>
</tr>
<tr>
<td></td>
<td>installs.</td>
</tr>
<tr>
<td>Rights not in use</td>
<td></td>
</tr>
<tr>
<td>Rights not allocated</td>
<td></td>
</tr>
<tr>
<td>Rights needed</td>
<td></td>
</tr>
<tr>
<td>Reclaimable rights</td>
<td></td>
</tr>
<tr>
<td>Unlicensed rights</td>
<td></td>
</tr>
<tr>
<td>(Field shown is based on Remediation action type)</td>
<td></td>
</tr>
<tr>
<td>Actionable rights</td>
<td>Total rights affected by the action.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The Unlicensed Installs related list contains the *software installations* that are unlicensed.

The Unlicensed Subscriptions related list contains the software subscriptions that are unlicensed. For more information, see *Microsoft Office 365 integration* and *Software Asset Management publisher pack for Adobe*.

**Note:** This related list is only shown if the software product is a subscription.

The Unlicensed Users related list contains the *SAP system users* that are unlicensed.

**Note:** This related list is only shown for SAP publisher.

The Removal Candidates related list contains *removal candidates* related to software installations.

3. To execute remediation options for specific remediation actions, click the applicable action.

### Remediation option action buttons

<table>
<thead>
<tr>
<th>Remediation option action</th>
<th>Action button</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove Unlicensed Installs</td>
<td>Create All Removal Candidates</td>
<td>When removal candidates are created for unlicensed installs, the status is set to Awaiting Revocation.</td>
</tr>
<tr>
<td>Remove Unallocated Installs</td>
<td>Create All Removal Candidates</td>
<td>When removal candidates are created for unallocated installs, the status is set to Ready.</td>
</tr>
<tr>
<td>Remove Allocations</td>
<td>Remove All Allocations</td>
<td>When allocations are removed, the number of allocations is adjusted.</td>
</tr>
<tr>
<td>Create Allocations</td>
<td>Create All Allocations</td>
<td>When allocations are created, the status of Remove Unallocated Installs remediation options (for the same license metric of the same software model result) are then set to Void.</td>
</tr>
<tr>
<td>Remediation option action</td>
<td>Action button</td>
<td>Result</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Purchase Rights</td>
<td>Create Purchase Order</td>
<td>When a purchase order is created, the status of any Purchase Rights remediation options for the same software model result are then set to Void.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Purchase order fields Part number, Metric group, License metric, and Ordered quantity are automatically populated with the content from the remediation option.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Metric group and License metric fields are added to the purchase order form so the entitlement can be automatically created when the order is complete.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A notification is shown if at least one active purchase order line item exists for the software model.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Once a purchase order is created, the Purchase order field, containing the purchase order reference, is added to the remediation option.</td>
</tr>
</tbody>
</table>

A confirmation message is shown and all applicable removal candidates are added to the Removal Candidates related list.

**Software license compliance position**

The Software Asset Management License Position report shows compliance details for each software model in a single list.

You can view and export the software model compliance list for your environment to understand your license position.

**License Position Report list**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software publisher</td>
<td>Software publisher of the software model.</td>
</tr>
<tr>
<td>Software product</td>
<td>Software product of the software model.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software product.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Status</td>
<td>Compliance status of the software model.</td>
</tr>
<tr>
<td></td>
<td>• Compliant (indicated with a green dot)</td>
</tr>
<tr>
<td></td>
<td>• Not Compliant (indicated with a red dot)</td>
</tr>
<tr>
<td>License metric</td>
<td>License metric of the software model.</td>
</tr>
<tr>
<td>Total spend</td>
<td>Total cost of rights owned.</td>
</tr>
<tr>
<td>Rights owned</td>
<td>Sum of all active rights.</td>
</tr>
<tr>
<td>Rights used</td>
<td>Sum of rights allocated in use and not allocated in use.</td>
</tr>
<tr>
<td>Rights needed</td>
<td>Rights needed to cover the number of unlicensed installs.</td>
</tr>
<tr>
<td>Rights available</td>
<td>Rights owned less rights used.</td>
</tr>
<tr>
<td>Unlicensed installs</td>
<td>Number of unlicensed software installations that are not covered by any entitlements.</td>
</tr>
<tr>
<td>True-up cost</td>
<td>Estimated cost of remediating non-compliance based on the least number of rights needed.</td>
</tr>
<tr>
<td>Potential savings</td>
<td>Estimated savings from reclaiming unused installs.</td>
</tr>
<tr>
<td>Over-licensed amount</td>
<td>Total cost of unused rights.</td>
</tr>
<tr>
<td>Software model</td>
<td>Software model name.</td>
</tr>
</tbody>
</table>

The License Position Report form also contains **Group** and **Subgroup** fields that specify the group and subgroup on which reconciliation was run.

**Software installation optimization and removal**

You can optimize your environment by reclaiming unused software as well as removing unauthorized software.

If a user is not **using software** installed, or infrequently, that software can be a candidate for removal. Removal means uninstalling and reallocating the software to an individual who will use it more often. Removal candidates are used to reclaim software installations.

Software reclamation is integrated with Workflow and **Client Software Distribution** (CSD) to automate the process of uninstalling software from devices and reclaiming those software rights. During the workflow, the state of the removal candidate changes based on the progression within the workflow.

A monthly scheduled job, **SAM – Identify new reclamation candidates**, uses the reclamation rules and software usage to create removal candidates.

In each list of Removal Candidates, you can select individual records for reclamation, or **Reclaim All** to reclaim all qualifying removal candidates. Qualifying candidates are those candidates in the Ready state.

**Removal candidate grouping and state**

Removal candidates are grouped according to justification.
- Low Usage
  
  **Software Asset > Removal Candidates > Reclamation Candidates**

- Blacklisted
  
  **Software Asset > Removal Candidates > Blacklisted Installations**

- All other justifications (Unlicensed, Unallocated, for example)
  
  **Software Asset > Removal Candidates > Other Candidates**

## Removal candidate state

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attention Required</td>
<td>A removal candidate requires attention if the User field is empty on an automatic removal candidate that has the Notify User check box selected.</td>
</tr>
<tr>
<td></td>
<td>Once the User field is populated, the state automatically changes to Ready.</td>
</tr>
<tr>
<td>Ready</td>
<td>When a removal candidate is in the Ready state, you can click Reclaim to advance the workflow.</td>
</tr>
<tr>
<td>Awaiting User</td>
<td>If the Notify User check box was selected, the user was sent a notification of the removal candidate to approve or deny.</td>
</tr>
<tr>
<td>Awaiting Approval</td>
<td>If the Notify User check box was selected, the user can approve or deny the removal candidate. If the user still wants to keep the software installation, it becomes the responsibility of the manager to approve or decline the removal.</td>
</tr>
<tr>
<td>Awaiting Revocation</td>
<td>The final step in the workflow. You can click Close Complete to reclaim software rights in the removal candidate manually.</td>
</tr>
<tr>
<td></td>
<td>Otherwise, a weekly scheduled job (named SAM — Updating Existing Reclamation Candidates) automatically updates removal candidates in the Awaiting Revocation state and with the software install field empty to Closed Complete state.</td>
</tr>
<tr>
<td></td>
<td>If the removal candidate is in any other state AND the software install is empty, the Reclamation workflow is canceled and updated to Closed Skipped state.</td>
</tr>
<tr>
<td></td>
<td>The state for a removal candidate that has blacklisted software is automatically set to Awaiting Revocation and the justification is set to Blacklisted.</td>
</tr>
<tr>
<td>Closed Complete</td>
<td>Software rights have been reclaimed.</td>
</tr>
<tr>
<td>Closed Skipped</td>
<td>Software rights not reclaimed by the removal candidate.</td>
</tr>
<tr>
<td>State</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Closed Canceled</td>
<td>Software rights not reclaimed by the removal candidate as user activity is detected.</td>
</tr>
</tbody>
</table>

**Blacklisted justification and unlicensed justification**

Workflows for removal candidates with a blacklisted justification or an unlicensed justification get executed automatically. The user is notified of unauthorized software use and is not prompted for approval.

- **Blacklisted:**
  
  Unauthorized Software Use
  
  [Publisher] [Product] installed on the device, [device name], is not authorized to be used on company property. Do not install this software again.

- **Unlicensed:**
  
  Unauthorized Software Use
  
  You are not licensed to use [Publisher] [Product] installed on the device, [device name]. Use the appropriate process to request a license for the software.

The workflow state for a blacklisted justification and an unlicensed justification is then set to Awaiting Revocation and, once discovery identifies that the installation no longer exists, the state is changed to Closed Complete.

**Unallocated justification and Low Usage justification**

Workflows for removal candidates with an unallocated justification or a low usage justification prompt the user for approval.

- **Unallocated:**
  
  [Publisher] [Product] installed on the device, [device name], has been flagged for removal because an allocation to use the software does not exist. Do you still require access to this software?

- **Low Usage:**
  
  [Publisher] [Product] has been flagged for reclamation. Do you still need this software installed on [device name]?

**Justification descriptions**

Removal candidate descriptions get updated based on the justification.

- **Unallocated:**
  
  [Publisher] [Product] installed on the device, [device name], has been flagged for removal because an allocation to use the software does not exist. If you do not require this software, Reject this task. If you still
require access to this software, Approve this task and your request for continued use of the software will be routed for software manager approval.

- **Unlicensed:**
  
  [Publisher] [Product] installed on the device, [device name], has been flagged for removal because the licenses to use it are not owned. Please request access to this software through the appropriate process.

- **Blacklisted:**
  
  [Publisher] [Product] installed on the device, [device name], is not authorized for use on company owned property.

- **Low Usage:**
  
  [Publisher] [Product] installed on the device, [device name], has been flagged for reclamation due to low usage. If you do not require this software, Reject this task. If you still require access to this software, Approve this task and your request for continued use of the software will be routed for manager approval.

When the Reclaim action is clicked, if the Notify User field is selected and the days before reclamation is greater than 0, then the state is set to Awaiting User. Otherwise the state is set to Awaiting Reclamation.

When the state changes to Awaiting User, a notification is sent to the user.

**Add a software reclamation rule**

You can add a reclamation rule to aggregate usage records and identify unused software. Reclamation rules aggregate usage over a time and specify a minimum number of hours the software must be used, or date last used, before being flagged for reclamation.

Role required: sam_admin

You can avoid purchasing more software rights for products with rights already allocated but aren't being used, being used infrequently, or not used recently enough to justify the allocation. Reclamation rules reclaim those software rights to be freed up and allocated elsewhere. Reclamation rules are configured to specify a period or amount of time the software must be used, or date last used, before being flagged for reclamation.

If you select the Notify user check box in the reclamation rule, the user has a chance to respond with approval during the process of reclamation. If no response is received during a specified period, the software rights are automatically reclaimed. If the user still wants to keep the software installation, it becomes the responsibility of the manager to approve or decline the removal.

For information on creating a reclamation rule for SCCM products, see *Create a reclamation rule to import Microsoft SCCM usage data*.

1. Navigate to Software Asset > Administration > Reclamation Rules and create a new record (see table for field descriptions).

### Note:

You can edit the software members of the Software Products list once the reclamation rule is created.

#### Reclamation Rules form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the reclamation rule.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applies to</td>
<td>Item type to which the reclamation rule applies.</td>
</tr>
</tbody>
</table>
| Reclamation type       | Type of reclamation rule.  
|                        | - Total Usage Time (default)  
|                        | - Last Used Date  
|                        | - Peak Concurrent Usage (only shown if you select Engineering App License from the Applies to list).                                                                                              |
| Notify user            | Check box for notifying the user assigned to the hardware on which the software is installed requesting permission via email to remove the software.                                      |
| Usage Metering Data    | Note: Only shown for reclamation time and peak concurrent usage type.  
| Aggregate usage by     | Time period over which to aggregate usage information.  
|                        | - Last Month  
|                        | - Last Two Months  
|                        | - Last Three Months  
|                        | - Last Six Months (only shown if you select Installed Software from the Applies to list).                                                                                                       |
| Total hours used       | Amount of time the software must be used to avoid being reclaimed.                                                                                                                                    |
| Percent utilized       | License utilization percentage. For example, If you specify 60% and you utilized less than 60%, a reclamation candidate is automatically created for the remaining 40% rights. |
| Last Used Data         | Note: Only shown for reclamation date type.  
| Last used before       | Amount of time to keep unused software before it is reclaimed.  
|                        | - One Month Ago  
|                        | - Two Months Ago  
|                        | - Three Months Ago  
|                        | - Six Months Ago  
|                        | - Nine Months Ago  
|                        | - One Year Ago  

2. Once the reclamation rule has been created, select a software product or Add a custom software product in the Software Product related list.
3. If a product process does not exist for the software product, click **New** in the Product Process related list to add a custom product process.

**Note:** The Product Process related list is shown only when a software product with a product process is selected.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>Software product.</td>
</tr>
<tr>
<td>File name</td>
<td>Software product filename required for SCCM Usage to pull data.</td>
</tr>
<tr>
<td>Platform</td>
<td>Platform of the product.</td>
</tr>
</tbody>
</table>

**Microsoft SCCM software usage**

Activate the Microsoft SCCM software usage plugin to integrate your software usage data with the Now Platform.

One of the following Microsoft SCCM Software Usage plugins must be installed to import software usage data from Microsoft SCCM to Software Asset Management.

- Integration — Microsoft SCCM 2012 v2 Software Usage (com.snc.samp_usage_sccm) plugin
- Integration — Microsoft SCCM 2016 Software Usage (com.snc.samp.usage_sccm_2016) plugin

**Note:** The Integration — Microsoft SCCM 2016 plugin is compatible with SCCM version 1606, 1906, 1910, and 2002.

The SCCM integration plugin installs several components.

After the SCCM usage plugin is activated and configured, a scheduled import runs monthly to bring SCCM software usage data into your instance. The usage data is then mapped to Software Usage table. During the scheduled job, a SQL query is executed.

The scheduled import runs once a month, but you can run the import on demand by clearing the Conditional option on the Scheduled Data Import form. However, the data is always pulled from the previous month, so there won’t be a change in the data until the following scheduled import.

**Note:** The SCCM software usage data source can’t be executed directly because the SQL statement doesn’t actually pull in the data, so the records aren’t retrieved. A valid SQL statement on the data source is updated dynamically through a scheduled import. So, if you need to pull the data into your ServiceNow instance, use the scheduled import.

There are two types of data (total usage and last used) that you can extract from SCCM and import into your instance. Last used data will only show the last time the software was used during the previous month.

Total usage data will show down to the second when the software was used in the previous month, which can be a large amount of data imported into your instance. A usage record tracks the sum of usage on a monthly basis so that you can assess the software usage in your environment.

Depending on what you’ve specified in the reclamation rule for the product, one of the following scheduled imports will run to pull in the data.
- SAMP Usage Import
- SAMP Usage 2016 Import
- SCCM 2012 v2 Software Last Used
- SCCM 2016 Software Last Used

**Note:** Only usage data for products associated with a reclamation rule is imported. The **Reclamation type** field on the Reclamation Rule form must match the scheduled import that you are running, otherwise the data is not pulled into your instance. For more information, see *Create a reclamation rule to import Microsoft SCCM usage data.*

You can also pull in user data from SCCM. User data is compared to the user_name field of the sys_user record. If the names don’t match, the user data isn’t imported.

**Note:** Configuration item (CI), user, product, and publisher values are used to identify a matching software installation.

Duplicate usage information cannot be created for the same CI, user, product, or publisher values in the same month and year.

You can also import usage information using ServiceNow **import sets** feature.

**Components installed with the Microsoft SCCM software usage plugin**

Several types of components are installed with activation of the Microsoft SCCM software usage plugin.

### Installed with SCCM Software Usage plugin

<table>
<thead>
<tr>
<th>Data source</th>
<th>SCCM 2012 v2</th>
<th>SCCM 2016</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAMP Usage (Total usage)</td>
<td>• SAMP Usage (Total usage)</td>
<td>• SAMP Usage 2016 (Total usage)</td>
</tr>
<tr>
<td>SCCM 2012 v2 Software Last Used (Last used)</td>
<td>• SCCM 2012 v2 Software Last Used (Last used)</td>
<td>• SCCM 2016 Software Last Used (Last used)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Scheduled imports</th>
<th>SCCM 2012 v2</th>
<th>SCCM 2016</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAMP Usage Import</td>
<td>• SAMP Usage Import</td>
<td>• SAMP Usage 2016 Import</td>
</tr>
<tr>
<td>SCCM 2012 v2 Software Last Used</td>
<td>• SCCM 2012 v2 Software Last Used</td>
<td>• SCCM 2016 Software Last Used</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transform map</th>
<th>SCCM 2012 v2</th>
<th>SCCM 2016</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAMP usage import (Total usage)</td>
<td>• SAMP usage import 2016 (Total usage)</td>
<td>• SAMP usage import 2016 (Total usage)</td>
</tr>
<tr>
<td>SAMP last used data import (Last used)</td>
<td>• SAMP last used data 2016 import (Last used)</td>
<td>• SAMP last used data 2016 import (Last used)</td>
</tr>
<tr>
<td>(An onComplete transform script is associated with the transform map)</td>
<td>(An onComplete transform script is associated with the transform map)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Script include</th>
<th>SCCM 2012 v2</th>
<th>SCCM 2016</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAMPUsageUtil</td>
<td>SAMPUsageUtil</td>
<td>SAMPUsage2016Util</td>
</tr>
</tbody>
</table>
If you’ve activated the Integration — Microsoft SCCM 2012 v2 Software Usage (com.snc.samp.usage_sccm) plugin, navigate to **Integration — Microsoft SCCM 2012 v2 > Scheduled Import**.

**SCCM data imported for SCCM 2012 v2**

<table>
<thead>
<tr>
<th></th>
<th>SCCM table</th>
<th>Staging table</th>
<th>Target table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total usage</td>
<td>v_MonthlyUsageSummary</td>
<td>Software usage import</td>
<td>Software Usage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(imp_samp_usage_import)</td>
<td>(samp_sw_usage)</td>
</tr>
<tr>
<td>Last used</td>
<td>v_GS_CCM_RECENTLY_USED</td>
<td>SCCM 2012 v2</td>
<td>Software Usage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Software Last Used</td>
<td>(samp_sw_usage)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(imp_sccm2012v2_software_last_used)</td>
<td></td>
</tr>
</tbody>
</table>

If you’ve activated the Integration — Microsoft SCCM 2016 Software Usage (com.snc.samp.usage_sccm_2016) plugin, navigate to **Integration — Microsoft SCCM 2016 > Scheduled Import**.

**SCCM data imported for SCCM 2016**

<table>
<thead>
<tr>
<th></th>
<th>SCCM table</th>
<th>Staging table</th>
<th>Target table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total usage</td>
<td>v_MonthlyUsageSummary</td>
<td>Software usage 2016 import</td>
<td>Software Usage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(imp_samp_usage_2016_import)</td>
<td>(samp_sw_usage)</td>
</tr>
<tr>
<td>Last used</td>
<td>v_GS_CCM_RECENTLY_USED</td>
<td>SCCM 2016</td>
<td>Software Usage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Software Last Used</td>
<td>(samp_sw_usage)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(imp_sccm2016_software_last_used)</td>
<td></td>
</tr>
</tbody>
</table>

**Create a reclamation rule to import Microsoft SCCM usage data**

To import your Microsoft SCCM data, create a reclamation rule for the product that you want the usage information for.

Role required: sam_admin

A software product must have a product process, which consists of a filename, that is required for SCCM Usage to pull data. When adding a software product to a reclamation rule, any product processes associated with the software product are shown in the Product Process related list. Product processes are stored in the Software Product Process (samp_sw_product_process) table.

If a product process does not exist for a software product, you can create a custom one on the form. Product processes are stored in the Custom Product Process (samp_custom_product_process) table.

Some software products may not include a product process, but new product processes are added weekly through the content library updates.

1. Navigate to **Software Asset > Administration > Reclamation Rules** and click **New**.
2. On the Reclamation Rule form, create a new record (see table for field descriptions).
Reclamation Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the product that you are creating the reclamation rule for.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Type of software to which the reclamation rule applies.</td>
</tr>
<tr>
<td></td>
<td>- Installed Software</td>
</tr>
<tr>
<td></td>
<td>- Engineering App License</td>
</tr>
<tr>
<td>Reclamation type</td>
<td>Type of data pulled from SCCM.</td>
</tr>
<tr>
<td></td>
<td>- Total Usage Time</td>
</tr>
<tr>
<td></td>
<td>- Last Used Date</td>
</tr>
<tr>
<td>Notify user</td>
<td>Check box for notifying the user assigned to the software requesting permission via email to remove the software.</td>
</tr>
</tbody>
</table>

3. If you selected **Total Usage Time** in the **Reclamation type** field, complete the fields in the Usage Metering Data section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregate usage by</td>
<td>Time period over which to aggregate usage information.</td>
</tr>
<tr>
<td></td>
<td>- Last Month</td>
</tr>
<tr>
<td></td>
<td>- Last Two Months</td>
</tr>
<tr>
<td></td>
<td>- Last Three Months</td>
</tr>
<tr>
<td></td>
<td>- Last Six Months</td>
</tr>
<tr>
<td>Total hours used</td>
<td>Amount of time the software must be used to avoid being reclaimed.</td>
</tr>
</tbody>
</table>

4. If you selected **Last Used Date** in the **Reclamation type** field, complete the fields in the Last Used Data section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last used before</td>
<td>Amount of time a user can keep unused software before it is reclaimed.</td>
</tr>
</tbody>
</table>

5. Click **Save**.
6. On the Software Product related list, complete the following steps if a product doesn’t exist for your reclamation rule.
   a) Click **New**.
   b) On the Custom Software Product form, **fill in the details** to add the product information.
   c) Click **Submit**.
   d) On the Reclamation Rule form, click **Edit** in the Software Product related list.

7. On the Software Product related list, click **Edit**.
8. Select the product that you created with on the Custom Software Product form.

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
9. Click Save.
10. Complete the following steps if the software product that you selected doesn’t have a product process associated with it.
   a) Click the link in the banner that displays on the Reclamation Rule form after you’ve applied the software product.
   b) On the Custom Product Process form, fill in the details to add a process to the product.

### Custom Product Process Form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>Name of the product.</td>
</tr>
<tr>
<td>File name</td>
<td>Name of the file associated with the product.</td>
</tr>
<tr>
<td>Platform</td>
<td>Platform of the product.</td>
</tr>
</tbody>
</table>

c) Click Submit

**Create a reclamation rule to import Microsoft SCCM usage data**

Create a reclamation rule to pull in the total usage data for Microsoft Excel from Microsoft SCCM.

To begin creating a reclamation rule, add the following information to the Reclamation Rule form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Microsoft Excel</td>
</tr>
<tr>
<td>Applies to</td>
<td>Installed Software</td>
</tr>
<tr>
<td>Reclamation type</td>
<td>Total Usage Time</td>
</tr>
<tr>
<td>Usage Metering Data</td>
<td></td>
</tr>
<tr>
<td>Aggregate usage by</td>
<td>Last Month</td>
</tr>
<tr>
<td>Total hours used</td>
<td>20</td>
</tr>
</tbody>
</table>

Click Save.
<table>
<thead>
<tr>
<th>Name</th>
<th>Microsoft Excel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applies to</td>
<td>Installed Software</td>
</tr>
<tr>
<td>Reclamation type</td>
<td>Total Usage Time</td>
</tr>
</tbody>
</table>

**Usage Monitoring Data**

<table>
<thead>
<tr>
<th>Aggregate usage by</th>
<th>Last Month</th>
<th>Total hours used</th>
<th>Specify the amount of time software must be used to avoid being reclaimed.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>20</td>
<td></td>
</tr>
</tbody>
</table>

**Software Product**

- No records to display.
A software product already exists for Microsoft Excel, so you need to associate the product with the reclamation rule.

On the Software Product related list, click **Edit**.

On the Edit Members form, navigate to Excel in the Collection column and select Excel. Add it to the Software Product List column.
Click **Save**.
### Reclamation Rule

**Microsoft Excel**

- **Name**: Microsoft Excel
- **Applies to**: Installed Software
- **Reclamation type**: Total Usage Time

#### Usage Metering Data

- **Aggregate usage by**: Last Month
- **Specify the amount of time software must be used to avoid being reclaimed.**

### Software Products

<table>
<thead>
<tr>
<th>ID</th>
<th>Software Product</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Excel</td>
<td></td>
</tr>
</tbody>
</table>

### Product Processes

<table>
<thead>
<tr>
<th>ID</th>
<th>Product Process</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Two product processes are associated with Excel. Click the Product Process related list to view the product processes.
### Reclamation Rule

**Microsoft Excel**

<table>
<thead>
<tr>
<th>Name</th>
<th>Microsoft Excel</th>
<th>Notify user</th>
<th>Applies to</th>
<th>Installed Software</th>
<th>Reclamation type</th>
<th>Total Usage Time</th>
</tr>
</thead>
</table>

### Usage History Data

Specify the amount of time software must be used to avoid being reclaimed.

<table>
<thead>
<tr>
<th>Aggregate usage by</th>
<th>Last Month</th>
<th>Total hours used</th>
</tr>
</thead>
</table>

### Software Product Process

**EXCEL 2003**

<table>
<thead>
<tr>
<th>File name</th>
<th>Product</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXCEL 2003</td>
<td>Excel</td>
<td>microsoft</td>
</tr>
</tbody>
</table>
On the Reclamation Rule form, click **Save**.

The reclamation rule is added to the Reclamation Rules list and the data of the product will be imported from SCCM during the next monthly scheduled import.

**View software usage with Microsoft SCCM or Import Sets**

A usage record tracks the software usage for products that you've created reclamation rules for. You can import usage information using Microsoft SCCM integration, or using the Import Sets feature.

**Role required: sam_user**

To view or create a Software Usage record, navigate to **Software Asset > Discovery > Software Usage** (see table for field descriptions).

### Software Usage form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher</td>
<td>Publisher of the product.</td>
</tr>
<tr>
<td>Product</td>
<td>Product name.</td>
</tr>
<tr>
<td>Reclamation type</td>
<td>Type of reclamation used on the software install.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>Configuration item (CI).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the CI Status or Hardware Status field changes to Retired or Stolen, installs related to the CI are deleted.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user of the software.</td>
</tr>
<tr>
<td>Usage Metering Data (Total Usage Time reclamation type)</td>
<td></td>
</tr>
<tr>
<td>Month</td>
<td>Month the software was used.</td>
</tr>
<tr>
<td>Year</td>
<td>Year the software was used.</td>
</tr>
<tr>
<td>Usage count</td>
<td>How many times the software was accessed.</td>
</tr>
<tr>
<td>Total seconds used</td>
<td>Amount of time (in seconds) the software was used.</td>
</tr>
<tr>
<td>Last Used Data (Last Used Date reclamation type)</td>
<td></td>
</tr>
<tr>
<td>Last used time</td>
<td>Date the software was last used.</td>
</tr>
</tbody>
</table>

**Add a software removal candidate**

Removal candidates reclaim software resources in your environment. They are created from reclamation rules, or can be created manually.

**Role required: sam_user**
Software reclamation is integrated with Workflow and Client Software Distribution to automate the process of uninstalling software from devices and reclaiming software rights. However, you can also create a removal candidate manually.

1. Navigate to **Software Asset > Removal Candidates** and create a new record on the Reclamation, Blacklisted, or Other Removal Candidates list (see table for field descriptions).
<table>
<thead>
<tr>
<th>Number</th>
<th>RCC00000001</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment group</td>
<td>Software Managers</td>
</tr>
<tr>
<td>Assigned to</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>Ready</td>
</tr>
<tr>
<td>Opened</td>
<td>2018-11-06 14:51:28</td>
</tr>
<tr>
<td>Closed</td>
<td></td>
</tr>
<tr>
<td>Justification</td>
<td>Low Usage</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Applies to</th>
<th>Installed Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reclamation rule</td>
<td></td>
</tr>
<tr>
<td>Potential savings</td>
<td>$0.00</td>
</tr>
<tr>
<td>Notify user</td>
<td></td>
</tr>
</tbody>
</table>

**Removal Candidate Activity**

- Software Installation
- User
- Configuration Item
## Removal Candidate form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique removal candidate number that is automatically generated.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Automatically set to the software managers group authorized to respond to removal candidates.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Person primarily responsible for working this task.</td>
</tr>
<tr>
<td>Name</td>
<td>Removal candidate name that is automatically generated. Contains the software installation display name.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of why the task exists, and what the user must do, if they receive an approval.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the removal candidate.</td>
</tr>
<tr>
<td></td>
<td>• Attention Required</td>
</tr>
<tr>
<td></td>
<td>• Ready</td>
</tr>
<tr>
<td></td>
<td>• Awaiting User</td>
</tr>
<tr>
<td></td>
<td>• Awaiting Approval</td>
</tr>
<tr>
<td></td>
<td>• Awaiting Revocation</td>
</tr>
<tr>
<td></td>
<td>• Closed Complete</td>
</tr>
<tr>
<td></td>
<td>• Closed Skipped</td>
</tr>
<tr>
<td></td>
<td>• Closed Canceled</td>
</tr>
<tr>
<td>Opened</td>
<td>Date the task was opened.</td>
</tr>
<tr>
<td>Closed</td>
<td>Date the task was closed.</td>
</tr>
<tr>
<td>Justification</td>
<td>Justification for becoming a removal candidate.</td>
</tr>
<tr>
<td></td>
<td>• Low Usage (default)</td>
</tr>
<tr>
<td></td>
<td>• Unallocated</td>
</tr>
<tr>
<td></td>
<td>• Unlicensed</td>
</tr>
<tr>
<td></td>
<td>• Blacklisted</td>
</tr>
<tr>
<td>Removal Candidate</td>
<td></td>
</tr>
<tr>
<td>Applies to</td>
<td>Item type to which the reclamation rule applies.</td>
</tr>
<tr>
<td></td>
<td>• Installed Software</td>
</tr>
<tr>
<td></td>
<td>• Subscription Software</td>
</tr>
<tr>
<td></td>
<td>• Engineering App License</td>
</tr>
<tr>
<td>Software installation</td>
<td>The software installation being reclaimed.</td>
</tr>
<tr>
<td>Engineering App License</td>
<td>The Engineering application license that you want to reclaim.</td>
</tr>
</tbody>
</table>

Note: Only appears if Engineering App License is selected in the Applies to list.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Name of the user assigned to the software installation. This value can be changed so that another user receives the notification of software being uninstalled.</td>
</tr>
<tr>
<td>Reclamation rule</td>
<td>The reclamation rule that created the removal candidate.</td>
</tr>
<tr>
<td>Rights to reclaim</td>
<td>The number of rights that you want to reclaim. For example, you have 100 rights installed on a license server but you want to reclaim only 40 rights.</td>
</tr>
<tr>
<td>Note: Engineering App License is selected in the Applies to list.</td>
<td></td>
</tr>
<tr>
<td>Potential savings</td>
<td>Estimated cost of savings if all removal candidates are in Closed Complete state, meaning the software was uninstalled and the rights were harvested (unused rights * average price per right from entitlements).</td>
</tr>
<tr>
<td>Notify user</td>
<td>Check box for notifying the user assigned to the hardware on which the software is installed requesting permission via email to remove the software.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>The device on which the software is installed.</td>
</tr>
<tr>
<td>Activity</td>
<td></td>
</tr>
<tr>
<td>Work notes</td>
<td>Used to track the actions that have been performed on this task.</td>
</tr>
</tbody>
</table>

2. For additional configuration, select the new record from the Removal Candidates list and click an action button.

*Note: Action buttons are dependent on removal candidate justification and state.*

### Action Description

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update</td>
<td>Update the removal candidate.</td>
</tr>
<tr>
<td>Close Complete</td>
<td>Reclaim rights and close the removal candidate.</td>
</tr>
<tr>
<td>Close Skipped</td>
<td>Close the removal candidate without reclaiming rights.</td>
</tr>
<tr>
<td>Reclaim</td>
<td>Reclaim rights.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete removal candidate.</td>
</tr>
</tbody>
</table>

### Analytics and Reporting Solutions for Software Asset Management Professional

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.
Enabling the Performance Analytics Solution

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.

**Note:** Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.

The Performance Analytics - Content Pack - Software Asset Management Professional is enabled automatically when ServiceNow activates Software Asset Professional on your instance.

In addition to the Software Asset dashboards, this content pack includes the Overlapping Software dashboard, which is available when Software Spend Detection is activated. For more information about this dashboard, see Overlapping Software dashboard.

Domain separation and ‘Run As’ user

By default, System Administrator is the Run As user for data collection jobs in the Analytics and Reporting Performance Analytics Solutions. Verify that this user exists on the instance, and whether this user has the appropriate level of access. An inappropriate Run As user can cause errors or limit the data that is collected. This setting only has an effect if domain separation is enabled.

Software Asset Analytics dashboard

View true-up costs and license, compliance, and removal summaries trend charts on the Software Asset Analytics dashboard integrated with Performance Analytics.

The Software Asset Analytics dashboard tab is accessed by navigating to **Software Asset > Overview**. Click an element within a report to see more information, or add and move widgets as needed.

The Overview, License Summary, and Compliance Summary tabs are updated whenever a new reconciliation result is available. Results are updated daily for the Removal Summary tab. You can save charts in PNG or JPG formats.

The graphs show important statistics about the software being tracked. In the Overview and Optimization tabs, you can filter by publisher and product to narrow the results.

**Note:** If you are not seeing data in the Overview dashboard, verify the glide.cms.enable.responsive_grid_layout system property is set to true.
### Overview

#### True-up Cost

- **2Q 2019 (Oct 01 - Oct 31)**: $854.00k
- **3Q 2019 (Nov 01 - Nov 30)**: $874.00k

#### Publishers Out of Compliance

- **2Q 2019 (Oct 01 - Oct 31)**: 9
- **3Q 2019 (Nov 01 - Nov 30)**: 18

#### Products Out of Compliance

- **2Q 2019 (Oct 01 - Oct 31)**: $0.00k
- **3Q 2019 (Nov 01 - Nov 30)**: $1.02M

#### Software Spend Breakdown

<table>
<thead>
<tr>
<th>Publisher</th>
<th>Oct 2019</th>
<th>Trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM</td>
<td>$400.4k</td>
<td></td>
</tr>
<tr>
<td>Microsoft</td>
<td>$169.4k</td>
<td></td>
</tr>
<tr>
<td>Oracle</td>
<td>$88.5k</td>
<td></td>
</tr>
<tr>
<td>SAP</td>
<td>$72.5k</td>
<td></td>
</tr>
<tr>
<td>VMware Inc.</td>
<td>$17.4k</td>
<td></td>
</tr>
</tbody>
</table>

#### Potential Savings

- **2Q 2019 (Oct 01 - Oct 31)**: $0.00k
- **3Q 2019 (Nov 01 - Nov 30)**: $1.02M
## Overview tab

<table>
<thead>
<tr>
<th>Report</th>
<th>Source list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>True-up Cost</td>
<td>Product Results</td>
<td>Cost to be compliant based on the average prices in entitlements for the rights.</td>
</tr>
<tr>
<td>Publishers out of Compliance</td>
<td>Product Results</td>
<td>Number of publishers that have at least one software model out of compliance. Click on the report view the results in the <em>Software license usage</em>.</td>
</tr>
<tr>
<td>Products out of Compliance</td>
<td>Product Results</td>
<td>Number of products that have at least one software model out of compliance. Click on the report view the results in the <em>Software license usage</em>.</td>
</tr>
<tr>
<td>Potential Savings</td>
<td>Product Results</td>
<td>Cost saved if removal candidates are reclaimed.</td>
</tr>
<tr>
<td>True-up Cost Breakdown</td>
<td>Product Results</td>
<td>Cost to be compliant based on the average prices in entitlements for the rights by publisher.</td>
</tr>
<tr>
<td>Software Spend Breakdown</td>
<td>License Metric Results</td>
<td>Total software cost of all entitlements not retired by publisher.</td>
</tr>
</tbody>
</table>
# License Summary

## Overall Product Compliance
- **W39 2019 (Oct 23-Sep 26)**: 50.00%

## Percent Spend Not in Use
- **W39 2019 (Oct 23-Sep 26)**: 36.81%

## Expiring Maintenance Entitlements
- **W39 2019 (Oct 23-Sep 26)**: 1

## Software Spend
- **Sep 2019**: $439.61k

### Week over Week Cost Summary

#### True-up Cost
- **W39 2019**:

#### Potential Savings
- **W39 2019**

#### Over-licensed Amount

### Month over Month Software Spend

#### Software Spend
- **Sep 19**

### Overall Publisher Compliance
- **Name**: ni-technologies
  - **W39 2019**: 0.00%

### Spend in Use by Publisher
- **Name**: Delunk
  - **W39 2019**: 25.37%

- **Name**: Adobe Systems
  - **Sep 2019**: $360.26k
# License Summary Tab

<table>
<thead>
<tr>
<th>Report</th>
<th>Source Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Product Compliance</td>
<td>Product Result (samp_product_result)</td>
<td>Total percent of compliant products.</td>
</tr>
<tr>
<td>Percent Spend Not in Use</td>
<td>Product Result and License Metric Results (samp_product_result) and (samp_license_metric_result)</td>
<td>Percent of software spend that is not in use (over-licensed amount and potential savings).</td>
</tr>
</tbody>
</table>
| Expiring Maintenance Entitlements | Software Entitlement (alm_license) | End date of the total sum of all entitlements that are going to expire within 6 months. The total sum of entitlements includes:  
- Perpetual  
- Maintenance  
- Perpetual + Maintenance  
- Upgrade  
- SA  
- Perpetual +SA  
- Step-up  
Click to view details about the specific entitlements that are going to expire.  
**Note:** Maintenance and SA entitlements are not displayed as the Perpetual entitlements associated with them are displayed. |
<p>| Software Spend                 | License Metric Results (samp_license_metric_result) | Total software cost of all entitlements not retired.                        |
| Week over Week Cost Summary    | Product Result and License Metric Results (samp_product_result) and (samp_license_metric_result) | True-up cost, potential savings, and over-licensed amount for a series of weeks. |
| Month Over Month Software Spend | License Metric Results (samp_license_metric_result) | Total software spend in a series of months.                               |
| Overall Publisher Compliance   | Product Result (samp_product_result)  | Percent of products compliant by publisher.                                |</p>
<table>
<thead>
<tr>
<th>Report</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spend In Use by Publisher</td>
<td>Product Result and License Metric Results</td>
<td>Spend in use by publisher = ( \frac{\text{(Total spend)} - \text{(Over-licensed amount)} - \text{(Potential savings)}}{\text{Total spend}} )</td>
</tr>
<tr>
<td></td>
<td>samp_product_result and samp_license_metric_result</td>
<td></td>
</tr>
<tr>
<td>Software Spend by Publisher</td>
<td>License Metric Results</td>
<td>Total software spend by publisher.</td>
</tr>
<tr>
<td></td>
<td>samp_license_metric_result</td>
<td></td>
</tr>
</tbody>
</table>

**Compliance Summary**

Compliance summary consists of time-series data using Performance Analytics to show the compliance trends over time. The source for compliance analysis data is the Product Result (samp_product_result) table.
### Compliance trend: True-up Cost

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>True-up Cost</td>
<td>Cost to be compliant based on the average prices for entitlements for the rights.</td>
</tr>
<tr>
<td>Publishers out of compliance</td>
<td>Number of publishers that have at least one software model out of compliance.</td>
</tr>
<tr>
<td>Products out of compliance</td>
<td>Number of products that have at least one software model out of compliance.</td>
</tr>
<tr>
<td>Potential savings</td>
<td>Cost saved if removal candidates are reclaimed.</td>
</tr>
<tr>
<td>Breakdowns</td>
<td>Shows the detailed list of results based on the widget selected. Breakdowns include Publisher, Product, and Scorecard.</td>
</tr>
<tr>
<td>Records</td>
<td>Shows the detailed list of product results based on the widget selected.</td>
</tr>
</tbody>
</table>

### Compliance trend: Over-licensed amount

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Over-licensed amount</td>
<td>Cost of licenses owned but not being used.</td>
</tr>
<tr>
<td>Publishers over-licensed</td>
<td>Number of publishers that have at least one software right not being used.</td>
</tr>
<tr>
<td>Products over-licensed</td>
<td>Number of products that have at least one software right not being used.</td>
</tr>
<tr>
<td>Breakdowns</td>
<td>Shows the detailed list of results based on the widget selected. Breakdowns include Publisher, Product, and Scorecard.</td>
</tr>
<tr>
<td>Records</td>
<td>Shows the detailed list of product results based on the widget selected.</td>
</tr>
</tbody>
</table>

### Removal Summary

The source for removal summary data is the Reclamation Candidate (samp_sw_reclamation_candidate) table.
Software Asset Analytics

Overview

Reclamation Candidates: 18k
Blacklisted Installs Being Removed: 4
Unlicensed Installs Being Removed: 0
Unallocated Installs Being Removed: 0

Candidates Requiring Attention: 0

Candidates Not Updated in 30 Days: 18k

Actual Savings Year-to-date:
- Mar '19
- Jun '19
- Jul '19
- Aug '19
- Sep '19
- Oct '19

Removal Candidates Breakdown:

- Ready: 17k (0.0%)
- Waiting Resolution: 54 (0.0%)
- Waiting User: 23 (0.0%)
- Waiting Approval: 2 (0.0%)
- Attention Required: 0 (0.0%)
Removal Summary tab

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reclamation Candidates</td>
<td>Total number of active removal candidates with a low usage justification.</td>
</tr>
<tr>
<td></td>
<td>Click on the report to show the filtered list of records.</td>
</tr>
<tr>
<td>Blacklisted Installs Being Removed</td>
<td>Total number of active removal candidates with a blacklisted justification.</td>
</tr>
<tr>
<td></td>
<td>Click on the report to show the filtered list of records.</td>
</tr>
<tr>
<td>Unlicensed Installs Being Removed</td>
<td>Total number of active removal candidates with an unlicensed justification.</td>
</tr>
<tr>
<td></td>
<td>Click on the report to show the filtered list of records.</td>
</tr>
<tr>
<td>Unallocated Installs Being Removed</td>
<td>Total number of active removal candidates with an unallocated justification.</td>
</tr>
<tr>
<td></td>
<td>Click on the report to show the filtered list of records.</td>
</tr>
<tr>
<td>Candidates Requiring Attention</td>
<td>Number of removal candidates in the attention required state.</td>
</tr>
<tr>
<td></td>
<td>Click on the report to show the filtered list of records.</td>
</tr>
<tr>
<td>Candidates Not Updated in 30 Days</td>
<td>Number of removal candidates that have an updated date value older than 30 days.</td>
</tr>
<tr>
<td></td>
<td>Click on the report to show the filtered list of records.</td>
</tr>
<tr>
<td>Actual Savings Year-to-date</td>
<td>Sum of potential savings in a given month of closed complete removal candidates.</td>
</tr>
<tr>
<td>Removal Candidates Breakdown</td>
<td>Active removal candidates in various breakdowns (State, Publisher, Product, Justification, and Last Updated).</td>
</tr>
</tbody>
</table>

Software Asset Management dashboard

View true-up costs, optimization results, and compliance trend charts on the Software Asset Management dashboard.

The Software Asset Management dashboard tab is accessed by navigating to Software Asset > Overview and selecting Software Asset Management from the dashboard list. Click an element within a report to see more information, or add and move widgets as needed.

Results are updated daily, or whenever a new reconciliation result is available, and can be refreshed by clicking the Refresh icon for each result. You can also save charts in PNG or JPG formats.
The graphs show important statistics about the software being tracked. In the Overview and Optimization tabs, you can filter by publisher, product, department, and country to narrow the results.

**Overview**

The source for overview data is the Product Result (samp_product_result) table.
Overview tab

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total True-up Cost</td>
<td>Cost to be compliant based on the average prices in entitlements for the rights.</td>
</tr>
<tr>
<td>Publishers out of Compliance</td>
<td>Number of publishers that have at least one software model out of compliance. Click on the report to show the filtered list of records.</td>
</tr>
<tr>
<td>Products out of Compliance</td>
<td>Number of products that have at least one software model out of compliance. Click on the report to show the filtered list of records.</td>
</tr>
<tr>
<td>Potential Savings</td>
<td>Cost saved if removal candidates are reclaimed.</td>
</tr>
<tr>
<td>Top 10 Products by True-up Cost</td>
<td>Top 10 products graphed in order of true-up cost.</td>
</tr>
<tr>
<td>Top 10 Products by Potential Savings</td>
<td>Top 10 products graphed in order of potential savings.</td>
</tr>
</tbody>
</table>

Optimization

The source for optimization data is the Reclamation Candidate (samp_sw_reclamation_candidate) table.
Optimization tab

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reclamations Requiring Attention</td>
<td>State is Attention Required</td>
</tr>
<tr>
<td>Potential Savings</td>
<td>• Created on This Year OR Active is true OR Closed on This Year AND Opened on Last Year</td>
</tr>
<tr>
<td>Actual Savings YTD</td>
<td>Closed on This Year AND State is Closed Complete</td>
</tr>
<tr>
<td>All Active Reclamations by State</td>
<td>Active is true</td>
</tr>
<tr>
<td>Top 10 Active Reclamations Breakdown</td>
<td>Active is true</td>
</tr>
<tr>
<td>Actual Savings per Month</td>
<td>State is Closed Complete AND Closed in Last 12 Months</td>
</tr>
</tbody>
</table>

Removal candidate state color key:

<table>
<thead>
<tr>
<th>Color</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Attention Required</td>
</tr>
<tr>
<td>Green</td>
<td>Ready</td>
</tr>
<tr>
<td>Yellow</td>
<td>Awaiting Use</td>
</tr>
<tr>
<td>Orange</td>
<td>Awaiting Approval</td>
</tr>
<tr>
<td>Purple</td>
<td>Awaiting Revocation</td>
</tr>
<tr>
<td>Blue</td>
<td>Closed Complete</td>
</tr>
</tbody>
</table>

Compliance Analysis

Compliance analysis consists of time-series data using Performance Analytics to show the compliance trends over time. The for compliance analysis data is the Product Result (samp_product_result) table.
Compliance Analysis: True-up Cost

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>True-up Cost</td>
<td>Cost to be compliant based on the average prices for entitlements for the rights.</td>
</tr>
<tr>
<td>Publishers out of compliance</td>
<td>Number of publishers that have at least one software model out of compliance.</td>
</tr>
<tr>
<td>Products out of compliance</td>
<td>Number of products that have at least one software model out of compliance.</td>
</tr>
<tr>
<td>Potential savings</td>
<td>Cost saved if removal candidates are reclaimed.</td>
</tr>
<tr>
<td>Breakdowns</td>
<td>Shows the detailed list of results based on the widget selected.</td>
</tr>
<tr>
<td>Records</td>
<td>Shows the detailed list of product results based on the widget selected.</td>
</tr>
</tbody>
</table>

Compliance Analysis: Over-licensed amount

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Over-licensed amount</td>
<td>Cost of licenses owned but not being used.</td>
</tr>
<tr>
<td>Publishers over-licensed</td>
<td>Number of publishers that have at least one software right not being used.</td>
</tr>
<tr>
<td>Products over-licensed</td>
<td>Number of products that have at least one software right not being used.</td>
</tr>
<tr>
<td>Breakdowns</td>
<td>Shows the detailed list of results based on the widget selected.</td>
</tr>
<tr>
<td>Records</td>
<td>Shows the detailed list of product results based on the widget selected.</td>
</tr>
</tbody>
</table>

Normalization and Content Service dashboard

View normalization trend charts on the Normalization and Content Service dashboard integrated with Performance Analytics.

The Normalization and Content Service dashboard tab is accessed by navigating to Software Asset > Overview and selecting Normalization and Content Service from the dashboard list. You can also access it from the dashboard list of another Software Asset Management dashboard. Click an element within a report to see more information, or add and move widgets as needed.

Normalization chart results are updated daily when the SAM — Discovery Model Normalization job is run. You can save charts in PNG or JPG formats.
**Normalization and Content Service**

**Overall Normalization Rates for Licensable Software**
- Normalized
- Manually Normalized
- Partially Normalized

**Normalization Rate Breakdown for Top Publishers**
- Manually Normalized
- Normalized
- Partially Normalized

Central Data Service Download Status

<table>
<thead>
<tr>
<th>Name</th>
<th>Current count</th>
<th>Expected count</th>
<th>Last updated on</th>
<th>Next action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

No records to display

---

**Report** | **Source list** | **Description**
--- | --- | ---
Overall Normalization Rates for Licensable Software | Software Installs Normalization Rates | Overall normalization status count for all licensable products.
Normalization Rate Breakdown for Top Publishers | Software Install Normalization Rates for Top Publishers | Licensable normalization status count per top publisher for Microsoft, Oracle, IBM, VMware, Citrix, SAP, and Adobe.
Central Data Service Download Status related list

The Central Data Service Download Status related list is updated daily when the SAM — Central Data Service Download Status job is run.

<table>
<thead>
<tr>
<th>Name</th>
<th>Current count</th>
<th>Expected count</th>
<th>Last updated on</th>
<th>Next action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software publisher</td>
<td>10,496</td>
<td>11,737</td>
<td>2018-09-28 18:54:03</td>
<td>2018-10-12 18:53:58</td>
</tr>
<tr>
<td>Software Product</td>
<td>4,925</td>
<td>6,315</td>
<td>2018-09-28 20:44:00</td>
<td>2018-10-12 20:43:58</td>
</tr>
<tr>
<td>Software Package</td>
<td>56</td>
<td>111</td>
<td>2018-09-28 19:59:00</td>
<td>2018-10-12 19:58:58</td>
</tr>
</tbody>
</table>

Field Description:

- **Name**: Table name from which content is pulled.
- **Current count**: Number of records in the table.
- **Expected count**: Expected number of records in the table.
- **Last updated on**: Last date and time the data was pulled.
- **Next action**: Next scheduled date and time to pull data.

Engineering License Overview dashboard

Monitor and gain insights into your engineering applications license position and usage by viewing product usage reports in the Engineering License Overview dashboard.

The Engineering License Overview dashboard displays reports on normalized products and publishers that belong to engineering applications such as AutoCAD, GIS.

Access the Engineering License Overview Dashboard by navigating to **Software Asset > Engineering License Overview**.

To narrow your results based on products or publishers across all tabs, use the filter in the left-hand corner of the dashboard. Only products and publishers that belong to engineering applications and are listed in the Engineering Application License (samp_eng_app_license) table appear in the filter. If no product or publisher is selected, the tabs display the cumulative data for all products and publishers that belong to engineering applications.
The **Overview**, **License Usage Summary**, and **Denial Summary** tabs are updated daily or whenever a new reconciliation result is available. You can save charts in PNG or JPG formats for viewing them locally and for sharing.
Overview tab

- Top Used Products
  - AutoCAD Architecture
  - ArcGIS 3D Analyst
  - Inventor Professional

- Top Active Users
  - James Vitozzo: 2 days
  - Pierre Salles: 3 days
  - Olga Hart: 4 days
  - Kasai Miyagi: 5 days

- Top Idle Users
  - Maryann Grose: 10 hours
  - Roman Sim: 11 hours
  - Corinne: 12 hours
  - Pierre Salles: 13 hours

- Top Denied Products
  - AutoCAD Architecture

- Product Usage by Location
  - World
This tab gives an overview of the high-level metrics of all engineering applications. You can filter the results in this tab by various date options.

**Note:** The Date filter is not applicable to **Current Spend** and **Potential Savings**.

### Overview tab

<table>
<thead>
<tr>
<th>Report</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
</table>
| Current Spend           | Product Result
  (samp_product_result) | Total cost of all entitlements for all products.                             |
| Potential Savings       | License Dashboard Inventory
  (license_dashboard_inventory) | Cost saved if licenses are not being utilized to their potential or are under-utilized. To optimize your costs, you can reallocate those licenses or return the licenses and save cost. |
| Top Used Products       | Engineering Application Usage
  (samp_eng_app_usage)   | Top products that are being currently used. The number of days and hours being used per product also appears. |
| Top Active Users        | Engineering Application Usage
  (samp_eng_app_usage)   | Top users who are currently using the product. The number of days and hours being used per user also appears. |
| Top Idle Users          | Engineering Application Usage
  (samp_eng_app_usage)   | Top users who have requested a license but are not using the license. The number of days and hours of inactivity per user also appears. |
| Top Denied Products     | Engineering Application Denial
  (samp_eng_app_denial)  | Top products that are denied to users as these products have reached their peak concurrent usage. |
| Top Denied Users        | Engineering Application Denial
  (samp_eng_app_denial)  | Top users that are denied licenses to products.                              |
| Product Usage by Location | Engineering Application Usage
  (samp_eng_app_usage)   | Based on the count of users using products by location.                    |
License Usage Summary tab

License Inventory

<table>
<thead>
<tr>
<th>Normalized product</th>
<th>License type</th>
<th>License server</th>
<th>Quantity</th>
<th>Start date</th>
<th>End date</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoCAD LT</td>
<td>Floating</td>
<td>LMS East</td>
<td>50</td>
<td>2023-01-20 07:00</td>
<td>2023-01-20 17:00</td>
</tr>
<tr>
<td>Inventor Professional</td>
<td>Network</td>
<td>LMS East</td>
<td>20</td>
<td>2023-01-20 07:00</td>
<td>2023-01-20 17:00</td>
</tr>
</tbody>
</table>

License Server Statistics

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Status</th>
<th>Last connection time</th>
</tr>
</thead>
<tbody>
<tr>
<td>LMS Central</td>
<td>Active</td>
<td>UP</td>
<td>2019-10-20 09:41:00</td>
</tr>
<tr>
<td>LMS East</td>
<td>FlexLM</td>
<td>UP</td>
<td>2019-10-20 09:41:00</td>
</tr>
<tr>
<td>LMS West</td>
<td>FlexLM</td>
<td>UP</td>
<td>2019-10-20 09:41:00</td>
</tr>
</tbody>
</table>
This tab lets you view data based on a license type (floating, network, or token). You can filter the data in this tab by date, license type, and license management server.

### License Usage Summary tab

<table>
<thead>
<tr>
<th>Report</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Usage overtime</td>
<td>Engineering Application License (samp_eng_app_license)</td>
<td>The total number or quantity of all available licenses; not just the active products but all the products.</td>
</tr>
<tr>
<td></td>
<td>Engineering Application Concurrent Usage (samp_eng_app_concurrent_usage)</td>
<td>The blue line represents the total number of licenses allocated to a product or a publisher.</td>
</tr>
<tr>
<td></td>
<td>Engineering Application Denial (samp_eng_app_denial)</td>
<td>The green line indicates the concurrent usage of the licenses.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The red line indicates denials or if and when the concurrent usage peaks.</td>
</tr>
<tr>
<td>License Inventory</td>
<td>Engineering Application License (samp_eng_app_license)</td>
<td>All available licenses for a product or publisher.</td>
</tr>
<tr>
<td>License Server Statistics</td>
<td>Engineering Application License Server (samp_end_app_license_server)</td>
<td>All the license management servers that OpenLM connects with.</td>
</tr>
</tbody>
</table>
Denials Summary tab

Publisher ▼ Select elements ▼

Overview | License Usage Summary | Denials Summary

Denials Over Time

Date
Last 30 days ▼

User
All ▼

License Server
All ▼

Denials by Product

Products
ArcGIS Engine
ArcGIS Engine v.5 (31.22%)

Denials by License Server

License Server
LIS West
LIS Central
You can filter the data in this tab by date, user, or user group.

**Denials Summary tab**

<table>
<thead>
<tr>
<th>Report</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Denials Over Time</td>
<td>Engineering Application Denial (samp_eng_app_denial)</td>
<td>Denials for a product over a period of time.</td>
</tr>
<tr>
<td>Denials by Product</td>
<td>Engineering Application Denial (samp_eng_app_denial)</td>
<td>The products that have been denied to users the most.</td>
</tr>
<tr>
<td>Denials by License Server</td>
<td>Engineering Application Denial (samp_eng_app_denial)</td>
<td>The license servers that have been denied licenses to products the most.</td>
</tr>
</tbody>
</table>

**Supported software publisher licenses**

With Software Asset Management, there are several publisher packs that can be used to extend functionality between the Now Platform and your third-party software applications.

These Software Asset Management publisher pack plugins can be requested from ServiceNow personnel for activation. See [Request Software Asset Management](#).

- Adobe
- Citrix
- IBM
- Microsoft
- Oracle
- SAP
- VMware

Each publisher has a set of *license metrics* specific to that metric group. License metrics are set in software entitlements and are used for reconciliation (metric group, license metric, and software model combination).

**Publisher pack plugins**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Asset Management Professional for Adobe (com.sn_samp_adobe)</td>
<td>Provides additional capabilities to reconcile Adobe subscription software.</td>
</tr>
<tr>
<td>Software Asset Management Professional for Citrix (com.sn_samp_citrix)</td>
<td>Provides additional capabilities to reconcile Citrix software, such as XenApp, Xen Server.</td>
</tr>
<tr>
<td>Software Asset Management Professional for IBM (com.sn_samp_ibm)</td>
<td>Provides additional capabilities to reconcile IBM products using PVU and RVU license metrics.</td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Software Asset Management Professional for Microsoft (com.snc.samp.microsoft)</td>
<td>Provides additional capabilities to reconcile Microsoft software, such as Microsoft SQL Server.</td>
</tr>
<tr>
<td>Software Asset Management Professional for Oracle (com.snc.samp.oracle)</td>
<td>Provides additional capabilities to reconcile Oracle software, such as Oracle DB Server.</td>
</tr>
<tr>
<td>Software Asset Management Professional for SAP (com.sn_samp_sap)</td>
<td>Provides additional capabilities to reconcile SAP named user compliance and optimization.</td>
</tr>
<tr>
<td>Software Asset Management Professional for VMware (com.sn_samp_vmware)</td>
<td>Provides additional capabilities to reconcile VMware software, such as vCenter and vSphere.</td>
</tr>
</tbody>
</table>

**Publisher pack dashboards**

View compliance analysis results for the following publishers on the Software Publisher Analytics dashboards.

- Adobe
- Citrix
- IBM
- Microsoft
- Oracle
- SAP
- VMware

**Note:** You must have one of the publisher pack add-ons (other than Adobe) activated to see the Software Publisher Overviews dashboard navigation module. In addition, the corresponding publisher pack must be activated to see the compliance analysis results tab for that publisher.

View compliance analysis results for Microsoft Office 365 and Adobe Cloud on the Office 365 and Adobe dashboard.

**Note:** The Software Asset Management Professional for Adobe publisher pack add-on must be activated to see the Office 365 and Adobe Cloud dashboard.

**Software Asset Management publisher pack for Adobe**

Use the Software Asset Management publisher pack for Adobe to track compliance using Adobe-specific licensing metrics and integrate with Adobe Cloud.
Adobe licensing options

The Adobe publisher pack (com.sn_samp_adobe) adds Adobe-specific licensing options for software entitlements.

<table>
<thead>
<tr>
<th>Field</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agreement type</td>
<td>• Generic&lt;br&gt;• Enterprise Term License Agreement (ETLA)&lt;br&gt;• Cumulative Licensing Program (CLP)&lt;br&gt;• Transactional Licensing Program (TLP)&lt;br&gt;• Value Incentive Plan (VIP)</td>
</tr>
<tr>
<td>License Metric</td>
<td>• Per Device&lt;br&gt;• Per User&lt;br&gt;• User Subscription</td>
</tr>
</tbody>
</table>

To use the Adobe-specific licensing options, select the Adobe metric group for the software entitlement.

Adobe Cloud integration

Create an Adobe Cloud integration profile to compare subscriptions with software installations for compliance reporting.

Note: Installation discovery sources include ServiceNow Discovery, Microsoft SCCM, and other third-party discovery sources that can integrate as a data source in the ServiceNow CMDB.

For instructions on how to create an Adobe Cloud integration profile, see Create an Adobe Cloud integration profile.

Adobe Cloud reporting

Adobe Cloud reports can be accessed by navigating to Reports > View/Run and searching all reports for Adobe.

- Adobe Cloud Users without Installations
- Underused Adobe Cloud Installations

You can view Adobe subscriptions, compliance, and cost on the Office 365 & Adobe Cloud dashboard.

Create an Adobe Cloud integration profile

Create an Adobe Cloud integration profile to download subscription information for compliance.

Role required: admin

You can integrate with the following Adobe Cloud services.
Integrate Adobe subscriptions with Software Asset Management for compliance reporting using Adobe I/O Authentication.

For Adobe integration, you need a valid digital signing certificate. You can either create a self-signed certificate manually, or purchase one from a Certificate Authority. If you specify an alias for the certificate, the alias must be 1. Certificates consist of two keys:

- Public key (CRT, CER, DER, or PEM format)
- Private key (PFX format)

The public key is used in the Adobe Console to obtain client credentials, and the private key is used for Software Asset Management integration in your ServiceNow instance. If the public key is not in PEM format, it must be converted to PEM format before use, and the private key must be converted to PKS format before use.

For more information about Adobe I/O Authentication integration and certificates, see Adobe I/O Authentication Overview. This integration uses the steps for Service Account Integration (JWT authentication flow).

1. Navigate to Adobe I/O Service Account Integration and follow steps 1 - 3.

   **Note:** For the Adobe service you wish to integrate with, select User Management API.

   You receive Client Id, Technical account Id, and Organization Id values. Click Retrieve Client Secret to retrieve the Client secret value.

2. Convert your private key from KEY format to PKS format using the openssl command.

   The private key must be in PKS format to create a ServiceNow X.509 certificate.

   ```
   openssl req -x509 -nodes -days 365 -key private.key -new -out test1-cert.crt
   openssl pkcs12 -export -out test1-certificate.pfx -inkey private.key -in test1-cert.crt
   ```

   This step requires you to create a password. Use this password as the Key store password and Certificate password when creating the ServiceNow certificate and integration profile in the next steps.

   **Note:** The password must be at least six characters.

3. Create and validate a ServiceNow X.509 certificate using the private key.
   a) In your ServiceNow instance, navigate to System Definition > Certificates.
   b) Click New.
   c) On the form, fill in the fields.
d) Attach the private key (PKS file) using the paper clip icon in the X.509 Certificate form title bar.

e) Click the Validate Stores/Certificates related link.

f) Click Update.

   a) Navigate to SaaS License > Administration > Create New Profile and select Adobe Cloud Integration Profile.
   b) On the form, fill in the fields.

```
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Create a unique name for the Adobe integration profile.</td>
</tr>
<tr>
<td>Client Id</td>
<td>Adobe Client ID key obtained when you registered your application using the Adobe I/O console.</td>
</tr>
<tr>
<td>Client secret</td>
<td>Adobe Client secret key obtained when you registered your application using the Adobe I/O console.</td>
</tr>
<tr>
<td>Organization Id</td>
<td>Adobe Organization ID key obtained when you registered your application using the Adobe I/O console.</td>
</tr>
<tr>
<td>Technical account Id</td>
<td>Adobe Technical Account ID key obtained when you registered your application using the Adobe I/O console.</td>
</tr>
<tr>
<td>Certificate</td>
<td>X.509 certificate you created.</td>
</tr>
</tbody>
</table>
```
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate password</td>
<td>Private key certificate password you created in the conversion from KEY format to PKS format.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
6. Click the **Validate Adobe Credential** related link to complete the connection.

When the user subscription scheduled job runs, Adobe subscription data is pulled into Software Asset Management. View the subscription data by navigating to SaaS License > All User Subscriptions. You can check the status of the user subscription job by navigating to Software Asset > Administration > Job Results.

You can also view Adobe subscriptions, compliance, and cost on the **Office 365 & Adobe Cloud dashboard**.

**Office 365 & Adobe Cloud dashboard**

View compliance analysis results related to Microsoft Office 365 and Adobe Cloud License Management.

Access the dashboard by navigating to Software Asset > Office 365 & Adobe Cloud.

You can filter by **Subscription Software Models** or **Subscription Publisher** using filter lists.

**Note:** The Subscription Publisher filter list always includes Microsoft and Adobe even when only one subscription publisher pack is active.

The dashboard is updated whenever a new reconciliation result is available. You can save charts in PNG or JPG format.

**Adobe**

You can manage Adobe subscription information with Adobe I/O authentication integration.

**Note:** The add-on Adobe publisher pack (com.sn_samp_adobe) plugin must be installed to view Adobe subscription reporting.

Only Adobe software products that are recognized as subscription software are shown. Adobe integration must be set up to view compliance information.

- List of Active Subscriptions with no Active Adobe Software installs
  - If a user has an active subscription but does not have any respective Adobe suite of products deployed.
  - User Name | Email ID | Subscription Name | List of devices assigned to users
- Optimization of Adobe install using SCCM metering data
  - If user is underutilizing Adobe subscriptions
  - User Name | Email ID | Subscription Name | Subscription Cost | List of devices assigned to users | List of Adobe suite of products | Last Access Time
SaaS subscription reports

Number of Assigned Subscriptions: 1,025
Percentage of Unused Subscriptions: 13%
Total Number of Purchased Subscriptions: 1,105
Current Subscription Spend: $662,73k

Software Models Out of Compliance:
7

True-up Cost:
$25,22k

Assigned Subscription Breakdown:
- Adobe Systems Creative Cloud: 380
- Microsoft Office 365 Enterprise E3: 367
- Adobe Systems Illustrator CC: 25
- Adobe Systems Photoshop CC: 21

Available Subscription Breakdown:
- Adobe Systems Creative Cloud: 460
- Microsoft Office 365 Enterprise E5: 338
- Adobe Systems Acrobat DC Professional: 20

Subscription Spend Breakdown:
- Adobe Systems Creative Cloud: $140,006
- Microsoft Office 365 Enterprise E3: $120,886
- Microsoft Office 365 Enterprise E5: $63,099
Software Asset Management publisher pack for Citrix

Use the Citrix publisher pack for optimization and reconciliation of Citrix products. Track licensing positions for Citrix users and devices to determine license compliance.

To use the Citrix publisher pack, activate the Software Asset Management Professional for Citrix (com.sn_samp_citrix) plugin.

The Citrix publisher pack supports Virtual Applications (formerly XenApp) and Virtual Desktop (formerly XenDesktop) products.

A discovery process is required for Citrix data to be collected. For ServiceNow Discovery, a user with the admin role must create a Discovery schedule to run on the Citrix Delivery Controller for communication with the Citrix License Server.

Discovery identifies applications deployed in your Citrix farm from the Citrix Delivery Controller using OData APIs.

See Citrix License Server and Delivery Controller discovery for discovery pattern and tables.

Citrix licensing models

The Citrix publisher pack supports both types of Citrix licensing models: concurrent and User/Device.

Concurrent licenses are licenses that are only used during an active session. If the session is disconnected or ends, the license can be consumed by another user or device. Concurrent licenses only allow either one connection to a virtual desktop or unlimited applications for any user and any device. License consumption is based on how many licenses are being used.
User/Device licenses are assigned to either a user or a shared device. If the license is assigned to the user, that user has unlimited connections from unlimited devices. If the license is assigned to a device, unlimited users and unlimited connections can be made from that single device. License consumption for User/Device licenses is based on the user or device using the license.

View your license usage with the Software Publisher Analytics dashboard for Citrix. Based on this information, reclaim any unused or unauthorized licenses to optimize your licensing position.

**Note:** Software products deployed in virtualized Citrix environments are licensed based on potential access and not based on actual usage. Any user or device with the potential to access the product consumes a software license. Potential access is determined by discovering the user to delivery group mapping from the Citrix delivery controller.

**Record software rights for Citrix**

Software entitlements enable you to define license details that are matched to software models. You can add an entitlement individually or import a list from a spreadsheet.

Role required: sam_user or sam_admin

The sam_admin role is required to import entitlements.

Before you can create a software entitlement, create a software model.

Manage available software and tie software installations (software being used) with entitlements (software owned) using software models. Create software models for all software to be monitored.

**Note:** Users with the model_manager role can navigate to Product Catalog > Product Model > Software Models but cannot administer all aspects of software models.

1. Navigate to Software Asset > Licensing > Software Entitlements and create a new record (see table for field descriptions).

For a detailed description of the fields related to all entitlements, see Record software rights and user allocations.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Metric</td>
<td>License metric for the license group that the software license is counted against when reconciliation is run. For detailed of the license metrics, see Software license metrics.</td>
</tr>
</tbody>
</table>

2. To set upgrade or downgrade entitlements, select the new software entitlement record from the Software Entitlements list.

For a detailed description on how to complete additional configurations for software entitlements, see Record software rights and user allocations.

3. Click Submit.

Your entitlement is added to the software entitlements list.

Run software reconciliation on your licenses.

**Software Publisher Analytics dashboard for Citrix**

View compliance analysis results for Citrix on the Software Publisher Analytics dashboard.
Access the Software Publisher Analytics dashboard by navigating to **Software Asset > Publisher Overview**.

**Note:** The add-on Citrix publisher pack (com.sn_samp_citrix) plugin must be installed to view the Citrix dashboard tab.

A discovery process is required for Citrix data to be collected. For ServiceNow Discovery, a user with the admin role must create a **Discovery schedule** to run on the Citrix Delivery Controller for communication with the Citrix License Server.

The dashboard is updated whenever a new reconciliation result is available. You can save charts in PNG or JPG format.
## Citrix Tab

<table>
<thead>
<tr>
<th>Report</th>
<th>Source list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>True-up Cost</td>
<td>Product Results</td>
<td>Cost to be compliant based on the average prices for entitlements for the rights.</td>
</tr>
<tr>
<td>Products out of Compliance</td>
<td>Product Results</td>
<td>Number of products that have at least one software model out of compliance. Click the report to view the results in the License Workbench.</td>
</tr>
<tr>
<td>Over-Licensed Amount</td>
<td>Product Results</td>
<td>Cost of licenses owned but not being used.</td>
</tr>
<tr>
<td>User Access to Products in Citrix Farm</td>
<td>Software</td>
<td>Number of users with access to the Citrix farms.</td>
</tr>
<tr>
<td>End of Life Products</td>
<td>Software Model Lifecycles</td>
<td>Heat map of software model lifecycles, including those lifecycles about to change to the next phase.</td>
</tr>
<tr>
<td>User/Device Rights vs Usage Software Installs in Citrix Farm</td>
<td>Software Installations</td>
<td>Number of User/Device rights owned versus the number of rights being consumed.</td>
</tr>
<tr>
<td>Concurrent License Consumption Trend</td>
<td>Concurrent License Consumption</td>
<td>Current license consumption trend for each day. Each data point denotes the maximum in-use count per day.</td>
</tr>
</tbody>
</table>

### Software Asset Management publisher pack for IBM

Use the IBM License Metric Tool (ILMT) and BigFix Inventory integration to create a connection between your IBM servers and the Now Platform. Create entitlements and software models and determine your license compliance by tracking your IBM products and components.

To use the IBM publisher pack, activate the Software Asset Management Professional for IBM (com.sn_samp_ibm) plugin.

Use ServiceNow Discovery to find software installs in your environment and import the data into your instance. For more information, see Data collected by ITOM Visibility.

Integrate one or more IBM servers with Software Asset Management using HTTP or HTTPS.

Upon plugin activation, an IBM Server connection alias is provided to set up IBM server connections. After the connection is successful, historical data is retrieved for the aggregated period set up in ILMT and BigFix Inventory. This data includes products, components, editions, hosts, virtual machines, and license usage.

**Note:** License usage is based on the product use and not component use.
You can automate reconciliation of IBM products, including complex server licensing scenarios, using IBM publisher pack. Integration with IBM BigFix Inventory discovery application measures subcapacity and full-capacity license compliance for PVU and RVU license metrics.

Set up the IBM License Metric Tool and BigFix Inventory integration for HTTPS

Set up IBM License Metric Tool (ILMT) and BigFix Inventory integration for IBM compliance reporting.

If you're using an HTTPS connection, you can use any of the following connection types:

- HTTPS with the MID Server
- HTTPS without the MID Server

**HTTPS with the MID Server**

Set up IBM License Metric Tool (ILMT) and BigFix Inventory integration for IBM compliance reporting using an HTTPS connection with the MID Server.

Role required: sys_admin

1. Download the certificate by logging in to the ILMT or BigFix Inventory server and navigating to Management > Server Settings.
2. Import a certificate for the MID Server.

After you've finished uploading your certificates, create a connection to ILMT/BigFix Inventory.

**HTTPS without the MID Server**

Set up IBM License Metric Tool (ILMT) and BigFix Inventory integration for IBM compliance reporting using an HTTPS connection without the MID Server.

Role required: sys_admin

**Note:** The firewall port must be opened for connectivity to your ServiceNow instance IP address.

1. Download the certificate by logging in to the ILMT or BigFix Inventory server and navigating to Management > Server Settings.
2. From your ServiceNow instance, navigate to System Definition > Certificates and create a certificate (Trust Store Cert, PEM format).
3. Paste the full downloaded ILMT or BigFix Inventory server certificate content into the PEM Certificate field (including banners).
4. Click the Validate Stores/Certificates related link.
5. To create the Java Key Store file using the IBM certificate file, open the command prompt on your computer and navigate to the folder that contains the JRE keytool.
6. Execute the following commands:

   ```
   keytool -import -trustcacerts -alias <Certificate alias> -file <Certificate file path> -keystore IBM_Server.keystore -storetype jks
   keytool -list -v -keystore IBM_Server.keystore
   ```

   These commands generate the IBM_Server.keystore file.
7. Return to the Now Platform, navigate to System Definition > Certificates and create a certificate (Java Key Store).
8. Upload the IBM_Server.keystore file that you generated as an attachment to the certificate record.
9. Click the Validate Stores/Certificates related link.
10. Navigate to **System Security > Protocol Profiles** and create a new protocol profile using the Java Key Store certificate that you created.

> **Note:** You need to select the protocol profile that you create when you create a connection to ILMT/BigFix Inventory.

After you’ve finished uploading your certificates, **create a connection to ILMT/BigFix Inventory.**

### Create a connection to ILMT/BigFix Inventory

If you’re using an HTTP connection or you’ve finished the initial configuration for HTTPS, establish a connection in the Now Platform.

Role required: sys_admin

> **Note:** If you’re using an HTTP or HTTPS connection without the MID Server, the firewall port must be opened for connectivity to your ServiceNow instance IP address.

1. Navigate to **Integration — ILMT / BigFix Inventory > Setup.**
2. In the **Connections** related tab, click **New** to create an HTTP or HTTPS connection record.
3. Fill in the form, as needed.

#### HTTP(s) Connection form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the connection.</td>
</tr>
<tr>
<td>Credential</td>
<td>Credentials used to establish the connection. These credentials can be either basic auth credentials or API key credentials.</td>
</tr>
<tr>
<td>Connection alias</td>
<td>Connection alias value with which the connection can be referred.</td>
</tr>
<tr>
<td></td>
<td>A connection alias resolves your connection and credential at runtime.</td>
</tr>
<tr>
<td></td>
<td>Use the IBMServers predefined alias.</td>
</tr>
<tr>
<td>Active</td>
<td>Option indicating that the connection is active.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain to which the connection belongs.</td>
</tr>
<tr>
<td>URL builder</td>
<td>Option indicating that the URL builder is used to build the connection string.</td>
</tr>
<tr>
<td></td>
<td>Use the URL builder, where the host and port are specified separately.</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Connection URL (if not using the URL builder).</td>
</tr>
<tr>
<td>Mutual authentication</td>
<td>Option indicating that mutual authentication is used.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Underlying protocol used by the connection.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use MID Server</td>
<td>Option indicating that the connection uses a MID Server. When you enable this option, the <strong>Advanced MID Server Configuration</strong> tab appears, where you can configure MID Server selection based on MID Server capabilities or applications. Use the URL builder, where the host and port are specified separately.</td>
</tr>
<tr>
<td>Host</td>
<td>Target host used by the connection. Enter the host IP address for IBM License Metric Tool (ILMT) or BigFix Inventory setup.</td>
</tr>
<tr>
<td>Override default port</td>
<td>Target port used by the connection. Enter the port number for ILMT or BigFix Inventory setup.</td>
</tr>
<tr>
<td>Base path</td>
<td>Base path for the connection.</td>
</tr>
<tr>
<td>Attributes</td>
<td></td>
</tr>
<tr>
<td>Source</td>
<td>Source of the server:</td>
</tr>
<tr>
<td></td>
<td>- ILMT</td>
</tr>
<tr>
<td></td>
<td>- BigFix Inventory</td>
</tr>
<tr>
<td>Computer system offset</td>
<td>Computer system offset based on the connection established. This field is populated automatically.</td>
</tr>
<tr>
<td>License usage peak date</td>
<td>Latest license usage peak date based on the connection established.</td>
</tr>
<tr>
<td>IBM Server Version</td>
<td>IBM server version based on the connection established. This field is populated automatically.</td>
</tr>
<tr>
<td>API Version</td>
<td>Version of the source based on the connection established. This field is populated automatically.</td>
</tr>
<tr>
<td>IBM Server checksum</td>
<td>IBM server checksum based on the connection established. This field is populated automatically.</td>
</tr>
<tr>
<td>Advanced MID Server Configuration</td>
<td></td>
</tr>
<tr>
<td>Capabilities</td>
<td>MID Server capability that an application requires. Applications can use capabilities to select an appropriate MID Server. See <strong>MID Server selection</strong> for more information on MID Server capabilities.</td>
</tr>
<tr>
<td>MID Application</td>
<td>Application that you designate for a specific MID Server. See <strong>MID Server selection</strong> for more information on MID Server applications.</td>
</tr>
</tbody>
</table>

4. **Click Submit.**

The active connection information displays.
5. To import ILMT or BigFix Inventory scheduled data, navigate to Integration - ILMT / BigFix Inventory > Scheduled Import and then click Execute Now.

6. Verify that the import has completed successfully.
   a) Navigate to Integration - ILMT / BigFix Inventory > Transform History to verify that both the import and transformation have completed successfully.
   
   **Note:** Every record in the Transform Histories table displays an Inserts value of 0.

   b) Navigate to Integration - ILMT / BigFix Inventory > Import Set Data > Computers to view all data imported into the Computer (cmdb_ci_computer) table.

   c) Navigate to Integration - ILMT / BigFix Inventory > Import Set Data > License Consumption to view all data imported into the License Consumption (samp_ilmt_sw_install) table.

**ILMT and BigFix Inventory transform maps**

When you import data from the ILMT or BigFix Inventory, your ServiceNow instance uses transform maps to process this data into ServiceNow tables.

**Default ILMT and BigFix Inventory transform maps**

By default, ServiceNow provides the following transform maps for ILMT and BigFix Inventory data:
## Default ILMT and BigFix Inventory transform maps

<table>
<thead>
<tr>
<th>Transform Map</th>
<th>Source Table</th>
<th>Target Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ILMT Computer Identity V1</td>
<td>Computer (imp_samp_ilmt_computer)</td>
<td>Computer (cmdb_ci_computer)</td>
<td>Processes identification data for your virtual machines (VMs) and hosts. The ILMT Computer Identity V1 transform map uses the CMDB IRE API to create a configuration item (CI) record for each VM or host in the Computer (cmdb_ci_computer) table. If a VM uses the same hardware serial number as its host, the transform map creates a CI record for only the host. For more information on the CMDB IRE API, see Identification and Reconciliation engine (IRE).</td>
</tr>
</tbody>
</table>

**Note:** ServiceNow does not support hardware serial numbers containing periods (.).
<table>
<thead>
<tr>
<th>Transform Map</th>
<th>Source Table</th>
<th>Target Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ILMT Software Instance</td>
<td>ILMT Software Instance (imp_samp_ilmt_sw_instance)</td>
<td>Global (global)</td>
<td>Processes installation data for each IBM software component and product on your VMs and hosts. Software components are the independent units of software that you install or run on a VM. You can identify but not license software components individually. Software products are the units of software packaging on a host that can comprise of a collection of software components. You can license the software product as a whole. For more information on software components and products, refer to the IBM Knowledge Center. The ILMT Software Instance transform map creates a record for each IBM software component and product installation in the IBM Peak Consumption (samp_ilmt_sw_install) table. Note: Although software products are not actual software installations, the transform map treats them as installations so that you can update and track license usage against each software product for reconciliation.</td>
</tr>
</tbody>
</table>
### ILMT and BigFix Inventory data processing

Each ILMT and BigFix Inventory transform map processes data using field maps or transform map scripts.

#### ILMT Computer Identity V1 transform map

The ILMT Computer Identity V1 transform map processes data from the source Computer (imp_samp_ilmt_computer_system) table to the target Computer (cmdb_ci_computer) table using both field maps and a transform map script.

By default, the ILMT Computer Identity V1 transform map includes the following field maps:

<table>
<thead>
<tr>
<th>Source Field</th>
<th>Target Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>u_ip_address</td>
<td>ip_address</td>
<td>IP address of the host or virtual machine.</td>
</tr>
<tr>
<td>u_dns_name</td>
<td>dns_domain</td>
<td>Domain name of the host or virtual machine.</td>
</tr>
<tr>
<td>u_server_processors</td>
<td>cpu_count</td>
<td>Number of CPUs or virtual CPUs (vCPUs) on the host or virtual machine.</td>
</tr>
<tr>
<td>u_host_name</td>
<td>name</td>
<td>Name of the host or virtual machine.</td>
</tr>
</tbody>
</table>
In addition to using field maps, the transform map processes data using the onAfter transform map script, which is an event script that processes at the end of each row transformation. For more information on this transform map script, see Map with transformation event scripts.

### ILMT Software Instance transform map

The ILMT Software Instance transform map processes data from the source ILMT Software Instance (imp_samp_ilmt_sw_instance) table to the target IBM Peak Consumption (samp_ilmt_sw_install) table using the onComplete transform map script. The onComplete transform map script is an event script that processes at the end of an import. For more information on this transform map script, see Map with transformation event scripts.

### ILMT Software License Usage transform map

The ILMT Software License Usage transform map processes data from the source License Consumption (imp_samp_ilmt_license_usage) table to the target IBM Peak Consumption (samp_ilmt_sw_install) table using the onStart transform map script. The onStart transform map script is an event script that processes at the beginning of an import. For more information on this transform map script, see Map with transformation event scripts.

### Software Publisher Analytics dashboard for IBM

View compliance analysis results related to IBM on the Software Publisher Analytics dashboard. Access the Software Publisher Analytics dashboard by navigating to Software Asset > Publisher Overview.

**Note:** The add-on IBM publisher pack (com.sn_samp_ibm) plugin must be installed to view the IBM dashboard tab.  
IBM License Metric Tool (ILMT) integration must be set up to view compliance information.

Results are updated whenever a new reconciliation result is available. You can save charts in PNG or JPG format.
IBM dashboard

You can manage IBM software using the IBM publisher pack.
IBM tab

<table>
<thead>
<tr>
<th>Report</th>
<th>Source list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Products out of Compliance</td>
<td>Product Results</td>
<td>Number of products that have at least one software model out of compliance. Click the report to view the results in the License Workbench.</td>
</tr>
<tr>
<td>True-up Cost</td>
<td>Product Results</td>
<td>Cost to be compliant based on the average prices for entitlements for the rights.</td>
</tr>
<tr>
<td>% of Total Excess Spend Not In Use</td>
<td>Software Entitlements</td>
<td>Sum of the over-licensed amount over the total of licensed amount.</td>
</tr>
<tr>
<td>PVU Subcapacity Consumption Trend</td>
<td>IBM Peak Consumption</td>
<td>Comparison of the aggregate peak consumption for all products over time.</td>
</tr>
<tr>
<td>End of Life Products</td>
<td>Software Model Lifecycles</td>
<td>Heat map of software model lifecycles, including those lifecycles about to change to the next phase.</td>
</tr>
<tr>
<td>PVU Subcapacity Breakdown of Top 10 Products</td>
<td>IBM Peak Consumption</td>
<td>Peak PVU utilization for the top 10 IBM products.</td>
</tr>
</tbody>
</table>

Software Asset Management publisher pack for Microsoft

Use the Software Asset Management publisher pack for Microsoft to track your license compliance position using Microsoft-specific licensing metrics.

Note: To use the publisher pack, activate the Software Asset Management Professional for Microsoft plugin (com.snc.samp.microsoft).

Microsoft offers a wide variety of products that span from database servers to subscription services. Each Microsoft product follows its own licensing model, which can make it hard to track your license compliance position. With the Software Asset Management publisher pack for Microsoft, you can accurately track your license compliance position for Microsoft products. Reconciliation identifies licenses that are out of compliance and provides a list of remediation options. For more information, see Software reconciliation for compliance.

To learn more about Microsoft licensing models, see Microsoft licensing.

Set up ServiceNow Discovery to identify Microsoft installations on your network. For more information, see Data collected by ITOM Visibility.

The Software Asset Management publisher pack for Microsoft supports the following licensing models.

- Per user
- Per device
- Per core
- Per core (with CAL)
- User CAL
- Device CAL
- Server (per instance)
- Server (per server)
- Per processor
- User subscription
- Software Assurance

For more information, see *Supported Microsoft license types*.

**Microsoft Office 365 integration**

Create an integration with Microsoft Office 365 to download subscription information that is compared with software installations for compliance.

Software subscription integration with Software Asset Management includes profiles available for Microsoft Office 365.

Microsoft Office 365 software products are automatically recognized as subscription software: Office 365, Project Online, Visio Pro for Office 365, Exchange Online, SharePoint Online, Skype for Business Online, OneDrive Online, Yammer, Secure Productive Enterprise, Enterprise Mobility + Security, Microsoft Dynamics 365 Services, and Bing Maps.

Content related to software subscriptions is accessed from the **SaaS License** application menu.

- **Office 365 & Adobe Cloud** shows the **Office 365 & Adobe Cloud dashboard**.
- **Software Models** lists software model records for subscription products.
- **All User Subscriptions** lists all subscription records for subscription products (also accessible through the **Software Asset > Discovery > Software Subscriptions** navigation menu).
- **Create New Profile** creates a new Microsoft Office 365 subscription profile.
- **All Integration Profiles** lists Microsoft Office subscription profile records.

A scheduled job to obtain subscription information from Software Asset Management runs once a week.

To setup Microsoft Office 365 subscription compliance reporting on the Microsoft Office 365 & Adobe Cloud dashboard, set up MicrosoftOffice 365 with Software Asset Management.

**Note:** The add-on Microsoft Office 365 content pack (com.snc.samp.microsoft) **plugin** must be installed to view Microsoft Office 365 compliance reporting on the Microsoft Office 365 & Adobe Cloud dashboard.

**Software Subscriptions form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Combination of publisher, product, version, and edition.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the product.</td>
</tr>
<tr>
<td>Product</td>
<td>Product name.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the product.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software model</td>
<td>Software model for the product.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When software subscriptions are imported, if a software model for the version and edition of the product does not exist, it is created.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user of the software.</td>
</tr>
<tr>
<td>User principal name</td>
<td>Email address of the user.</td>
</tr>
<tr>
<td>Last activity</td>
<td>Date the software was last used.</td>
</tr>
</tbody>
</table>

The Computers related list contains the list of devices for the subscription.

*Create a Microsoft Office 365 integration profile*

Create a Microsoft Office 365 integration profile to download subscription information for compliance.

**Role required:** admin

1. Register an application in the Microsoft Azure portal.
   a) Navigate to *Microsoft Azure App Registrations* and log in using an admin account.
   b) Click *+ New registration* and add the name of the application.
   c) Under Supported account types, select *Accounts in any organizational directory*.
   d) Click *Register*.
   e) Open the application that you registered to obtain the Application (client) ID and the Application (tenant) ID in the Overview section.
   f) In the Certificates and Secrets section, create a new client secret.
   g) Copy and save the client secret. You will use it in your ServiceNow instance.
   h) In the API permissions section, click *+ Add a permission* and select *APIs my organization uses*.
   i) Select *Microsoft Graph*, add Application Permissions *Reports.Read.All* and *User.Read.All*.
   j) In the Grant consent section, click *Grant admin consent*.

2. Return to your ServiceNow instance and create an integration profile.
   a) Navigate to *SaaS License > Administration > Create New Profile* and select *Office 365 Integration Profile*.
   b) On the form, fill in the fields.
### Office 365 Integration Profile form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Create a unique name for the integration profile. For example, Office 365 integration for (your company).</td>
</tr>
<tr>
<td>Client Id</td>
<td>Office 365 application ID you obtained when you registered your application in the Microsoft Azure portal.</td>
</tr>
<tr>
<td>OAuth application</td>
<td>OAuth application for the integration. This field is automatically populated when the integration profile is saved.</td>
</tr>
<tr>
<td>Tenant name or Id</td>
<td>Office 365 globally unique identifier (GUID) you obtained when you registered your application in the Microsoft Azure portal.</td>
</tr>
<tr>
<td>REST message</td>
<td>This field is automatically populated when the integration profile is saved.</td>
</tr>
</tbody>
</table>

- **c)** Click **Submit**.
- **d)** Open the **OAuth application** record from the integration profile form and update the **Client Secret** field with the client secret you received in the Microsoft Azure portal.
- **e)** Open the **REST message** record from the integration profile form. Click the **Get OAuth Token** related link and follow the steps to get an OAuth token.

When the user subscription scheduled job runs, Microsoft Office 365 subscription data is pulled into Software Asset Management. View the subscription data by navigating to **SaaS License > All User Subscriptions**. You can check the status of the user subscription job by navigating to **Software Asset > Administration > Job Results**.

You can also view Microsoft Office 365 subscriptions, compliance, and cost on the **Office 365 & Adobe Cloud dashboard**.

**Create a Microsoft Office 365 reserve entitlement**

Create a Microsoft Office 365 reserve entitlement to add licenses to your Microsoft Office 365 subscription. Pay for the new licenses during your true-up process.

**Role required:** sam_user or sam_admin

**Note:** You can only create a reserve entitlement from an existing Microsoft Office 365 entitlement. The existing entitlement must meet the following criteria.

- **License type** is Subscription.
- **Metric group** is Microsoft.
- **License Metric** is User Subscription.
- **Publisher** is Microsoft for the product on the software model.
1. Navigate to **Software Asset > Licensing > Software Entitlements** and click a Microsoft Office 365 entitlement.
2. Click the **Create Reserve Entitlement** related link.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start date</td>
<td>Start date for the new licenses.</td>
</tr>
<tr>
<td>End date</td>
<td>This field is automatically calculated as the soonest anniversary of the source entitlement end date.</td>
</tr>
<tr>
<td>Purchased rights</td>
<td>Number of new licenses.</td>
</tr>
<tr>
<td>Monthly unit cost</td>
<td>This field is automatically calculated as the unit cost of the source entitlement divided by the duration of the source entitlement (in months).</td>
</tr>
<tr>
<td>Software model</td>
<td>This field is automatically set as a reference to the software model for the existing entitlement.</td>
</tr>
<tr>
<td>Source entitlement</td>
<td>This field is automatically set as a reference to the existing entitlement used to create the reserve entitlement.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
   The new reserve entitlement is added to the Reserve Entitlements related list in the source entitlement. The state of the reserve entitlement is In use and the [Reserve entitlement] check box is selected.

Run reconciliation to include the new reserve entitlement in the true-up cost calculation.
Navigate to **Software Asset > Office 365 & Adobe Cloud** to view the Office 365 & Adobe Cloud dashboard. The cost of the reserve entitlement is included in True-up Cost and is not included in Current Subscription Spend.

When it’s past the end date of the reserve entitlement, the SAM - Subscription Maintenance scheduled job creates a new entitlement to replace it.

**Note:** The new entitlement is not added to the Reserve Entitlements related list in the original source entitlement.

**New entitlement record**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserve entitlement</td>
<td>Not selected</td>
</tr>
<tr>
<td>Start date</td>
<td>Date the new entitlement is created</td>
</tr>
<tr>
<td>End date</td>
<td>End date of the original source entitlement</td>
</tr>
<tr>
<td>Source entitlement</td>
<td>Reference to the original source entitlement</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Purchased rights</td>
<td>Same number of purchased rights as the reserve entitlement</td>
</tr>
<tr>
<td>Active rights</td>
<td>Same number of active rights as the reserve entitlement</td>
</tr>
<tr>
<td>Allocations available</td>
<td>Same number of allocations available as the reserve entitlement</td>
</tr>
<tr>
<td>State</td>
<td>In use</td>
</tr>
</tbody>
</table>

The state of the reserve entitlement changes to Retired. On the Office 365 & Adobe Cloud dashboard, the cost of the retired reserve entitlement is removed from True-up Cost. The cost of the new entitlement is included in Current Subscription Spend.

**Manage licenses for Microsoft Visual Studio**

Manage your Visual Studio subscriptions with the Software Asset Management publisher pack for Microsoft. Verify licensing compliance and detect unlicensed installations. Reduce licensing costs by identifying subscriptions that are allocated but are not being used.

Set up ServiceNow Discovery to find Microsoft software installations on your network. By using Discovery, you can view license compliance information by comparing your purchased licenses with actual installations.

Role required: sam_admin

Visual Studio subscriptions allow developers to download, install, configure, and use most Microsoft software products on any number of devices or virtual machines without having to purchase individual rights, as long as the software is deployed only in development or test environments. Use the Microsoft Publisher Pack to manage Visual Studio licensing and mitigate compliance risks.

First, set up software models and entitlements to track your Visual Studio subscriptions. Then, run reconciliation and view the License Workbench to manage license compliance.

For more information, see [White paper - Manage Licenses for Microsoft Visual Studio](#).

1. **Import software entitlements** for your Visual Studio subscriptions.

    **Important:** Fill in the Publisher part number column on the entitlement import template to automatically create software models for Visual Studio and all included software (suite components). You can look up publisher part numbers in the Software Product Definition table (samp_sw_product_definition). If you fill in the Publisher part number field, Publisher, Product, Version, Edition, Platform, and Language are not required because the publisher part number provides that information.

    When the import is complete, software models and entitlements are automatically created for your Visual Studio subscriptions. The Visual Studio software models are automatically populated with Suite Components and Downgrade Rights.

2. **Add software install conditions** on your Visual Studio software models.

    Install conditions define where the software can be installed. For Visual Studio, installing the software anywhere that is not a development or test environment is a violation of the Microsoft license agreement. Install conditions are used during reconciliation. When you run reconciliation, any Microsoft software installed on production, disaster recovery, or other
environments will not be covered by your Visual Studio licenses and will be considered unlicensed installations unless they are covered by another Microsoft license.

a) Navigate to **Software Asset > Licensing > Software Models** and click the Visual Studio software model that you want to update.

b) Add filter conditions to the **Software install condition field** to limit installations to your development or test environments.

For example, you could use the conditions `Installed on contains dev` or `Installed on contains test`.

c) Click **Update** to save your changes.

3. Add user allocations to your Visual Studio entitlements.

You can import user allocations using an import set and transform map. Import into the User Allocation table (`alm_entitlement_user`). In the transform map, map the **Assigned to** field to the User table (`sys_user`). Use the **Asset tag** field from the entitlement record to link the allocations to the correct entitlements. For the coalesce value, use a two-attribute coalesce on the entitlement and the user.

For additional information, see **Import sets**.

Run reconciliation to view your Visual Studio license compliance. Reconciliation runs weekly or on demand. Reconciliation compares your purchased Visual Studio rights recorded in software entitlements with actual installations found by Discovery. To view reconciliation results in a simplified workbench view, navigate to **Software Asset > Reconciliation > License Workbench**. For more information, see **Software reconciliation for compliance**.

**Microsoft dashboards**

View installations, cost, and compliance for Microsoft software such as SQL Server. View subscription use, cost, and compliance for Microsoft Office 365.

**Note:** The add-on Microsoft publisher pack (`com.snc.samp.microsoft`) plugin must be installed to view the dashboards.

Dashboards are updated whenever a new reconciliation result is available. You can save charts in PNG or JPG format.

**Software Publisher Analytics dashboard for Microsoft**

Access the Software Publisher Analytics dashboard for Microsoft by navigating to **Software Asset > Publisher Overview**.
## Microsoft tab

<table>
<thead>
<tr>
<th>Report</th>
<th>Source list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Products out of Compliance</td>
<td>Product Results</td>
<td>Number of products that have at least one software model out of compliance. Click the report to view the results in the License Workbench.</td>
</tr>
<tr>
<td>True-up Cost</td>
<td>Product Results</td>
<td>Cost to be compliant based on the average prices for entitlements for the rights.</td>
</tr>
<tr>
<td>Over-Licensed Amount</td>
<td>Product Results</td>
<td>Cost of licenses owned but not being used.</td>
</tr>
<tr>
<td>Reclamations Requiring Attention</td>
<td>Reclamation Candidates</td>
<td>State is Attention Required.</td>
</tr>
<tr>
<td>Potential Savings</td>
<td>Reclamation Candidates</td>
<td>Cost saved if removal candidates are reclaimed.</td>
</tr>
<tr>
<td>Actual Savings Year-to-date</td>
<td>Reclamation Candidates</td>
<td>Closed this Year and the State is set to Closed Complete.</td>
</tr>
<tr>
<td>Products by True-up Cost</td>
<td>Product Results</td>
<td>Greatest true-up costs by product.</td>
</tr>
<tr>
<td>Products by Potential Savings</td>
<td>Reclamation Candidates</td>
<td>Greatest potential savings by product.</td>
</tr>
<tr>
<td>End of Life Products</td>
<td>Software Model Lifecycles</td>
<td>Heat map of software model lifecycles, including those lifecycles about to change to the next phase.</td>
</tr>
<tr>
<td>SQL Server Install Breakdown</td>
<td>Software Installations</td>
<td>Total software installations per SQL Server.</td>
</tr>
<tr>
<td>SQL Server Active Right Breakdown</td>
<td>Software Entitlements</td>
<td>Number of total active rights per SQL Server.</td>
</tr>
</tbody>
</table>

### Microsoft 365 & Adobe Cloud dashboard

Only Microsoft Office 365 software products that are recognized as subscription software are shown. Microsoft Office 365 integration must be set up to view compliance information.
<table>
<thead>
<tr>
<th>Report</th>
<th>Source list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Assigned Subscriptions</td>
<td>Software Subscriptions</td>
<td>Aggregate sum of the number of subscriptions that are used (for example, user accounts active).</td>
</tr>
<tr>
<td>Percentage of Unused Subscriptions</td>
<td>Software Subscriptions</td>
<td>Ratio of rights available to rights owned.</td>
</tr>
<tr>
<td>Total Number of Purchased Subscriptions</td>
<td>License Metric Results</td>
<td>Total number of rights owned.</td>
</tr>
<tr>
<td>Current Subscription Spend</td>
<td>License Metric Results</td>
<td>Aggregate sum of the total cost for subscription rights.</td>
</tr>
<tr>
<td>Software Models Out of Compliance</td>
<td>Software Model Results</td>
<td>Number of software models out of compliance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click on the report view the results in the License Workbench.</td>
</tr>
<tr>
<td>True-up cost</td>
<td>Software Model Results</td>
<td>Sum of true-up costs on the latest software model results.</td>
</tr>
<tr>
<td>Subscriptions Consumption Trend</td>
<td>Software Subscriptions</td>
<td>Trend assigned, active, and available subscriptions.</td>
</tr>
<tr>
<td></td>
<td>License Metric Results</td>
<td></td>
</tr>
<tr>
<td>Assigned Subscription Breakdown</td>
<td>Software Subscriptions</td>
<td>Breakdown of assigned subscriptions by software model.</td>
</tr>
<tr>
<td></td>
<td>License Metric Results</td>
<td></td>
</tr>
<tr>
<td>Available Subscription Breakdown</td>
<td>License Metric Results</td>
<td>Breakdown of total active rights by software model.</td>
</tr>
<tr>
<td>Subscription Spend Breakdown</td>
<td>License Metric Results</td>
<td>Breakdown of subscription total cost by product/version/edition (software model).</td>
</tr>
</tbody>
</table>

### Supported Microsoft license types

The Software Asset Management publisher pack for Microsoft adds Microsoft-specific license metrics.

The license metrics are available when Microsoft is selected as the **Metric group** for the entitlement.

### Per user licenses

A per user license is used when each user accessing the software is licensed, regardless of the number of devices they use to access the software.

To define the number of installations a user has, select the **Maximum installs per right** on the Metric Attribute related list of the associated software model. If the user exceeds the number of installations you've defined, additional rights are consumed until the user is fully licensed, or there are no more rights available.

You can manage user allocations for the per user license metric. Users are assigned a quantity of rights. Even if they don’t need all of the allocations, the user will consume the number of rights...
you've allocated to them. If a user isn't assigned to a device, a right will be consumed for each unique device with a software installation.

During reconciliation, for a software model that has one or more software entitlements that use this license metric, a right is consumed for each unique user that has at least one installation of the software on any device assigned to them.

When a software model has downgrade or upgrade rights to another versions of a software product, rights are assigned to users with the specified versions of software installed after the primary version of the software has been fully licensed.

**Per device licenses**

A per device license is used when each device accessing the software is licensed, regardless of the number of users accessing the software.

To define the number of installations a device can have, select the **Maximum installs per right** on the Metric Attribute related list of the associated software model. If the device exceeds the number of installations you've defined, additional rights are consumed until the device is fully licensed, or there are no more rights available.

You can manage device allocations for the per device license metric. Devices are assigned a quantity of rights. Even if they don't need all of the allocations, the device will consume the number of rights you've allocated to them.

During reconciliation, for a software model that has one or more software entitlements that use this license metric, a right is consumed for each unique device that has at least one installation of the software.

When a software model has downgrade or upgrade rights to another versions of a software product, rights are assigned to users with the specified versions of software installed after the primary version of the software has been fully licensed.

**Per core licenses**

A server processor is one of the main components of a server. Each server processor contains smaller processing units called cores and the number of cores your processor has is dependant on your system hardware.

System hardware runs in an operating system environment (OSE) and they act as middleware between the operating system and the software applications on your system. OSEs can be either physical or virtual. Depending on the OSE you have, your processor will be physical, virtual, or a combination of both.

Regardless of if your processor is in a physical or virtual OSE, Microsoft requires that every processor core on a server running SQL Server, Windows Server, or any of their components must be licensed. However, the number of core licenses you need will depend on if you are licensing a physical server or an individual virtual OSE. The number of licenses you need is based on the core factor table provided by Microsoft.

Use the per core license metric for any of your physical or virtual core-based licenses.

During reconciliation, for a software model that has one or more software entitlements that use this license metric, a check is done to see which edition of the software is installed. If the software is an Enterprise edition, a set number of rights are consumed based on the normalized core count on a physical server that has at least one installation of the Enterprise edition software in the physical operating system environment (OSE) or on a virtual machine hosted by the physical server. Another check is run to ensure that the number of OSEs that have an Enterprise edition
install don’t exceed the number of core rights applied to the physical server. If the number of OSEs exceeds the number of core rights, a core right will be consumed for each additional OSE. If the edition is anything but Enterprise, a right is still consumed for every core on a physical server that has at least one install in the physical OSE. The difference is the additional check. In this case, the check ensures that these other editions of software are only installed on the physical server.

If other editions of software are found in a virtual environment and no other rights are owned, then the reconciliation result will be not compliant. Per core rights can’t partially license a server or license software installations on two different servers.

You can manage device allocations. Devices are assigned a quantity of rights. Even if they don’t need all of the allocations, the device will consume the number of rights you’ve allocated to them. For this license metric, all device allocations should be created against the physical server. No matter what edition of the software it is, if the normalized core count is less than the specified value in the Minimum cores per processor metric attribute related to the software model, then the minimum number of rights will be consumed.

**Per core (with CAL) licenses**

You can manage device allocations for this license metric. Devices are assigned a quantity of rights. Even if they don’t need all of the allocations, the device will consume the number of rights you’ve allocated to them. For example, if a device allocation with a quantity of six is created for a server, but only four core rights are needed to fully license the server, six rights would still be consumed during reconciliation. The additional two rights would be considered allocated not in use in reconciliation results.

For the Per core (with CAL) license metric, all device allocations should be created against the physical server. If the core count is less than the specified value in either the Minimum cores per processor or Minimum cores per server metric attributes of the software model, the minimum number of rights will be consumed.

This license metric should be used with device or user CAL license metrics. You need to create software entitlements using those license metrics separately.

During reconciliation, for a software model that has one or more software entitlements that use this license metric, a right is consumed for every core on a physical server that has at least one installation of the software in the physical OSE or on a virtual machine hosted by the physical server. A check runs to verify that the number of installations within an OSE and the number of active OSEs on a server don’t exceed the specified maximums you defined in the Metric Attributes related list on the Software Model form.

If the specified number of installs and OSEs are exceeded, core rights that are equal to the number of cores or minimum cores on the physical server will be consumed until all installs and OSEs are licensed or there are no more available rights. Per core (with CAL) rights can’t partially license a physical server or license software installations on two different physical servers.

**User CAL licenses**

A user CAL license is a client access license (CAL) that allows users to access a server to use its services, regardless of the number of devices the user uses to access the services.

During reconciliation, for a software model that has one or more software entitlements that use this license metric, the number of rights consumed is equal to total user count in all client access records related to that software model.
**Device CAL licenses**

A device CAL license is a client access license (CAL) that allows a set number of devices to access a server to use its services, regardless of the number of users accessing the services from the device.

During reconciliation, for a software model that has one or more software entitlements that use this license metric, the number of rights consumed is equal to total device count in all client access records related to that software model.

**Server (per instance) licenses**

A server (per instance) license is used to license a set number of software installations on either a physical server or virtual machine.

During reconciliation, for a software model that has one or more software entitlements that use this license metric, a right is consumed for the number of installations that exist in an OSE. If the number of installations in an OSE exceeds the value specified in the maximum installs per OSE metric attribute, additional rights will be consumed until all installations on a physical server or virtual machine are licensed or there are no more rights variable.

You can manage device allocations. Devices are assigned a quantity of rights. Even if the software installations, the device will consume the number of rights you’ve allocated to them during reconciliation. For example, if a device allocation with a quantity of two is created for a server, but only one server (per instance) right is needed to fully license the server, two rights would still be consumed during reconciliation. The extra right would be marked as allocated no in use in the license metric results. Device allocations can be created against physical servers or virtual machines.

**Server (per server) licenses**

A server (per server) license is used to license all software installations on a physical server and any virtual machines hosted by the physical server.

During reconciliation, for a software model that has one or more software entitlements that use this license metric, a right is consumed for every unique physical server. This license metric differs from the per device license metric, which consumes a right for every unique physical server and virtual machine that has a software installation.

You can manage device allocations. Devices are assigned a quantity of rights. Even if the software installations, the device will consume the number of rights you’ve allocated to them during reconciliation. For example, if a device allocation with a quantity of two is created for a server, but only one right is needed to fully license the server, two rights would still be consumed during reconciliation. The extra right would be marked as allocated not in use in the license metric results. Device allocations should be created against the physical server.

**Per Processor licenses**

A per processor license is used to license a number of processors on a physical server.

During reconciliation, for a software model that has one or more software entitlements that use this license metric, a right is consumed for processors on a physical server that have at least one installation of the software in the physical OSE or on a virtual machine hosted by the physical
server. The quantity of processors licensed by a single right is determined by the **Maximum processor per rights** on the Metric Attribute related list of the software model.

An additional check is done to ensure that the number of installations in an OSE and the number of OSEs on a server don’t exceed the specified maximums in the **Maximum installs per OSE** and **Maximum active OSEs per server** Metric Attribute related list of the software model. If any of the metric attributes are exceeded, additional rights are consumed until all processors, installs, and OSEs are licensed, or there are no more available rights. Per processor rights cannot partially license a physical server or license software installations on two different physical servers.

You can manage device allocations. Devices are assigned a quantity of rights. Even if the software installations, the device will consume the number of rights you’ve allocated to them during reconciliation. All device allocations should be created against the physical server.

**User Subscription licenses**

User subscription licenses a user for the number of activated software subscriptions.

During reconciliation, for a software model that has one or more software entitlements that use this license metric, a right is consumed for each unique user that has at least one software subscription record associated with the software model. Any software installations that correspond with the software model will also be licensed. However, if a user has software installations, but no subscription record, that user will not consume a right and the installations will be unlicensed.

**Software Assurance licenses**

Microsoft Software Assurance (SA) is the maintenance program used by Microsoft to provide active maintenance to its users. For more information, see [Software license maintenance](#).

**Software Asset Management publisher pack for Oracle**

Use the Software Asset Management publisher pack for Oracle to track your licensing positions for Oracle databases, database options, and management packs.

To use the publisher pack, activate the Software Asset Management Professional for Oracle plugin (com.snc.samp.oracle).

**Oracle licensing**

The Oracle publisher pack adds Oracle-specific licensing options for software entitlements.

**Software entitlement fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agreement Type</td>
<td>• Generic</td>
</tr>
<tr>
<td></td>
<td>• Unlimited License Agreement (ULA)</td>
</tr>
<tr>
<td>License metric</td>
<td>• Named User Plus</td>
</tr>
<tr>
<td></td>
<td>• Per Processor</td>
</tr>
</tbody>
</table>
The **Named User Plus** license metric licenses the physical host. Rights Used By and Rights Needed By allocations are for a physical host.

**Note:** From the Paris release onwards, allocations made on database instances are not considered and are marked as allocations not in use.

If a single Client Access License (CAL) record exists for an entire device configuration, that device is licensed with the Named User Plus license metric. However, if you have a CAL record for a device configuration and do not want to license it with the Named user Plus license metric, you can allocate per processor rights to that device.

The **Per Processor** license metric licenses the number of cores. It is used in environments where users can’t be easily identified or counted, or several users are known to be accessing the environment. The number of required licenses is determined by multiplying the total number of cores the processor has by a core processor licensing factor specified on the Oracle Processor Core Factor Table.

**Note:** For the **Per Processor** license metric, enable Hyper-Threading if you are using a virtual machine running Amazon Web Services (AWS).

The same license metric is used to license installs and its options. For example, if an install is licensed by the Per Processor license metric, it’s options are also licensed by the Per Processor license metric.

For more information about license metrics, see [Software license metrics](#).

### Oracle database management packs and options

Manage licensing for Oracle database server separately from database options/packs. Separate software models and entitlements are required for database server and for database options. The database options follow the database server lifecycle. Along with database server, database options are also displayed in the License workbench. For Oracle database options, in the License workbench, the following remediation options are not available:

- Remove Unallocated Installs
- Remove Unlicensed Installs

Compliance position for database server is reported separately from the database options. Licenses for each database option is managed on its software model. This provides increased visibility to the compliance position and licenses owned for the database server and database options.

For example, say you have Oracle DB Server 12c R1 Enterprise with the Partitioning option. To correctly track your licenses, you need two software models and two entitlements.
Example Oracle DB licensing

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Software model</th>
<th>Software entitlement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track licensing for Oracle DB Server 12c R1 Enterprise.</td>
<td>Oracle DB Server 12c R1 Enterprise</td>
<td>Record your purchased rights for Oracle DB Server 12c R1 Enterprise.</td>
</tr>
<tr>
<td>Track licensing for the Partitioning option.</td>
<td>Oracle DB Server 12c R1 Enterprise Partitioning</td>
<td>Record your purchased rights for the Partitioning option.</td>
</tr>
</tbody>
</table>

**Licensing Oracle databases in hard partitioned environments**

Software Asset Management reconciliation supports Oracle hard partitioning licensing rules for IBM AIX LPAR and Solaris zones. Hard partitioning can reduce the number of licenses required for database installations. For more information about Oracle licensing and hard partitioning, see the Oracle Help Center.

**IBM LPAR**

An LPAR is a defined subset of the processor hardware that supports the operating system. An LPAR contains resources such as processors, memory, and input or output devices, that operate as an independent system. You can have multiple LPARs within your mainframe hardware system. ServiceNow Discovery patterns for the IBM Hardware Management Console (HMC) are available on the ServiceNow Store.

*Note:* The `lparstat` command pulls a report of LPAR-related information and usage. For more information, see the IBM Knowledge Center.

**Solaris zones**

You can set up a global zone on a Solaris server and hard partition it with multiple local zones. You can then run an Oracle database on one or more local zones. To license your Oracle database installations, rights should be allocated to the physical machine running the entire Solaris zone configuration. For the Per Processor license metric, rights must cover the cores for all local zones up to the maximum capacity of the physical machine. For the Named User Plus license metric, rights must cover the clients accessing the database on the local zones. For information about Solaris zone discovery, see Solaris discovery.

**Reconciliation and Oracle database servers**

You can select the level of aggregation for the reconciliation calculation of VMware-based Oracle instances using the `com.snc.samp.oracle.reconlevel` property. See Software Asset Management properties.
Oracle Infrastructure report

Use the Oracle Infrastructure report to gain visibility into your Oracle infrastructure. This report includes information on the Oracle databases you are running, the physical servers and virtual machines supporting these databases, and the number of processor cores that must be licensed. The SAM – Generate Data for Oracle Infrastructure Report scheduled job runs weekly to generate this data.

**Note:** The Oracle Infrastructure report is domain separated.

### Oracle Infrastructure Report

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical Server Name</td>
<td>Name of the physical server that the product is installed on.</td>
</tr>
<tr>
<td>Virtual Server Name</td>
<td>Name of the virtual machine that hosts the Oracle software.</td>
</tr>
<tr>
<td>Cluster</td>
<td>Cluster the database is deployed on.</td>
</tr>
<tr>
<td>Virtualization/Partitioning Technology</td>
<td>Technology used to create the virtual machine. If you didn’t use virtualization or partitioning, leave the column blank.</td>
</tr>
<tr>
<td>DB Instance Name</td>
<td>Name of the database instance installed on the server.</td>
</tr>
<tr>
<td>Environment Usage</td>
<td>Type of environment the Oracle software is deployed.</td>
</tr>
<tr>
<td></td>
<td>• Production</td>
</tr>
<tr>
<td></td>
<td>• Test</td>
</tr>
<tr>
<td></td>
<td>• Development</td>
</tr>
<tr>
<td>Options/Management Packs in Use</td>
<td>Database options or Oracle Enterprise Manager (OEM) management packs being used.</td>
</tr>
<tr>
<td>Primary Database for Standby/Failover/DR/Backup Testing</td>
<td>Name of the primary production database supported by standby, failover, DR, or backup testing.</td>
</tr>
<tr>
<td>Batching To/From</td>
<td>Name of the server or application that sends or receives batches from the database. If batching isn’t used, the row is blank.</td>
</tr>
<tr>
<td>Source Database</td>
<td>Name of the source database this database was duplicated from.</td>
</tr>
<tr>
<td>Duplicate Database Creation Date</td>
<td>Date the duplicated database was created.</td>
</tr>
<tr>
<td>Product Version</td>
<td>Version or release of the product.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Product License Allocated</td>
<td>Edition of the database.</td>
</tr>
<tr>
<td></td>
<td>• Enterprise</td>
</tr>
<tr>
<td></td>
<td>• Standard</td>
</tr>
<tr>
<td>License Metric Allocated</td>
<td>License metric the Oracle database is licensed with.</td>
</tr>
<tr>
<td></td>
<td>• Per Processor</td>
</tr>
<tr>
<td></td>
<td>• Named User Plus</td>
</tr>
<tr>
<td>Number of Licenses in Use</td>
<td>Number of licenses in use for the Oracle database installation.</td>
</tr>
<tr>
<td>Customer Support Identifier (CSI)</td>
<td>CSI associated with the applicable Oracle database licenses.</td>
</tr>
<tr>
<td>Restricted Use</td>
<td>Name of the Oracle product, solution, or component using the license under restricted use terms.</td>
</tr>
<tr>
<td>Software Installation Data</td>
<td>Date the software was installed.</td>
</tr>
<tr>
<td>Application Name</td>
<td>Name of the application using the database.</td>
</tr>
<tr>
<td></td>
<td>Note: The application doesn't have to be an Oracle application.</td>
</tr>
<tr>
<td>Server Model</td>
<td>Name of the server manufacturer and model.</td>
</tr>
<tr>
<td>Processor Model</td>
<td>Name of the CPU manufacturer and model.</td>
</tr>
<tr>
<td>Processor (Sockets)</td>
<td>Number of sockets occupied by physical processors. If hardware partitioning is used, this number is the number of occupied sockets allocated to the partition.</td>
</tr>
<tr>
<td>Core per Processor</td>
<td>Number of physical cores in each processor.</td>
</tr>
<tr>
<td>Physical Cores</td>
<td>Number of physical cores in the server. If hardware partitioning is used, this number is the number of physical cores allocated to the partition.</td>
</tr>
<tr>
<td>Threads per Core</td>
<td>Number of virtual cores on each physical machine if multi-threading is enabled.</td>
</tr>
<tr>
<td>Core Factor</td>
<td>Core factor for the hardware specification.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Licensable Cores</td>
<td>Oracle cores that are licensable. If the database is running on a cluster, the number of licensable cores is specified for the cluster and not each physical host or VM that is part of the cluster.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Since the report shows all the physical and VMs in the cluster, the value is repeated for each row.</td>
</tr>
<tr>
<td></td>
<td>If the database is running on a physical machine with multiple VMs, then the number of licensable cores is specified for the physical machine.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Since the report shows all the VMs running on the physical host, the value is repeated for each row.</td>
</tr>
<tr>
<td>Processor Speed (MHz)</td>
<td>Speed of the physical processor.</td>
</tr>
<tr>
<td>Server Purchase Date</td>
<td>Date the server was purchased.</td>
</tr>
<tr>
<td>Operating System</td>
<td>Name of the operating system running on the server where the Oracle software is installed.</td>
</tr>
</tbody>
</table>

**Software Publisher Analytics dashboard for Oracle**

View compliance analysis results related to Oracle on the Software Publisher Analytics dashboard. Access the Software Publisher Analytics dashboard by navigating to **Software Asset > Publisher Overview**.

**Note:** The add-on Oracle publisher pack (com.snc.samp.oracle) plugin must be installed to view the Oracle dashboard tab.

Results are updated whenever a new reconciliation result is available. You can save charts in PNG or JPG format.

**Oracle dashboard**

You can manage Oracle Server Software, such as Database Server, using the Oracle publisher pack.
### Oracle tab

<table>
<thead>
<tr>
<th>Report</th>
<th>Source list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Products out of Compliance</td>
<td>Product Results</td>
<td>Number of products that have at least one software model out of compliance. Click the report to view the results in the License Workbench.</td>
</tr>
<tr>
<td>True-up Cost</td>
<td>Product Results</td>
<td>Cost to be compliant based on the average prices for entitlements for the rights.</td>
</tr>
<tr>
<td>Over-Licensed Amount</td>
<td>Product Results</td>
<td>Cost of licenses owned but not being used.</td>
</tr>
<tr>
<td>Products by True-up Cost</td>
<td>Product Results</td>
<td>Greatest true-up costs by product.</td>
</tr>
<tr>
<td>Oracle Options Usage</td>
<td>Oracle Options</td>
<td>Installed Oracle licenses versus licenses in use (true versus false). Time frame used to determine if an option is in use is 365 days.</td>
</tr>
<tr>
<td>Database Instances by Edition</td>
<td>Oracle Instances</td>
<td>Total number of database instances by database edition.</td>
</tr>
<tr>
<td>Top 10 Database Instances by Client Access Users</td>
<td>Client Access</td>
<td>Database instances with the greatest number of client access users.</td>
</tr>
<tr>
<td>End of Life Products</td>
<td>Software Model Lifecycles</td>
<td>Heat map of software model lifecycles, including those lifecycles about to change to the next phase.</td>
</tr>
</tbody>
</table>

**Oracle database options and management packs**

Use the Software Asset Management publisher pack for Oracle to track your licensing positions for Oracle database options and management packs. The Licensable Oracle Options table (samp_oracle_option_set) provides the options and management packs that you can create software models for.

<table>
<thead>
<tr>
<th>Oracle database options and management packs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Data Guard</td>
</tr>
<tr>
<td>Active Data Guard or Real Application Clusters</td>
</tr>
<tr>
<td>Advanced Compression</td>
</tr>
<tr>
<td>Advanced Security</td>
</tr>
<tr>
<td>Change Management Pack</td>
</tr>
<tr>
<td>Configuration Management Pack for Oracle Database</td>
</tr>
<tr>
<td>Database In-Memory</td>
</tr>
<tr>
<td>Database Vault</td>
</tr>
</tbody>
</table>
Software Asset Management publisher pack for SAP

Use the Software Asset Management publisher pack for SAP to manage and optimize your SAP licenses. Get comprehensive visibility into your SAP license compliance and uncover potential savings.

Note: To use the publisher pack, activate the Software Asset Management Professional for SAP plugin (com.sn_samp.sap).

Supported license types

The SAP publisher pack supports licensing for named user types and engines.

Named User Types

You can purchase different types of named user licenses, such as Professional, Limited, and Employee, and then assign each license to a user.

Engines

SAP engines, also known as packages, are optional applications that require additional licenses. Every engine has a unique license metric that is used to calculate license consumption for the engine. Examples of license metrics are number of employees or number of contracts.

SAP connection with the Now Platform

To start connecting your SAP systems and your ServiceNow instance, deploy the ABAP program for SAP. Then, follow the steps to establish an SAP connection.

The Software Asset Management publisher pack for SAP uses a centralized design. Once you import the transport files into one SAP client that is considered a central system, with the custom program selected RFC connection list, it connects all other clients through RFC from the central system and fetches data to store in central system custom tables. To import the transport files, use
SAP Solution Manager or another SAP client that has RFC connections activated to fetch data into a central system.

After the connection is established, data is pulled into your ServiceNow instance from your SAP system. For a list of all data that is pulled, see Tables installed with the SAP publisher pack.

SAP data is scheduled to be pulled weekly. User activity data, web activity data, and engine usage data is pulled monthly. All user and web activity is deleted after 90 days. Engine usage measurement records in the SAP License Metric Measurement table (samp_sap_license_metric_measurement) are deleted after one year.

When SAP data enters the Now Platform, it is initially stored in staging tables before it is transferred to the final SAP tables. To edit the tables where data transfer takes place or to view the transfer logic, see transform maps.

**Note:** The user activity and web activity transform maps aren’t enabled by default because they may cause performance issues due to the large amount of data. However, you can manually enable these transform maps. To enable the activity transform maps, navigate to SAP Compliance and Optimization > Administration > SAP Connections and click the connection. In the Configuration section, set the Fetch activity field to True and then click Update.

**View SAP license usage and compliance**

View your SAP license costs, usage, and compliance with the Software Publisher Analytics dashboard. The dashboard also shows how you can optimize license consumption by reassigning user roles in your SAP system.

Reconciliation runs weekly or on demand to determine your license compliance position for all of your SAP products. Reconciliation compares your purchased rights recorded in software entitlements with actual usage data pulled from your SAP systems. To view reconciliation results for SAP in a simplified workbench view, navigate to SAP Compliance and Optimization > Reconciliation > License Workbench. The License Workbench shows unlicensed users and engines, remediation options to make your license position compliant, potential savings, and more. For more information about the License Workbench, see Software license usage.
To view the License Position Report for SAP, navigate to **SAP Compliance and Optimization > Reconciliation > SAP License Position**. For more information about the License Position report, see **Software license compliance position**.
Tables installed with the SAP publisher pack

Tables are installed with the Software Asset Management Professional for SAP plugin. The tables store data pulled from the SAP systems.

**Note:** Use the Application Files table to see all components installed with the SAP publisher pack. For more information, see *Find components installed with an application.*

Demo data is available for the SAP publisher pack.

## Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Named User Type Role (samp_named_user_type_has_role)</td>
<td>Roles assigned to each named user type.</td>
<td>The table is periodically updated with new data from the Content Service. New license metrics may be added, and existing license metrics may be deactivated to reflect current SAP licensing. To view your software models that have deactivated license metrics, navigate to <strong>SAP Compliance and Optimization &gt; Administration &gt; Software Models with Deactivated SAP License Metrics.</strong></td>
</tr>
<tr>
<td>SAP Client (samp_sap_client)</td>
<td>Remote Function Call (RFC) destination connecting Advanced Business Application Programming (ABAP) systems to external systems. To view the table, navigate to <strong>SAP Compliance and Optimization &gt; Administration &gt; SAP Clients.</strong></td>
<td></td>
</tr>
<tr>
<td>SAP Connection (samp_sap_connection)</td>
<td>SAP system connections. To view the table, navigate to <strong>SAP Compliance and Optimization &gt; Administration &gt; SAP Connections.</strong></td>
<td></td>
</tr>
<tr>
<td>SAP Engine Usage (samp_sap_sw_client_access)</td>
<td>Most recent engine usage measurements for SAP clients based on the license metric for each engine.</td>
<td></td>
</tr>
<tr>
<td>SAP License Metric (samp_sap_license_metric)</td>
<td>This table is populated by the ServiceNow Content Service. It is a list of all license metrics that are used by SAP engines. To view the table, navigate to <strong>SAP Compliance and Optimization &gt; Administration &gt; Engines.</strong></td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>SAP License Metric Measurement</td>
<td>Monthly engine usage measurements for SAP clients based on the license metric for each engine. To view the table, navigate to SAP Compliance and Optimization &gt; Licensing &gt; All SAP Engines.</td>
<td></td>
</tr>
<tr>
<td>SAP Roles (samp_sap_role)</td>
<td>SAP roles pulled from the SAP systems.</td>
<td></td>
</tr>
<tr>
<td>SAP System User (samp_sap_system_user)</td>
<td>Discovered users pulled from the SAP systems. To view the table, navigate to SAP Compliance and Optimization &gt; Licensing &gt; All SAP Users.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The Discovered Users table (samp_discovered_user) maps the discovered SAP users to system user records in the Users table (sys_user).

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP User Activity (samp_sap_user_activity)</td>
<td>Data related to a user’s activity on an SAP client, such as the amount of time spent on an SAP system or the number of database records created or updated.</td>
</tr>
<tr>
<td>SAP User Roles (samp_sap_user_has_role)</td>
<td>SAP users and their assigned roles.</td>
</tr>
<tr>
<td>SAP Web Activity (samp_sap_web_activity)</td>
<td>Data related to web activity or RFC connections performed in the SAP client, such as the number of calls or amount of data received or sent by each connection.</td>
</tr>
</tbody>
</table>

**Note:** Staging tables for SAP data are also installed.

Data from SAP is also stored in some additional tables that are not part of the SAP publisher pack.

- Price list data is pulled and stored in the Price List table (samp_price_list).
  To view the table, navigate to SAP Compliance and Optimization > Administration > Price Lists.
- Named user types are pulled and stored in the Named User Type table (samp_named_user_type).
  To view the table, navigate to SAP Compliance and Optimization > Administration > Named User Types.

**Deploy the ABAP program for SAP**

To begin establishing a connection between your SAP system and your ServiceNow instance, deploy the Advanced Business Application Programming (ABAP) program. Deploying the ABAP program allows data to be shared between SAP and your ServiceNow instance.

To access the ABAP program, download the SAP ABAP for Software Asset Management app on the ServiceNow Store. Make sure you download the app version that is compatible with the Paris release.

Role required: sam_admin
To deploy the ABAP program, import the transport files provided with the SAP ABAP for Software Asset Management app and configure a service provider with the service-oriented architecture (SOA) Manager.

**Note:** If you upgrade your ServiceNow instance, you must download and deploy a new version of the ABAP program that is compatible with the new release and reconfigure a service provider with the SOA Manager.

For SAP setup information, see [KB0813999](https://service-now.com/kb0813999). For additional information on SAP and how to use its related tools, see the [SAP Help Portal](https://help.sap.com).

1. In your SAP system, import the transport files using the SAP Transport Management System (STMS).
   a) Copy and extract the **COFILE** and **DATA** files to your directory.
   b) Start STMS and click **Import Overview**.
   c) Double-click the target system, select **Extras > Other Requests > Add**, and then enter the transport request number.
   d) Highlight the request and select **Request > Import**.
   e) From the Import Transport Request window, enter the client number in the **Target Client** field.
   f) Select the Options tab, and then select the **Ignore Invalid Component Version** check box.
   g) Click **OK**.

2. In your SAP system, configure a service provider with the SOA Manager.
   a) Start the SOA Manager and select **Service Administration > Web Service Configuration**.
   b) Select **Service Definition** from the **Search By** field.
   c) Enter the service definition location in the **Search Pattern** field.
   d) Click **Go**.
   e) From the Search Results pane, select the service definition row, and then click **Apply Selection**.
   f) From the Configurations tab, click **Create**.
   g) Complete the following fields.

<table>
<thead>
<tr>
<th><strong>SOA Management dialog box</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Service Name</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>New Binding Name</td>
</tr>
</tbody>
</table>

   h) Click **Apply Settings**.
   i) Select **Provider Security > Message Authentication**, and then select the **User ID/Password** check box.
   j) Click **Save**.
   k) Select **Overview > Open Design time WSDL document**.
A browser window opens and a new WSDL is generated.

1. Click **Open Service WSDL Generation**.
2. Copy the link from the **WSDL URL for Binding** field.

3. Verify the RFC connection.

Return to your ServiceNow instance to establish your SAP connection.

**Establish an SAP connection**

After you have deployed the Advanced Business Application Programming (ABAP) program in your SAP system, create a connection profile to establish a connection between your SAP system and your ServiceNow instance.

Before establishing a connection between SAP and your ServiceNow instance, check if your SAP system network is accessible to external applications like ServiceNow. If external connections are blocked, you can install a MID Server. A MID Server enables communication and data movement between a ServiceNow instance and external applications or data sources. For instructions, see **Installing the MID Server**.

If you already have a MID Server installed in the network and connected to your ServiceNow instance, this SAP connection will automatically use it.

**Role required: admin**

1. Navigate to **SAP Compliance and Optimization > System Administration > Connection Setup** and click **New**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of connection profile.</td>
</tr>
<tr>
<td>Default price list</td>
<td>Default price list that should be considered for reconciliation.</td>
</tr>
<tr>
<td>WSDL</td>
<td>Web Service Description Language (WSDL) URL from the SOA manager, that includes an IP address, that is used to connect to the SAP system.</td>
</tr>
<tr>
<td>User name</td>
<td>User name used to connect to the SAP system.</td>
</tr>
<tr>
<td>Password</td>
<td>Password used to connect to the SAP system.</td>
</tr>
</tbody>
</table>

**Note:** Do not change the SAP WSDL name. The WSDL service definition name must be /NOW/SAMP and the service binding name must be NOW_SAMP. The only WSDL name that can be changed is the WSDL generation name.

3. Click **Submit**.

The initial connection is established.

4. Click the SAP Connection and review the fields on the record.
SAP Connection record

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the connection profile. The value is generated in the SAP Connection Setup form.</td>
</tr>
<tr>
<td>Default price list</td>
<td>Default price list that should be considered for reconciliation. The value is generated in the SAP Connection Setup form.</td>
</tr>
<tr>
<td>Last run</td>
<td>Date and time that data was last pulled for the SAP connection.</td>
</tr>
<tr>
<td>SOAP message</td>
<td>SOAP message that has the SAP WSDL information.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>Connection alias that contains the credentials for the connection. The connection alias resolves your connection and credentials at runtime.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that indicates that the SAP connection is active.</td>
</tr>
<tr>
<td>User Mapping</td>
<td>SAP users across different clients that are mapped to a corresponding ServiceNow user.</td>
</tr>
<tr>
<td>SAP user field</td>
<td>ServiceNow user field</td>
</tr>
<tr>
<td>User field</td>
<td>Note: Changing the values in the User Mapping fields after data is pulled causes the mapping between discovered users and system users to be lost. The mapping between discovered users and the Rights used by and Rights needed by fields is also lost.</td>
</tr>
</tbody>
</table>

Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fetch roles</td>
<td>Controls the data pull from SAP for roles data.</td>
</tr>
<tr>
<td>Fetch engine usage</td>
<td>Controls the data pull from SAP for engine usage data.</td>
</tr>
<tr>
<td>Fetch activity</td>
<td>Controls the data pull from SAP for user activity and web activity data.</td>
</tr>
</tbody>
</table>

5. In the SAP Credentials related list, view the credentials you used to create the connection.

   Note: Only one credential record should be active for a given SAP connection.

6. To test your SAP connection and if you're running the latest version of the ABAP program, click the **Test Connection and Version** related link.
Note: If you upgrade your ServiceNow instance, you must download and deploy the new version of the ABAP program and reconfigure a service provider with the SOA Manager.

7. SAP data is scheduled to be pulled regularly. If the data you pulled is corrupted and you need to see current data, click the **Pull all SAP Data** related link.

8. To send a request to the custom ABAP program to collect the SAP data into the custom tables again, click the **Request SAP to Refresh Data** related link.

9. View SAP clients in the SAP Clients related list.
   The SAP clients are generated when SAP data is pulled during the scheduled job.

10. Click **Update**.

You can now begin creating software models and entitlements.

**Create software models for SAP**

Create software models to record SAP product information.

Role required: sam_user

Software models are automatically created for engines and license metrics that are pulled from your SAP systems. You can manually create additional software models for SAP products as needed.

The following steps describe information specific to SAP. For general instructions on creating software models, see [Record product details](#).

1. Navigate to **SAP Compliance and Optimization > Licensing > SAP Software Models** and click **New**.
2. On the form, fill in the fields.

   **Note:** Only fields specific to SAP software models are shown below. For a detailed description of all software model fields, see [Software model fields](#).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Named user type</td>
<td>SAP named user type.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field appears only when Named Users is selected from the Product field.</td>
</tr>
<tr>
<td>Price List</td>
<td>Software group that corresponds to the named user type.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field appears only when Named Users is selected from the Product field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SAP license metric</td>
<td>License metric that is used to calculate license consumption for an engine. Examples of license metrics are number of employees or number of contracts.</td>
</tr>
<tr>
<td>Note: This field appears only when an SAP engine is selected from the Product field.</td>
<td></td>
</tr>
<tr>
<td>Is relevant</td>
<td>Some SAP engines don’t require additional licensing. Select the check box if the engine requires additional licensing. Software models with Is relevant set to false will always be considered compliant by reconciliation.</td>
</tr>
<tr>
<td>Note: This field appears only when an SAP engine is selected from the Product field.</td>
<td></td>
</tr>
<tr>
<td>Threshold</td>
<td>Some SAP engines allow a certain amount of unlicensed usage before your licence position becomes not compliant. The threshold defines the allowed usage and is specific to each engine and license metric. If your engine usage exceeds your licensed amount but is less than the threshold value, the software model is still considered compliant by reconciliation.</td>
</tr>
<tr>
<td>Note: This field appears only when an SAP engine is selected from the Product field.</td>
<td></td>
</tr>
</tbody>
</table>

3. Click **Submit**.

Create a software entitlement to record your licenses for the software model.

**Create entitlements for SAP**

Create software entitlements to record your license information for SAP products. You can create entitlements individually or import them from a spreadsheet.

Role required: sam_user or sam_admin

Note: The sam_admin role is required to import entitlements.

The following steps describe information specific to SAP. For general instructions on creating software entitlements, see Record software rights and user allocations.

1. Navigate to SAP Compliance and Optimization > Licensing > SAP Software Entitlements and click **New**.
2. On the form, fill in the fields.
Only information specific to SAP software entitlements is shown below. For a detailed description of all software entitlement fields, see Software entitlement fields.

### Software Entitlement form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metric group</td>
<td>SAP</td>
</tr>
</tbody>
</table>
| License metric| Select **Named User** to license the number of named users that can be assigned a given Named User Type. The Named User Type is defined by the software model linked to the entitlement.  
Select **Engine Measurement** to license the amount of usage for an SAP engine. The type of usage is defined by the **SAP license metric** field on the software model.  
For more information about license metrics, see Software license metrics. |

3. Click **Submit**.

### Create a custom named user type

Create a custom named user type that can be used with your SAP software entitlement. Creating a custom named user type allows users to track licenses that are specific to their SAP systems.

**Role required:** sam_admin

**Note:** Custom named user types created in your ServiceNow instance with the SAP publisher pack aren't reflected in the SAP system, so you must make the changes in your SAP system too.

1. Navigate to **SAP Compliance and Optimization > Administration > Named User Types** and create a new record (see table for field descriptions).

### Custom Named User Type form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of custom named user.</td>
</tr>
<tr>
<td>Price List</td>
<td>Default price list.</td>
</tr>
<tr>
<td>Is developer</td>
<td>Option that indicates the user has a developer role.</td>
</tr>
<tr>
<td>Grants access to</td>
<td>Grant access to a named user type.</td>
</tr>
<tr>
<td>Value</td>
<td>Value associated with the named user type. This value can be either numbers or letters.</td>
</tr>
<tr>
<td>Rank</td>
<td>Priority of the named user type during reconciliation. Lower rank values take precedence.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Is licensable</td>
<td>Option that indicates the named user type license status.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that indicates if the named user type is active.</td>
</tr>
</tbody>
</table>

2. Click **Submit**.

The named user type is added to the Named User Types list.

After you have added the custom named user, create a software model designating the custom named user in the form.

**Map a role to a named user type**

You can optimize your SAP licenses by mapping roles to a named user type. During reconciliation, discovered user roles and their assigned named user types are compared against these roles to identify users that can be given a lower named user type.

Role required: *sam_admin*

1. Navigate to **SAP Compliance and Optimization > Administration > Named User Types**.
2. Select one of the named user types from the Named User Types list.
3. In the SAP Roles related list, click **Edit**.
4. Add additional roles to the named user type.
5. Click **Save**.

**Software Publisher Analytics dashboard for SAP**

View your license compliance position for SAP on the Software Publisher Analytics dashboard.

Access the dashboard by navigating to **SAP Compliance and Optimization > Overview**.

The dashboard is updated whenever a new reconciliation result is available.

**End users and roles**

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAM user: Can view the dashboard to track SAP license compliance and potential savings.</td>
<td><em>sam_user</em></td>
</tr>
<tr>
<td>Report</td>
<td>Source list</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Named User Types Out of Compliance</td>
<td>Software Model Result</td>
</tr>
<tr>
<td>True-up Cost</td>
<td>Software Model Result</td>
</tr>
<tr>
<td>Potential Savings</td>
<td>Software Model Result</td>
</tr>
<tr>
<td>Over-licensed Amount</td>
<td>Software Model Result</td>
</tr>
<tr>
<td>Engines Out of Compliance</td>
<td>Software Model Result</td>
</tr>
<tr>
<td>Active Engines</td>
<td>SAP License Metric Measurement</td>
</tr>
<tr>
<td>Unused Engines</td>
<td>License Metric Results</td>
</tr>
<tr>
<td>Engines Usage Reached 90% and Above</td>
<td>License Metric Results</td>
</tr>
<tr>
<td>Locked Out Licensed SAP Users</td>
<td>SAP System Users</td>
</tr>
<tr>
<td>Users Without a Named User Assignment</td>
<td>SAP System Users</td>
</tr>
<tr>
<td>Inactive Users</td>
<td>SAP System Users</td>
</tr>
<tr>
<td>Users For License Optimization</td>
<td>SAP System Users</td>
</tr>
<tr>
<td>Licensed Non-Dialog Users</td>
<td>SAP System Users</td>
</tr>
<tr>
<td>Report</td>
<td>Source list</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Potential Indirect Access From Web Activity</td>
<td>SAP System Users</td>
</tr>
<tr>
<td>Potential Indirect Access From User Activity</td>
<td>SAP System Users</td>
</tr>
<tr>
<td>Unique User Growth Year-To-Date</td>
<td>SAP System Users</td>
</tr>
<tr>
<td>Named User Count Distribution</td>
<td>SAP System Users</td>
</tr>
<tr>
<td>Named User Types True-up Cost Breakdown</td>
<td>Software Model Result</td>
</tr>
<tr>
<td>Client Distribution</td>
<td>Software Model Result</td>
</tr>
</tbody>
</table>

**Software Asset Management publisher pack for VMware**

Use the Software Asset Management publisher pack for VMware to create software entitlements, software models, and track your licensing positions using VMware-specific licensing metrics.

**Note:** To access all the benefits of the Software Asset Management publisher pack for VMware, activate the VMware content pack (com.sn_samp_vmware) plugin.

VMware is a virtualization and cloud computing software. VMware virtualization offers two types of hypervisors, as well as additional products that you can use to optimize virtualization.

Most VMware product features are accessed using a license key, which can make managing your license compliance difficult. The Software Asset Management publisher pack for VMware
allows you to track your license compliance position to optimize your software spend and reduce audit risk.

A discovery process is required for VMware data to be collected. For more information, see *Data collected by ITOM Visibility.*

*Track the software rights* that you’ve purchased for your VMware with the Software Entitlement form. You can also store the licensing key information for your software using the License Key related list on the form. For more information on the different license agreement types that are supported for VMware, see *License agreement types.*

View your VMware license compliance from the License Workbench. If your VMware software is out of compliance, the License Workbench provides remediation suggestions on how to return your licenses back to compliance. For more information, see *Software license usage.*

Use the Software Publisher Analytics dashboard to view compliance analysis results related to VMware. For more information, see *Software Publisher Analytics dashboard for VMware.*

**Software Publisher Analytics dashboard for VMware**

View compliance analysis results related to VMware on the Software Publisher Analytics dashboard.

Access the Software Publisher Analytics dashboard by navigating to *Software AssetPublisher Overview.*

> **Note:** The add-on VMware publisher pack (com.sn_samp_vmware) plugin must be installed to view the VMware dashboard tab.

The dashboard is updated whenever a new reconciliation result is available. You can save charts in PNG or JPG format.

**VMware dashboard**

Information from VMware vCenter software is discovered and used for VMware reconciliation. Discovery uses these probes and populates these tables:

- *vCenter probe* VMware — vCenter ESX Hosts License
- VMware Discovered License Key (samp_vmware_license_key) and VMware Discovered License Key Consumption (samp_vmware_license_key_usage) tables

For more information, see *vCenter discovery with Software Asset Management.*

> **Note:** The add-on VMware publisher pack (com.sn_samp_vmware) plugin must be installed to view the VMware dashboard tab.
VMware tab

<table>
<thead>
<tr>
<th>Report</th>
<th>Source list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Products out of Compliance</td>
<td>Product Results</td>
<td>Number of products that have at least one software model out of compliance. Click the report to view the results in the Software license usage.</td>
</tr>
<tr>
<td>Over-licensed Amount</td>
<td>Product Results</td>
<td>Cost of licenses owned but not being used.</td>
</tr>
<tr>
<td>True-up Cost</td>
<td>Product Results</td>
<td>Cost to be compliant based on the average prices for entitlements for the rights.</td>
</tr>
<tr>
<td>Top 5 Installed Products</td>
<td>Software Installations</td>
<td>Count of top 5 VMware products installed.</td>
</tr>
<tr>
<td>vSphere Territorial Non-compliance</td>
<td>VMware Discovered License Key Consumptions</td>
<td>Compliance of VMware vCenter deployments. Drill down on the location to filter.</td>
</tr>
<tr>
<td>ESX Servers by Region</td>
<td>ESX Servers</td>
<td>Location, ESX count, CPU count, and cores count.</td>
</tr>
<tr>
<td>Audit View</td>
<td>VMware Discovered License Key Consumptions</td>
<td>VMware vSphere deployments: Product, License Key, Used By, Assigned To, Location, CPU core count, CPU count, vCenter reference, evaluation expiration date, and software install.</td>
</tr>
<tr>
<td>End of Life Products</td>
<td>Software Model Lifecycles</td>
<td>Heat map of software model lifecycles, including those lifecycles about to change to the next phase.</td>
</tr>
</tbody>
</table>

The vSphere Deployment related link shows the VMware Discovered License Key Consumptions list.

**Engineering license management**

Get visibility into your license position and usage of your engineering applications to eliminate audit risks, inefficient usage of licenses, inaccurate forecasting, and to prevent denials.

**Note:** To access all the benefits of the Software Asset Management Professional for Engineering Applications, activate the com.sn_samp_eng_app plugin.

Engineering applications refer to categorizing software products in industries such as aerospace, oil and gas, and construction.
A concurrent license enables multiple users to share access to software applications from any computer on a network or from a virtual machine. License management servers that are installed on the network manage the distribution of a pool of shared licenses.

You can have multiple license management servers; one for each engineering application. The number of concurrent licenses in the shared pool determines the number of users who can use the software application at a given time. When you want to use an application, that application sends a request to the appropriate license management server to determine if a license is available. If a license is available, the application starts and the number of available licenses decreases by one. When the user exits the application, the license returns to the pool.

The following graphic illustrates the way OpenLM works with the ServiceNow instance.
Optimizing Engineering Software Licenses with Software Asset Management Professional

License Usage, User Activity, Denials, and Alerts

Software Asset Management Lifecycle

Optimization > Request > Entitlements

Remediation > CMDB

Reconciliation > Normalization

OpenLM integration is available in the ServiceNow Store

Analytics

Monitor concurrent license consumption for more accurate forecasting

Track and reduce software spend by optimizing license usage

Avoid employee productivity losses by monitoring license denials

Provide support for audits and contract renewals

Single system of record and action

$311.01k

$18.00k
The Software Asset Management application supports three types of licenses: floating, network, and token licenses. For information on these licenses, see Software license metrics.

The ServiceNow instance integrates with OpenLM to collect data from license management servers. OpenLM is a software license monitoring and management tool that integrates with a wide variety of license management servers such as IBM License Use Management (LUM), Sentinel Technologies, and Bentley Systems, Inc. OpenLM connects with each license management server, consolidates the data, and gets the data into your ServiceNow instance via the ServiceNow Store application.

After you download the ServiceNow Store application and configure the application via Guided Setup, OpenLM triggers data collection from all the license management servers that are connected to OpenLM. Data such as license usage, denials, user activity, and alerts are collected from the license management servers by OpenLM and transferred to the ServiceNow instance. The data is normalized and reconciled to produce reports. You can see the total spend on engineering software, the most used or the most denied products, license usage over time, and many other reports on the Engineering License Overview dashboard.

SaaS License Management

Use the ServiceNow SaaS License Management application to view SaaS and SSO usage data and immediately reclaim unused subscriptions. Manage compliance and optimize licensing.

- Create and manage direct integrations with SaaS applications.
- Create integrations with SSO providers to view subscription usage for all connected applications.
- View SaaS and SSO subscription usage, cost, and compliance information on the SaaS License Management Overview dashboard.
- Reclaim user subscriptions that have limited to no activity.

You can create direct integrations for the following SaaS applications:

- Box
- DocuSign
- Dropbox
- G Suite
- Jira Software
- Salesforce
- Cisco Webex Meetings
- Zoom

If you want to integrate with a SaaS application that is not on this list, you can create a custom integration profile using SaaS License Connections.

You can create integrations with the following SSO providers:

- Microsoft Azure AD

Note: For information about managing licenses for Microsoft Office 365 and Adobe Cloud, see Microsoft Office 365 integration and Software Asset Management publisher pack for Adobe.
Request SaaS License Management

Request SaaS License Management to view SaaS license usage data and immediately reclaim unused licenses.

To use SaaS License Management, you must have the Software Asset Management Professional (com.snc.samp) plugin activated on your ServiceNow® instance. For more information about activating Software Asset Management Professional, see Request Software Asset Management.

To use SaaS License Management, enable the Software Asset Management - SaaS License Management Integrations (com.sn_sam_saas_int) plugin. This plugin includes demo data.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.
4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>like this plugin to be enabled</td>
<td>Note: Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments.</td>
</tr>
</tbody>
</table>

5. Click Submit.

**SaaS License Management setup for large companies**

Set up SaaS License Management for large companies to ensure that you can view all SaaS usage data in your ServiceNow instance.

Some large companies must update the `com.snc.pa.dc.max_row_count_indicator_source` system property before creating integration profiles. If either of the following is true for your company, a user with the admin role must update this property.

- You have more than 50,000 user subscriptions for Box, DocuSign, Dropbox, G Suite, Salesforce, and Zoom combined.
- You have more than 50,000 user subscriptions for Adobe Cloud and Microsoft Office 365 combined.
Update the `com.snc.pa.dc.max_row_count_indicator_source` system property to be the greater value between your subscriptions for the two groups. For example, if you have 60,000 user subscriptions for Box, DocuSign, Dropbox, G Suite, Salesforce, and Zoom combined and 25,000 user subscriptions for Adobe Cloud and Microsoft Office 365 combined, update the property to be 60,000.

**SaaS License Management Overview dashboard**

View subscription usage, cost, and compliance for SaaS and SSO applications on the SaaS License Management Overview dashboard.

Access the dashboard by navigating to **SaaS License > Overview**. You can filter the dashboard by software model or publisher. Click any element to see more information.

*iNote:* To view software usage and compliance for Microsoft Office 365 and Adobe Cloud, navigate to **SaaS License > Office 365 & Adobe Cloud**.

To view all cloud spend on a single dashboard, including software, platform, and infrastructure, see the **Cloud Spend Dashboard**.
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Subscription Spend</td>
<td>Total cost of all active entitlements for subscription software.</td>
</tr>
<tr>
<td>Percentage of Stale Subscriptions</td>
<td>Percentage of subscriptions that don’t meet the usage requirements defined by reclamation rules.</td>
</tr>
<tr>
<td></td>
<td>This percentage is calculated as the number of stale rights divided by the total number of assigned rights.</td>
</tr>
<tr>
<td>Underperforming Subscription Spend</td>
<td>Total amount spent on stale subscriptions.</td>
</tr>
<tr>
<td>Assigned Subscriptions</td>
<td>Total number of assigned subscriptions.</td>
</tr>
<tr>
<td>True-up Cost</td>
<td>Cost to have the number of rights you own match the number of rights you’ve assigned to users.</td>
</tr>
<tr>
<td></td>
<td>This metric helps verify that you’re paying for all the rights you’re using.</td>
</tr>
<tr>
<td>Actual Savings Year-to-Date</td>
<td>Total savings for the year for all subscription software products.</td>
</tr>
<tr>
<td></td>
<td>This value is calculated as the total savings from closed complete reclamation candidates.</td>
</tr>
<tr>
<td>Subscription Consumptions Trend</td>
<td>Weekly number of assigned subscriptions, subscriptions in use, and available subscriptions. A new graph is added each week.</td>
</tr>
</tbody>
</table>

**Integrate with SaaS applications**

Create an integration profile to view software usage information and optimize stale licenses.

A SaaS integration profile pulls your company’s software usage information from the software vendor. This information includes a list of all users and identifies which users haven’t recently used the software.

You can create an integration profile for the following SaaS applications:

- Box
- DocuSign
- Dropbox
- G Suite
- Jira Software
- Salesforce
- Cisco Webex Meetings
- Zoom

You can also create integrations for Adobe Cloud and Microsoft Office 365. For more information, see [Microsoft Office 365 integration](#) and [Software Asset Management publisher pack for Adobe](#).

If you want to integrate with a SaaS application that is not on this list, you can create a custom integration profile.

The SaaS integration automatically creates a software model and a reclamation rule for the software. Always **review the reclamation rule** to make sure that reclamation candidates are identified using the criteria you want.

After reviewing the reclamation rule, **create a software entitlement** to track purchased licenses and cost.
Integrating with SaaS applications

After following this process, you’re ready to start reclaiming unused licenses to reduce software costs for your company.

Create a Box integration profile

Create an integration profile to track software subscriptions and optimize stale licenses for the Box service.

The Box account you use to connect the integration requires the following user access permissions.

**Edit User Access permissions**

<table>
<thead>
<tr>
<th>Permission</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared contacts</td>
<td>Allow this user to see all managed users.</td>
</tr>
<tr>
<td>Enable Box Sync</td>
<td>Allow this user to synchronize files between Box and the user’s desktop.</td>
</tr>
<tr>
<td>Co-Admin</td>
<td>User is granted the following administrative privileges.</td>
</tr>
</tbody>
</table>
| Users and Groups     | • Manage users  
<pre><code>                   | • Manage groups                                                     |
</code></pre>
<table>
<thead>
<tr>
<th>Permission</th>
<th>Value</th>
</tr>
</thead>
</table>
| Files and Folders     | • View users’ content  
                       | • Edit users’ content  
                       | • Log in to users’ accounts |
| Reports and Settings  | • View settings and apps for your company  
                       | • Edit settings and apps for your company  
                       | • Run new reports and access existing reports |

These permissions enable the integration to get a list of users, get user activity, and reclaim unused subscriptions.

Role required: sam_integrator or admin

For additional information on the Box service, see the Box Community.

1. Create an application on the Box Platform.
   a) Navigate to the Box Developer Console and sign in to your account.
   b) On the My Apps page, click Create New App.
   c) Select Custom App.
   d) On the Authentication Method page, select Standard OAuth 2.0 (User Authentication).
   e) Enter an application name, and then click Create App.
   f) On the Configuration page, obtain the Client ID and Client Secret. You will need to copy and paste these values into your ServiceNow instance in the following steps.

   ![Note]
   Your client ID and client secret are sensitive. Do not share them.

   g) Enter https://instance.service-now.com/oauth_redirect.do as the Redirect URI, where instance is the name of your ServiceNow instance.
   h) Select the following application scope check boxes:
      • Read all files and folders stored in Box
      • Read and write all files and folders stored in Box
      • Manage users
      • Manage enterprise properties

      These scopes enable the integration to get a list of users, get user activity, and reclaim unused subscriptions.
   i) Click Save Changes.

2. Return to your ServiceNow instance and create an integration profile.
   a) Navigate to SaaS License > Administration > Direct Integration Profiles and click New. Select the type of integration profile you want to create.
   b) On the form, fill in the fields.
Integration Profile form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the integration profile.</td>
</tr>
<tr>
<td>Client Id</td>
<td>Client ID for the OAuth application created in the SaaS admin account.</td>
</tr>
<tr>
<td>Redirect url</td>
<td>URL of the OAuth provider that you're redirected to after authentication. This value is automatically populated.</td>
</tr>
<tr>
<td>Client secret</td>
<td>Password associated with the client ID.</td>
</tr>
<tr>
<td>Profile type</td>
<td>Type of integration profile. This value is automatically populated.</td>
</tr>
<tr>
<td>Analyze user activity from</td>
<td>You can choose to start analyzing data from the current date or from up to 60 days in the past. Choosing a date in the past enables you to detect stale subscriptions without waiting in real time because you can see subscriptions that haven't been used recently. Because choosing a date in the past increases the amount of data that is analyzed, it could take several hours for you to be able to view the results.</td>
</tr>
</tbody>
</table>

c) Click **Submit**.

3. On the integration profile, click the **Get OAuth Token** related link.
4. In the pop-up window, select your Box admin account and click **Allow**.

**Note:** When user subscriptions are reclaimed, files from the reclaimed accounts are transferred to the admin account selected in this step. This account can be a different admin account than the one used to set up the integration. If you need to start transferring files to a new admin, you can click the **Get OAuth Token** related link again at any time to select a different admin account. After selecting a new admin, you can reclaim the old admin account to transfer all of their files to the new admin, including all previously reclaimed user files.

Software models, reclamation rules, user subscriptions, and stale user reclamation candidates are created automatically after the integration is connected and are refreshed daily.

It's important that you review all automatically generated reclamation rules to ensure that they meet your specifications for reclaiming user subscriptions. For more information, see **Review a software reclamation rule**.

Create software entitlements for the automatically generated software models to track software used against software owned. For more information, see **Record software rights and user allocations**.

**Create a DocuSign integration profile**

Create an integration profile to track software subscriptions and optimize stale licenses for the DocuSign service.
Role required: sam_integrator or admin

For more information about DocuSign, see the DocuSign Developer site.

1. Register an application through the DocuSign admin portal.

   Note: If you already have an API integrator key from a previous integration ready for use in production, skip to step r. If you don’t have your client secret saved, you must generate a new one.

   a) Log in to your DocuSign demo (sub-production) account, click your profile picture, and select Go to Admin.
   b) Select API and Keys > Add App / Integrator Key.
   c) In the Add API Integrator Key form, enter a description in the App Description field and click Add.
   d) In the Redirect URIs field, add https://www.getpostman.com/oauth2/callback and https://instance.service-now.com/oauth_redirect.do, where instance is the name of your ServiceNow instance.
   e) Click Add Secret Key.
      An integrator key (client ID) and secret key (client secret) are displayed. Before saving, copy and paste the keys in a secure location. You will need to input them later in the Postman App and in your ServiceNow instance.
   f) Click Save.
   g) Download the Postman App and skip the login.
   h) Click New > Request.
   i) Name the request. Click Create Collection and name the collection, then click Save.
   j) Click the Authorization tab.
   k) Click the Type drop-down menu and select OAuth 2.0
   l) Click Get New Access Token and complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Callback URL</td>
<td><a href="https://www.getpostman.com/oauth2/callback">https://www.getpostman.com/oauth2/callback</a></td>
</tr>
<tr>
<td>Auth URL</td>
<td><a href="https://account-d.docusign.com/oauth/auth">https://account-d.docusign.com/oauth/auth</a></td>
</tr>
<tr>
<td>Access Token URL</td>
<td><a href="https://account-d.docusign.com/oauth/token">https://account-d.docusign.com/oauth/token</a></td>
</tr>
<tr>
<td>Client ID</td>
<td>The integrator key from your DocuSign demo account</td>
</tr>
<tr>
<td>Client Secret</td>
<td>The secret key from your DocuSign demo account</td>
</tr>
</tbody>
</table>

   Note: Your client ID and client secret are sensitive. Do not share them.

   m) Click Request Token. Enter your DocuSign demo account credentials if prompted and then click Use Token.
In the GET field, enter `https://demo.docusign.net/restapi/v2/accounts/account-id/users`, where `account-id` is your DocuSign API Account ID found in the API and Keys section of the DocuSign admin portal. Click Send 20 times to make 20 API calls. This process is required because you must make at least 20 API calls to register your application through the DocuSign admin portal.

Return to the API and Keys section of the DocuSign admin portal. Next to your application, click Actions > Review Transactions.

Select today as the test date and click Review. After 5-20 minutes, your application review is complete and you can promote the application to your production account. If the review fails, wait 5 minutes for DocuSign to register all 20 API calls. Then click Actions > Resubmit for Review. Your review should pass.

Next to your application, click Actions > Go Live to promote the application.

Log in to your DocuSign production content account, click your profile picture, and select Go to Admin.

Select API and Keys. Locate your API Account ID to use for the integration profile in your ServiceNow instance.

Next to your application, click Actions > Edit.

In the Redirect URIs field, add `https://instance.service-now.com/oauth_redirect.do` where `instance` is the name of your ServiceNow instance.

Click Save.

2. Return to your ServiceNow instance and create an integration profile.

Navigate to SaaS License > Administration > Direct Integration Profiles and click New. Select the type of integration profile you want to create.

On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the integration profile.</td>
</tr>
<tr>
<td>Client Id</td>
<td>Client ID for the OAuth application created in the SaaS admin account.</td>
</tr>
<tr>
<td>Redirect url</td>
<td>URL of the OAuth provider that you're redirected to after authentication.</td>
</tr>
<tr>
<td></td>
<td>This value is automatically populated.</td>
</tr>
<tr>
<td>Client secret</td>
<td>Password associated with the client ID.</td>
</tr>
<tr>
<td>Profile type</td>
<td>Type of integration profile. This value is automatically populated.</td>
</tr>
<tr>
<td>Technical account id</td>
<td>API Account ID from your DocuSign production account.</td>
</tr>
</tbody>
</table>

Click Submit.

3. On the integration profile, click the Get OAuth Token related link and follow the steps to get an OAuth token.
Software models, reclamation rules, user subscriptions, and stale user reclamation candidates are created automatically after the integration is connected and are refreshed daily.

It’s important that you review all automatically generated reclamation rules to ensure that they meet your specifications for reclaiming user subscriptions. For more information, see Review a software reclamation rule.

Create software entitlements for the automatically generated software models to track software used against software owned. For more information, see Record software rights and user allocations.

Create a Dropbox integration profile

Create an integration profile to track software subscriptions and optimize stale licenses for the Dropbox service.

Role required: sam_integrator or admin

For Dropbox product documentation, see the Dropbox Business User and Admin Guides.

1. Create an application on the DBX Platform for user subscriptions through the Dropbox admin portal.
   a) Navigate to Dropbox Developer Apps and sign in to your account.
   b) Click Create app.
   c) Select Dropbox Business for API.
   d) Select Team member file access.
   e) Enter a name for your application and click Create app.
   f) Obtain the App key and App secret. You will need to copy and paste these values into the Client ID and Client Secret fields in your ServiceNow instance in the following steps.

   ![Note]
   
   Your App key (client ID) and App secret (client secret) are sensitive. Do not share them.

   g) Enter https://instance.service-now.com/oauth_redirect.do as the redirect URI, where instance is the name of your ServiceNow instance.
   h) Click the Branding tab and then click Save changes.

2. Create another application on the DBX Platform for reclamation through the Dropbox admin portal.
   a) Click Create a new app.
   b) Select Dropbox Business for API.
   c) Select Team member management.
   d) Enter a name for your application and click Submit.
   e) Obtain the App key and App secret. You will need to copy and paste these values into the Client ID and Client Secret Reclamation Credentials fields in your ServiceNow instance in the following steps.
   f) Enter https://instance.service-now.com/oauth_redirect.do as the redirect URI.
   g) Click the Branding tab and then click Save changes.
3. Using the information from the application with the permissions set to **Team member file access**, return to your ServiceNow instance and create an integration profile.
   a) Navigate to **SaaS License > Administration > Direct Integration Profiles** and click **New**. Select the type of integration profile you want to create.
   b) On the form, fill in the fields.

   **Integration Profile form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the integration profile.</td>
</tr>
<tr>
<td>Client Id</td>
<td>Client ID for the OAuth application created in the SaaS admin account.</td>
</tr>
<tr>
<td>Redirect url</td>
<td>URL of the OAuth provider that you’re redirected to after authentication. This value is automatically populated.</td>
</tr>
<tr>
<td>Client secret</td>
<td>Password associated with the client ID.</td>
</tr>
<tr>
<td>Profile type</td>
<td>Type of integration profile. This value is automatically populated.</td>
</tr>
<tr>
<td>Analyze user activity from</td>
<td>You can choose to start analyzing data from the current date or from up to 60 days in the past. Choosing a date in the past enables you to detect stale subscriptions without waiting in real time because you can see subscriptions that haven’t been used recently. Because choosing a date in the past increases the amount of data that is analyzed, it could take several hours for you to be able to view the results.</td>
</tr>
</tbody>
</table>

c) In the Reclamation Credentials section, complete the following fields using the information from the application with the permissions set to **Team member management**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Id</td>
<td>Client ID for the OAuth application created in the SaaS admin account.</td>
</tr>
<tr>
<td>Client secret</td>
<td>Password associated with the client ID.</td>
</tr>
</tbody>
</table>

d) Click **Submit**.

4. On the integration profile, click the **Get OAuth Token** related link.
5. In the pop-up window, select your Dropbox admin account and click **Allow**.
6. Click the **Get OAuth Token for reclamation** related link.
7. In the pop-up window, select your Dropbox admin account and click **Allow**.

**Note:** When user subscriptions are reclaimed, files from the reclaimed accounts are transferred to the admin account selected in this step. This account can be a different admin account than the one used to set up the integration. If you need to start transferring files to a new admin, you can click the **Get OAuth Token** and **Get OAuth Token for reclamation** related links again at any time to select a different admin.
account. After selecting a new admin, you can reclaim the old admin account to transfer all of their files to the new admin, including all previously reclaimed user files.

Software models, reclamation rules, user subscriptions, and stale user reclamation candidates are created automatically after the integration is connected and are refreshed daily.

It’s important that you review all automatically generated reclamation rules to ensure that they meet your specifications for reclaiming user subscriptions. For more information, see Review a software reclamation rule.

Create software entitlements for the automatically generated software models to track software used against software owned. For more information, see Record software rights and user allocations.

Create a G Suite integration profile

Create an integration profile to track software subscriptions and optimize stale licenses for the G Suite service.

Role required: sam_integrator or admin

For additional information about G Suite, see G Suite Admin Help.

1. Create a new project in the Google API Console.
   a) Log in to Google API Console.
   b) Click Select a project > New Project.
   c) Enter a name for your project and click Create.
   d) Click Credentials on the left navigation menu and then click the OAuth consent screen tab.
   e) Fill out the form as shown and click Save.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application type</td>
<td>Internal</td>
</tr>
<tr>
<td>Application name</td>
<td>Choose a name for your application</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scopes for Google APIs</td>
<td><a href="https://www.googleapis.com/auth/apps.licensing">https://www.googleapis.com/auth/apps.licensing</a></td>
</tr>
<tr>
<td></td>
<td><a href="https://www.googleapis.com/auth/admin.directory.user">https://www.googleapis.com/auth/admin.directory.user</a></td>
</tr>
<tr>
<td></td>
<td><a href="https://www.googleapis.com/auth/admin.directory.user.readonly">https://www.googleapis.com/auth/admin.directory.user.readonly</a></td>
</tr>
<tr>
<td></td>
<td><a href="https://www.googleapis.com/auth/admin.directory.domain.readonly">https://www.googleapis.com/auth/admin.directory.domain.readonly</a></td>
</tr>
<tr>
<td></td>
<td><a href="https://www.googleapis.com/auth/admin.datatransfer">https://www.googleapis.com/auth/admin.datatransfer</a></td>
</tr>
<tr>
<td></td>
<td><a href="https://www.googleapis.com/auth/admin.datatransfer.readonly">https://www.googleapis.com/auth/admin.datatransfer.readonly</a></td>
</tr>
<tr>
<td></td>
<td><a href="https://www.googleapis.com/auth/admin.reports.usage.readonly">https://www.googleapis.com/auth/admin.reports.usage.readonly</a></td>
</tr>
<tr>
<td></td>
<td><a href="https://www.googleapis.com/auth/userinfo.profile">https://www.googleapis.com/auth/userinfo.profile</a></td>
</tr>
<tr>
<td></td>
<td><a href="https://www.googleapis.com/auth/userinfo.email">https://www.googleapis.com/auth/userinfo.email</a></td>
</tr>
</tbody>
</table>

Note: To add the URLs, click Add scope and then click the manually paste hyperlink at the bottom of the pop-up window. After pasting all URLs, click Add.

Authorized domains | service-now.com

f) Click Create credentials > OAuth client ID.

g) Fill out the form as shown and click Create.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application type</td>
<td>Web application</td>
</tr>
<tr>
<td></td>
<td>Note: Selecting a value for this field causes the remaining fields to be displayed.</td>
</tr>
<tr>
<td>Name</td>
<td>Any name of your choice</td>
</tr>
<tr>
<td>Authorized JavaScript origins</td>
<td><a href="https://instance.service-now.com">https://instance.service-now.com</a>, where instance is the name of your ServiceNow instance</td>
</tr>
<tr>
<td>Authorized redirect URIs</td>
<td><a href="https://instance.service-now.com/oauth_redirect.do">https://instance.service-now.com/oauth_redirect.do</a>, where instance is the name of your ServiceNow instance</td>
</tr>
</tbody>
</table>

You can now view your client ID and client secret that you will use in your ServiceNow instance.
h) Click Library on the left navigation menu. Search for and enable the following APIs:

- Enterprise License Manager API
- Admin SDK
- Google People API

2. Return to your ServiceNow instance and create an integration profile.
   a) Navigate to SaaS License > Administration > Direct Integration Profiles and click New. Select the type of integration profile you want to create.
   b) On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the integration profile.</td>
</tr>
<tr>
<td>Client Id</td>
<td>Client ID for the OAuth application created in the SaaS admin account.</td>
</tr>
<tr>
<td>Redirect url</td>
<td>URL of the OAuth provider that you’re redirected to after authentication. This value is automatically populated.</td>
</tr>
<tr>
<td>Client secret</td>
<td>Password associated with the client ID.</td>
</tr>
<tr>
<td>Profile type</td>
<td>Type of integration profile. This value is automatically populated.</td>
</tr>
</tbody>
</table>

   c) Click Submit.

3. On the integration profile, click the Get OAuth Token related link.
4. In the pop-up window, select your Google admin account and click Allow.

   Note: When user subscriptions are reclaimed, files from the reclaimed accounts are transferred to the admin account selected in this step. This account can be a different admin account than the one used to set up the integration. If you need to start transferring files to a new admin, you can click the Get OAuth Token related link again at any time to select a different admin account. After selecting a new admin, you can reclaim the old admin account to transfer all of their files to the new admin, including all previously reclaimed user files.

Software models, reclamation rules, user subscriptions, and stale user reclamation candidates are created automatically after the integration is connected and are refreshed daily.

It’s important that you review all automatically generated reclamation rules to ensure that they meet your specifications for reclaiming user subscriptions. For more information, see Review a software reclamation rule.

Create software entitlements for the automatically generated software models to track software used against software owned. For more information, see Record software rights and user allocations.
Create a Jira Software Cloud integration profile

Create an integration profile to track software subscriptions and reclaim unused licenses for Atlassian Jira Software Cloud.

To create a Jira Software integration profile, request the Jira spoke app from the ServiceNow Store.

Role required: sam_integrator or admin

1. Create an API token in Atlassian.
   a) Navigate to Atlassian API Tokens.
   b) Click Create API token.
   c) Enter a name for your API token, then click Create.
   d) Copy the API token and save it. You will use the token later.

2. Return to your ServiceNow instance and create an integration profile.
   a) Navigate to SaaS License > Administration > Direct Integration Profiles and click New. Select Jira Integration Profile.
   b) On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of your choice. For example, Jira integration.</td>
</tr>
<tr>
<td>Connection &amp; Credential</td>
<td>sn_jira_spoke.Jira. This field is automatically populated.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the integration profile. The options are Draft and Published. This field is automatically populated.</td>
</tr>
<tr>
<td>Profile type</td>
<td>Jira Subscription. This field is automatically populated.</td>
</tr>
</tbody>
</table>

c) In the Calculate Activity Subflow form section, choose a value for the Analyze user activity from field.
   You can choose to start analyzing data from the current date or from up to 60 days in the past. Choosing a date in the past enables you to detect stale subscriptions without waiting in real time because you can see subscriptions that haven’t been used recently. Because choosing a date in the past increases the amount of data that’s analyzed, it could take several hours for you to be able to view the results.

   Note: After you save the integration profile, the Analyze user activity from field becomes read only.

d) Click Save.
   A draft integration profile is created. The integration profile uses the Jira Download Subscriptions, Jira Update User Activity, and Jira Reclaim Subscription subflows to get user data from the Jira Software application.
e) Open the Connection & Credential alias record by clicking the preview icon and then clicking Open Record.

f) Click the Create New Connection & Credential related link.

g) On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection URL</td>
<td><a href="https://site.atlassian.net">https://site.atlassian.net</a>, where site is the name of your Jira site.</td>
</tr>
<tr>
<td>User Name</td>
<td>Email address of the admin user that created the API token in Atlassian.</td>
</tr>
<tr>
<td>API Key</td>
<td>API token created in Atlassian.</td>
</tr>
</tbody>
</table>

h) Click Create.

i) Return to the integration profile and click Publish.

Software models, reclamation rules, user subscriptions, and stale user reclamation candidates are created automatically after the integration is connected and are refreshed daily.

It’s important that you review all automatically generated reclamation rules to ensure that they meet your specifications for reclaiming user subscriptions. For more information, see Review a software reclamation rule.

Create software entitlements for the automatically generated software models to track software used against software owned. For more information, see Record software rights and user allocations.

Create a Salesforce integration profile

Create an integration profile to track software subscriptions and optimize stale licenses for the Salesforce Sales Cloud and Salesforce Service Cloud services.

Role required: sam_integrator or admin

The Salesforce account you use to connect the integration requires a Salesforce user license and the following user access permissions.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permissions required for Discovery and reclamation</td>
<td>Enables access to Salesforce APIs.</td>
</tr>
<tr>
<td>API Enabled</td>
<td>Allows you to view Setup pages. When you enable this permission, Salesforce automatically enables the View Roles and Role Hierarchy permission.</td>
</tr>
</tbody>
</table>
For additional information on the Salesforce Sales Cloud and Salesforce Service Cloud, see the Salesforce Developer Documentation.

1. Register an application through the Salesforce admin portal.
   a) Log in to Salesforce and switch to the classic UI.
   b) Click Setup.
   c) From the left navigation menu, select Build > Create > Apps. In the Connected Apps section, click New.
   d) Fill out the following fields in the New Connected App form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connected App Name</td>
<td>Choose a name for your app.</td>
</tr>
<tr>
<td>API Name</td>
<td>Name of API. This field is automatically populated.</td>
</tr>
<tr>
<td>Contact Email</td>
<td>Email addressed associated with app.</td>
</tr>
<tr>
<td>Enable OAuth Setting</td>
<td>You must check the box to enable OAuth settings.</td>
</tr>
<tr>
<td>Callback URL</td>
<td><a href="https://instance.service-now.com/oauth_redirect.do">https://instance.service-now.com/oauth_redirect.do</a>, where instance is the name of your ServiceNow instance.</td>
</tr>
<tr>
<td>Selected OAuth Scopes</td>
<td>OAuth scopes that determine the amount of access that is granted to an access token. The following values are required:</td>
</tr>
<tr>
<td></td>
<td>• Access and manage your data (api)</td>
</tr>
<tr>
<td></td>
<td>• Perform requests on your behalf at any time (refresh_token, offline_access)</td>
</tr>
</tbody>
</table>
   e) Click Save.
   f) On the page for your new app, locate the Consumer Key and Consumer Secret. You will need to copy and paste these values into the Client ID and Client Secret fields in your ServiceNow instance in the following steps.

   **Note:** Your Consumer Key (client ID) and Consumer Secret (client secret) are sensitive. Don’t share them.

2. Return to your ServiceNow instance and create an integration profile.
   a) Navigate to SaaS License > Administration > Direct Integration Profiles and click New. Select the type of integration profile you want to create.
   b) On the form, fill in the fields.
Integration Profile form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the integration profile.</td>
</tr>
<tr>
<td>Client Id</td>
<td>Client ID for the OAuth application created in the SaaS admin account.</td>
</tr>
<tr>
<td>Redirect url</td>
<td>URL of the OAuth provider that you're redirected to after authentication. This value is automatically populated.</td>
</tr>
<tr>
<td>Client secret</td>
<td>Password associated with the client ID.</td>
</tr>
<tr>
<td>Profile type</td>
<td>Type of integration profile. This value is automatically populated.</td>
</tr>
</tbody>
</table>

c) Click Submit.

3. On the integration profile, click the Get OAuth Token related link and follow the steps to get an OAuth token.

Software models, reclamation rules, user subscriptions, and stale user reclamation candidates are created automatically after the integration is connected and are refreshed daily.

It's important that you review all automatically generated reclamation rules to ensure that they meet your specifications for reclaiming user subscriptions. For more information, see Review a software reclamation rule.

Create software entitlements for the automatically generated software models to track software used against software owned. For more information, see Record software rights and user allocations.

Create a Webex Meetings integration profile

Create an integration profile to track software subscriptions and reclaim unused licenses for the Cisco Webex Meetings application.

To create a Webex Meetings integration profile, request the Cisco Webex Meetings spoke app from the ServiceNow Store.

**Note:** This integration is for Webex Meetings and does not include Webex Teams.

Role required: sam_integrator or admin

1. Create an OAuth integration application in Cisco DevNet.
   a) Navigate to Cisco DevNet Webex Integration. Log in using the Login with Webex Meetings option.
   b) On the My App Information page, click Add App Information.
   c) On the form, fill in the fields.

New App Information form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration name</td>
<td>Name of your choice. For example, ServiceNow integration.</td>
</tr>
</tbody>
</table>
d) Click **Submit**.

e) Copy the Client ID and Client Secret and save them. You will use them later.

2. Return to your ServiceNow instance and create an integration profile.

   a) Navigate to **SaaS License** > **Administration** > **Direct Integration Profiles** and click **New**. Select **Webex Meetings Integration Profile**.

   b) On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of your choice. For example, Webex integration.</td>
</tr>
<tr>
<td>Connection &amp; Credential</td>
<td>sn_webex_mtg_spoke.Webex. This field is automatically populated.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the integration profile. The options are Draft and Published. This field is automatically populated.</td>
</tr>
<tr>
<td>Profile type</td>
<td>Webex Meetings Subscription. This field is automatically populated.</td>
</tr>
</tbody>
</table>

   c) In the **Calculate Activity Subflow** form section, choose a value for the **Analyze user activity from** field.

   You can choose to start analyzing data from the current date or from up to 60 days in the past. Choosing a date in the past enables you to detect stale subscriptions without waiting in real time because you can see subscriptions that haven't been used recently. Because choosing a date in the past increases the amount of data that is analyzed, it could take several hours for you to be able to view the results.

   **Note:** After you save the integration profile, the **Analyze user activity from** field becomes read only.

   d) Click **Save**.
A draft integration profile is created. The integration profile uses the Webex Download Subscriptions, Webex Update User Activity, and Webex Reclaim Subscription subflows to get user data from the Webex Meetings application.

e) Open the Connection & Credential record by clicking the preview icon and then clicking Open Record.

f) Click the Create New Connection & Credential related link.

g) On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Create Connection and Credential form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Connection URL</td>
</tr>
<tr>
<td>OAuth Client ID</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
</tr>
<tr>
<td>Email address</td>
</tr>
</tbody>
</table>

h) Click Create and Get OAuth Token and follow the steps to get an OAuth token.

i) Return to the integration profile and click Publish.

Software models, reclamation rules, user subscriptions, and stale user reclamation candidates are created automatically after the integration is connected and are refreshed daily.

It’s important that you review all automatically generated reclamation rules to ensure that they meet your specifications for reclaiming user subscriptions. For more information, see Review a software reclamation rule.

Create software entitlements for the automatically generated software models to track software used against software owned. For more information, see Record software rights and user allocations.

Create a Zoom integration profile

Create an integration profile to track software subscriptions and optimize stale licenses for the Zoom service.

Role required: sam_integrator or admin

For additional information about Zoom, see Zoom Developer Documentation.

1. Create an application in Zoom App Marketplace.
a) Navigate to Zoom App Marketplace and sign in to your account.
b) Click **Develop > Build App**.
c) For your app type, select **OAuth**.
d) On the form, fill in the fields and then click **Create**.

<table>
<thead>
<tr>
<th>Create an OAuth app</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>App Name</td>
</tr>
<tr>
<td>Choose app type</td>
</tr>
<tr>
<td>Would you like to publish this app on Zoom App Marketplace?</td>
</tr>
</tbody>
</table>

e) On the App Credentials page, obtain the Client ID and Client Secret. You will need to copy and paste these values into your ServiceNow instance in the following steps.

   **Note:**
   Your client ID and client secret are sensitive. Do not share them.

f) Enter `https://instance.service-now.com/oauth_redirect.do` in the **Redirect URL for OAuth** and **Whitelist URL** fields, where `instance` is the name of your ServiceNow instance.

g) Click the **Scopes** tab on the left navigation menu. Add the scopes `user:read:admin`, `user:write:admin`, and `report:read:admin`. These scopes enable the integration to get a list of users, get user activity, and reclaim unused subscriptions.

h) Click the **Activation** tab on the left navigation menu. Click **Install**.

2. Return to your ServiceNow instance and create an integration profile.
   a) Navigate to **SaaS License > Administration > Direct Integration Profiles** and click **New**. Select the type of integration profile you want to create.
   b) On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Integration Profile form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Display name</td>
</tr>
<tr>
<td>Client Id</td>
</tr>
<tr>
<td>Redirect url</td>
</tr>
<tr>
<td>Client secret</td>
</tr>
<tr>
<td>Profile type</td>
</tr>
</tbody>
</table>
You can choose to start analyzing data from the current date or from up to 60 days in the past. Choosing a date in the past enables you to detect stale subscriptions without waiting in real time because you can see subscriptions that haven’t been used recently. Because choosing a date in the past increases the amount of data that is analyzed, it could take several hours for you to be able to view the results.

c) Click **Submit**.

3. On the integration profile, click the **Get OAuth Token** related link and follow the steps to get an OAuth token.

Software models, reclamation rules, user subscriptions, and stale user reclamation candidates are created automatically after the integration is connected and are refreshed daily.

It’s important that you review all automatically generated reclamation rules to ensure that they meet your specifications for reclaiming user subscriptions. For more information, see **Review a software reclamation rule**.

Create software entitlements for the automatically generated software models to track software used against software owned. For more information, see **Record software rights and user allocations**.

### SaaS License Connections

To connect with a SaaS application that doesn’t have an existing integration in SaaS License Management, create a custom integration.

The low-code framework uses ServiceNow® IntegrationHub and ServiceNow® Flow Designer to connect with a SaaS provider’s API endpoints. Download a list of all users, view meaningful usage data, and optimize your SaaS spend by reclaiming unused subscriptions. Manage your custom SaaS connections along with the base system SaaS connections using Software Asset Management software models and reporting.

Install IntegrationHub Starter, Standard, Professional, or Enterprise to create a custom integration. There is no charge to install IntegrationHub plugins on a sub-production instance. Build a custom integration on a sub-production instance that has IntegrationHub installed, then bring it into your production environment using an update set. For more information about update sets, see **System update sets**. This way, you can validate your custom integrations before putting them in production and you’re not charged for an IntegrationHub subscription. For more information about IntegrationHub, see **Request IntegrationHub**.

**Note:** You can only create custom integrations for SaaS applications that use the User Subscription license metric. Other license metrics, such as DocuSign envelopes, are not supported.

Some SaaS applications have existing IntegrationHub spokes that you can use to create your custom integration. If there’s an existing spoke for the SaaS application that you’re integrating with, skip the step to create a custom spoke. If you use an existing spoke, you may also be able to use some of its data stream actions. Find out what actions are included with the spoke.
before creating your own actions. For a list of applications that have IntegrationHub spokes, see IntegrationHub available spokes.

Building a custom integration with SaaS License Connections requires you to keep track of many different values. Use the SaaS License Connections Worksheet while researching the SaaS API and building your data stream actions to make sure that you have all the information you need.

Create a custom spoke

To set up a custom integration in SaaS License Management, create a spoke to connect with a SaaS application.

Role required: admin

If there’s already a spoke for the SaaS application that you’re integrating with, you can use the existing spoke instead of creating one. For a list of applications that have ServiceNow IntegrationHub spokes, see IntegrationHub available spokes.

Use ServiceNow Studio to create a spoke. For more information about Studio, see ServiceNow Studio.

1. Navigate to System Applications > Studio.
2. Click Create Application.
3. Give your app a name that includes the name of the SaaS application that you’re integrating with and a description. Keep the auto-filled value for the Scope field.
4. Click Create.
5. Add the roles admin, sam_developer, and delegated_developer, then click Continue.
6. Select the Classic format, then click Continue.
7. Click Done with tables.
8. To close the session and create your app, click X.

Tip: You may have to refresh the page to see your new spoke app in the list of apps.

As you continue building your custom integration, use the spoke to save the following items.

- Connection & Credential alias
- Data stream actions to get users and user activity
- Action to reclaim a user

If you are publishing your custom spoke application on the ServiceNow Store, also use the spoke to save your subflows.

Create a custom integration profile

Create a custom integration profile to track software subscriptions and optimize stale licenses for any SaaS application.

Before you create a custom integration profile in your ServiceNow instance, set up a method of authentication in the SaaS application admin or developer account. For example, create an OAuth application or an API token.

If you create an OAuth application, make sure that you enable the appropriate scopes. The app needs scopes to read users, read user activity, and to modify or delete users. These scopes enable the integration to get a list of users, get user activity, and reclaim unused subscriptions. Record the client ID and client secret for the OAuth application. You will input these values in your ServiceNow instance.
If you create an API token, record the value for the API token. You will input this value in your ServiceNow instance.

Role required: sam_integrator or admin

1. Navigate to **SaaS License > Administration > Create New Profile** and select **Custom Integration Profile**.

2. On the form, fill in the fields.

### Integration Profile form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of your choice. For example, the name of the SaaS application that you're integrating with.</td>
</tr>
<tr>
<td>Connection &amp; Credential</td>
<td>Click the lookup icon then click <strong>New</strong>. On the Connection and Credential Aliases form, fill in the fields.</td>
</tr>
<tr>
<td></td>
<td>- Name: Name of your choice. For example, <strong>app_alias</strong>, where <strong>app</strong> is the name of the SaaS application that you're integrating with.</td>
</tr>
<tr>
<td></td>
<td>- Application: Spoke for connecting with the SaaS application. This spoke can be an existing IntegrationHub spoke or a new spoke that you created. You can change the application in the Developer section of the System Settings.</td>
</tr>
<tr>
<td></td>
<td>- Type: <strong>Connection and Credential</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Connection Type: <strong>HTTP</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Support Multiple Active Connections: Not selected.</td>
</tr>
<tr>
<td></td>
<td>- Default Retry Policy: <strong>Default HTTP Retry Policy</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Configuration Template: If you're using the OAuth authorization code grant type, <strong>OAuth Authorization Code</strong>. If you're using an API token, <strong>Basic Auth with API Key</strong>. If you're using another authentication method, create a configuration template. For more information, see Create a configuration template and Configure a template for OAuth JWT Bearer grant type.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the integration profile. The options are <strong>Draft</strong> and <strong>Published</strong>. This value is automatically populated.</td>
</tr>
<tr>
<td>Profile type</td>
<td>Custom Integration. This value is automatically populated.</td>
</tr>
</tbody>
</table>
3. Click **Save**.
4. Open the Connection & Credential alias record by clicking the preview icon
   and then clicking **Open Record**.
5. Click the **Create New Connection & Credential** related link.
6. If you’re using the OAuth Authorization Code configuration template, fill in the form as shown.

   ### Create Connection and Credential form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection URL</td>
<td>Base URL for the API.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>OAuth authorization code endpoint.</td>
</tr>
<tr>
<td>Token URL</td>
<td>OAuth endpoint to retrieve and refresh access tokens.</td>
</tr>
<tr>
<td>Token Revocation URL</td>
<td>Oauth endpoint to revoke access tokens.</td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
<td><code>https://instance.service-now.com/oauth_redirect.do</code>, where <code>instance</code> is the name of your ServiceNow instance.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>8640000.</td>
</tr>
<tr>
<td>OAuth Client ID</td>
<td>Client ID that you created in the SaaS application admin or developer account.</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
<td>Client secret that you created in the SaaS application admin or developer account.</td>
</tr>
<tr>
<td>OAuth Scopes</td>
<td>Scopes that you enabled for your OAuth application in the SaaS application admin or developer account.</td>
</tr>
</tbody>
</table>

7. If you’re using the Basic Auth with API Key configuration template, fill in the form as shown.

   ### Create Connection and Credential form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection URL</td>
<td>URL for your SaaS account.</td>
</tr>
<tr>
<td>User Name</td>
<td>Email address of the admin user that created the API token in the SaaS application admin or developer account.</td>
</tr>
<tr>
<td>API Key</td>
<td>API token created in the SaaS application admin or developer account.</td>
</tr>
</tbody>
</table>

**Note:** If you’re using a different method of authentication, the available fields are determined by the configuration template that you created.

8. Click **Create** and grant access for the integration.
Tip: Log in to your SaaS application admin account in a new browser tab to ensure that the integration connects to the correct account.

If the connection is successful, a new connection record is created in the Connections related list on the Connection & Credential Alias record. If the connection fails, you must delete the connection record, credential record, and application registry record that were created during the attempted connection.

- Navigate to **Connections & Credentials > Connections** and delete the connection record for the SaaS application.
- Navigate to **Connections & Credentials > Credentials** and delete the credential record for the SaaS application.
- Navigate to **System OAuth > Application Registry** and delete the application registry record for the SaaS application.

Return to the Connection & Credential Alias record for the SaaS application and click the **Create New Connection & Credential** related link to reattempt the connection.

### Create a data stream action to get users

Create a data stream action to get a list of user subscriptions from the SaaS application.

If you’re using an existing ServiceNow® IntegrationHub spoke, find out if it has a data stream action to get a list of users that you can use instead of creating one.

For more information about data stream actions, see [Data Stream actions](data_stream_actions).

Role required: flow_designer or admin

1. Navigate to **Flow Designer > Designer**.
2. Click **New** and then select **Data Stream**.
3. On the form, fill in the fields.

#### Action Properties form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your choice. For example, <strong>Get Users</strong>.</td>
</tr>
<tr>
<td>Accessible From</td>
<td>All application scopes.</td>
</tr>
<tr>
<td>Category</td>
<td>Leave this field empty.</td>
</tr>
<tr>
<td>Protection</td>
<td>None.</td>
</tr>
<tr>
<td>Application</td>
<td>Spoke app to integrate with the SaaS application. This spoke app can be an existing IntegrationHub spoke or a new spoke that you created.</td>
</tr>
<tr>
<td>In-Flow Annotation</td>
<td>Leave this field empty.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of your choice.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
5. If the API that you’re working with requires user authentication for requests, click **Inputs** in the Action Outline and add inputs for authentication.
Examples of common user authentication inputs are admin user id and site name. See the
documentation for your chosen API to learn about the requirements for user authentication
in your specific case. If the API requires an access token, a Credential Value variable is
automatically created later. You don’t need to add an access token as an input.

When you use your completed data stream action in a subflow, you define what values to
pass as these inputs.
6. Click Request in the Action Outline.
7. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>How will you get data</td>
<td>Choose either REST Step or SOAP step. Your choice depends on the API for the SaaS application that you’re integrating with.</td>
</tr>
<tr>
<td>Enable pagination</td>
<td>Selected.</td>
</tr>
<tr>
<td>Run a script before each request</td>
<td>Not selected.</td>
</tr>
</tbody>
</table>

8. Click Pagination Setup step in the Action Outline.
9. Define pagination variables based on the query parameters used by the SaaS API. If you’re
   using offset-based pagination, use the Limit / Offset pagination template to preload the
   pagination configuration.

   **Note:** The value of the reserved getNextPage variable determines whether to request
   another page of results. As long as the getNextPage variable is true, the action
   continues to send requests for the next page.

10. Write a Pagination Variables Script to update the pagination variables. The script runs on
each request. If you’re using a pagination template, adjust the preloaded script as needed.

   The following image shows a completed example of the pagination setup step. This example
   is from the Get Users data stream action used in the Webex Download Subscriptions subflow.
### 1. Pagination Setup step

#### Pagination Variables

<table>
<thead>
<tr>
<th>Name</th>
<th>Initial Value</th>
<th>Next Value From</th>
</tr>
</thead>
<tbody>
<tr>
<td>getNextPage</td>
<td>false</td>
<td>Script</td>
</tr>
<tr>
<td>startFrom</td>
<td>1</td>
<td>Script</td>
</tr>
<tr>
<td>pageSize</td>
<td>10</td>
<td>Script</td>
</tr>
<tr>
<td>total</td>
<td>20</td>
<td>Response Body</td>
</tr>
</tbody>
</table>

**Extract value using**: XML

**Expression**: `/message/body/bodyContent/matchingRecords/total`

#### Pagination Variables Script

```javascript
(function paginateVariables, pageResponse) {
    // Change the limit above to configure results per page.

    var startFrom = parseInt(variables.startFrom);
    var pageSize = parseInt(variables.pageSize);
    var variables.startFrom = startFrom + pageSize;
    variables.startFrom = variables.startFrom.toString();
    variables.getNextPage = (parseInt(variables.startFrom) <= parseInt(variables.total));
}
```
11. Click **SOAP step** or **REST step** in the Action Outline depending on the option that you selected for how you will get data.

12. If you selected **SOAP step**, fill in the form as shown.

**SOAP step form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Details</td>
<td>Use Connection Alias.</td>
</tr>
<tr>
<td>Connection</td>
<td>Connection alias that you created when you created the integration profile. If you have not yet created an integration profile, follow the steps to create a custom integration profile with a connection alias.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>This value is automatically populated when you select the connection alias. It’s set to the Connection URL from the HTTP(s) Connection record linked to the alias.</td>
</tr>
<tr>
<td>Request Details</td>
<td></td>
</tr>
<tr>
<td>Build Envelope</td>
<td>Manually.</td>
</tr>
<tr>
<td>SOAP Action</td>
<td>API request to get a list of all users. See the documentation for your chosen API to select the appropriate request.</td>
</tr>
<tr>
<td>SOAP Envelope</td>
<td>XML request message to get a list of all users. See the documentation for your chosen API to learn how to write an XML request message. In general, the header should have your input variables for user authentication as well as the Credential Value variable as the access token. The body should include the request to get a list of all users and your variables from the pagination setup step.</td>
</tr>
</tbody>
</table>

**Note:** For an example of a SOAP envelope, see the Get Users data stream action used in the Webex Download Subscriptions subflow.

13. If you selected **REST step**, fill in the form as shown.

**REST step form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Details</td>
<td>Use Connection Alias.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection alias that you created when you created the integration profile. If you have not yet created an integration profile, follow the steps to <a href="#">create a custom integration profile with a connection alias</a>.</td>
</tr>
<tr>
<td>Base URL</td>
<td>This value is automatically populated when you select the connection alias. It's set to the Connection URL from the HTTP(s) Connection record linked to the alias.</td>
</tr>
</tbody>
</table>

**Request Details**

<table>
<thead>
<tr>
<th>Build Request</th>
<th>Manually.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Path</td>
<td>Path to the resource. This value gets appended to the Base URL. See the documentation for the API that you're working with to learn how to construct the resource path.</td>
</tr>
<tr>
<td>HTTP Method</td>
<td>GET</td>
</tr>
<tr>
<td>Query Parameters</td>
<td>Add parameters for pagination. Set the values as the variables that you created in the pagination setup step.</td>
</tr>
</tbody>
</table>

The following image shows a completed example of the REST step. This example is from the Get Jira Users data stream action used in the Jira Download Subscriptions subflow.
14. Click Parsing in the Action Outline.
15. On the form, fill in the fields.
Parsing form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>How will you identify each record</td>
<td>JSON/XML Splitter</td>
</tr>
<tr>
<td>How will you parse each item into an object</td>
<td>Script Parser</td>
</tr>
</tbody>
</table>

16. Click **Splitter step** in the Action Outline.
17. On the form, fill in the fields.

### Splitter step

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Format</td>
<td>Select XML or JSON, depending on the format returned by the API response.</td>
</tr>
</tbody>
</table>
| Item Path | Absolute path to a user element in the response message. See the documentation for the API that you're working with for information about the format of the response message.  
- Example XML item path: `/message/body/user`  
- Example JSON item path: `$data.user` |

18. Click **Outputs** in the Action Outline.
19. Click **Create Output** and edit the variable as shown.

### Action Output

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetObject</td>
<td>targetObject</td>
<td>Object</td>
<td>No</td>
</tr>
</tbody>
</table>

20. Add child items for `targetObject` based on the user child elements returned in the response message.

For example, an XML response might look like this.

```xml
<message>
  <body>
    <user>
      <userID>12345</userID>
      <email>email@email.com</email>
      <firstName>Jane</firstName>
      <lastName>Doe</lastName>
      <lastLoginTime>08/13/2019 20:08:16</lastLoginTime>
      <active>TRUE</active>
    </user>
    ... 
  </user>
</body>
</message>
```

For this response, add the child items as shown.
Child items for targetObject

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>userID</td>
<td>userID</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>email</td>
<td>email</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>firstName</td>
<td>firstName</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>lastName</td>
<td>lastName</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>lastLoginTime</td>
<td>lastLoginTime</td>
<td>String</td>
<td>No</td>
</tr>
<tr>
<td>active</td>
<td>active</td>
<td>True/False</td>
<td>No</td>
</tr>
</tbody>
</table>

21. Click **Script Parser step** in the Action Outline.
22. Create a `targetObject` output object for each user element in the response. Map each user child element to a `targetObject` child item. The parser script is executed for each user element.

**Note:** These examples show the types of elements that are generally contained in a response to a get users request. Do not directly copy these scripts. Use element names from the documentation for the API that you're working with.

**Example script that parses an XML response.**

```javascript
(function parse(inputs, outputs) {
  var xmlDoc = new XMLDocument(inputs.sourceItem, false);
  outputs.targetObject.userID = xmlDoc.getNodeText('/user/userID');
  outputs.targetObject.email = xmlDoc.getNodeText('/user/email');
  outputs.targetObject.firstName = xmlDoc.getNodeText('/user/firstName');
  outputs.targetObject.lastName = xmlDoc.getNodeText('/user/lastName');
  outputs.targetObject.lastLoginTime = xmlDoc.getNodeText('/user/lastLoginTime');
  outputs.targetObject.active = xmlDoc.getNodeText('/user/active');
})(inputs, outputs)
```

**Example script that parses a JSON response.**

```javascript
(function parse(inputs, outputs) {
  var record = JSON.parse(inputs.sourceItem);
  outputs.targetObject.userID = record.userID;
  outputs.targetObject.email = record.email;
  outputs.targetObject.firstName = record.firstName;
  outputs.targetObject.lastName = record.lastName;
  outputs.targetObject.lastLoginTime = record.lastLoginTime;
  outputs.targetObject.active = record.active;
})(inputs, outputs)
```

23. To test your data stream action, click **Test**.
   a) View the test results and system logs for details about any errors.
      To view system logs, navigate to **System Logs > System Log > All**.
   b) If your data stream action has errors, make sure that you're using the correct endpoints and that the API requests and responses are structured as expected.
24. After verifying that the data stream action is working as expected, click **Publish**.

Create a subflow to get users

Create a subflow to add a list of users to the Software Subscription table.

This subflow requires a data stream action to get users. For more information, see *Create a data stream action to get users*.

Role required: flow_designer or admin

**Note:** For examples of subflows to get users, see the Jira Download Subscriptions and Webex Download Subscriptions subflows.

1. Navigate to **Flow Designer > Designer**.
2. Click **New** and then select **Subflow**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name of your choice. For example, <em>Application Download Subscriptions</em>, where <em>Application</em> is the name of the SaaS application that you're integrating with.</td>
</tr>
<tr>
<td><strong>Application</strong></td>
<td><em>Software Asset Management - SaaS License Management Integrations</em>.</td>
</tr>
<tr>
<td><strong>Accessible From</strong></td>
<td><em>All application scopes</em>.</td>
</tr>
<tr>
<td><strong>Category</strong></td>
<td>Leave this field empty.</td>
</tr>
<tr>
<td><strong>Protection</strong></td>
<td><strong>None</strong>.</td>
</tr>
<tr>
<td><strong>In-Flow Annotation</strong></td>
<td>Leave this field empty.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Description of your choice.</td>
</tr>
<tr>
<td><strong>Run As</strong></td>
<td><strong>User who initiates session</strong>.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
5. Add an integration profile input.
6. In the Actions section, click the plus icon and then click **Action** to add a new action.
7. Select the spoke for the SaaS application that you want to integrate with from the list of installed spokes.

**Note:** To add additional spokes to your list of installed spokes, request them on the ServiceNow Store. For a complete list of available spokes, see IntegrationHub available spokes. If there is no existing spoke for the SaaS application that you want to integrate with, you can create a new spoke.

8. Select a data stream action to get users.
9. Define the values to pass for any user authentication inputs for the data stream action.
10. The data stream action may return users that you don't want to include in your list of user subscriptions. If you need to perform filtering to exclude some users, add an If flow logic as a child of the get users data stream action.

   The amount of required filtering, if any, depends on the specific application you're integrating with. For example, if the user `targetObject` has an **active** property, you could add a condition to check that the value is **true** to ensure that the subflow doesn't download deactivated users. An example of filtering used by the Jira Download Subscriptions subflow is that the account type cannot be **app** to prevent the subflow from returning accounts that are not actual users.

   a) Add conditions to the If flow logic for any required filtering.

11. If you're using an If flow logic to filter users, add the **Upsert User Subscription** action from the Software Asset Management spoke as a child of the flow logic. If you're not filtering users, add the **Upsert User Subscription** action as a child of the get users data stream action.

   This action adds the SaaS application user subscription to the Software Subscription table (`samp_sw_subscription`). If the subscription is already in the table, the action updates the subscription record.

12. Use values from the Data panel to fill in the action inputs. Your request to the SaaS API may not return data for all the inputs. Fill in the inputs that are applicable to your integration.

**Upsert User Subscription action**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>External user id</td>
<td>User id or account id from the user <code>targetObject</code>. This is generally a numeric, non human-readable value.</td>
</tr>
<tr>
<td>User principal name</td>
<td>Email address from the user <code>targetObject</code>. If email address is not available, use another value such as user name plus user id. This value must be unique and should be human readable.</td>
</tr>
<tr>
<td>Integration profile (Integration Profile)</td>
<td>Integration profile input that you created for the subflow.</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product (Software Product)</td>
<td>Software product that you're connecting to with the integration. This value must be a reference to the Software Product table (samp_sw_product). If the product doesn't exist in the table, add a custom software product.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the SaaS application.</td>
</tr>
<tr>
<td>Edition</td>
<td>Edition of the SaaS application, such as Standard or Enterprise.</td>
</tr>
<tr>
<td>Last activity</td>
<td>Date of most recent activity from the user targetObject. For example, the last login time.</td>
</tr>
<tr>
<td>External created</td>
<td>Account creation date from the user targetObject. This value helps create better reclamation candidates. A new user may not have any activity yet. If the record shows that the user account was created, a reclamation candidate won't be created for that user because it's a new account rather than an unused account.</td>
</tr>
</tbody>
</table>

13. To test your subflow, click **Test**.
   a) View the test results and system logs for details about any errors. To view system logs, navigate to **System Logs > System Log > All**.

   ![Note](image)
   **Note:** The data stream action to get users should retrieve multiple pages of users successfully. Don't write to the Software Subscription table (samp_sw_subscription) until you verify that the data stream action retrieves all users. To verify, you can make a subflow that consumes the data stream and log the results.

14. After verifying that the subflow is working as expected, click **Publish**.

   ![Tip](image)
   **Tip:** You can still edit the subflow after it's published.

### Create a data stream action to get user activity

Create a data stream action to get user activity from a SaaS application.

If you're using an existing ServiceNow® IntegrationHub spoke, find out if it has a data stream action to get user activity that you can use instead of creating one.

For more information about data stream actions, see **Data Stream actions**.

Role required: flow_designer or admin

Monitor user activity to find software subscriptions that your company is paying for but are not being used. You can reclaim these unused subscriptions to reduce your company's software expenses.

Before creating the data stream action, decide how you want to define meaningful user activity. Meaningful activity can be a combination of user actions. Create a separate data stream action...
for each user activity metric. For example, the base system Webex Meetings integration defines meaningful activity as hosting a meeting. It uses one data stream action to get the dates of the most recently hosted meetings for all users. If you also wanted the Webex Meetings integration to include logging in as meaningful activity, you would create a second data stream action to get the most recent login times for all users.

Your data stream action to get users may return a user activity metric such as last login time. In this case, you don’t need to create a data stream action to get user activity or a subflow to get user activity unless you want to define additional user activity metrics. Make sure that your subflow to get users sets this user activity metric as the Last activity input in the Upsert User Subscription action.

1. Navigate to Flow Designer > Designer.
2. Click New and then select Data Stream.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your choice. For example, Get User Activity.</td>
</tr>
<tr>
<td>Accessible From</td>
<td>All application scopes.</td>
</tr>
<tr>
<td>Category</td>
<td>Leave this field empty.</td>
</tr>
<tr>
<td>Protection</td>
<td>None.</td>
</tr>
<tr>
<td>Application</td>
<td>Spoke app to integrate with the SaaS application. This spoke app can be an existing IntegrationHub spoke or a new spoke that you created.</td>
</tr>
<tr>
<td>In-Flow Annotation</td>
<td>Leave this field empty.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of your choice.</td>
</tr>
</tbody>
</table>

4. Click Submit.
5. In the Inputs section of the Action Outline, click Create Input.
6. Add a look back time input.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look back time</td>
<td>look_back_time</td>
<td>Date/Time</td>
<td>Yes</td>
</tr>
</tbody>
</table>

7. If the API that you’re working with requires user authentication for requests, add inputs for authentication.

Examples of common user authentication inputs are admin user id and site name. See the documentation for your chosen API to learn about the requirements for user authentication in your specific case. If the API requires an access token, a Credential Value variable is automatically created later. You don’t need to add an access token as an input.

When you use your completed data stream action in a subflow, you define what values to pass as these inputs.

8. Click Request in the Action Outline.
Request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>How will you get data</td>
<td>Choose either REST Step or SOAP step. Your choice depends on the API for the SaaS application that you’re integrating with.</td>
</tr>
<tr>
<td>Enable pagination</td>
<td>Selected.</td>
</tr>
<tr>
<td>Run a script before each request</td>
<td>Not selected.</td>
</tr>
</tbody>
</table>

10. Click **Pagination Setup step** in the Action Outline.
11. Define pagination variables based on the query parameters used by the SaaS API. If you’re using offset-based pagination, use the Limit / Offset pagination template to preload the pagination configuration.

**Note:** The value of the reserved `getNextPage` variable determines whether to request another page of results. As long as the `getNextPage` variable is `true`, the action continues to send requests for the next page.

12. Write a Pagination Variables Script to update the pagination variables. The script runs on each request. If you’re using a pagination template, adjust the preloaded script as needed.

The following image shows a completed example of the pagination setup step. This example is from the Get Users data stream action used in the Webex Download Subscriptions subflow.
1. Pagination Setup step

**Pagination Variables**

<table>
<thead>
<tr>
<th>Name</th>
<th>Initial Value</th>
<th>Next Value From</th>
</tr>
</thead>
<tbody>
<tr>
<td>getNextPage</td>
<td>false</td>
<td>Script</td>
</tr>
<tr>
<td>startFrom</td>
<td>1</td>
<td>Script</td>
</tr>
<tr>
<td>pageSize</td>
<td>10</td>
<td>Script</td>
</tr>
<tr>
<td>total</td>
<td>20</td>
<td>Response Body</td>
</tr>
</tbody>
</table>

**Extract value using** XML

**Expression** `message/body/bodyContent/matchingRecords/total`

**Pagination Variables Script**

```javascript
(function paginateVariables, pageResponse) {
    // Change the limit above to configure results per page.

    var startFrom = parseInt(variables.startFrom);
    var pageSize = parseInt(variables.pageSize);
    variables.startFrom = startFrom + pageSize;
    variables.startFrom = variables.startFrom.toString();
    variables.getNextPage = (parseInt(variables.startFrom) <= parseInt(variables.total));
}(variables, pageResponse);
```
13. Click **SOAP step** or **REST step** in the Action Outline depending on the option that you selected for how you will get data.

14. If you selected **SOAP**, fill in the form as shown.

**SOAP step form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Details</strong></td>
<td></td>
</tr>
<tr>
<td>Connection</td>
<td><strong>Use Connection Alias.</strong></td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection alias that you created when you created the integration profile. If you have not yet created an integration profile, follow the steps to create a custom integration profile with a connection alias.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>This value is automatically populated when you select the connection alias. It's set to the Connection URL from the HTTP(s) Connection record linked to the alias.</td>
</tr>
</tbody>
</table>

| Request Details       | Manually.                                                             |
| SOAP Action          | API request to get a list of meaningful user activity. For example, the base system Webex Meetings integration defines meaningful user activity as hosting a meeting so that it uses the `ListSummaryMeeting` request to get a list of all meetings. See the documentation for your chosen API to select the appropriate request. |
| SOAP Envelope        | XML request message to get a list of all users. See the documentation for your chosen API to learn how to write an XML request message. In general, the header should have your input variables for user authentication as well as the **Credential Value** variable as the access token. The body should include the request to get a list of meaningful user activities, a start date set as the **Look back time** input, and your variables from the pagination setup step. |

**Note:** For an example of a SOAP envelope, see the Get User Activity data stream action used in the Webex Update User Activity subflow.

15. If you selected **REST**, fill in the form as shown.
REST step form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Details</td>
<td></td>
</tr>
<tr>
<td>Connection</td>
<td>Use Connection Alias.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Connection alias that you created when you created the integration profile. If you have not yet created an integration profile, follow the steps to create a custom integration profile with a connection alias.</td>
</tr>
<tr>
<td>Base URL</td>
<td>This value is automatically populated when you select the connection alias. It’s set to the Connection URL from the HTTP(s) Connection record linked to the alias.</td>
</tr>
<tr>
<td>Request Details</td>
<td></td>
</tr>
<tr>
<td>Build Request</td>
<td>Manually.</td>
</tr>
<tr>
<td>Resource Path</td>
<td>Path to the resource. This value gets appended to the Base URL. See the documentation for the API that you’re working with to learn how to construct the resource path.</td>
</tr>
<tr>
<td>HTTP Method</td>
<td>GET.</td>
</tr>
<tr>
<td>Query Parameters</td>
<td>Add parameters for pagination. Set the values as the variables that you created in the Pagination Setup step. Add another parameter for the start date so that the request returns results from the start date to the current date. Set the value as the Look back time input.</td>
</tr>
</tbody>
</table>

Note: Make sure the Look back time input date/time variable is correctly formatted for the API that you’re working with. If you need to reformat or convert to another data type such as a string, you can do this in the action preprocessing script step.

The following image shows a completed example of the REST step. This example is from the Get Audit Log data stream action used in the Jira Update User Activity subflow.
16. Click **Parsing** in the Action Outline.

17. On the form, fill in the fields.

© 2020 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Parsing form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>How will you identify each record</td>
<td>JSON/XML Splitter</td>
</tr>
<tr>
<td>How will you parse each item into an object</td>
<td>Script Parser</td>
</tr>
</tbody>
</table>

18. Click **Splitter step** in the Action Outline.

19. On the form, fill in the fields.

**Splitter step form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Format</td>
<td>Select XML or JSON depending on the format returned by the API response.</td>
</tr>
<tr>
<td>Item Path</td>
<td>Absolute path to a meaningful activity element in the response message. See the documentation for the API that you're working with for information about the format of the response message.</td>
</tr>
<tr>
<td></td>
<td>• Example XML item path: /message/body/meeting</td>
</tr>
<tr>
<td></td>
<td>• Example JSON item path: $.data.meeting</td>
</tr>
</tbody>
</table>

20. Click **Outputs** in the Action Outline.

21. Click **Create Output** and edit the variable as shown.

**Action Output**

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetObject</td>
<td>targetObject</td>
<td>Object</td>
<td>No</td>
</tr>
</tbody>
</table>

22. Add child items for `targetObject` to store the user email and the date of meaningful activity. For example, an XML response might look like this.

```xml
<message>
  <body>
    <meeting>
      <meetingID>12345</meetingID>
      <startDate>08/13/2019 20:08:16</startDate>
      <hostEmail>email@email.com</hostEmail>
    </meeting>
    <meeting>
      ...
    </meeting>
  </body>
</message>
```

For this response, add the child items as shown.
23. In the Action Outline, click **Script Parser step**.
24. Create a `targetObject` output object for each meaningful activity element in the response. Map each the activity date and user email to the `targetObject` child items.

   The parser script is executed for each user element.

   **Note:** These examples show the types of elements that could be contained in a response. Don't directly copy these scripts. Use element names from the documentation for the API that you're working with.

   **Example script that parses an XML response.**

   ```javascript
   (function parse(inputs, outputs) {
       var xmlDoc = new XMLDocument(inputs.sourceItem, false);
       outputs.targetObject.email = xmlDoc.getNodeText('/meeting/hostEmail');
       outputs.targetObject.last_activity = xmlDoc.getNodeText('/meeting/startDate');
   })(inputs, outputs)
   ```

   **Example script that parses a JSON response.**

   ```javascript
   (function parse(inputs, outputs) {
       var record = JSON.parse(inputs.sourceItem);
       outputs.targetObject.email = record.hostEmail;
       outputs.targetObject.last_activity = record.startDate;
   })(inputs, outputs)
   ```

25. To test your data stream action, click **Test**.
   
   a) View the test results and system logs for details about any errors.
     
     To view system logs, navigate to **System Logs > System Log > All**.
   
   b) If your data stream action has errors, make sure that you're using the correct endpoints and that the API requests and responses are structured as expected.

26. After verifying that the data stream action is working as expected, click **Publish**.

**Create a subflow to get user activity**

Create a subflow to update the Software Subscription table with each user's most recent activity in the SaaS application.

This subflow requires a data stream action to get user activity. For more information, see *Create a data stream action to get user activity*.

Role required: flow_designer or admin
1. Navigate to Flow Designer > Designer.
2. Click New and then select Subflow.
3. On the form, fill in the fields.

Subflow Properties form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your choice. For example, Application Update User Activity, where Application is the name of the SaaS application you are integrating with.</td>
</tr>
<tr>
<td>Application</td>
<td>Software Asset Management - SaaS License Management Integrations.</td>
</tr>
<tr>
<td>Accessible From</td>
<td>All application scopes.</td>
</tr>
<tr>
<td>Category</td>
<td>Leave this field empty.</td>
</tr>
<tr>
<td>Protection</td>
<td>None.</td>
</tr>
<tr>
<td>In-Flow Annotation</td>
<td>Leave this field empty.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of your choice.</td>
</tr>
<tr>
<td>Run As</td>
<td>User who initiates session.</td>
</tr>
</tbody>
</table>

4. Click Submit.
5. Add an integration profile input and a look back time input.

Inputs

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration profile</td>
<td>integration_profile</td>
<td>Reference.Integration Profile</td>
<td>Yes</td>
</tr>
<tr>
<td>Look back time</td>
<td>look_back_time</td>
<td>Date/Time</td>
<td>Yes</td>
</tr>
</tbody>
</table>

6. In the Actions section, click the plus icon and then click Action to add a new action.
7. Select the spoke for the SaaS application that you want to integrate with from the list of installed spokes.
8. Select a data stream action to get user activity.
9. Add the **Look back time** subflow input as the value to pass to the **Look back time** input for the data stream action.
10. Define the values to pass for any user authentication inputs for the data stream action.
11. Add the **Update User Activity If Later** action from the Software Asset Management spoke as a child of the get user activity data stream action.
12. Use values from the Data panel to complete the action.

**Update User Activity If Later action**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last activity</td>
<td>Date of most recent activity from the targetObject.</td>
</tr>
<tr>
<td>Product (Software Product)</td>
<td>Software product that you're connecting to with the integration. This value must be a reference to the Software Product table (samp_sw_product). If the product doesn't exist in the table, add a custom software product.</td>
</tr>
<tr>
<td>External user id</td>
<td>User id or account id from the user targetObject. This is generally a numeric, non human-readable value.</td>
</tr>
<tr>
<td>User principal name</td>
<td>Email address from the user targetObject. If email address is not available, use another value such as user name plus user id. This value must be unique and should be human readable.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the SaaS application.</td>
</tr>
<tr>
<td>Edition</td>
<td>Edition of the SaaS application, such as Standard or Enterprise.</td>
</tr>
</tbody>
</table>

13. If you want to use more than one data stream action to get multiple types of user activity, repeat steps 6 - 12 to add each data stream action to the subflow.
14. Click **Test** to test your subflow.
   a) View the test results and system logs for details about any errors.

   To view system logs, navigate to System Logs > System Log > All.
15. After verifying that the subflow is working as expected, click **Publish**.

**Tip:** You can still edit the subflow after it's published.

**Create an action to remove a user**

Create an action to deactivate or delete a user account in the SaaS application.
If you're using an existing ServiceNow® IntegrationHub spoke, find out if it has an action to remove a user that you can use instead of creating one.

Role required: flow_designer or admin

This action is used to reclaim unused subscriptions to reduce your company's software expenses.

1. Navigate to Flow Designer > Designer.
2. Click New and then select Action.
3. On the form, fill in the fields.

   **Action Properties form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your choice. For example, Remove User.</td>
</tr>
<tr>
<td>Accessible From</td>
<td>All application scopes.</td>
</tr>
<tr>
<td>Category</td>
<td>Leave this field empty.</td>
</tr>
<tr>
<td>Protection</td>
<td>None.</td>
</tr>
<tr>
<td>Application</td>
<td>Spoke app to integrate with the SaaS application. This can be an existing IntegrationHub spoke or a new spoke that you created.</td>
</tr>
<tr>
<td>In-Flow Annotation</td>
<td>Leave this field empty.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of your choice.</td>
</tr>
</tbody>
</table>

4. Click Submit.
5. In the Inputs section of the Action Outline, click Create Input.
6. Add a user ID input. This is how the action gets the user ID of the user to delete.

   **Inputs**

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>userID</td>
<td>String</td>
<td>Yes</td>
</tr>
</tbody>
</table>

7. If the API that you're working with requires user authentication for requests, add inputs for authentication.

   Examples of common user authentication inputs are admin user id and site name. See the documentation for your chosen API to learn about the requirements for user authentication in your specific case. If the API requires an access token, a Credential Value variable is automatically created later so you don't need to add it as an input.

   When you use your completed action in a subflow, you define what values to pass as these inputs.

8. Add a SOAP step or REST step to the action outline. Your choice will depend on the API for the SaaS application that you're integrating with.

9. If you selected SOAP, fill in the form as shown.

   **SOAP step form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Details</td>
<td></td>
</tr>
</tbody>
</table>
### Connection Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection</strong></td>
<td><strong>Use Connection Alias.</strong></td>
</tr>
<tr>
<td><strong>Connection Alias</strong></td>
<td>Connection alias that you created when you created the integration profile. If you have not yet created an integration profile, follow the steps to create a custom integration profile with a connection alias.</td>
</tr>
<tr>
<td><strong>Endpoint</strong></td>
<td>This value is automatically populated when you select the connection alias. It's set to the Connection URL from the HTTP(s) Connection record linked to the alias.</td>
</tr>
<tr>
<td><strong>Request Details</strong></td>
<td></td>
</tr>
<tr>
<td>Build Envelope</td>
<td>Manually.</td>
</tr>
<tr>
<td><strong>SOAP Action</strong></td>
<td>API request to delete or deactivate a user. See the documentation for your chosen API to select the appropriate request.</td>
</tr>
<tr>
<td><strong>SOAP Envelope</strong></td>
<td>XML request message to delete a user. See the documentation for your chosen API to learn how to write an XML request message. In general, the header should have your input variables for user authentication as well as the Credential Value variable as the access token. The body should include the request to delete a user and the user ID input.</td>
</tr>
</tbody>
</table>

*Note: For an example of a SOAP envelope, see the Remove User action used in the Webex Reclaim Subscription subflow.*

10. If you selected REST, fill in the form as shown.

#### REST step form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Details</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Connection</strong></td>
<td><strong>Use Connection Alias.</strong></td>
</tr>
<tr>
<td><strong>Connection Alias</strong></td>
<td>Connection alias that you created when you created the integration profile. If you have not yet created an integration profile, follow the steps to create a custom integration profile with a connection alias.</td>
</tr>
<tr>
<td><strong>Base URL</strong></td>
<td>This value is automatically populated when you select the connection alias. It's set to the Connection URL from the HTTP(s) Connection record linked to the alias.</td>
</tr>
<tr>
<td><strong>Request Details</strong></td>
<td></td>
</tr>
<tr>
<td>Build Request</td>
<td>Manually.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Resource Path</td>
<td>Path to the resource. This value gets appended to the Base URL. See the documentation for the API that you’re working with to learn how to construct the resource path.</td>
</tr>
<tr>
<td>HTTP Method</td>
<td>DELETE.</td>
</tr>
<tr>
<td>Query Parameters</td>
<td>Add a parameter for user ID. Set the value as the user ID input.</td>
</tr>
</tbody>
</table>

11. Add a **Script step** to the Action Outline for error handling.

a) For **Required Runtime**, select **Instance**.

b) Create input variables.

**Input Variables**

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>response</td>
<td>Response Body output from the SOAP or REST step</td>
</tr>
<tr>
<td>status_code</td>
<td>Status Code output from the SOAP or REST step</td>
</tr>
</tbody>
</table>

c) Create output variables.

**Output Variables**

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>status</td>
<td>status</td>
<td>Choice</td>
<td>Yes</td>
</tr>
<tr>
<td>error_message</td>
<td>error_message</td>
<td>String</td>
<td>Yes</td>
</tr>
</tbody>
</table>

d) In the **Script** field, write a script to assign values to the status and error message outputs.

- Use the `status_code` input to check if there is an error. Set the status output equal to **Error** if there is an error and **Success** if there is no error.
- In cases where there is an error, use the `response` input to get information about the kind of error. Set the `error_message` output to a description of the error so that a user can understand what went wrong.

12. In the Action Outline, click **Outputs**.

13. Create output variables.

**Output Variables**

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>status</td>
<td>Choice</td>
<td>No</td>
</tr>
<tr>
<td>Error message</td>
<td>error_message</td>
<td>String</td>
<td>No</td>
</tr>
</tbody>
</table>

14. Assign values to the output variables.
Output Variables

<table>
<thead>
<tr>
<th>Label</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>status output variable from the script step</td>
</tr>
<tr>
<td>Error message</td>
<td>error_message output variable from the script step</td>
</tr>
</tbody>
</table>

15. To test your action, click Test.
   a) View the test results and system logs for details about any errors.
      To view system logs, navigate to System Logs > System Log > All.
   b) If your action has errors, make sure that you’re using the correct endpoints and that the API request is structured as expected.

Note: When testing, remember that this action deactivates a user. Test this action in a sub-production environment. If only a production environment is available, you can create fake users for testing.

16. After verifying that the action is working as expected, click Publish.

Create a subflow to reclaim a user

Create a subflow to reclaim a user subscription.

This subflow requires an action to remove a user. For more information, see Create an action to remove a user.

Role required: flow_designer or admin

Note: For examples of subflows to reclaim a user, see the Jira Reclaim Subscription and Webex Reclaim Subscription subflows.

1. Navigate to Flow Designer > Designer.
2. Click New and then select Subflow.
3. On the form, fill in the fields.

Subflow Properties form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your choice. For example, Application Reclaim Subscription, where Application is the name of the SaaS application you are integrating with.</td>
</tr>
</tbody>
</table>
4. Add an integration profile input and a user subscription input.

**Inputs**

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration profile</td>
<td>integration_profile</td>
<td>Reference.Integration Profile</td>
<td>Yes</td>
</tr>
<tr>
<td>User subscription</td>
<td>user_subscription</td>
<td>Reference.Software Subscription</td>
<td>Yes</td>
</tr>
</tbody>
</table>

5. Add an error message output and a status output.

**Outputs**

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error message</td>
<td>error_message</td>
<td>String</td>
</tr>
<tr>
<td>Status</td>
<td>status</td>
<td>String</td>
</tr>
</tbody>
</table>

6. In the Actions section, click the plus icon and then click **Action** to add a new action.
7. In the list of installed spokes, select the spoke for the SaaS application that you’re integrating with.

**Note:** To add additional spokes to your list of installed spokes, request them on the ServiceNow Store. For a complete list of available spokes, see IntegrationHub available spokes. If there’s no existing spoke for the SaaS application that you want to integrate with, you can create a new spoke.
8. To remove a user, select an action.
   a) Define the value to pass as the **User ID** input. The value that you use depends on the API that you're working with, but it will generally be the **External user ID** or **User principal name** field from the **User subscription** input for this subflow.
   
   b) Define the values to pass for any user authentication inputs for the action.

9. To check if the Remove User action returns an error, add an If flow logic.
10. Add a child flow logic to assign subflow outputs.

### Assign Subflow Outputs

<table>
<thead>
<tr>
<th>Name</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error message</td>
<td>Error message output from the Remove User action</td>
</tr>
<tr>
<td>Status</td>
<td>failure</td>
</tr>
</tbody>
</table>

11. Add an Else flow logic at the same level as the If logic for cases when the Remove User action doesn't return an error.
12. Add a child flow logic to assign subflow outputs.

### Assign Subflow Outputs

<table>
<thead>
<tr>
<th>Name</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>success</td>
</tr>
</tbody>
</table>

The following image shows a completed example of a subflow to reclaim a user subscription. The example shown is the Webex Reclaim Subscription subflow.
13. To test your subflow, click **Test**.
   a) View the test results and system logs for details about any errors.
      To view system logs, navigate to **System Logs > System Log > All**.

   **Note:** When testing, remember that this subflow deactivates a user. Test this subflow in a sub-production environment. If only a production environment is available, you can create fake users for testing.

14. After verifying that the subflow is working as expected, click **Publish**.

   **Tip:** You can still edit the subflow after it's published.

**Publish a custom integration profile**

Publish a custom integration profile to complete the custom integration.
Make sure that all actions and subflows are published in ServiceNow® Flow Designer before adding them to the integration profile.

Role required: sam_integrator or admin

1. Navigate to SaaS License > Administration > All Integration Profiles and select the custom integration profile that you created.
2. In the Download Subscription Subflow form section, select the Download Subscriptions subflow for the SaaS application.
3. Click Publish.
   A software model is automatically created for the SaaS application. A scheduled job is created to immediately run the Download Subscription Subflow, which adds user subscriptions for the SaaS application to the Software Subscription table (samp_sw_subscription).
4. In the Calculate Activity Subflow form section, select the Update User Activity subflow for the SaaS application.

Note: The scheduled job to get user subscriptions must finish before you can add the Update User Activity subflow.

5. Choose a value for the Analyze user activity from field.
   You can choose to start analyzing data from the current date or from up to 60 days in the past. Choosing a date in the past enables you to detect stale subscriptions without waiting in real time because you can see subscriptions that haven’t been used recently. Because choosing a date in the past increases the amount of data that is analyzed, it could take several hours for you to be able to view the results.
   This value is passed as the Look back time input for the subflow to get user activity.
6. In the Reclaim Subscription Subflow form section, select the Reclaim Subscription subflow for the SaaS application.
7. Click Save.

Reclamation rules and stale user reclamation candidates are created automatically after the integration is connected. User subscriptions and reclamation candidates are refreshed daily.

It’s important that you review all automatically generated reclamation rules to ensure that they meet your specifications for reclaiming user subscriptions. For more information, see Review a software reclamation rule.

Create software entitlements for the automatically generated software models to track software used against software owned. For more information, see Record software rights and user allocations.

Create a store app for a custom integration

Publish your custom integration application on the ServiceNow Store to make it available for others to use.

Role required: admin

You must complete these steps so that your custom integration works correctly when other users download it from the ServiceNow Store.

1. Create a fix script in your custom integration application.
   When a new integration profile is created using your application, the subflows and connection alias you created are automatically linked to the profile through this fix script.
   a) Navigate to System Applications > Studio.
   b) Select your custom integration application.
c) On the Welcome to Studio page, click + Create New. The Create Application File dialog box opens.

d) On the dialog box, search for and select Fix Script.

e) Click Create.

f) On the Fix Script form, fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the fix script. For example, Custom Integration Fix Script.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that enables the fix script. This option is enabled by default.</td>
</tr>
<tr>
<td>Unloadable</td>
<td>Option to create Customer Update (sys_update_xml) records when the fix script runs. Do not select this option.</td>
</tr>
<tr>
<td>Application</td>
<td>Your custom integration application. This field is populated automatically.</td>
</tr>
<tr>
<td>Run once</td>
<td>Option to run the fix script only one time. If you enable this option, the fix script is ignored during subsequent upgrades. This option is enabled by default. Do not enable this option if you want the script to run every time the application is installed or upgraded.</td>
</tr>
<tr>
<td>Flush cache</td>
<td>Option to require a cache flush after the application is installed or upgraded.</td>
</tr>
<tr>
<td>Before</td>
<td>Option that enables you to run the fix script before installing or upgrading the application. Do not select this option.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the fix script.</td>
</tr>
</tbody>
</table>

g) Enter the following script in the Script field. For the subflows and connection alias, replace the example ids with the real ids. You can find the id in the URL for each item.

```javascript
new global.CustomIntegrationProfileUtils().createCustomIntegration({
  name: 'Name', // choose a name for the integration
  downloadSubscriptionSubflow: '3a23e189a1400010fa9bed1383c83d38', // replace example id
  updateActivitySubflow: '77a66d23e5500010fa9bc9581d0c0f47', //replace example id
  reclamationSubflow: 'e62b672e39400010fa9b4845e477fe02', //replace example id
  connectionAlias: '629ad2bfdb1893005963ff041d961971' //replace example id
});
```

<i>Note:</i> The update activity and reclamation subflows are not required. If you do not include a subflow to update activity, the integration does not get user activity unless your download subscription subflow includes user activity. If you do not
Include a reclamation subflow, the integration cannot deactivate SaaS user subscriptions.

h) Click Submit.

2. Create a cross scope privilege record.
   This record allows the fix script you created to access the CustomIntegrationProfileUtils() script include.
   a) Navigate to System Applications > Application Cross-Scope Access.
   b) Click New.
   c) On the form, fill in the fields.

   Cross scope privilege

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Scope</td>
<td>Your custom integration application. This field is populated automatically. To select a different application, click the Settings (⚙️) icon on the banner frame of your ServiceNow instance. On the System Settings dialog box, select the Developer tab and then choose an application from the Application dropdown list.</td>
</tr>
<tr>
<td>Target Scope</td>
<td>Application from which resources are being requested. Click the search (🔍) icon to locate and select the Global application.</td>
</tr>
<tr>
<td>Target Name</td>
<td>Name of the script include. Set this field to CustomIntegrationProfileUtils.</td>
</tr>
<tr>
<td>Target Type</td>
<td>Type of request. Select Script Include.</td>
</tr>
<tr>
<td>Application</td>
<td>Your custom integration application. This field is populated automatically.</td>
</tr>
<tr>
<td>Operation</td>
<td>Operation that the script performs on the target scope. Select Execute API.</td>
</tr>
<tr>
<td>Status</td>
<td>Authorization for this cross scope privilege record. Select Allowed.</td>
</tr>
</tbody>
</table>

d) Click Submit.

Before you publish your custom integration application on the ServiceNow Store, make sure that your actions and subflows are active, published, and saved in your application.
Integrate with SSO providers

Integrate with a Single Sign-On (SSO) provider to view software usage for all connected SSO applications.

Download a list of all your applications, users, and groups. Track user login data for all connected applications and reclaim unused licenses. Leverage usage data to forecast future licensing needs and cut back on unused licenses at renewal.

Integrate with Azure AD

Integrate with Microsoft Azure Active Directory (AD) to view software usage for all connected SSO applications.

Create an Azure AD application

Create an app in the Microsoft Azure portal to integrate with the Now Platform.

You must have Azure AD admin credentials to create an application.

1. From the Azure portal, access Azure Active Directory.
2. Create an Azure AD application.
   
   See Create an Azure Active Directory application for detailed instructions on registering and configuring an application.

   a) In the Redirect URI field, enter https://<instance-name>.service-now.com/oauth_redirect.do, where <instance-name> is the name of your ServiceNow instance.

   b) Record the application (client) ID and directory (tenant) ID to register the app as a third-party OAuth provider on your ServiceNow instance.

   c) Create a client secret and record the value to register the app as a third-party OAuth provider on your ServiceNow instance.

   d) Add permissions to access the Microsoft Graph API.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>AuditLog.Read.All</td>
<td>Delegated</td>
</tr>
<tr>
<td>Directory.AccessAsUser.All</td>
<td>Delegated</td>
</tr>
<tr>
<td>Directory.Read.All</td>
<td>Delegated</td>
</tr>
<tr>
<td>User.Read</td>
<td>Delegated</td>
</tr>
</tbody>
</table>

   See Add permissions to access web APIs for more information.

   e) Grant admin consent to your application. See Understanding API permissions and admin consent UI for more information.

Create an Azure AD integration profile

Create an Azure AD integration profile in your ServiceNow instance.

To create an Azure AD integration profile, install the Microsoft Azure AD Spoke for IntegrationHub (com.sn.azure_ad.spoke) plugin.

Role required: sam_integrator or admin

1. Navigate to Saas License > Administration > SSO Integration Profiles.
2. Click New.
3. Select Microsoft Azure AD Integration Profile.
4. In the **Display name** field, enter a name for the integration profile. For example, **Azure AD integration**.

The remaining fields are automatically populated when you submit the form.

**Note:** The SSO integration is created using a directory integration. The directory integration pulls SSO user and group data. If you already have a Microsoft Azure AD directory integration, the SSO integration uses your existing directory integration. Otherwise, a Microsoft Azure AD directory integration is automatically created.

5. Click **Submit**.

6. Click the **Create New Connection & Credential** related link.

7. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Create Connection and Credential form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Auth URL</td>
</tr>
<tr>
<td>Token URL</td>
</tr>
<tr>
<td>Revoke token URL</td>
</tr>
<tr>
<td>OAuth Client ID</td>
</tr>
<tr>
<td>OAuth Client Secret</td>
</tr>
<tr>
<td>OAuth Redirect URL</td>
</tr>
</tbody>
</table>

8. Click **Create and Get OAuth Token**.

9. In the pop up window, sign in to your account with Azure AD admin credentials.

10. Click **Publish**.

    Scheduled jobs and directory jobs download a list of all your applications, users, and groups. View the status of the jobs in the Scheduled Job Results and Directory Job Results related lists on the integration profile. Software models are automatically created for apps with an **External Catalog ID** that matches an **External ID** in the Subscription Product Definitions table (samp_sw_subscription_product_definition).
**Connect SSO apps**

Connect an SSO app to view all users and groups with access to the app. Track user login data and reclaim unused licenses.

Role required: sam_integrator or admin

SaaS License Management offers direct integrations with select applications. Direct integrations provide the most robust usage data. For a list of available direct integrations, see **Integrate with SaaS applications.** If you have a direct integration for an app, connecting the same app in an SSO integration creates duplicate subscription records in your ServiceNow instance. If you connect an SSO app and later decide to create a direct integration for that app, disconnect the app before creating a direct integration.

1. Navigate to **SaaS License > SSO Applications.**
2. Click the application you want to connect.
3. If the **Software model** field is empty, add a software model for the app.
   
   An app must have a software model before you can connect it. Software models are automatically created for apps with an **External Catalog ID** that matches an **External ID** in the Subscription Product Definitions table (samp_sw_subscription_product_definition). For all other apps, you can create a software model manually. For instructions, see **Record product details.**
4. Select a date for the **Analyze last activity from** field.
   
   You can choose to start analyzing login data from the current date or from up to 60 days in the past. The default value is 30 days. Choosing a date in the past enables you to detect stale subscriptions without waiting in real time because you can see subscriptions that haven’t been used recently. Because choosing a date in the past increases the amount of data that is analyzed, it may take longer for you to be able to view the results.

   Once you submit a value in the **Analyze last activity from** field, the field becomes read only.
5. Click **Connect.**

   **Tip:** You can also connect multiple apps at once from the **SSO Applications** list. Select the apps using the check box on the left side of the list. At the bottom of the list, click the **Actions on selected rows** drop down menu and then click **Connect.** If some apps don’t have a software model, the **Connect** action shows that not all apps will be connected. For example, **Connect (1 of 4)** shows that only 1 of the 4 apps you selected will be connected. Add software models to connect the remaining apps.

SSO application users, groups, subscriptions, reclamation rules, and stale user reclamation candidates are created automatically after the application is connected and are refreshed daily.

It’s important that you review the automatically generated reclamation rule to ensure that it meets your specifications for reclaiming user subscriptions. For more information, see **Review a software reclamation rule.**

Create software entitlements for the automatically generated software models to track software used against software owned. For more information, see **Record software rights and user allocations.**

**View software usage and cost**

View a list of all subscriptions for SaaS and SSO applications. View underused subscriptions and potential savings.
View all subscriptions

To view subscriptions for all SaaS and SSO applications, navigate to SaaS License > All User Subscriptions.

Software Subscriptions list

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>The software publisher and product for the subscription.</td>
</tr>
<tr>
<td>User principle name</td>
<td>The user’s email address for the subscription.</td>
</tr>
<tr>
<td>Software Model</td>
<td>The software model for the subscription.</td>
</tr>
<tr>
<td>Subscription profile</td>
<td>The direct integration profile for the subscription. This field is empty if the subscription is from an SSO integration.</td>
</tr>
<tr>
<td>Subscription type</td>
<td>Classifies the subscription as a software subscription or an SSO subscription.</td>
</tr>
</tbody>
</table>

**Note:** You can add the Subscription assigned column to view the date a user was given access to an app. For SSO subscriptions, this field is empty if the user has access to the app through a group membership.

You can also view all subscriptions for an application in the Software Subscriptions related list on the software model.

User Summary

View software usage information such as total number of users, number of stale users, and total cost in the User Summary for the software model. The User Summary is available for SaaS and SSO applications. To access the User Summary, navigate to SaaS License > Software Models and select a model, then click the User Summary tab.
### User Summary tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total rights owned</td>
<td>Total number of purchased rights across active entitlements for the software model.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Total rights assigned</td>
<td>Number of licenses assigned to users based on the integration. The list of all users appears in the Software Subscriptions related list at the bottom of the software model.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the number of rights assigned is more than the number of rights owned, a warning is displayed.</td>
</tr>
<tr>
<td>Total suspended rights</td>
<td>Number of user accounts that are suspended. The list of all suspended users appears in the Software Subscriptions related list at the bottom of the software model, where the value of the state field is Suspended.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is only shown for the G Suite direct integration.</td>
</tr>
<tr>
<td>Total stale rights</td>
<td>Number of subscriptions that had limited to no activity within the activity threshold defined by the reclamation rule for the software product. The list of stale users appears in the Reclamation Candidates related list at the bottom of the software model.</td>
</tr>
<tr>
<td>Total rights available</td>
<td>Number of rights owned minus the total number of rights assigned to users.</td>
</tr>
<tr>
<td>Unit cost</td>
<td>Override license cost, if specified, otherwise it is the average cost of purchased rights across entitlements for the software model. This value is used for true-up and underperforming spend calculations.</td>
</tr>
<tr>
<td>Total spend</td>
<td>Total amount spent across all entitlements for the software model.</td>
</tr>
<tr>
<td>Underperforming spend</td>
<td>Total amount spent on stale licenses.</td>
</tr>
</tbody>
</table>

**View SSO subscriptions**

View SSO applications, users, and groups.

**View SSO integration information**

To view applications, users, and groups for an SSO integration, navigate to **SaaS License > Administration > SSO Integration Profiles** and click a profile. The related lists show information for the integration.
<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSO Applications</td>
<td>All SSO applications.</td>
</tr>
<tr>
<td>Directory Users</td>
<td>All SSO users.</td>
</tr>
<tr>
<td>Directory Groups</td>
<td>All SSO groups.</td>
</tr>
<tr>
<td>Scheduled Jobs</td>
<td>The <strong>SAM - SSO Azure AD download applications</strong> scheduled job downloads all SSO apps. The job runs when the SSO integration profile is published, and then runs daily. The <strong>SAM - SSO Azure AD update connected applications</strong> scheduled job downloads users, groups, and subscriptions for SSO apps. The job runs daily and whenever an app is connected.</td>
</tr>
<tr>
<td>Scheduled Job Results</td>
<td>Status of the scheduled jobs.</td>
</tr>
<tr>
<td>Directory Jobs</td>
<td>The <strong>Microsoft Azure AD - Download Group Membership</strong> directory job downloads group memberships for all users. The job runs when the SSO integration profile is published, and then runs daily. The <strong>Microsoft Azure AD - Download Groups</strong> directory job downloads all groups. The job runs when the SSO integration profile is published, and then runs daily. The <strong>Microsoft Azure AD - Download Users</strong> directory job downloads all users. The job runs when the SSO integration profile is published, and then runs daily.</td>
</tr>
<tr>
<td>Directory Job Results</td>
<td>Status of the directory jobs.</td>
</tr>
</tbody>
</table>

**View SSO application information**

To view users, groups, and reclamation candidates for an application, navigate to **SaaS License > SSO Applications** and click an application. The related lists show information for the application.

<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSO Application Users</td>
<td>All users that have direct access to the application (not through membership in a group).</td>
</tr>
<tr>
<td>SSO Application Groups</td>
<td>All groups that have access to the application.</td>
</tr>
</tbody>
</table>
### List

<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSO Subscriptions</td>
<td>The total number of subscriptions for the application. A user may have both direct access to an app and have access through a group, but their access only counts as one subscription so they will only have one record in the SSO Subscriptions list.</td>
</tr>
</tbody>
</table>

**Note:** Add the **SSO application role** column to see how the user is granted access to the application. If value is a group, the user has access through membership in that group. If the value is the user’s name, they have direct access to the application. User subscriptions can’t be reclaimed in Software Asset Management if the user has access to the application through a group membership. To reclaim the subscription, remove the user from the group in the Azure AD portal and set the reclamation candidate state to **Closed Complete**.

| Reclamation Candidates   | Subscriptions that don’t meet the usage requirements defined by the reclamation rule for the application.                                                                                                      |

### Data sync with Azure AD

If you delete a user, group, or app in the Azure AD portal, the corresponding records in Software Asset Management are deleted when the daily scheduled jobs run. If you revoke a user’s access to an application in the Azure AD portal, either directly or by removing them from a group, their user subscription record for the app is deleted when the daily scheduled jobs run.

### DocuSign envelope consumption

Access DocuSign envelope usage information from the **Envelope Consumption** tab in the DocuSign software model.

Access envelope consumption data by navigating to **SaaS License > Software Models** and selecting the DocuSign software model, then clicking the **Envelope Consumption** tab.
**Envelope Consumption tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit of measure</td>
<td>Envelopes.</td>
</tr>
<tr>
<td>Total units</td>
<td>Number of envelopes you can send in accordance with your DocuSign contract.</td>
</tr>
</tbody>
</table>

Actual consumption is greater than expected. At current rate, subscription will run out of envelopes 3 months before the contract end date.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract period</td>
<td>Length of the DocuSign contract</td>
</tr>
<tr>
<td>Contract start</td>
<td>Contract start date.</td>
</tr>
<tr>
<td>Contract end</td>
<td>Contract end date.</td>
</tr>
<tr>
<td>Units consumed</td>
<td>Number of envelopes you’ve already sent during the contract period.</td>
</tr>
<tr>
<td>Units remaining</td>
<td>Number of remaining envelopes you can send until the end of the contract.</td>
</tr>
<tr>
<td></td>
<td>This value is equal to total units minus units consumed.</td>
</tr>
<tr>
<td>Expected monthly consumption</td>
<td>This value is calculated by dividing total units by</td>
</tr>
<tr>
<td></td>
<td>the number of months in the contract period.</td>
</tr>
<tr>
<td>Actual monthly consumption</td>
<td>Average number of envelopes sent each month.</td>
</tr>
</tbody>
</table>

**Review a software reclamation rule**

Use reclamation rules to cancel user subscriptions that have limited to no activity.

Role required: sam_admin

When you create a direct integration profile or connect an SSO application, a reclamation rule is automatically created for the software. It’s important that you review the reclamation rule to ensure that it meets your specifications.

Reclamation rules define the minimum amount that a subscription must be used. If the subscription doesn’t have any activity within a specified time limit, it’s added to the list of reclamation candidates. User activity is defined differently for each direct integration. Only one of the listed actions is required to occur within the time limit, not all of them.

<table>
<thead>
<tr>
<th>Direct integration</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box</td>
<td>• User login</td>
</tr>
<tr>
<td></td>
<td>• Any file activity, including 60 actions such as create, edit, delete, share, upload, or download</td>
</tr>
<tr>
<td>DocuSign</td>
<td>• Send an envelope</td>
</tr>
<tr>
<td>Dropbox</td>
<td>• User login</td>
</tr>
<tr>
<td></td>
<td>• Any file activity, including 60 actions such as create, edit, delete, share, upload, or download</td>
</tr>
<tr>
<td>Direct integration</td>
<td>Activity</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------</td>
</tr>
<tr>
<td>G Suite</td>
<td>Google Drive and Google Docs</td>
</tr>
<tr>
<td></td>
<td>• Any file activity, such as create, edit, delete, upload, download, or sync</td>
</tr>
<tr>
<td></td>
<td>Gmail</td>
</tr>
<tr>
<td></td>
<td>• Any email activity, such as read, create, edit, send, or delete</td>
</tr>
<tr>
<td>Jira Software</td>
<td>• User login</td>
</tr>
<tr>
<td></td>
<td>• Create an issue</td>
</tr>
<tr>
<td></td>
<td>• Comment on an issue</td>
</tr>
<tr>
<td></td>
<td>• Update a comment on an issue</td>
</tr>
<tr>
<td>Salesforce</td>
<td>• User login</td>
</tr>
<tr>
<td>Webex Meetings</td>
<td>• Host a meeting</td>
</tr>
<tr>
<td>Zoom</td>
<td>• Host a meeting</td>
</tr>
</tbody>
</table>

For SSO subscriptions, the reclamation rule checks for user logins.

1. Navigate to **Software Asset > Administration > Reclamation Rules** and select the reclamation rule that corresponds to your integration profile.
2. Review the following fields and modify the reclamation rule as necessary.

### Reclamation Rules form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the reclamation rule.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Item type to which the reclamation rule applies.</td>
</tr>
<tr>
<td>Notify user</td>
<td>Option for notifying the user via email that their account will be reclaimed unless they respond with a request to keep it. If a user wants to keep their license, it becomes the responsibility of their manager to approve or reject the removal of the license.</td>
</tr>
<tr>
<td>Days before auto-reclamation</td>
<td>If no response is received from the user within the specified number of days, the account is reclaimed.</td>
</tr>
</tbody>
</table>

**Note:** This field appears when **Notify user** is selected.
### Paris IT Asset Management

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last activity threshold</td>
<td>Time limit for no meaningful activity before a user account is added to the list of reclamation candidates. The default value is 60 days for direct integrations and 30 days for SSO applications.</td>
</tr>
</tbody>
</table>

3. **Click Update.**

View the reclamation candidates that are identified by your reclamation rule and start reclaiming user subscriptions.

**Reclaim user subscriptions**

Reclaim unused SaaS and SSO subscriptions to reduce your total software costs.

**Role required: sam_user**

The process of reclaiming a user subscription is similar to reclaiming a software license in ServiceNow® Software Asset Management.

**Warning:** Make sure that users don’t lose access to files they need when their account is reclaimed. Users don’t have a chance to stop their account from being reclaimed unless the **Notify user** check box is selected on the reclamation rule.

- Reclaiming a Box account deletes the account and moves all files into a folder in the Box admin account that authenticated the integration.
- Reclaiming a Dropbox account deletes the account and moves all files into a folder in the Dropbox admin account that authenticated the integration. The name of the folder that’s created to store the files is the deleted user’s email address.
- Reclaiming a DocuSign account deletes the account. The DocuSign admin can access the user’s files through the DocuSign admin portal.
- Reclaiming a G Suite account deletes the account and moves all files from the Google Drive into a folder in the G Suite admin account that authenticated the integration. The name of the folder that’s created to store the files is the deleted user’s email address. To transfer email messages, use the Google data migration service before reclaiming the account. All email messages are deleted when the account is reclaimed.
- Reclaiming a Jira account deletes the user. If a user has issues or other dependent items in Jira, you can’t delete the user through reclamation. You must deactivate the user in your Jira admin account instead and then set the reclamation candidate state to **Closed Complete**.
- Reclaiming a Microsoft Azure AD SSO application subscription removes the user’s access to the application. If a user has access to an application through a group membership, you can’t remove the group membership through reclamation. To reclaim the subscription, remove the user from the group in the Azure AD portal and set the reclamation candidate state to **Closed Complete**.
- Reclaiming a Salesforce account deletes the account.
- Reclaiming a Webex account deactivates the user. Recorded meetings are saved in the deactivated user account. Users with a link to these recordings will not be able to view them unless the recordings are reassigned to an active user. If your Webex site is managed using Cisco Webex Control Hub, you can’t delete users through reclamation. You must delete users in Cisco Webex Control Hub instead and then set the reclamation candidate state to **Closed Complete**.
1. Navigate to **SaaS License > Software Models** and select the software model from the list.
2. Click the Reclamation Candidates related list.
   - To reclaim all users listed, click **Reclaim All**.
   - **Note:** Use caution when reclaiming all users. Some users may still need their licenses even if they have no activity.
   - To specify which candidates are reclaimed, use the filter, and then click **Reclaim All**.
   - To reclaim an individual user record, click the removal candidate number, and then click **Reclaim** in the Removal Candidate record.

### Removal Candidate record

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applies to</td>
<td>Software type.</td>
</tr>
<tr>
<td>User subscription</td>
<td>Reference field to the user subscription record with information including email address for the account and last activity date.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the subscription user.</td>
</tr>
<tr>
<td>User principal name</td>
<td>Email address associated with the subscription software account.</td>
</tr>
<tr>
<td>Reclamation rule</td>
<td>Name of the reclamation rule applied to the removal candidate.</td>
</tr>
<tr>
<td>Potential savings</td>
<td>Amount of money that would be saved by reclaiming the user subscription.</td>
</tr>
<tr>
<td>Notify user</td>
<td>Option for notifying the user via email that their account will be reclaimed unless they respond with a request to keep it. If a user wants to keep their license, it becomes the responsibility of their manager to approve or reject the removal of the license.</td>
</tr>
</tbody>
</table>

After you reclaim a user subscription, the subscription record is deleted from the Software Subscriptions table (samp_sw_subscription) and the reclamation candidate state is set to Closed Complete. If reclamation fails, the state is set to Attention Required. An error message is displayed at the top of the screen with additional details on how to resolve the error.

**Disconnect SSO apps**

Disconnect an SSO application to stop viewing subscription information for the app, or before creating a direct integration for the app.

Role required: sam_integrator
SaaS License Management offers direct integrations with select applications. Direct integrations provide the most robust usage data. For a list of available direct integrations, see [Integrate with SaaS applications](#). If you have a connected SSO app and want to replace it with a direct integration, disconnect the app before creating the direct integration to avoid creating duplicate subscription records for the app.

When an app is disconnected, all SSO subscriptions for the app are deleted and any open reclamation candidates are set to Closed Skipped.

1. Navigate to SaaS License > SSO Applications.
2. Click the application you want to disconnect.
3. Click Disconnect.

**Tip:** You can also disconnect multiple apps at once from the SSO Applications list. Select the apps using the check box on the left side of the list. At the bottom of the list, click the Actions on selected rows drop down menu and then click Disconnect.

**Delete an integration profile**

If your company stops using a SaaS application or SSO provider, you can delete the integration profile.

To delete an integration profile, navigate to the integration profile record and click **Delete**. The sam_integrator role is required to delete integration profiles.

**Direct integrations**

When you delete a direct integration profile, all subscriptions and scheduled jobs for the integration are also deleted. Open reclamation candidates are updated to Closed Skipped. Reclamation rules are not deleted.

**SSO integrations**

When you delete an SSO integration profile, all SSO applications, subscriptions, and scheduled jobs for the integration are also deleted. Open reclamation candidates are updated to Closed Skipped. Reclamation rules are not deleted.

An SSO integration is created using a directory integration. When you delete an SSO integration profile, the directory integration (including directory jobs, directory users, and directory groups) is not deleted. Before deleting a directory integration, make sure it is not being used by additional connections, such as Microsoft Azure AD integration for new hire onboarding. The sn_remote_dir_sync.admin role is required to delete directory integrations.

**Installed with SaaS License Management**

User roles and tables are installed with SaaS License Management. Demo data is available for the Software Asset Management - SaaS License Management Integrations (com.sn_sam_saas_int) plugin.
### User roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sam_integrator</td>
<td>Inherits the sam_user role and can also create and manage SaaS integration profiles.</td>
</tr>
</tbody>
</table>

### Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product profile types (samp_sw_product_profile_type)</td>
<td>Provides a mapping between integration profile types and products in the Software Product (samp_sw_product) table.</td>
</tr>
<tr>
<td>SAM Subscription Script Routes (sam_saas_script_route)</td>
<td>Stores which script includes and scopes implement a given integration type to register available integrations from separate scoped apps.</td>
</tr>
<tr>
<td>SSO Application (samp_sso_application)</td>
<td>List of all SSO applications for all SSO integrations.</td>
</tr>
<tr>
<td>SSO Application Groups (m2m_sso_group_application)</td>
<td>Provides a mapping between connected SSO applications and the directory groups that have access to them.</td>
</tr>
<tr>
<td>SSO Application Role (samp_sso_application_role)</td>
<td>List of SSO users and groups for all connected SSO applications.</td>
</tr>
<tr>
<td>SSO Application Users (m2m_sso_user_application)</td>
<td>Provides a mapping between connected SSO applications and the directory users that have access to them.</td>
</tr>
<tr>
<td>SSO Integration Profile (samp_sso_integration_profile)</td>
<td>List of all SSO integration profiles.</td>
</tr>
<tr>
<td>SSO Subscription (samp_sso_subscription)</td>
<td>List of SSO subscriptions for all connected SSO applications.</td>
</tr>
<tr>
<td>Subscription Consumption Summary (sam_saas_consumption_summary)</td>
<td>DocuSign envelope consumption summary information including envelopes sent, envelopes remaining, monthly consumption, and contract dates.</td>
</tr>
<tr>
<td>Subscription Integration (samp_sw_subscription_integration)</td>
<td>List of SSO providers that is mapped to subscription products in the Subscription Product Definition (samp_sw_subscription_product_definition) table.</td>
</tr>
<tr>
<td>Subscription Product Definition (samp_sw_subscription_product_definition)</td>
<td>This table is used to automatically create software models for SSO applications. Software models are automatically created for apps with an External Catalog ID that matches an External ID in this table.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Subscription Usage Summary (samp_subscription_usage_summary)</td>
<td>Software usage summary information including rights owned, rights assigned, stale rights, available rights, and cost.</td>
</tr>
</tbody>
</table>

**Software Spend Detection**

Use the ServiceNow Software Spend Detection application to track, analyze, and optimize software spending from imported financial data.

Use Software Spend Detection to optimize software spending.

- Streamline business processes and reduce costs by consolidating software products with similar functionality.
- Reinforce company software purchasing policies by viewing all software purchased in each department.
- Start managing any unmanaged software by creating software models and entitlements with Software Asset Management.

**Request Software Spend Detection**

Request Software Spend Detection to track, analyze, and optimize software spending. To access Software Spend Detection, enable the Software Asset Management - Spend Detection (com.sn_sam_spend) plugin. This plugin includes demo data.

Before you can request Software Spend Detection, you must sign the Software Spend Detection legal agreement. For more information about the Software Spend Detection legal agreement, contact your ServiceNow account representative.

To use Software Spend Detection, you must activate the Software Asset Management Professional (com.snc.samp) plugin on your ServiceNow instance. For more information about activating Software Asset Management Professional, see Request Software Asset Management.

**Note:** Software Spend Detection is not supported for on-premises users hosting their own ServiceNow instance.

Role required: admin

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the request form on Hi.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.
4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Software Spend Detection Overview dashboard**

View all software spend from uploaded financial data in the Software Spend Detection Overview dashboard.

Access the Software Spend Detection dashboard by navigating to **Software Spend Detection > Overview**.

Expand a publisher in the left menu bar to see their products. Click a publisher or product to show only those transactions. Click **Edit date range** to filter transactions by date. By default, the dashboard shows all transactions from within the past year. Move your cursor over the Software Spend Over Time graph to view exact spend amounts. You can also view transactions grouped by cost center, department, or location using the tabs at the bottom of the dashboard.
Sharing the dashboard’s URL displays your currently selected publisher, product, and date range. To view the applied filters, the URL recipients must already be logged in to their ServiceNow instance.

Note: Transactions that aren’t labeled with a software publisher aren’t included in the dashboard. You can manually update these transactions with a publisher to add them to the dashboard. For more information, see Manually update transactions.
### Indicator Description

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Publishers</td>
<td>Total number of publishers. This includes publishers automatically detected from imported financial transactions and publishers manually added to transactions.</td>
</tr>
<tr>
<td>Indicator</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unmanaged Publishers</td>
<td>Number of publishers that have unmanaged products.</td>
</tr>
<tr>
<td>Total Products</td>
<td>Total number of products. This includes products automatically detected from imported financial transactions and products manually added to transactions.</td>
</tr>
<tr>
<td>Unmanaged Products</td>
<td>Number of products that don’t have a software model.</td>
</tr>
<tr>
<td>Total Detected Spend</td>
<td>Total amount spent on software. This value is equal to Accounts Payable Spend plus Expense Spend.</td>
</tr>
<tr>
<td>Unmanaged Spend</td>
<td>Total spend for transactions where the publisher and product are identified but there's no software model for the product. You can create software models and entitlements to start tracking those products and turn unmanaged spend into managed spend.</td>
</tr>
<tr>
<td>Accounts Payable Spend</td>
<td>Total spend for transactions where the type is Accounts Payable. These transactions are from an accounting or procurement system.</td>
</tr>
<tr>
<td>Expense Spend</td>
<td>Total spend for transactions where the type is Expense. These transactions are from an employee expense system or credit card feed.</td>
</tr>
<tr>
<td>Software Spend Over Time</td>
<td>Amount spent on software each month.</td>
</tr>
</tbody>
</table>

**Opt in to Content Service**

Opt in to Content Service for Software Spend Transactions to get more accurate predictions in Software Spend Detection by sharing financial transaction data with the ServiceNow Content Service team.

**Role required: sam_admin**

Opting in to Content Service for Software Spend Transactions means that you agree to have a copy of your financial transaction data securely sent to ServiceNow. Your data is used only to improve future publisher and product predictions when importing data into Software Spend Detection. You can opt out of Content Service at any time.

If you already opted in to Software Asset Management Content Service, you still need to manually enable data sharing for Software Spend Detection by clicking the Software Spend Transactions toggle button on the Content Service Setup page. Software Spend Transactions data sharing is disabled by default.

If you opt in after you’ve already imported data into Software Spend Detection, data from previous imports is shared as well as data from future imports.

**Note:** If you want to hide the ability to opt in, a user with the admin role can set the glide.samp.spend_detection_opt_in.enabled system property to false. Setting this value to false hides the toggle button used to turn on sharing for software spend transactions. Also, if
1. Navigate to Software Spend Detection > Administration > Content Service Setup.
2. Select the check box to accept the opt-in agreement and then click Opt-in.

**Note:** If you already opted in to Content Service through Software Asset Management, you don’t see the opt-in screen.

Data sharing for Software Discovery Models, Software Model Lifecycles, Part Numbers and Discovery Maps, and Processor Names KPIs is automatically enabled after opting in. If you don’t want to share data for some KPIs, individually disable sharing by clicking the toggle button next to the KPI and then clicking Save. For more information about Content Service KPIs, see Software Asset Management Content Service.

3. To turn on sharing for software spend transaction data, click the toggle button next to Software Spend Transactions, then click Save.

You can return to the Content Service Setup page to adjust your data sharing settings for each KPI. You can completely opt out by clicking I would like to opt my company out of the Software Asset Management Content Service Program. After opting out, you can opt back in at any time.

**Content Service for Software Spend Detection**

Opt in to Software Asset Management Content Service for Software Spend Transactions to get more accurate predictions in Software Spend Detection by sharing financial transaction data with the ServiceNow Content Service team.

Opting in to Content Service for Software Spend Transactions means that you agree to have a copy of your financial transaction data securely sent to the ServiceNow Content Service team. ServiceNow uses your data only to improve future publisher and product predictions when importing data into Software Spend Detection. ServiceNow protects all data using the same policies that protect customer instances.

Opting-in shares the following data with ServiceNow:

- Vendor name
- Transaction description
- GL account
- Prediction results (Publisher ID, Product ID, Is Software)

Your data is sent anonymously to the Content Service team. Your data isn’t linked to any identifiable information, such as company or instance name. Before importing data, it’s your responsibility to ensure that the fields Vendor name, Transaction Description, and GL account don’t contain any identifiable information such as company or employee names.

The ServiceNow Content Service team uses these data points to improve machine learning models used by ServiceNow Artificial Intelligence (AI) Services. The AI Services are a set of web services that reside within every ServiceNow datacenter. All Software Spend Detection users benefit from continual improvements to ServiceNow AI Services, but users who are opted-in to Content Service benefit the most. ServiceNow AI Services learns how to identify software products and publishers in your transactions that Software Spend Detection previously was not able to identify. This learning improves the functionality for your future imports.
You can opt out of Content Service at any time. If you opt out, no data from future imports is sent to the ServiceNow Content Service team, but your previously shared data is not deleted. If you would like to participate in Content Service but exclude some transactions from being shared with ServiceNow, you can select the **Exclude from content service** check box on those transaction records.

## Import financial transactions

Import a Microsoft Excel spreadsheet of financial transaction data to start managing software spending.

Role required: sam_spend_import or sam_admin

**Note:** Users with the sam_user role can manually create transaction records by clicking **New** at the top of the All Imported Transactions page.

Your imported data can include all financial transaction data for your company. Software Spend Detection automatically determines whether each transaction is a software purchase. Before importing data, ensure that the fields **Vendor name**, **Transaction Description**, and **GL account** don’t contain any identifiable information such as company or employee names. Make any necessary changes to the data before you import. All imported financial transaction data fields are read-only once loaded in your instance.

The import may take several hours when importing large numbers of transactions.

**Note:** Software Spend Detection currently supports transaction data in English only. If you would like to help train ServiceNow artificial intelligence using data in other languages, contact the ServiceNow IT Asset Management product team.

1. Navigate to **Software Spend Detection > Administration > Import Transactions**.
2. Click **Download Template File (.xlsx)**.
3. Copy your financial data into the template file.

The required fields are **Transaction date**, **Vendor name** or **Description**, and **Type**. Fill in as many fields as possible for the most robust results.

### Software Spend Transactions import template

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction date</td>
<td>Required. Transaction date.</td>
</tr>
<tr>
<td>Vendor name</td>
<td>Company associated with the transaction. Don't include any identifiable information such as your company or employee names. Provide at least one of vendor name or description.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the purchase. Don't include any identifiable information such as your company or employee names. Provide at least one of vendor name or description.</td>
</tr>
<tr>
<td>GL account</td>
<td>General ledger account or expense category. Don't include any identifiable information such as your company or employee names. Optional.</td>
</tr>
<tr>
<td>Amount</td>
<td>Transaction amount. Optional.</td>
</tr>
</tbody>
</table>
### Field Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Required. Select Accounts Payable or Expense. Accounts Payable transactions are from an accounting or procurement system. Expense transactions are from an employee expense system or credit card feed.</td>
</tr>
<tr>
<td>Location</td>
<td>Location. Optional.</td>
</tr>
<tr>
<td>Cost center</td>
<td>Cost center. Optional.</td>
</tr>
<tr>
<td>Department</td>
<td>Department. Optional.</td>
</tr>
<tr>
<td>Source</td>
<td>Name of the system that the transaction came from. Optional.</td>
</tr>
<tr>
<td>Type detail</td>
<td>Description for the Type field. For Accounts Payable, examples are vendor bill or invoice payment. For Expense, examples are credit card purchase or employee reimbursement. Optional.</td>
</tr>
<tr>
<td>External ID</td>
<td>ID of the transaction in the source system. Optional.</td>
</tr>
<tr>
<td>Employee ID</td>
<td>Employee ID. Optional.</td>
</tr>
<tr>
<td>Employee name</td>
<td>Employee name. Optional.</td>
</tr>
<tr>
<td>Employee email</td>
<td>Employee email. Optional.</td>
</tr>
</tbody>
</table>

4. Upload the completed file.

5. Navigate to **Software Spend Detection > Administration > Transaction Import Results** to view information about the import and resolve any import errors.

   When the import is complete, Software Spend Detection begins matching your transactions to software publishers and products. Software Spend Detection also assigns a 0 - 1 value to the **Is software probability**, **Product confidence**, and **Publisher confidence** fields for every transaction. For example, a value of .85 for **Publisher confidence** means that Software Spend Detection is 85% sure that it matched the correct publisher to the transaction. When the matching process is complete, you can view the data in the Overview, Overlapping Software, and Software Spend Transactions modules under Software Spend Detection.

Navigate to **Software Spend Detection > Unnormalized Transactions** to view any transactions that Software Spend Detection wasn't able to match with a software publisher and product. You can manually update these transactions to add a publisher and product. **Opt in to Content Service** to improve matching for future imports.

If necessary, you can mass delete all transactions from an import. Navigate to **Software Spend Detection > Administration > Transaction Import Results**, select the import record, and click **Delete**.

### Manually update transactions

Manually update imported software transactions that weren't automatically labeled with a software product and publisher to track all software spending.

Role required: sam_user

Sometimes, Software Spend Detection can't match a transaction to a software publisher and product. If Software Spend Detection can identify the publisher but not the product, the transaction is categorized as Unnormalized in the list of products for that publisher in the Software
Spend Detection dashboard. The transaction amount is added to the total cost for that publisher. If Software Spend Detection can’t identify the publisher, the transaction is added to **Unnormalized Transactions** and is excluded from the Software Spend Detection dashboard. The transaction amount isn’t included in any of the spend amounts shown on the dashboard.

1. Navigate to **Software Spend Detection > Unnormalized Transactions**.

   ![Image](image1.png)

   **Note:** By default, this list shows only transactions identified as software by Software Spend Detection. To include transactions not identified as software, remove the filter condition `is software = true`.

2. Click a transaction date.
3. Select values for the **Publisher** and **Product** fields.

   ![Image](image2.png)

   **Note:** You can create software publishers and products directly from this form by clicking the lookup icon (🔍) next to the field and then clicking **New**.

4. Clear or select the **Is software** check box to indicate if the transaction is a software purchase.
5. Click **Update**.

   The transaction is removed from the list of unnormalized transactions and is added to the Software Spend Detection dashboard.

**Overlapping Software dashboard**

View software products with overlapping functionality in the Overlapping Software dashboard. Discover unnecessary spending on redundant software and create demands for application rationalization.
The Overlapping Software dashboard groups all software spending into categories based on the main function of the software, such as video conferencing, project management, and email marketing. Access the Overlapping Software dashboard by navigating to **Software Spend Detection > Overlapping Software**.

**Note:** The Overlapping Software dashboard is included in the ServiceNow® Performance Analytics solution for Software Asset Management and is available when Software Spend Detection is installed. For more information, see *Analytics and Reporting Solutions for Software Asset Management Professional*.

The Overlapping Software dashboard supports domain separation when the Performance Analytics - Domain Support plugin (com.snc.pa.domain_support) is activated. To filter the data by domain, select a domain at the top of the dashboard.

### End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAM admin: Can view the dashboard and use the dashboard to create demands.</td>
<td>sam_admin</td>
</tr>
<tr>
<td>SAM user: Can view the dashboard.</td>
<td>sam_user</td>
</tr>
<tr>
<td><strong>Note:</strong> A SAM user can use the dashboard to create demands if they also have the it_demand_user role.</td>
<td></td>
</tr>
<tr>
<td>Software Spend Detection import user: Can view the dashboard.</td>
<td>sam_spend_import</td>
</tr>
</tbody>
</table>
View software spending from the last three months, last 12 months, last two years, or all time.

**Reports**

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highest Count In Overlapping Software</td>
<td>Software categories with the highest number of purchased products.</td>
</tr>
<tr>
<td>Highest Spend in Overlapping Software</td>
<td>Software categories with the highest total spend.</td>
</tr>
<tr>
<td>All Categories with Products</td>
<td>All software categories that have spend transactions. The number next to each category shows the number of products in that category.</td>
</tr>
</tbody>
</table>

**Note:** To edit the reports shown on the dashboard, navigate to Software Spend Detection > Administration > Overlapping Software Setup. The sam_user and report_admin roles are required. When domain separation is enabled, the domain_admin role is also required to view and edit all records.

**Create demands**

Create demands to take meaningful action against the redundant software you discover. You can discontinue software, reduce software usage, migrate users to approved software, or take other actions.

**Note:** The PPM Standard plugin (com.snc.financial_planning_pmo) must be installed to create demands.

For more information, see Create demands for application rationalization.

**Create demands for application rationalization**

Create demands to discontinue software, reduce software usage, migrate users to approved software, or take other actions.

The PPM Standard plugin (com.snc.financial_planning_pmo) must be installed to create demands.

Software Asset Management includes the following demand actions that are ready for you to use.

- Discontinue after expiration
- Migrate to approved product
- Discontinue immediately
- Reclaim licenses
- No action

You can create additional demand actions to cover your company’s processes by navigating to Software Asset > Administration > Software Asset Demand Actions and clicking New.

Role required: sam_admin
Use the Overlapping Software dashboard to drive app rationalization by viewing software categories with the highest count and highest spend. For more information, see Overlapping Software dashboard.

1. Navigate to Software Spend Detection > Overlapping Software.

   Note: The Overlapping Software dashboard shows redundant software products and high spending areas to help you decide which software products can be optimized. If you already know the specific software products that you need to create demands for, navigate to Software Asset > Software Asset Demand > Create New instead.

2. On any of the reports, click a software category that you want to optimize. A list of all products in the category is displayed.
3. Select the check box for each product on the list that you want to add to the demand, then click Create Demand.
4. In the Demand Requirements related list, select an action for each requirement.
5. Click Submit demand.

A demand is created with the Stage field set to Submitted.

Use ServiceNow Demand Management to approve and complete the demand. For more information, see Demand Management.

You can create a project for the demand by clicking the Create Project related link. A project allows you to track the status, percent complete, and duration of the work required to accomplish the demand. You can also create project tasks to define the work items that are required to complete the project. For more information, see Project Management.

To view all Software Asset Management demands, navigate to Software Asset > Software Asset Demand > Demands.

To view all Software Asset Management demand requirements, navigate to Software Asset > Software Asset Demand > Demand Requirements.

Installed with Software Spend Detection

User roles and tables are installed with Software Spend Detection. Demo data is available for Software Spend Detection.

User roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sam_spend_import</td>
<td>Role required to import financial transaction data into Software Spend Detection. Users with this role can view all modules in Software Spend Detection except Content Service Setup. Users with this role cannot view Software Asset Management.</td>
</tr>
</tbody>
</table>
Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Spend Transactions (sam_spend_transaction)</td>
<td>Financial transaction data.</td>
</tr>
<tr>
<td>Software Spend Transactions Import (sam_spend_transaction_import)</td>
<td>Import summary table showing number of rows imported and any import errors.</td>
</tr>
<tr>
<td>Software Spend Transactions Import (imp_sam_spend_transaction)</td>
<td>Staging table for financial transaction data imports.</td>
</tr>
<tr>
<td>Overlapping Software Configuration (sam_sw_overlap_configuration)</td>
<td>List of reports shown on the Overlapping Software dashboard.</td>
</tr>
<tr>
<td>Overlapping Software Summary (sam_sw_overlap_summary)</td>
<td>List of software products with spend transactions.</td>
</tr>
</tbody>
</table>

Software Asset Management administration

Software Asset Management administration tasks include adding client access, custom product, and custom part number records, and creating pattern normalization and reclamation rules. You can also view Software Asset Management job results, refresh processor definitions, and migrate software installations. Software Asset Management content service can be enabled, and migration procedures are also included.

The sam_admin role is required to configure administrative tasks. However, the sam_user role can view and read configurations.

Software Asset Management job results show the status of discovery model normalization and software usage import jobs.

Software Asset Job Results records are listed in the navigation path Software Asset > Administration > Job Results (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Number of the job result that is generated when the job is run.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the job.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the job.</td>
</tr>
<tr>
<td>Created</td>
<td>Date and time job was created.</td>
</tr>
<tr>
<td>Updated</td>
<td>Date and time job was updated.</td>
</tr>
</tbody>
</table>

Engineering license servers

View the list of all the license management servers that OpenLM connects with to get data into your ServiceNow instance.

You can view information pertaining to the all license management servers by navigating to Software Asset > Administration > Engineering License Server
Information such as the name of the server, the current status of the servers, the last connection time is displayed in the **Engineering Application License Servers** form layout.

**Add a software client access record**

You can add a client access record to specify the number of devices or users that are accessing a particular version of software with a client access license (CAL).

Role required: sam_admin, sam_user can view and read but not create

Client access records are used when reconciling these Microsoft and Oracle license metrics.

<table>
<thead>
<tr>
<th>Metric group</th>
<th>License metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft</td>
<td>User CAL</td>
</tr>
<tr>
<td></td>
<td>Device CAL</td>
</tr>
<tr>
<td>Oracle</td>
<td>Named User Plus</td>
</tr>
</tbody>
</table>

License metrics are set on the **software entitlement** form and can be accessed from the Metric Attributes related list on the **software model** form.

Navigate to **Software Asset > Administration > Client Access** and create a new record (see table for field descriptions).

**Client Access form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specify a unique name for the client access record.</td>
</tr>
<tr>
<td>Software model</td>
<td>Specify the software model for the client access record.</td>
</tr>
<tr>
<td>Database instance</td>
<td>Oracle database instance.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note: Only shown for Oracle Named User Plus license metric." /></td>
</tr>
<tr>
<td>Total device count</td>
<td>Specify the number of unique devices allowed to access the product.</td>
</tr>
<tr>
<td>Total user count</td>
<td>Specify the number of unique users allowed to access the product.</td>
</tr>
<tr>
<td>Total user/device count</td>
<td>Specify the number of user/device licenses that are allowed to access a user or a shared device.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note: Only shown when Citrix is specified." /></td>
</tr>
</tbody>
</table>
Add a custom software product

If a software product does not exist in the Software Library, you can add a custom product. Custom products enable you to normalize and account for homegrown software, or software that is not yet part of the Software Library.

Role required: sam_admin

The product and publisher combination is used during discovery model normalization. If the custom product exists, a message is shown.

Navigate to Software Asset > Administration > Custom Products and create a new record (see table for field descriptions).

### Custom Software Product form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher</td>
<td>Publisher of the custom software product. If it does not exist, a new one can be created on the Publisher field Companies lookup list.</td>
</tr>
<tr>
<td>Product</td>
<td>Name of the custom software product.</td>
</tr>
<tr>
<td>Subscription software</td>
<td>Option that indicates that the software has a subscription.</td>
</tr>
<tr>
<td>Product type</td>
<td>Product type of the custom software product.</td>
</tr>
<tr>
<td></td>
<td>- Child: A subcomponent of main software (not licensable).</td>
</tr>
<tr>
<td></td>
<td>- Driver: A software product that controls a device.</td>
</tr>
<tr>
<td></td>
<td>- Licensable: A software product that is licensable.</td>
</tr>
<tr>
<td></td>
<td>- Not Licensable: A software product that is not licensable.</td>
</tr>
<tr>
<td></td>
<td>- Patch: A software product designed to update, fix, or improve an existing computer program.</td>
</tr>
<tr>
<td></td>
<td>- Unknown: A software product that is unknown.</td>
</tr>
<tr>
<td>Product classification</td>
<td>Official UNSPSC classification.</td>
</tr>
<tr>
<td>Exclude from content service</td>
<td>Option that excludes the custom product details from being shared with Software Asset Management Content Service if opted in.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that indicates the rule is active.</td>
</tr>
</tbody>
</table>

Add a custom part number

You can add a custom part number to resolve an entitlement import error that occurs when a part number does not exist in the Software Library.
Add a custom license metric

You can add a custom license metric to modify the default reconciliation process.

Role required to read the custom metric script: sam_admin

Role required to create or modify a custom metric script: sam_developer

Custom license metrics can be created to define specific software calculations not included in the predefined license metrics list. Custom license metrics are useful so reconciliation can calculate rights per user or device for certain software products and bundles of lesser-known software publishers.

For example, you can create a custom metric to avoid over counting installs for products that are part of an unrecognized bundle.

Custom metrics can be disabled using the custom license metric property. This feature is enabled by default.

1. Navigate to Software Asset > Administration > Custom License Metrics and create a new record (see table for field descriptions).
Custom License Metric form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License metric</td>
<td>Name of the custom license metric. This name is shown in the License Metric field of software entitlements, and in the license metric results for the software model.</td>
</tr>
<tr>
<td>Metric group</td>
<td>Custom license metric.</td>
</tr>
<tr>
<td>Allocation type</td>
<td>Allocation type of the metric license, per device or per user.</td>
</tr>
<tr>
<td></td>
<td>• Device</td>
</tr>
<tr>
<td></td>
<td>• User</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the custom license metric.</td>
</tr>
<tr>
<td>Reconciliation order — allocated</td>
<td>Reconciliation metric rank priority for allocated licenses. Lower rank value takes precedence.</td>
</tr>
<tr>
<td>Reconciliation order — unallocated</td>
<td>Reconciliation metric rank priority for unallocated licenses. Lower rank value takes precedence.</td>
</tr>
<tr>
<td>Calculation</td>
<td></td>
</tr>
<tr>
<td>Calculation Script</td>
<td>The calculation method for the license metric is script. Specify the reconciliation script.</td>
</tr>
</tbody>
</table>

2. Click Submit.

Custom license metric example script

The following is an example of a custom license metric script.

Note: This example is for demo purposes only and is not meant to be used for actual compliance scenarios.

```html
<script><![CDATA[getRightsForDevice();
function getRightsForDevice(){
var rightsForDevice = -1;
var deviceRecord = new SampRecord('cmdb_ci_computer');
if(deviceRecord.get(entity)){
  rightsForDevice = deviceRecord.getValue('disk_space');
}
return rightsForDevice;
}]]></script>
```

Refresh processor definitions

After activating Software Asset Management, refresh processor definitions to normalize processors on servers in the CMDB.

Role required: sam_admin
Refresh processor definitions after activating Software Asset Management and before running reconciliation. Refreshing processor definitions enables CPU types (name of the processor discovered) to be mapped to the correct processor definition.

Refreshing processor definitions can be time consuming when running for the first time. Allocate enough time to complete this task before proceeding.

Navigate to Software Asset > Administration > Refresh Processor Definitions and click Proceed. The Processor definitions list is shown.

Migrate software installations

If you are using Discovery, run this script after installing Software Asset Management to copy previously discovered software installation records from the (cmdb_software_instance) table to the (cmdb_sam_sw_install) table, which is used by Software Asset Management to store software installation records.

Role required: sam_admin

If you are running Discovery and have used a version of Software Asset Management previously, there is no need to run this script.

When running the Migrate Software Installs script, allow enough time for the process to complete.

Navigate to Software Asset > Administration > Migrate Software Installs and click Proceed. The Software Installations list is shown. If the data has already been migrated, a message is shown.

Software Asset Management properties

You can set default reconciliation properties such as grouping and reconciliation debugging.

These properties are available for Software Asset Management.

To access these properties, navigate to Software Asset > Administration > Properties.

Properties for Software Asset Management

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the default Group setting for the weekly run of reconciliation</td>
<td>Determines how rights and software installations are grouped during reconciliation. Values (default is None):</td>
</tr>
<tr>
<td>com.snc.samp.recon.group</td>
<td></td>
</tr>
<tr>
<td>Company</td>
<td>Cost Center</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Select the default Subgroup setting for the weekly run of reconciliation | Determines the secondary grouping for rights and software installations during reconciliation. Except for None, group and subgroup values must be different. Values (default is None):  
  - Company  
  - Cost Center  
  - Country  
  - Department  
  - Region                                                                 |
| com.snc.samp.recon.subgroup                                             |                                                                                                                                |
| Run reconciliation with all available custom license metrics          | Enable custom license metrics when running reconciliation. If you have a custom license metric configured, it is not applied when this property is set to No. Default is Yes.                                         |
| com.snc.samp.recon.enablecustommetrics                                 |                                                                                                                                |
| Enable debugging of reconciliation results                             | Enable debugging of reconciliation results to troubleshoot a result. Default is No.                                                                                                 |
| com.snc.samp.debug                                                     | Note: Enabling debugging may have an impact on performance.                                                                                           |
| Automatically create software models for all 'licensable' products     | Automatically create a software model, in non-compliant state, for any unlicensed installs, subscriptions, or options (of licensable products) in the Product Results list that do not have an entitlement.  
  The new software model and results are used to show the unlicensed count in the License Position Report. |
| com.snc.samp.automaticsmrcreation                                       |                                                                                                                                |
| Select the level of aggregation for the reconciliation calculation of VMware based Oracle instances | Level of aggregation. Default is vCenter cluster.  
  - ESX  
  - VCenter Cluster  

Note: This property is only available if you've activated the Software Asset Management publisher pack for Oracle, activate the Oracle content pack (com.snc.samp.oracle) plugin. 

For vCenter cluster, the Named User Plus license metric considers all processors on every ESX server within a cluster to determine the minimum number of users that needs be licensed.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically create software models for all ‘not licensable’ products</td>
<td>Automatically create a software model, in non-compliant state, for any unlicensed installs (of not-licensable products) in the Product Results list. The new software model is used by Application Portfolio Management. Default is No.</td>
</tr>
<tr>
<td>Enter the name of the true/false field added to cmdb_ci_hardware table to exclude software installed on selected devices from Software Asset Management</td>
<td>Enter the column name, exclude_from_sam, to exclude the software installed on devices (from the Software Asset Management application) where the Exclude from SAM column is set to true.</td>
</tr>
<tr>
<td>Enter the license period (in days) to be considered during reconciliation, for applications published on Citrix environment</td>
<td>The license period (in days) for Citrix applications to be considered during reconciliation. Default is 90 days. Note: This property is only available if you’ve activated the Software Asset Management publisher pack for Citrix.</td>
</tr>
<tr>
<td>Enter the period (in days) to be considered for peak usage consumption, for engineering applications.</td>
<td>The period (in days) for engineering applications to be considered for peak usage consumption. The default value is 30 days and only a user with the sam_admin role can update this field.</td>
</tr>
<tr>
<td>Enter the number of scheduled jobs to run in parallel for reconciliation.</td>
<td>Indicates the number of scheduled jobs that run in parallel to reconciliation. Several scheduled jobs run reconciliation for different publishers simultaneously.</td>
</tr>
</tbody>
</table>

**Revert Software Asset Management customizations**

After installing Software Asset Management for the first time, or upgrading from the Software Asset Management Foundation plugin, you need to revert customizations for all features work. The Revert Customizations module in Software Asset Management can revert customized files related to Software Asset Management back to the base configurations that were skipped during the installation or upgrade process.

Role required: sam_admin

The Revert Customizations module shows the **Software Asset Skipped Files** list. All customizations and configurations related to Software Asset Management can be reverted to the base application version.

To ensure feature functionality, you must revert customizations after:

- A new installation of Software Asset Management Professional (com.snc.samp) plugin
- Upgrading from Software Asset Management Foundation (com.snc.sams) plugin
You can also revert customizations using the System Diagnostics > Upgrade History navigation.

1. Navigate to Software Asset > Administration > Revert Customizations to view the Software Asset Skipped Files list.
2. Click Revert to revert all files with a disposition of Skipped to the base application version.
3. Verify that the disposition of all skipped files is Reverted in the customization summary.
   You can also verify the disposition of all skipped files in the Upgrade Details (sys_upgrade_history_log) table and the current OOB version in the Update Versions (sys_update_version) table.

Manage Software Library

On-premise instances (instances not in the cloud to receive automatic Software Library updates) can manually upload Software Library data to their instance using the Manage Software Library module. You can also choose to export your normalization content for participation in the Software Asset Management content service.

Role required: admin (to enable module), sam_admin (to manage software library)

Activate the Manage Software Library module to manage Software Library content imports or exports by navigating to System Definition > Modules.

The Manage Software Library module must be activated using the System Definition module for it to be shown in the Software Asset Management administration navigation.

Software Library content data is provided in a zip file. During import, data tables are successfully updated with content from the XML file during a background process.

You can also export your data for participation in the Software Asset Management content service to contribute to the improvement of the normalization service.

1. Navigate to Software Asset > Administration > Manage Software Library.
2. To import the Software Library content file:
   a) Click Import Software Library Content File.
   b) Click Attach Content File to choose the Software Library content (.zip) file.
   c) Click Run Import.
3. To export your normalization content:
   a) Click Content Service Opt-In: Export Normalization Content.
   b) Click Run Export.
   c) When the export status is Ready for Download, click Refresh.
   d) Click the attachment to open or save.

Software Asset Management references

Use the descriptions provided to help you fill in the Software Asset Management forms.

Software Asset Management roles

Software Asset Management adds the following roles.
## Software Asset Management roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Asset Management administrator</td>
<td>This role has full access to the Software Asset Management application. This role is required to import entitlements, manage reclamation rules, run reconciliation, create custom products and pattern normalization rules, set up Content Service, and other administrative features.</td>
<td>• sam_user&lt;br&gt;• sam_spend_import&lt;br&gt;• asset&lt;br&gt;• model_manager&lt;br&gt;• contract_manager&lt;br&gt;• it_demand_user</td>
</tr>
<tr>
<td>Software Asset Management user</td>
<td>This role has access to all Software Asset Management features except administrative. If Software Spend Detection is installed, this role has access to all Software Spend Detection features except financial transaction data import and Content Service setup.</td>
<td>• pa_viewer&lt;br&gt;• cmd_read&lt;br&gt;• report_user&lt;br&gt;• sn_remote_dir_sync.reader</td>
</tr>
<tr>
<td>Software Asset Management developer</td>
<td>Writes scripts on the platform, comparable to the script-writing privileges granted to a sys_admin. Users with this role must be trained ServiceNow administrators.</td>
<td>• sam_admin</td>
</tr>
</tbody>
</table>

### Note:
The sam_spend_import role is installed with Software Spend Detection. The it_demand_user role is installed with PPM Standard.

## SaaS License Management roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>SaaS License Management integration</td>
<td>Role required to create and manage SaaS integration profiles.</td>
<td>• sam_user&lt;br&gt;• oauth_admin&lt;br&gt;• connection_admin&lt;br&gt;• flow_operator</td>
</tr>
<tr>
<td>administrator (sam_integrator)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Software Spend Detection roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Spend Detection import user</td>
<td>Role required to import financial transaction data into Software Spend Detection. Users with this role have access to all Software Spend Detection features except Content Service setup. Users with this role cannot view Software Asset Management without being granted additional roles.</td>
<td>pa_viewer</td>
</tr>
</tbody>
</table>

### License agreement types

Types of license agreements determine the product usage rights.

#### Agreement types

The agreement types for the publisher packs.

<table>
<thead>
<tr>
<th>Publisher pack</th>
<th>Agreement type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe</td>
<td>• Generic&lt;br&gt;• Enterprise Term License Agreement (ETLA)&lt;br&gt;• Cumulative Licensing Program (CLP)&lt;br&gt;• Transactional Licensing Program (TLP)&lt;br&gt;• Value Incentive Plan (VIP)</td>
</tr>
<tr>
<td>Citrix</td>
<td>• Generic</td>
</tr>
<tr>
<td>Common</td>
<td>• Generic&lt;br&gt;• Enterprise License Agreement (ELA)</td>
</tr>
<tr>
<td>Custom</td>
<td>• Generic&lt;br&gt;• Enterprise License Agreement (ELA)</td>
</tr>
<tr>
<td>IBM</td>
<td>• Generic&lt;br&gt;• Enterprise License Agreement (ELA)&lt;br&gt;• International Program License Agreement (IPLA): No license impact.&lt;br&gt;• IBM Customer Agreement (ICA): No license impact.&lt;br&gt;• IBM Unlimited License Agreement (IULA)</td>
</tr>
</tbody>
</table>
### Discovery models fields

Discovery Models form and related list field descriptions.

### Discovery Models form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the discovery model as it appears in record lists. This value is generated automatically using the discovered publisher, discovered product, and discovered version.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Normalization status</td>
<td><strong>Status</strong> of the normalization process:</td>
</tr>
<tr>
<td></td>
<td>· Normalized</td>
</tr>
<tr>
<td></td>
<td>· Partially Normalized</td>
</tr>
<tr>
<td></td>
<td>· Publisher Normalized</td>
</tr>
<tr>
<td></td>
<td>· Match Not Found</td>
</tr>
<tr>
<td></td>
<td>· Manually Normalized</td>
</tr>
<tr>
<td></td>
<td>· New</td>
</tr>
<tr>
<td><strong>Note:</strong> If a normalization suggestion record exists, a caution icon is shown next to the <strong>Normalization status</strong> field.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The caution icon opens the <strong>Normalization Suggestion</strong> record for the discovery model.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Normalized publisher of the software.</td>
</tr>
<tr>
<td>Product</td>
<td>Normalized product name of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>Normalized version of the software product.</td>
</tr>
<tr>
<td>Discovered publisher</td>
<td>Discovered publisher of the software.</td>
</tr>
<tr>
<td>Discovered product</td>
<td>Discovered name of the software.</td>
</tr>
<tr>
<td>Discovered version</td>
<td>Discovered version of the software.</td>
</tr>
<tr>
<td>Additional Information</td>
<td></td>
</tr>
<tr>
<td>Product type</td>
<td>· Child: Subcomponent of main software (not licensable).</td>
</tr>
<tr>
<td></td>
<td>· Driver: Software product that controls a device.</td>
</tr>
<tr>
<td></td>
<td>· Licensable: Software product that is licensable.</td>
</tr>
<tr>
<td></td>
<td>· Not Licensable: Software product that is not licensable.</td>
</tr>
<tr>
<td></td>
<td>· Patch: Software product designed to update, fix, or improve an existing computer program.</td>
</tr>
<tr>
<td></td>
<td>· Unknown: Not discovered.</td>
</tr>
<tr>
<td></td>
<td>For unknown product types, the product type can be changed to another value.</td>
</tr>
<tr>
<td></td>
<td>When the product type is changed, the normalization status of the discovery model is updated to Manually Normalized.</td>
</tr>
<tr>
<td></td>
<td>The reconciliation process only considers software discovery models that are licensable.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Platform</td>
<td>Platforms include:</td>
</tr>
<tr>
<td></td>
<td>• Windows</td>
</tr>
<tr>
<td></td>
<td>• Mac</td>
</tr>
<tr>
<td></td>
<td>• UNIX</td>
</tr>
<tr>
<td>Language</td>
<td>Languages include:</td>
</tr>
<tr>
<td></td>
<td>• Dutch</td>
</tr>
<tr>
<td></td>
<td>• English</td>
</tr>
<tr>
<td></td>
<td>• French</td>
</tr>
<tr>
<td></td>
<td>• German</td>
</tr>
<tr>
<td></td>
<td>• Italian</td>
</tr>
<tr>
<td></td>
<td>• Spanish</td>
</tr>
<tr>
<td></td>
<td>If discovered, more languages are generated.</td>
</tr>
<tr>
<td>Full version</td>
<td>Normalized full version of the software.</td>
</tr>
<tr>
<td>Exclude from content service</td>
<td>Option that excludes the software discovery model details from being transferred to the Software Asset Management Content Service. The value is set on the custom product form.</td>
</tr>
</tbody>
</table>

**Note:** This field is only shown for custom products when you have opted in to the Software Asset Management Content Service.
## Additional Information section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Product type | - Child: Subcomponent of main software (not licensable).  
- Driver: Software product that controls a device.  
- Licensable: Software product that is licensable.  
- Not Licensable: Software product that is not licensable.  
- Patch: Software product designed to update, fix, or improve an existing computer program.  
- Unknown: Not discovered.  
  For unknown product types, the product type can be changed to another value.  
  When the product type is changed, the normalization status of the discovery model is updated to Manually Normalized.  
  The reconciliation process only considers software discovery models that are licensable. |
| Platform     | Platforms include:  
- Windows  
- Mac  
- UNIX |
| Language     | Languages include:  
- Dutch  
- English  
- French  
- German  
- Italian  
- Spanish  
  If discovered, more languages are generated. |
| Full version | Normalized full version of the software.                                                                                                    |
### Exclude from content service

Option that excludes the software discovery model details from being transferred to the Software Asset Management Content Service. The value is set on the custom product form.

*Note:* This field is only shown for custom products when you have opted in to the Software Asset Management Content Service.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude from content service</td>
<td>Option that excludes the software discovery model details from being transferred to the Software Asset Management Content Service. The value is set on the custom product form.</td>
</tr>
</tbody>
</table>

### Software Installation related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the software install as it appears in the record lists.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Name of the publisher of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software.</td>
</tr>
<tr>
<td>Installed on</td>
<td>Name of the hardware the software is installed on.</td>
</tr>
</tbody>
</table>

### Software installation fields

Software Installation form and related list field descriptions.

### Software Installations form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the software installation as it appears in the record lists. Can be a combination of the discovered product name and edition.</td>
</tr>
<tr>
<td>Discovery model</td>
<td>Software discovery model that represents the installed software.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Edition Override</td>
<td>Override of the software edition setting.</td>
</tr>
<tr>
<td></td>
<td>For Office 365 subscriptions, this field is set from the software subscriptions record.</td>
</tr>
<tr>
<td></td>
<td>If the edition for the software was not discovered, you can edit this field to set the edition, if known, so reconciliation can be performed successfully.</td>
</tr>
<tr>
<td></td>
<td>For more information, see .</td>
</tr>
<tr>
<td>Installation</td>
<td></td>
</tr>
<tr>
<td>Prod Id</td>
<td>Unique ID for the product assigned by the manufacturer. Found through discovery.</td>
</tr>
<tr>
<td>Install location</td>
<td>Path under which the software is installed.</td>
</tr>
<tr>
<td>Install date</td>
<td>Date that the software was installed.</td>
</tr>
<tr>
<td>Revision</td>
<td>Revision of the software.</td>
</tr>
<tr>
<td>Instance key</td>
<td>Unique ID for the instantiation of the software. Automatically generated when the software is installed.</td>
</tr>
<tr>
<td>Installed on</td>
<td>Hardware on which the software is installed.</td>
</tr>
<tr>
<td>Uninstall string</td>
<td>Identifier used to uninstall the software.</td>
</tr>
<tr>
<td>ISO serial number</td>
<td>ISO number of the software.</td>
</tr>
<tr>
<td>Reconciliation</td>
<td></td>
</tr>
<tr>
<td>Entitlement</td>
<td>The entitlement found to use with this installation.</td>
</tr>
<tr>
<td>Inferred suite</td>
<td>The inferred suite model this installation belongs to.</td>
</tr>
<tr>
<td>Omit from suites</td>
<td>Check box for not counting the software install as a component of a suite during reconciliation.</td>
</tr>
</tbody>
</table>

**Normalization statuses**

Discovery Models form normalization status descriptions.

Normalization status can have six different results:
### Status Description

**Normalized**
A discovery model is fully normalized based on publisher, product, version fields. No fields are editable.

Under specific conditions, certain fields that are typically read-only can be edited. If edited, the status changes to **Manually Normalized**.

If only publisher and product fields are discovered, but the product type is Not Licensable, Child, Driver, or Patch, the status is **Normalized**.

**Partially Normalized**
A discovery model is partially normalized based on publisher and product fields only. In this case, the version field is editable and once that information is added the normalization status is changed to **Manually Normalized**.

**Publisher Normalized**
A discovery model that is partially normalized based on the publisher field alone. In this case, the version and product fields are editable, and once that information is added, the normalization status is changed to **Manually Normalized**.

**Match Not Found**
The normalization process could not match any of the three key fields of the discovery model with a rule in the Software Library. In this case, all key fields are editable and once the information is added the normalization status is changed to **Manually Normalized**.

**Match Not Found** status could occur if a normalization rule for the software does not exist.

For example, if the organization created custom software specific to the organization.

**Manually Normalized**
A discovery model is manually normalized when key fields in a **New**, **Match Not Found**, **Partially Normalized**, or **Publisher Normalized** discovery model are filled in manually.

**New**
The software discovery model has not yet run through the normalization process.

---

**Software model fields**

Software Model form and related list field descriptions.
### Software Model form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the model. The system property <code>glide.cmdb_model.display_name.shorten</code> controls how software model display names are generated. Users with the admin role can configure this property. The default format is publisher + product + version + edition + platform + language. If the Platform or Language fields aren't set to Anything, the values are appended.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software. You can use the lookup list provided. <strong>Note:</strong> Publisher is a reference to the company (core_company) table. Only companies that you are using internally are shown.</td>
</tr>
<tr>
<td>Product</td>
<td>Software product name. The same lookup list provided on the Software Discovery Models form. You can create a custom product from the lookup list, if desired. <strong>Note:</strong> If the relationship between the software publisher (samp_sw_publisher) and company (core_company) tables is not correct, products for that publisher may not be shown. If the publisher and product do not exist, you can Add a custom software product.</td>
</tr>
</tbody>
</table>
| Database option | Oracle database option or management pack. Each option or pack requires a separate software model. Database option is an identifier for software models. **Note:** This field is shown when creating software models that meet the following conditions:  
  - The Publisher is Oracle.  
  - The Product is DB Server. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Discovery map | Set of conditions that determines which software discovery models get mapped to the software models. Purchased rights are only applied to software discovery models that meet the condition. This matching is important for reconciliation. Discovery models with predefined suites are indicated in the **Suite defined** field. A value of **Yes** indicates that the discovery model is a suite parent. You can use the discovery maps provided, or you can choose to specify the condition information directly instead. A user with the **sam_admin** role can choose to create a custom discovery map. When you select a discovery map, you may encounter a message: Many underlying software models will be created. These might be part of suite components, downgrade rights or next version. Please validate on completion. The message appears only if there are greater than or equal to 50 suite components for the software model and if any of the following conditions are met:  
  - A software model does not exist for any suite component  
  - A software model does not exist for any downgrade right  
  - A software model does not exist for the next version  

**Note:** If you change the discovery map in an existing software model, a warning message appears. The warning message informs you that the downgrade rights on the software model and on the related entitlements also change. For example, if you change the discovery map on a software model from DMAP1 to DMAP2, and save the software model, then all the downgrade rights associated with DMAP1 are removed from the software model and the downgrade rights associated with DMAP2 are populated. However, if the value in the **Agreement type** field in the Software Entitlement form layout is **Generic**, the downgrade rights for that entitlement don't change.  

If the discovery map has a lifecycle definition defined, those settings are automatically populated in the Software Model Lifecycles related list. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Version condition     | Condition qualifier for the Version field.  
|                       | - starts with  
|                       | - is  
|                       | - is anything  
|                       | The default is is anything.                                                                                                                                                                               |
|                       | - starts with  
|                       | - is  
|                       | - is anything  
|                       | The default is is anything.                                                                                                                                                                               |
| Platform              | Platform of the software product to use when searching for the normalized discovery model.  
|                       | The default is Anything for Windows, Mac, UNIX.                                                                                                                                                           |
| Language              | Language of the software product to use when searching for the normalized discovery model, which is populated once it has been normalized or added manually.  
|                       | The default is Anything.                                                                                                                                                                                 |
| License under management | Option that indicates you want to manage licenses for that software. If you clear the option, your software model won't be included in your reconciliation results.  
|                       | The value is set to true by default. It is also set to true for any software models that have been upgraded.  
|                       | If you upgrade and have software models with this option selected, you can do a bulk update and clear the License Under Management option from any software models you don't want to include in your reconciliation results. When you run reconciliation again, only the software models with the option still selected will display in your results. |
| Software install condition | Only software installations that meet this software discovery map condition are counted during reconciliation.  
|                       | If needed, specify a subset of software installations that should be counted during reconciliation.                                                                                                         |
Paris    IT Asset Management

**Field** | **Description**
--- | ---
Product type | Product type values include: **Child**, **Driver**, **Licensable**, **Not Licensable**, **Patch**, and **Unknown**.  

**Note:** The reconciliation process only considers software products that are licensable.

Version | Version of the software product.  
Required if the version condition value is *(starts with)* or *(is)-*.

Edition | Edition of the software product to use when searching for the normalized discovery model.  
Required if the edition condition value is *(starts with)* or *(is)*.

---

**General tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>A brief description of the model.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the model. The options are <strong>In Production</strong>, <strong>Retired</strong>, and <strong>Sold</strong>.</td>
</tr>
<tr>
<td>Cost</td>
<td>The cost of a single unit of the software.</td>
</tr>
<tr>
<td>Owner</td>
<td>The person responsible for the model.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Next version| Reference to another software model of the same manufacturer which represents the next version of the product. The next version is defined on the discovery map and is part of the content service. The next version is populated on the software model in either of the two ways:  
- When you create a software model or update the discovery map on a software model, a business rule is triggered when you click **Save**. The next version is populated if the discovery map has a next version defined for it.  
- If the content service has the next version specified for the associated discovery map on an existing software model, the next version is populated when the schedule job, **SAM-Create downgrades/upgrades for a software entitlement** runs.  

**Note:** The next version is populated only after the **SAM- Create downgrades/upgrades for a software entitlement** scheduled job runs weekly. However, if you entered a value in the **Next version** field, that value is not overridden.  
If a software model for the next version does not exist, a software model is automatically created. If the newly created software model consists of downgrade rights and child components, these components are automatically created.  
When the next version is populated on a software model, any associated Perpetual, Perpetual + Maintenance, or Maintenance entitlements with active maintenance are moved to the latest software model version.  

**Note:** Any Perpetual, Perpetual + Maintenance, or Maintenance entitlements with expired maintenance are not moved to the latest software model.  
Downgrade rights are created on this latest version of the software model and propagated to the entitlements associated with the latest software model.  

**Note:** Downgrade support is available only for license metrics that support downgrade rights. |
### Certified
Option to indicate that the software model is approved for use.

### Blacklisted
Option for blacklisting the software model.
Blacklisting identifies software that you should not install in your environment (inappropriate software, or software with vulnerabilities, for example).
If the removal candidates don’t exist, a scheduled job runs nightly that creates removal candidates for blacklisted software.

### Suite Components tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow automated content update</td>
<td>Option allowing ServiceNow to automatically send updated suite definitions to your instance through weekly content updates.</td>
</tr>
<tr>
<td>Inference percent</td>
<td>The percentage of suite components that must be present on a system to count as a suite. Used for suite management. Software installations on the same device and assigned to same user that meets the inference percent could be considered a suite. For example, if the inference percent for a suite of five products is set to 60% and three software installs on the same device, or assigned to the same user, are discovered, all three installations are considered a suite.</td>
</tr>
<tr>
<td>Suite child</td>
<td>The child product or products of the suite. For example, Microsoft Word and Microsoft Excel are child products of Microsoft Office.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Requirement of a suite component. A suite component can be Optional, Always Mandatory, or Mandatory Group. Set to Always Mandatory if the software must be installed to count the model as a suite.</td>
</tr>
<tr>
<td>Suite relationship assumed</td>
<td>Relationship that indicates that multiple software models exist for one or more of the suite components. Therefore, the relationship between suite parent and suite component was assumed. Review the created suite components to ensure the relationship is correct.</td>
</tr>
</tbody>
</table>
## Suite Parents tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suite parent</td>
<td>The parent suites to which the software is assigned. For example, the parent suite for several common Microsoft products is a version of Microsoft Office.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Requirement of a suite component. A suite component can be Optional, Always Mandatory, or Mandatory Group. Set to Always Mandatory if the software must be installed to count the model as a suite.</td>
</tr>
<tr>
<td>Suite relationship assumed</td>
<td>Relationship that indicates that multiple software models exist for one or more of the suite components, therefore the relationship between suite parent and suite component was assumed. Review the created suite components to ensure the relationship is correct.</td>
</tr>
</tbody>
</table>

## Product Catalog tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog Item</td>
<td>Information about the model as it appears in the product catalog and service catalog. Information only appears if the model has been published to the product catalog.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the software model as it appears in the product catalog.</td>
</tr>
<tr>
<td>Picture</td>
<td>Image of the software logo can be added. This logo appears in the service catalog if the software model is published.</td>
</tr>
</tbody>
</table>

## Software Model Lifecycle related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software model</td>
<td>Name of software model.</td>
</tr>
<tr>
<td>Lifecycle type</td>
<td>Lifecycle type values include:</td>
</tr>
<tr>
<td></td>
<td>• Internal</td>
</tr>
<tr>
<td></td>
<td>• Publisher</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lifecycle phase</td>
<td>Lifecycle phase values include:</td>
</tr>
<tr>
<td></td>
<td>- Pre Release</td>
</tr>
<tr>
<td></td>
<td>- General Availability</td>
</tr>
<tr>
<td></td>
<td>Date the software became generally available to the market.</td>
</tr>
<tr>
<td></td>
<td>- Upgrade</td>
</tr>
<tr>
<td></td>
<td>Only shown when the Lifecycle type field is Internal.</td>
</tr>
<tr>
<td></td>
<td>- End of Life</td>
</tr>
<tr>
<td></td>
<td>Date the software was no longer supported by the publisher.</td>
</tr>
<tr>
<td></td>
<td>- End of Support</td>
</tr>
<tr>
<td></td>
<td>- End of Extended Support</td>
</tr>
<tr>
<td>Source</td>
<td>Source of the lifecycle model. If the record is created manually, it's set to Internal. If it's created automatically, the field is set to ServiceNow.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the software model lifecycle.</td>
</tr>
<tr>
<td>Phase start date</td>
<td>Date the lifecycle phase starts.</td>
</tr>
<tr>
<td>Phase end date</td>
<td>Date the lifecycle phase ends.</td>
</tr>
<tr>
<td>Risk</td>
<td>The risk level to an organization with regards to the lifecycle phase. For example, the risk for the end of support phase for a publisher maybe moderate or the end of life phase maybe high.</td>
</tr>
<tr>
<td></td>
<td>Risk type values include:</td>
</tr>
<tr>
<td></td>
<td>- Very High</td>
</tr>
<tr>
<td></td>
<td>- High</td>
</tr>
<tr>
<td></td>
<td>- Moderate</td>
</tr>
<tr>
<td></td>
<td>- Low</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
</tbody>
</table>

Override License Cost related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Model</td>
<td>The software model that the software entitlement belongs to.</td>
</tr>
<tr>
<td>Metric Group</td>
<td>The metric group the software entitlement belongs to.</td>
</tr>
<tr>
<td>License Metric</td>
<td>The license metric specified for the software entitlement.</td>
</tr>
</tbody>
</table>
### Metric Attributes related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software model</td>
<td>Software model associated with the metric attributes.</td>
</tr>
<tr>
<td>Metric group</td>
<td>Grouping for the software metric.</td>
</tr>
<tr>
<td></td>
<td>If you have optional publisher packs installed that the software applies to, those options are shown. Otherwise, the metric group value is <strong>Common</strong>.</td>
</tr>
<tr>
<td>License metric</td>
<td>The license metric that the software license is counted against when reconciliation is run (per user, per device, for example).</td>
</tr>
<tr>
<td>Description</td>
<td>Attribute type description that is based on the license metric value.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Attribute type for reconciling entitlement license metrics.</td>
</tr>
<tr>
<td></td>
<td>• Maximum active OSEs per server</td>
</tr>
<tr>
<td></td>
<td>• Maximum installs per OSE</td>
</tr>
<tr>
<td></td>
<td>• Maximum installs per right: For Per User, Per Device, Per Named User, and Per Named Device</td>
</tr>
<tr>
<td></td>
<td>• Maximum processors per right</td>
</tr>
<tr>
<td></td>
<td>• Minimum users per processor</td>
</tr>
<tr>
<td></td>
<td>• Minimum cores per processor</td>
</tr>
<tr>
<td></td>
<td>• Minimum cores per server</td>
</tr>
</tbody>
</table>
### Paris IT Asset Management

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute value</td>
<td>Value of the attribute (integer).</td>
</tr>
<tr>
<td>Attribute value is unlimited</td>
<td>Option for setting the attribute as unlimited.</td>
</tr>
</tbody>
</table>

### Client Access related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the client access record.</td>
</tr>
<tr>
<td>Software model</td>
<td>Software model for the client access record.</td>
</tr>
<tr>
<td>Database instance</td>
<td>Oracle database instance.</td>
</tr>
<tr>
<td>Note: Only shown for Oracle Named User Plus license metric.</td>
<td></td>
</tr>
<tr>
<td>Total device count</td>
<td>Number of unique devices allowed to access the product.</td>
</tr>
<tr>
<td>Total user count</td>
<td>Number of unique users allowed to access the product.</td>
</tr>
<tr>
<td>Total user/device count</td>
<td>Number of user/device licenses that are accessed a user or a shared device.</td>
</tr>
<tr>
<td>Note: Only shown when Citrix is specified.</td>
<td></td>
</tr>
</tbody>
</table>

### Downgrade Rights related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent software model</td>
<td>Parent (or the topmost hierarchy) of the software model.</td>
</tr>
<tr>
<td>Software model</td>
<td>Software model associated with the downgrade rights. Based on the parent software model that you select, the related software models appear in the list. For example, if you select Microsoft SQL Server 2012 Standard as the parent software model, only Microsoft-related software models appear in the list.</td>
</tr>
<tr>
<td>Source</td>
<td>Source of the downgrade rights. If the record is created manually, it’s set to Internal. If it’s created automatically, the field is set to ServiceNow.</td>
</tr>
</tbody>
</table>
Active

Option that indicates if the downgrade rights on the software model are active or not. If needed, you can deactivate the downgrade rights. Only the active downgrade rights appear in the field. To see all the downgrade rights, remove the Active condition from the filter.

If you deactivate a downgrade right on a software model, the change is propagated to the related software entitlement downgrade rights, irrespective of the source of the downgrade right. You cannot deactivate the downgrade right on a software model and keep the downgrade right activated on the software entitlement.

To deactivate a downgrade right, double-click the field to display the toggle button, select false, and click the Save icon.

- false: deactivates the downgrade right on the software model and on the related software entitlements.
- true: reactivates the downgrade right on the software model and on the related software entitlements.

**Software entitlement fields**

Software Entitlement form and related list field descriptions.

**Software Entitlement form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Automatically generated name based on the software model display name.</td>
</tr>
<tr>
<td>Asset tag</td>
<td>Serial number and the bar code used for tracking the asset.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Publisher part number | Publisher part number (PPN) from the Software Product Definitions lookup list of predefined software that may have already been purchased. When you select a publisher part number, you may encounter a message: Many underlying software models are being created. These might be part of suite components, downgrade rights or next version. Please validate on completion. The message appears only if there are greater than or equal to 50 suite components for the software model and if any of the following conditions are met:  
  - A software model does not exist for any suite component  
  - A software model does not exist for any downgrade right  
  - A software model does not exist for the next version  |
| Software model   | The software model to match the entitlement.  
  
  **Note:** A warning message is shown if the publisher part number is not associated with the publisher and product for the software model. You can either change the software model, or save the entitlement as is. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agreement type</td>
<td>Based on the agreement type that you select, downgrade rights are automatically generated.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the agreement type is Enterprise License Agreement or Unlimited Level Agreement, the Status is Compliant even if there are unlicensed installations.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Generic:</strong> Downgrade rights are not created for this agreement type. If you change the agreement type on an existing software entitlement from <strong>Generic</strong> to any other type (for example <strong>CLP</strong>), the downgrade rights are automatically populated.</td>
</tr>
<tr>
<td></td>
<td>• Any agreement type other than <strong>Generic:</strong> Downgrade rights are automatically populated. If you change the agreement type on an existing software entitlement from an agreement type other than <strong>Generic</strong> (for example, <strong>ELTA</strong>) to <strong>Generic</strong>, the downgrade rights that were already populated are not deleted or deactivated.</td>
</tr>
<tr>
<td>License type</td>
<td>License type. The type determines whether the rights grant full access to the software or if they are being upgraded from a previous version of the software. When the type is <strong>Upgrade</strong>, the Upgraded Entitlements related list is shown. The upgrade license type is used to specify the entitlements you are upgrading. This field becomes read-only after the form has been submitted.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The default value for SaaS entitlements is <strong>Subscription</strong>.</td>
</tr>
<tr>
<td>Start date</td>
<td>Start date of your maintenance entitlement or SA service.</td>
</tr>
<tr>
<td>End date</td>
<td>End date of your maintenance entitlement or SA service. Once the end date is reached, the maintenance flag is cleared and the state is retired if <strong>Software Assurance</strong> was specified as the <strong>License type</strong>.</td>
</tr>
<tr>
<td>Metric group</td>
<td>This field is automatically populated based on the <strong>Software Model</strong> field. Each metric group has a set of license metrics that are specific to the software publisher.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| License metric        | License metric for the license group that the software license is counted against when reconciliation is run. The options for license metric change based on the **Metric group** field. For more information, see *Software license metrics*.  
  **Note:** The default value for SaaS entitlements is **User Subscription**. Use the **Envelopes** license metric only for DocuSign entitlements.                                                                                                                                                                                                                                             |
| Rights per license pack | Rights associated with each pack that is purchased for Microsoft Per Core or Microsoft Per Core with CAL licenses.                                                                                                                                                                                                                                                                                                                                                      |
| Number of packs       | Number of packs for Microsoft Per Core or Microsoft Per Core with CAL licenses.                                                                                                                                                                                                                                                                                                                                                                                            |
| Purchased right       | Number of rights that you are purchasing.  
  **Note:** If you’ve specified a Microsoft Per Core or Microsoft Per Core with CAL license type, this field is automatically populated. This value is based on the values entered in the **Rights per license pack** field multiplied by the value in the **Number of packs** field.                                                                                           |
| Active rights         | Number of rights to be granted for this entitlement.  
  **Note:** If an enterprise contract is attached to the license, the **Active rights** field is not shown.                                                                                                                                                                                                                                                                                                                                                       |
| Allocations available | Number of user or device allocations that have not been created for an entitlement.  
  Allocations available = (number of active rights) - (sum of all allocation quantities).                                                                                                                                                                                                                                                                                                                                                       |
| Unit cost             | Unit cost of the software.  
  **Note:** Required for total cost and savings calculations on the *Software Asset Management dashboard*.                                                                                                                                                                                                                                                                                                                                                                      |
| Total cost            | Total cost of the entitlement calculated from the unit cost.                                                                                                                                                                                                                                                                                                                                                                                                                                                                             |
### General tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial number</td>
<td>Unique number assigned for identification of the asset.</td>
</tr>
<tr>
<td>Owned by</td>
<td>User or department with financial ownership of the asset. The asset owner can be different than the manager.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the asset. Values include On order, In stock, In transit, In use, Consumed, In maintenance, Retired, and Missing.</td>
</tr>
<tr>
<td></td>
<td>If the state is Retired, the Active rights field is set to 0.</td>
</tr>
<tr>
<td></td>
<td>For entitlements with a Subscription license duration, the State field is automatically updated based on the Start date and End date fields.</td>
</tr>
<tr>
<td>Substate</td>
<td>More details about the software license stage. The available substate settings depend on the state selected in the State field.</td>
</tr>
<tr>
<td></td>
<td>For example, if you select the Retired state, the substate options available are Disposed, Sold, Donate, and Vendor credit.</td>
</tr>
<tr>
<td>Active maintenance</td>
<td>Option that indicates if SA or maintenance is activated on the entitlement. If the entitlement has an active SA or maintenance associated to it, the check box is automatically selected. If an entitlement initially had SA or maintenance activated on it and SA or maintenance is no longer active, the check box is automatically cleared.</td>
</tr>
<tr>
<td>Company</td>
<td>Company that this asset belongs to.</td>
</tr>
<tr>
<td>Location</td>
<td>Where the license is used. For example, you can specify a specific site, country, or region.</td>
</tr>
<tr>
<td>Department</td>
<td>Department of the person Assigned to this software license.</td>
</tr>
</tbody>
</table>

### Financial tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>Company that the asset was purchased from.</td>
</tr>
<tr>
<td>Invoice number</td>
<td>Invoice that the asset was billed under.</td>
</tr>
<tr>
<td>Request line</td>
<td>Request line linked to the asset.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Opened</td>
<td>Date that the request was opened.</td>
</tr>
<tr>
<td>GL account</td>
<td>General ledger account number associated with the asset.</td>
</tr>
<tr>
<td>Cost center</td>
<td>Cost center financially responsible for the asset.</td>
</tr>
</tbody>
</table>

### Contracts tab

When **importing software entitlements**, use the **Contract number** column on the downloadable template to link contracts to the entitlements. **Contract number** is a reference field, so enter existing contract numbers. After importing the entitlements, the contract appears on the entitlement form in the Contracts related list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lease contract</td>
<td>Contract that applies to the asset.</td>
</tr>
<tr>
<td>Warranty expiration</td>
<td>Expiration date of the warranty.</td>
</tr>
<tr>
<td>Support group</td>
<td>Group that supports incidents related to the asset.</td>
</tr>
<tr>
<td>Supported by</td>
<td>Individual that supports incidents related to the asset.</td>
</tr>
</tbody>
</table>

### Upgraded Entitlements tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Entitlement</td>
<td>The entitlement from which rights are upgrading. Multiple upgrade entitlements are supported. You can upgrade previously owned rights for a particular version of software to a newer version (for example, Microsoft Office Professional Plus 2013 to Microsoft Office Professional Plus 2016).</td>
</tr>
</tbody>
</table>

**Note:** This field is available when **Upgrade** is selected from the **License type** field.

The rights from entitlements that you are upgrading from get deactivated when you upgrade because they are moved to the new entitlement.

| Number of rights | Number of rights to upgrade.                                                                                                           |
Activities tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work notes</td>
<td>Work notes for the asset.</td>
</tr>
</tbody>
</table>

Downgrade Rights related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software entitlement</td>
<td>Software entitlement with which the downgrade is associated.</td>
</tr>
<tr>
<td>Software model</td>
<td>Software model corresponding to the downgrade right.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates if the downgrade rights on the software entitlement are active or not. Only the active</td>
</tr>
<tr>
<td></td>
<td>downgrade rights appear in the list. To see all the downgrade rights, remove the Active condition</td>
</tr>
<tr>
<td></td>
<td>from the filter.</td>
</tr>
<tr>
<td></td>
<td>If you deactivate a downgrade right on a software model, the change is propagated to the related</td>
</tr>
<tr>
<td></td>
<td>software entitlement downgrade rights; irrespective of the source of the downgrade right.</td>
</tr>
<tr>
<td></td>
<td>To deactivate a downgrade right, double-click the field to display the toggle button. Select false</td>
</tr>
<tr>
<td></td>
<td>and click the Save icon (✓).</td>
</tr>
<tr>
<td></td>
<td>• false: Deactivates the downgrade right on the software model and on the related software entitlements.</td>
</tr>
<tr>
<td></td>
<td>• true: Deactivates the downgrade right on the software model and on the related software entitlements.</td>
</tr>
<tr>
<td>Order</td>
<td>Order of the downgrade. If required, you can edit this field.</td>
</tr>
<tr>
<td>Start date</td>
<td>Start date of the downgrade.</td>
</tr>
<tr>
<td>End date</td>
<td>End date of the downgrade.</td>
</tr>
</tbody>
</table>
License Key related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is allocated</td>
<td>Option that indicates that the license key has been allocated.</td>
</tr>
<tr>
<td>License key</td>
<td>License key value. Must be unique per entitlement.</td>
</tr>
<tr>
<td>Software entitlement</td>
<td>Software entitlement associated with the license key.</td>
</tr>
</tbody>
</table>

Entitlement import error fields

Entitlement Import Error form and related list field descriptions.

Entitlement Import Error form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error status</td>
<td>Status of the entitlement.</td>
</tr>
<tr>
<td>Reason</td>
<td>Reason the imported entitlement couldn’t be added to the Entitlement list.</td>
</tr>
<tr>
<td>Asset tag</td>
<td>Serial number and the bar code used for tracking the asset.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Publisher part number | Publisher part number from the Software Product Definitions lookup list of predefined software that may have already been purchased. When you select a publisher part number, you may encounter a message: Many underlying software models are being created. These might be part of suite components, downgrade rights or next version. Please validate on completion. The message appears only if there are greater than or equal to 50 suite components for the software model and if any of the following conditions are met:  
  
  - A software model does not exist for any suite component  
  - A software model does not exist for any downgrade right  
  - A software model does not exist for the next version  
  
  Note: If a software model exists for the publisher part number, the **Software model** field is automatically populated. Otherwise, the software model is automatically created for you directly from this form. If there are multiple software models created with the same discovery map conditions, the software model must be selected manually.  
  
  Note: A warning message is shown if the publisher part number is not associated with the publisher and product for the software model. You can either change the software model, or save the entitlement as is. |
<p>| Software model        | The software model to match the entitlement.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                   |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License type</td>
<td>License type. Whether the rights grant full access to the software or if they are being upgraded from a previous version of the software. When the type is <strong>Upgrade</strong>, the Upgraded Entitlements related list is shown. The upgrade license type is used to specify the entitlements you are upgrading. This field becomes read-only after the form has been submitted.  <strong>Note:</strong> For SaaS entitlements, keep the default value (Full).</td>
</tr>
<tr>
<td>Metric group</td>
<td>This field is automatically populated based on the <strong>Software Model</strong> field. Each metric group has a set of license metrics that are specific to the software publisher.</td>
</tr>
<tr>
<td>License metric</td>
<td>License metric for the license group that the software license is counted against when reconciliation is run. The options for license metric change based on the <strong>Metric group</strong> field. The default value for SaaS entitlements is <strong>User Subscription</strong>. For more information, see Software license metrics.  <strong>Note:</strong> Use the Envelopes license metric only for DocuSign entitlements.</td>
</tr>
<tr>
<td>Rights per license pack</td>
<td>Rights associated with each pack that is purchased for Microsoft Per Core or Microsoft Per Core with CAL licenses.</td>
</tr>
<tr>
<td>Number of packs</td>
<td>Number of packs for Microsoft Per Core or Microsoft Per Core with CAL licenses.</td>
</tr>
<tr>
<td>Purchased right</td>
<td>Number of rights that you are purchasing.  <strong>Note:</strong> If you’ve specified a Microsoft Per Core or Microsoft Per Core with CAL license type, this field is automatically populated. This value is based on the values entered in the <strong>Rights per license pack</strong> field multiplied by the value in the <strong>Number of packs</strong> field.</td>
</tr>
</tbody>
</table>
## Agreement type

Based on the agreement type that you select, downgrade rights are automatically generated.

**Note:** If the agreement type is **Enterprise License Agreement** or **Unlimited Level Agreement**, the Status is Compliant even if there are unlicensed installations.

- **Generic:** Downgrade rights are not automatically populated. If you change the agreement type on an existing software entitlement from **Generic** to any other type (for example **CLP**), the downgrade rights are automatically populated.
- Any agreement type other than **Generic:** Downgrade rights are automatically populated. If you change the agreement type on an existing software entitlement from an agreement type other than **Generic** (for example, **ELTA**) to **Generic**, the downgrade rights that were already populated are not deleted or deactivated.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agreement type</td>
<td>Based on the agreement type that you select, downgrade rights are automatically generated.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchased rights</td>
<td>Number of rights that you are purchasing.</td>
</tr>
<tr>
<td>Oracle options</td>
<td>Oracle options related to the entitlement.</td>
</tr>
<tr>
<td>Contract number</td>
<td>Contract number for the entitlement.</td>
</tr>
</tbody>
</table>

### Reference software related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher</td>
<td>Name of the software publisher.</td>
</tr>
<tr>
<td>Product</td>
<td>Name of the product.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software product.</td>
</tr>
<tr>
<td>Language</td>
<td>Language of the software product to use when searching for the normalized discovery model, which is populated once it has been normalized or added manually.</td>
</tr>
<tr>
<td>Platform</td>
<td>Platform of the software product to use when searching for the normalized discovery model.</td>
</tr>
</tbody>
</table>
General related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owned by</td>
<td>User or department with financial ownership of the asset. The asset owner can be different than the manager.</td>
</tr>
<tr>
<td>PO number</td>
<td>Purchase order number.</td>
</tr>
<tr>
<td>Company</td>
<td>Company that this asset belongs to.</td>
</tr>
<tr>
<td>Location</td>
<td>Where the license is used. For example, a specific site, country, or region.</td>
</tr>
<tr>
<td>Department</td>
<td>Department of the person Assigned to this software license.</td>
</tr>
</tbody>
</table>

Financial related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>Company that the asset was purchased from.</td>
</tr>
<tr>
<td>Unit cost</td>
<td>Unit cost of the software.</td>
</tr>
<tr>
<td>GL account</td>
<td>General ledger account number associated with the asset.</td>
</tr>
<tr>
<td>Cost center</td>
<td>Cost center financially responsible for the asset.</td>
</tr>
</tbody>
</table>

Entitlement import error actions

Entitlement Import Error form action descriptions.
Entitlement Import Errors actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Option that saves the Entitlement Import Error record. After you save the record, you remain on the Entitlement Import Error form, so you can easily save the form between actions. Upon saving, all values are reevaluated and the form is updated. For example, if both the publisher part number and software model fields are missing, once a known publisher part number is added and the form is saved, the <strong>Software model</strong> field is filled in automatically. <strong>Note:</strong> Because the form is reevaluated after each save, changes made to one entitlement may cause an error for another entitlement, such as a Duplicate entry. When all required fields are filled in and the form is saved, an entitlement record is created and the error status is changed to Fixed.</td>
</tr>
<tr>
<td>Create Part Number</td>
<td>Part number for custom software. To add a custom part number for an entitlement, see Add a custom part number for the entitlement. If multiple discovery maps for the entitlement are found for the Reference related list fields, the Discovery map field on the Reference Software tab is shown. If no matching discovery maps are found, the Create Discovery Map pop-up form is shown to create a custom discovery map, which is automatically associated with the publisher part number.</td>
</tr>
<tr>
<td>Create Entitlement</td>
<td>Duplicate entitlement records cause an import error. Click Create entitlement to override the error and create an entitlement for the duplicate record. This action can also be performed as a mass update using Actions on selected rows on the Entitlement Import Errors list. <strong>Note:</strong> This action is only available when the duplicate check is the only error for the record. Any other errors must be corrected first.</td>
</tr>
</tbody>
</table>
### Domain separation and Software Asset Management

This is an overview of domain separation in Software Asset Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: Enhanced**

- Includes **Basic** and **Standard** levels
- Data-driven process enables service provider customers to modify business logic that is based on defined use cases. These configurations are UI-based and fail-safe so that configurations by one customer cannot affect another.
- Tenants of the instance need to be able to configure minimum viable product (MVP) business logic and data parameters for themselves. This logic and parameters would be expected for the application's normal function.

Use case: Tenant-customers of a shared environment need to be able to make changes to the impact, urgency, or priority matrix to set priority within their domain.

### Overview

Domain separation support in the product enables service providers to offer managed services for software and hardware asset management to their customers. This feature also caters to large organizations who manage their subsidiaries as independent domains.

### How domain separation works in Software Asset Management

In SAM, domain separation occurs in two stages: data separation and process separation. There are two system properties that are used to enable or disable the separation. In the Paris release, both data and process are domain-separated.

Any user with `sam_integrator` role has access to create and modify the SaaS integration profiles. Since users with this role can also access the Oauth application registry (currently not domain-separated, so records across all domains are visible), this `sam_integrator` role should be assigned with caution. The user should be in the service provider organization and satisfy high permissions criteria.

In a domain-separated instance, the content data service (CDS) should populate data in the instance with domain set as **global**.

### Note:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Option that deletes the error. An entitlement record is not created. This action can also be performed as a mass update using <strong>Actions on selected rows</strong> on the Entitlement Import Errors list.</td>
</tr>
</tbody>
</table>
The **Recommended practice** is to avoid customizing the base system domain configuration record.
Required plugins

- Domain separation extension (com.glide.domain.msp_extensions.installer)
- Performance Analytics – Domain Support (com.snc.pa.domain_support)
- SAMP (com.sn_samp_master)
- HAMP (store app)

Other supported plugins

- Service Catalog – Domain Separation (com.glideapp.servicecatalog.domain_separation)
- Procurement (com.snc.procurement)
- Cost Management (com.snc.cost_management)
- Contract Management (com.snc.contract_management)

To learn more, see Domain separation explained, Contains queries and domain access, and Importance of Default domain.

Quick start tests for Software Asset Management

Validate that Software Asset Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Software Asset Management quick start tests require activating the Software Asset Management Professional plugin (com.snc.samp). Some quick start tests require activating the following additional plugins.

- Software Asset Management - Spend Detection (com.sn_sam_spend)
- Software Asset Management Professional for Microsoft (com.snc.samp.microsoft)
- Software Asset Management Professional for SAP (com.sn_samp_sap)
- Software Asset Management - SaaS License Management Integrations (com.sn_sam_saas_int)

Software Asset Management test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAM - Validate CIS Suites</td>
<td>Validates reconciliation of Core Infrastructure Server (CIS) suites along with downgrade rights.</td>
<td>Paris</td>
</tr>
</tbody>
</table>

Note: Requires demo data and the Software Asset Management Professional for Microsoft (com.snc.samp.microsoft) plugin.
<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAM - PerCoreForMSCluster</td>
<td>Verifies the reconciliation functionality for Microsoft per core with cluster.</td>
<td>Paris</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Software Asset Management Professional for Microsoft (com.snc.samp.microsoft) plugin.</td>
<td></td>
</tr>
<tr>
<td>SAM - Validate upgrade/ downgrade during Reconciliation for Microsoft publisher</td>
<td>Validates upgrade and downgrade rights during reconciliation for Microsoft products.</td>
<td>Paris</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires demo data and the Software Asset Management Professional for Microsoft (com.snc.samp.microsoft) plugin.</td>
<td></td>
</tr>
<tr>
<td>SAM - Generate demand to consolidate SaaS applications</td>
<td>Validates generation and submission of a demand on SaaS applications.</td>
<td>Paris</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Software Asset Management - Spend Detection (com.sn_sam_spend) plugin.</td>
<td></td>
</tr>
<tr>
<td>SAM - Software Model and Software Entitlement checks for SAP Engines</td>
<td>Verifies that the Software Model and Software Entitlement forms change when the product is an SAP engine.</td>
<td>Paris</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Software Asset Management Professional for SAP (com.sn_samp_sap) plugin.</td>
<td></td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>SAM - Downgrade Rights on Software Model</td>
<td>Validates that the downgrade rights pushed from the content service are correctly populated on the Downgrade Rights related list on the software model form.</td>
<td>Orlando</td>
</tr>
<tr>
<td>SAM - Multi-core pack validation on Software Entitlement</td>
<td>Validates the functionality of new fields for a multi-core pack on software entitlements.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Note: Requires the Software Asset Management Professional for Microsoft (com.snc.samp.microsoft) plugin.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAM - Downgrade Rights on Software Entitlement</td>
<td>Validates that the downgrade rights pushed from the content service are correctly populated on the Downgrade Rights related list on the software entitlement form.</td>
<td>Orlando</td>
</tr>
<tr>
<td>SAM - Validate Reconciliation for Custom Product</td>
<td>Validates reconciliation for a custom product.</td>
<td>Orlando</td>
</tr>
<tr>
<td>SAM - Software Spend Transaction</td>
<td>Validates the creation of a Software Spend Transaction.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Note: Requires the Software Asset Management - Spend Detection (com.sn_sam_spend) plugin.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAM - Pin and Unpin Publishers on License Workbench</td>
<td>Validates the pin and unpin of publishers on License Workbench.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Note: Requires demo data.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAM - Software Model and Software Entitlement</td>
<td>Tests that a user can create a software model and software entitlement and validates those records.</td>
<td>New York</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>SAM - Software Installation and Discovery Model</td>
<td>Tests that a user can create a software installation and discovery model and validates those records.</td>
<td>New York</td>
</tr>
<tr>
<td>SAM - Software Entitlement Creation Using Custom PPN</td>
<td>Creates a custom software product, a custom DMAP for the custom product, a custom Part Number for the custom DMAP, a software entitlement using the custom Part Number, and verifies that a software model is automatically created.</td>
<td>New York</td>
</tr>
<tr>
<td>SAM - Software Model Checks for SAP Named Users</td>
<td>Tests that the software model form changes when the publisher is SAP and the product is Named Users.</td>
<td>New York</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Software Asset Management Professional for SAP (com.sn_samp_sap) plugin.</td>
<td></td>
</tr>
<tr>
<td>SAM - Software Model Checks for SaaS</td>
<td>Tests that the Software Model form changes when a SaaS product is selected.</td>
<td>New York</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Software Asset Management - SaaS License Management Integrations (com.sn_sam_saas_int) plugin.</td>
<td></td>
</tr>
<tr>
<td>SAM - Validate Fields on SaaS Software Products</td>
<td>Tests that the <strong>Subscription software</strong> and <strong>Ignore installs</strong> fields are present on the Software Product form.</td>
<td>New York</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the Software Asset Management - SaaS License Management Integrations (com.sn_sam_saas_int) plugin.</td>
<td></td>
</tr>
</tbody>
</table>
Hardware Asset Management

The ServiceNow® Hardware Asset Management application is a licensable application that on activation provides advanced workflow, automation, and mobile capabilities to maintain your assets.

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Watch this short video for an introduction to the Hardware Asset Management application.

If you decide to install Hardware Asset Management demo data, make sure to select the demo data option while installing the Hardware Asset Management application from the ServiceNow Store. Install the Hardware Asset Management application and navigate to Plugins in your ServiceNow instance. To ensure that the demo data related scripts are executed, open the Hardware Model Normalization plugin (com.sn_hwnorm) and click the Load Demo Data Only related link.

Explore
• Hardware Asset Management release notes

Set up
• Hardware model normalization
• Asset automation
• Import and export content data

Use
• Hardware Asset dashboard
• Disposal orders for Asset Management
• Hardware asset request flow
• Inventory stock order request

Develop
• Developer training
• Developer documentation

Troubleshoot and get help
• Ask or answer questions in the Hardware Asset Management community on the Now Community
• Search the HI Knowledge Base for known error articles
• Contact ServiceNow Technical Support

Mobile for IT Asset Management

Use the Now® Mobile and Agent mobile apps to manage your assets.

Agent Mobile app

Use the Agent Mobile app to create assets, look up assets, and receive assets from a purchase order.

Create an asset

Use the Agent Mobile app to create an asset record by scanning the asset.
Role required: asset

1. Navigate to **Asset** and tap **Create Asset**.

2. Scan the asset serial number or asset tag, then tap **Search**.
An asset record is displayed if the asset already exists in your ServiceNow instance. This is to ensure you don’t create duplicate asset records.

3. If no existing asset record is found, tap the action icon in the upper right and select Create Asset.
4. Scan or enter values for the Asset Tag, Serial Number, Model, and Stockroom fields.
5. Tap Submit to create the asset.

Asset lookup

Search for an asset record in your ServiceNow instance by scanning the asset.

Role required: asset

1. Navigate to Asset and tap Asset lookup.
2. Scan the asset tag, then tap Search.
3. An asset record is displayed if the asset exists in your ServiceNow instance.

Receive assets from a purchase order

Scan assets from a purchase order (PO) to verify that you received all assets from the order.

Role required: procurement_admin or procurement_user

1. Navigate to Procurement and tap POs Next 30 Days.
2. Select a purchase order.
3. Tap Related list.
4. Tap the PO Line Items asset that you ordered and swipe Receive to receive the asset.
5. If you only need to receive a single purchase, on the Receive form, scan the QR code for either the asset tag or serial number.

6. If you need to receive multiple purchases, on the Receive form, tap **Scan next item**. Continue tapping **Scan next item** until you've scanned all of your purchases.

7. Tap **Submit**.

The purchase order is marked as received.

**Now Mobile app**

Use the Now Mobile app to view the assets assigned to you. Create incidents to report any issues with your assets to your IT department.
Tap My Locker on the Services page to view all assets that are assigned to you. Select any of your assets to create an incident for that asset.

**Asset and CI management**

Asset and configuration item (CI) management refers to creating assets, setting appropriate states and substates, synchronizing assets and CIs, managing consumables, and retiring assets.

**Relationship between asset and CI**

It is important to manage the relationship between assets and associated CIs. Assets are tracked with the Asset Management application, which focuses on the financial aspects of owning property. Configuration items are stored in the CMDB, which is used to track items and make them available to users.

When an asset has a corresponding configuration item, the asset record and the configuration item record are kept synchronized with two business rules.

- **Update CI fields on change** (on the Asset (alm_asset) table)
- **Update Asset fields on change** (on the Configuration Item (cmdb_ci) table)

**Note:** Assets and CIs can be synchronized only if they are logically mapped.

**Asset-CI mapping and synchronization**

The State field of asset record and Status field of CI record are synchronized so that changes made on one form trigger the same update on the corresponding form, ensuring consistent reporting.

**Note:** The Now Platform synchronizes updates between assets and configuration items only if the asset and configuration item are pointed toward each other.

The following diagram illustrates the concept of Asset-CI mapping and synchronization.
Asset records and CI records are mapped logically

Asset record
- State
- Sub state

Synchronization directions
- Asset to CI
- CI to Asset

CI record
- Install Status
- Hardware Status
- Sub status

Fields

This synchronization and mapping is based on the following factors:

- Asset state and CI status are not mapped on one-to-one basis; rather they are mapped to the most logical counterpart on the other table. For example, for a hardware asset set to state In Stock - Pending disposal, the corresponding CI is set to In Disposition with no substate.
- This synchronization happens between the asset’s State field and the following CI fields:
  - Install Status field: Install Status does not have a sub status and must be used for non-hardware CIs.
  - Hardware Status and Sub status field: Hardware Status is visible only for Hardware CI.
- Drive changes by updating the state on the Asset form. The Asset-CI synchronization can be driven in the following ways:
  - Asset to CI synchronization: Change to the asset’s status updates the logically mapped CI’s Install Status or Hardware Status and sub status.
  - CI to Asset: Change to the CI’s activate Status or Hardware Status updates the logically mapped asset’s states and sub states.
For a CMDB hardware CI, if both Hardware Status and Install Status is updated, the Hardware Status change is considered for mapping the corresponding state of the asset.

CI’s Install Status and Hardware Status work independently, so the two fields aren’t related. CI’s Hardware Status change does not change CI’s Install Status and vice versa. To avoid confusion, keeping both status for CMDB CI Hardware is not recommended.

List of the fields that get synced between Asset and CI

When modifying any of following fields on the asset or CI record, the same field on the corresponding record is automatically updated (with the exception of the Cost field, which is informational-only on the CI record).

Following is a list of fields that are synched.

- Asset tag
- Assigned
- Assigned to
- Checked in
- Checked out
- Company
- Cost (synchs in only one direction: asset to CI)
- Cost center
- Delivery date
- Department
- Due in
- Due
- GL account
- Install date
- Invoice number
- Justification
- Lease id
- Location
- Managed by
- Model
- Order date
- Order received
- Ordered
- Owned by
- PO number
- Purchase date
- Purchased
- Serial number
- Support group
- Supported by
- Vendor
- Warranty expiration
Asset and CI creation properties

**glide.create_alm_asset.async**

The system property `glide.create_alm_asset.async` controls whether assets are created immediately when a configuration item (CI) is created, or are created after a delay. A delay in asset creation allows large numbers of CIs to be created quickly. When this property is set to true, assets are created by the **Asset - Create asset delayed sync** scheduled job that runs every 15 minutes. View the status of the scheduled job in the Asset Job Log table (asset_job_log). To view assets waiting to be created and asset creation errors, navigate to **Asset > Administration > Asset Creation Queue**. To reprocess an error, update the state from Error to Ready. The next time the scheduled job runs, it reattempts to create the asset.

When the `glide.create_alm_asset.async` property is set to false, assets are created immediately from CIs.

**Note:** The default value of this property is false if you upgrade to Paris from Orlando or earlier. Before updating this property, review your processes that depend on an asset value present on a CI and make any necessary changes to account for delayed asset creation.

**glide.asset.create_ci_with_ire**

The system property `glide.asset.create_ci_with_ire` enables CIs to be created from assets using the ServiceNow® Configuration Management Database (CMDB) Identification and Reconciliation engine (IRE). This property affects CI classes that have an identification rule on serial number and have no dependent relationships with other CI classes.

**Note:** CI classes that are extended from the hardware CI class (cmdb_ci_hardware) are also created from assets using the IRE, but are not controlled by this property.

CIs created with the IRE are named using the format **Serial number - Model name** and the source is SNAssetManagement. The Seri**al number** field is mandatory on assets with model categories that correspond to these CI classes. Asset creation fails if its serial number is present on an existing CI or asset. The **Serial number** field is also required to receive purchase order line items for model categories that correspond to these CI classes. The **Serial number** field is not mandatory to create pre-allocated assets, but the serial number must be provided when the asset is allocated.

**Note:** The default value of this property is false if you upgrade to Paris from Orlando or earlier. Before updating this property, review customizations on the **Serial number** field and any integrations or flows that use an existing serial number to create an asset.

Create assets

You can create hardware, software license, consumable, license, software entitlement, and facility assets.

Role required: asset

1. Navigate to **Asset > Portfolios > All Assets**.
2. Select the type of asset you want to create.
3. Click **New**.
4. Fill in the fields.

### Asset record fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the asset as it appears in record lists. Automatically set when asset is created, based on Asset Tag and Model fields.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model grouping of the asset. Based on the model category selected, the asset can be linked to a configuration item.</td>
</tr>
<tr>
<td>Model</td>
<td>Specific product model of the asset.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>CI automatically created when this asset is created. The name that appears in this field is based on Serial number and Model. Point to the reference icon to see the configuration item details inherited from the asset record.</td>
</tr>
</tbody>
</table>
| Quantity               | Number of items this asset represents. An asset always has a quantity of one unless one or more of these points are true.  
  - It is a consumable. Quantity is unrestricted because consumables are tracked in groups.  
  - It is pre-allocated. Quantity is unrestricted when Model category and Model are defined and Substate is set to Pre-allocated. |
<p>| General                | Not all fields are available for each type of asset.                         |
| Asset tag              | Alphanumeric information assigned by your organization to help track the asset. |
| State                  | Current state of the asset, such as On order or In use.                      |
| Assigned to            | Person using or primarily responsible for this item. This field is visible when the asset state is In Use. |
| Managed by             | Person who maintains the asset. This can be different from the person in the Owned by field. |
| Owned by               | Person who has financial ownership of the asset. This can be different from the person in the Managed by field. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent</td>
<td>Parent asset of the asset. For example, a monitor or peripheral can have a workstation as their parent asset. When a parent link is defined, the fields related to assignment and state of the child assets is set to read-only and are populated based on the parent assignment and state fields. For more information, see Creating Bundled Models.</td>
</tr>
<tr>
<td>Class</td>
<td>Asset group, for example, base, hardware, license, or consumable.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the asset that would be helpful for others to know.</td>
</tr>
<tr>
<td>Serial number</td>
<td>Serial number of this asset.</td>
</tr>
<tr>
<td>Substate</td>
<td>Current substate of the asset. The available substate settings depend on the state selected. For example, the Retired state contains the Substate options Disposed, Sold, Donated, and Vendor credit.</td>
</tr>
<tr>
<td>Location</td>
<td>Current physical location of the asset.</td>
</tr>
<tr>
<td>Department</td>
<td>Department to which the asset belongs.</td>
</tr>
<tr>
<td>Company</td>
<td>Company or organization to which this asset belongs.</td>
</tr>
<tr>
<td>Assigned</td>
<td>Date on which the asset was assigned to a user.</td>
</tr>
<tr>
<td>Installed</td>
<td>Date on which the asset was installed.</td>
</tr>
<tr>
<td>Financial</td>
<td>The Financial section is only available for hardware, software entitlement, and facility assets.</td>
</tr>
<tr>
<td>Request line</td>
<td>Requested item to which the asset is linked.</td>
</tr>
<tr>
<td>Invoice number</td>
<td>Invoice under which the asset was billed.</td>
</tr>
<tr>
<td>Cost</td>
<td>Price at which the asset was purchased.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor from which the asset was purchased. For assets automatically created from purchase orders in Procurement, the default value of the Vendor field is the vendor specified on the purchase order.</td>
</tr>
<tr>
<td>Opened</td>
<td>Date on which the requested item record was opened. The system automatically populates the field when a request line is specified.</td>
</tr>
<tr>
<td>GL account</td>
<td>General ledger account number with which the asset is associated.</td>
</tr>
<tr>
<td>Cost center</td>
<td>Group financially responsible for the asset.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>How the asset was acquired. Base system choices are <strong>Purchase</strong>, <strong>Lease</strong>, <strong>Rental</strong>, and <strong>Loan</strong>. For assets automatically created from purchase orders in Procurement, the default value is <strong>Purchase</strong>.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Capex</strong>: Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Opex</strong>: Operational expenditure is an ongoing expenditure. For example, toners for the photocopier.</td>
</tr>
<tr>
<td>Disposal</td>
<td></td>
</tr>
<tr>
<td>Disposal order number</td>
<td>A unique number assigned to the asset disposal order.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal vendor</td>
<td>The vendor assigned to carry out the asset disposal order.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Vendor disposal order ID</td>
<td>Order number assigned by the vendor assigned to carry out the asset disposal order.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal date</td>
<td>The date when the asset disposal order process is completed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal reason</td>
<td>Text explaining why the asset is being retired.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Beneficiary</strong></td>
<td>Organization that receives the asset when it is retired.</td>
</tr>
<tr>
<td><strong>Resale price</strong></td>
<td>Value of the asset when it is retired. For example, if the asset is donated, the value used when reporting taxes.</td>
</tr>
<tr>
<td><strong>Scheduled retirement</strong></td>
<td>Scheduled date on which the asset is retired.</td>
</tr>
<tr>
<td><strong>Retired date</strong></td>
<td>Actual date on which the asset was retired.</td>
</tr>
<tr>
<td><strong>Depreciation</strong></td>
<td>The Depreciation section is only available for hardware and facility assets.</td>
</tr>
<tr>
<td><strong>Depreciation</strong></td>
<td>Depreciation method that is applied. Base system choices are <strong>Declining Balance</strong> and <strong>Straight Line</strong>. The depreciation value is defaulted from the associated Model.</td>
</tr>
<tr>
<td><strong>Depreciation effective date</strong></td>
<td>Date on which the specified depreciation method begins.</td>
</tr>
<tr>
<td><strong>Salvage value</strong></td>
<td>Estimated value of an asset at the end of its useful life. This value must be less than or equal to the Cost of the asset.</td>
</tr>
<tr>
<td><strong>Residual date</strong></td>
<td>Number of days that have passed since the <strong>Depreciation effective date</strong>.</td>
</tr>
<tr>
<td><strong>Residual value</strong></td>
<td>Value in the Cost field with the depreciation method applied.</td>
</tr>
<tr>
<td><strong>Depreciated amount</strong></td>
<td>Amount the asset has depreciated.</td>
</tr>
<tr>
<td><strong>Contracts</strong></td>
<td>The Contract section is only available for hardware, software entitlement, or facility assets.</td>
</tr>
<tr>
<td><strong>Lease contract</strong></td>
<td>Name of the lease contract that applies to the asset.</td>
</tr>
<tr>
<td><strong>Warranty expiration</strong></td>
<td>Expiration date of the asset warranty.</td>
</tr>
<tr>
<td><strong>Support group</strong></td>
<td>Group managing the contract covering the asset.</td>
</tr>
<tr>
<td><strong>Supported by</strong></td>
<td>Person managing the contract covering the asset.</td>
</tr>
</tbody>
</table>

**Activities**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Work notes</strong></td>
<td>Work notes are updated for the following cases:</td>
</tr>
<tr>
<td></td>
<td>- Updates to <strong>Assigned To</strong>, <strong>Managed To State</strong>, <strong>Substate</strong>, and <strong>Reserved</strong> fields of asset. The columns for these fields are audited by default and any update is recorded in the work notes.</td>
</tr>
<tr>
<td></td>
<td>- Work notes for hardware and software assets are updated when asset is received by a purchase order and transfer order. These work notes help in tracking life cycle of the asset.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Related links</td>
<td></td>
</tr>
<tr>
<td>Calculate Depreciation</td>
<td>Click to calculate the depreciation amount and residual value.</td>
</tr>
<tr>
<td>Delete Assets Only</td>
<td>Click to delete the assets and not the associated CI.</td>
</tr>
<tr>
<td>Related lists</td>
<td></td>
</tr>
<tr>
<td>Assets</td>
<td>Assets that are related to the asset you created.</td>
</tr>
<tr>
<td>Expense lines</td>
<td>Expense line associated with the asset</td>
</tr>
</tbody>
</table>

5. Click Submit.

**Retire assets**

You can retire an asset at any time.

Role required: asset

After you change the state of an asset to Retired, the Substate field is active. When you retire an asset, the status of related CIs also changes to Retired. Selecting a substate is not required, but can be helpful for tracking and reporting.

1. Navigate to Asset > Portfolios > All Assets.
2. In State, select Retired.
3. Optional: In Substate, select Disposed, Sold, Donated, or Vendor Credit.
4. Click Update.

**Delete assets**

You can delete an asset at any time.

Role required: asset

A confirmation must be accepted before the asset and components are permanently deleted. If a CI and asset are linked, deleting one also deletes the other.

Only delete an asset to clean up errors. For tracking purposes, the correct method for managing an asset that is no longer in use is to change the state of the asset to Retired.

1. Navigate to Asset > Portfolios > All Assets.
2. Select the check box to the left of the asset Name.
3. In the Actions choice list below the list, select Delete.

**Map asset and CI fields**

When you map the asset and CI fields, synchronization happens both ways. Changes to either the asset or CI record are updated to the logically mapped record. You can synchronize custom mappings and mappings provided with the base instance.

Role required: admin or asset
Note: If you upgraded from a prior release and customized the `AssetAndCISynchronizer` script include before the upgrade, you must overwrite the customization and then recreate the custom mappings.

You can conditionally map the fields for synchronization. For example, you can map the Location field only for a hardware asset and not for a software asset. So when an asset is updated, the Location field is synchronized only for the hardware asset.

1. Navigate to Asset > Administration > Asset-CI Field Mapping and click New.
2. From the Asset field list, select the field.
   This list refers to the alm_asset table.
3. From the Configuration Item field list, select the logically associated field. This list refers to the cmdb_ci table.
4. To create conditions for the mapping, click the Advanced view related link.
   - To specify conditions for synchronizing the asset field with the CI field, use the Asset mapping condition builder.
   - To specify conditions for synchronizing the CI field with the asset field, use the Configuration Item mapping condition builder.
5. Select the Active check box to activate the mapping.
6. Click Submit.

---

Map asset state and CI install status

Map the asset State and Substate fields to the CI Install Status field. The Substatus field of the CI Install Status field should not be used for hardware CIs. Asset synchronization does not update this field when hardware assets are updated. When you create the mapping, you can set the synchronization direction from the asset, CI, or both.

Role required: admin or asset

Note: If you upgraded from a prior release and customized the `AssetAndCISynchronizer` script include before the upgrade, you must overwrite the customization and then recreate the custom mappings.

1. Navigate to Asset > Administration > Asset-CI Install Status Mapping.
2. By default, only custom mappings display. The list of mappings uses the filter condition of (Out of the box) (is) (False).
3. Click New.
4. From the Asset State list, select the state you want to map.
5. Optional: If available, select a substate from the Asset Substate list.
   Some of the asset states do not have a substate.
6. From the Configuration Item Status list, select the logically associated CI status you want to map.
7. From the Sync direction list, select the direction you want to drive the synchronization.
8. Select the Active check box to activate the mapping.
9. Click Submit.
Map asset state and CI hardware status

Map the asset **State** and **Substate** fields to the **CI Install Status** field. Don't use the **Substatus** field on hardware CIs because the CI synchronization does not update the field when assets are updated. When you create the mapping, you can set the synchronization direction from the asset, CI, or both.

Role required: admin or asset

Note: If you upgraded from a prior release and you've customized the AssetAndCISynchronizer script before the upgrade, overwrite the customization and then recreate the custom mappings.

The **Install Status** and **Hardware Status** fields of a CI are independent of each other. There is no correlation between them. A change to the **Hardware Status** field does not change the **CI Install Status** field and vice versa.

1. Navigate to **Asset > Administration > Asset-CI Hardware Status Mapping**.
   By default, only custom mappings display. The list of mappings uses the filter condition of (Out of the box) (is) (False).
2. Click **New**.
3. From the **Asset state** list, select the state you want to map.
4. Optional: If available, select a substate from the **Asset substate** list.
   Some of the asset states do not have a substate.
5. From the **Configuration Item status** list, select the logically associated CI state you want to map.
6. Optional: If available, select a substate from the **Configuration Item substatus** list.
   Some of the CI statuses do not have a substatus.
7. From the **Sync direction** list, select the direction you want to drive the synchronization.
8. Select the **Active** check box to activate the mapping.
9. Click **Submit**.

Asset life cycle automation

Automate the update of your asset records throughout its life cycle and remove the effort of manually maintaining asset accuracy.

Assets need to be updated and tracked from the time they are purchased until they are disposed. The automation process starts from the time you request an asset through determining if the asset is in stock or if it needs to be purchased. If it's in stock, then the asset is transferred via the transfer order workflow. If the asset needs to be bought, then the purchase order workflow is triggered. The automated workflows take away the need to manually update each asset record or the associated configuration item (CI). Once the workflow is complete, the asset records or CIs are automatically updated.

You can create bulk stock orders for hardware assets for your stockrooms. You can specify the model and the exact quantity you require. Once the item is procured or transferred, the workflow is complete.

You can also create disposal orders for hardware and consumable assets. This workflow guides you through five asset disposal tasks. These tasks involve the planning, scheduling, verification, departure, and the final confirmation of the disposed assets. Closing a task completes the task and creates the next task in the workflow.
For example, Verify is the first task in the asset disposal workflow. Once you complete and close
the Verify task, the Schedule pickup task is automatically created. This process continues till you
close all the tasks required for disposing the asset. For information, see Hardware disposal order
stages.

**Asset tasks**

Asset tasks are provided for deploy, replace or swap, or retirement operations for your assets.
These tasks automatically update the CI/asset record upon the completion of these operations.

If an asset is being deployed, replaced, or retired via an incident, change request or a field
service work order, the CI/asset record is automatically updated along with the related records
for the CI/asset. For example, you have a change ticket to retire a server. Once the change is
implemented, the Change Management application triggers the retire asset event. The retire task
is triggered and updates the following:

- CI
- related asset record
- software allocations
- maintenance contracts

This increases the data accuracy by reducing the need for manual intervention to update
records.

This table lists the asset tasks available in each application.

<table>
<thead>
<tr>
<th>Application</th>
<th>Asset Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Management</td>
<td>• Retire</td>
</tr>
<tr>
<td></td>
<td>• Swap/Replace</td>
</tr>
<tr>
<td>Change Management</td>
<td>• Deploy</td>
</tr>
<tr>
<td></td>
<td>• Retire</td>
</tr>
<tr>
<td>Field Service Management</td>
<td>• Deploy</td>
</tr>
</tbody>
</table>

**Audit your asset inventory**

Conduct scheduled or blind audits of asset stockrooms and other locations such as offices or
data centers.

Requirements:

- Hardware Asset Management
- ServiceNow Agent mobile app

Role required: asset

1. Create an audit on the Now Platform or in the Agent mobile app.
   The Now Platform is typically used to create scheduled audits, and the Agent mobile app
can be used for blind audits.
a) To create an audit on the Now Platform, navigate to Asset Audits > Asset Audits and click New.

b) To create an audit in the Agent mobile app, navigate to Asset and select either Stockroom audits or Location audits.

2. Scan assets using the Agent mobile app.
   a) Select the audit you created, then click Scan.
   b) When you are done scanning assets, click Review.

   **Tip:** On the review page, you can delete assets if needed. However, Hardware Asset Management automatically removes duplicates for assets that you accidentally scan twice.

   c) Click Submit.

   d) If you are finished scanning assets, mark the audit as Complete in the Agent mobile app. Otherwise, return to the audit and continue scanning.

   **Note:** You can start a new scan as many times as you need while the audit is in progress. Once you mark the audit as Complete, you can't scan any more assets.

3. View audit results on the Now Platform.
   a) Navigate to Asset Audits > Asset Audits and select the audit.
The Audit Results section shows the status of the assets from the audit.

**Audit Results**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanned and expected</td>
<td>Number of expected assets that were scanned.</td>
</tr>
<tr>
<td>Scanned and not expected</td>
<td>Number of assets that were scanned but were not expected.</td>
</tr>
<tr>
<td>Expected and not found</td>
<td>Number of expected assets that were not scanned.</td>
</tr>
<tr>
<td>New</td>
<td>Number of assets that were scanned but do not have a record in your ServiceNow instance.</td>
</tr>
</tbody>
</table>

The Expected Assets related list shows all assets that are assigned to the stockroom or location that is being audited. The list is not populated until scanning begins.

The Scanned Assets related lists shows all assets that are scanned during the audit. The list is updated each time scans are submitted from the mobile app.

**Asset classes**

The default asset classes are Hardware, Software License, and Consumable. These general classes can be used to manage various assets.

If the general classes that are provided aren't appropriate for a specific group of assets, consider creating a new asset class. For example, a fleet of cars could be tracked in a custom asset class named Vehicle. Before creating new asset classes, analyze business needs to see if the general classes can be used. Managing a lot of asset classes can be difficult to maintain.

Built-in functionality allows you to use asset classes for financial tracking, in a model bundle, and as a pre-allocated asset.

**Create an asset class**

Creating a new asset class requires defining a new table and creating a corresponding application and module, then adding the new asset class to new or existing model categories. The default asset classes are Hardware, Software License, and Consumable. These general classes can be used to manage a variety of assets.

Role required: asset or category_manager

If the general classes are not appropriate for a specific group of assets, consider creating a new asset class. For example, a fleet of cars could be tracked in a custom asset class named Vehicle. Before creating new asset classes, analyze business needs to see if the general classes can be used. A large number of asset classes can be difficult to maintain.

Built-in functionality allows you to use asset classes for financial tracking, in a model bundle, and as a pre-allocated asset.
Ensure that the model categories contain models. Use the Table form to extend an existing table.

1. Navigate to **System Definition > Tables & Columns > Create Table** and fill out the Table form fields with information on the new table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Display name of table that can be localized.</td>
</tr>
<tr>
<td>Name</td>
<td>Internal name of table that cannot be changed later.</td>
</tr>
<tr>
<td>Extends table</td>
<td>Table that new table inherit fields from.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that uses the record.</td>
</tr>
<tr>
<td>Create module</td>
<td>Check box for creating a module.</td>
</tr>
<tr>
<td>Create mobile module</td>
<td>Check box for creating a mobile module.</td>
</tr>
<tr>
<td>Add module to menu</td>
<td>Menu that module will display.</td>
</tr>
<tr>
<td>New menu name</td>
<td>New menu name.</td>
</tr>
</tbody>
</table>

2. Click **Submit**.
3. Navigate to the new application (for example, **Asset > Vehicle**) and click **New**.
4. Configure the form to include **Model, Model Category, and Quantity**.
5. Create a model category and add the asset class you created to the **Asset class** field.
6. Create new models and add them to the model category.

Now that the model category (associated with the new asset class) and the models are created, manage the models as assets. For example, use the model in a bundle.

**Add depreciation to an asset**

Depreciation is the reduction in value of an asset over time.

Role required: asset

A depreciation schedule can be added to hardware assets. Based on the information specified in the asset record, the ServiceNow platform calculates the depreciation amount daily using the Calculating Depreciation scheduled job.

The Now Platform calculates the read-only **Residual date** and **Residual value** fields based on the **Cost, Depreciation, and Depreciation effective date** fields. For example, if the asset **Cost** is $1000.00, the **Straight Line** depreciation method is selected, and exactly two years have passed, the **Residual value** would be $500.00.

For more information about fixed assets and depreciation, see **Using Depreciation with Fixed Assets**.

1. Navigate to **Asset > Portfolios > Hardware Assets**.
2. Select an asset.
3. Fill in the **Depreciation, Depreciation effective date, Salvage Value, and Covered by fixed asset** fields as described in **Create assets**.
   Consider these points.
   - If the depreciation effective date is in the future, depreciation is 0 and the current, residual value is the original purchase price. The system does not begin to calculate depreciation until the effective date is reached.
The salvage value must be less than or equal to the asset cost. If a salvage value greater than the cost is entered, a warning message appears and the record cannot be saved.

4. Right-click the header and click **Save**.

5. Click **Calculate Depreciation**.
   The Residual date, Residual value, and Depreciated amount fields are automatically calculated.

### Create license assets

You can manage your organization’s software license assets.

Role required: sam

Examples include a license to use a single copy of a desktop software program and an enterprise license to install a software program on multiple computers.

1. Navigate to **Asset > Portfolios > License Assets** and click **New**.

2. In the **Rights** field, type the number of entitlements to be granted by this license.

3. Complete the form as described in **Create assets**.

### Set asset states and substates

Asset states and corresponding substates can be used to accurately track assets at a detailed level.

Role required: asset

Good asset information helps with reporting, controlling assets, and lowering costs. For example, recording missing items using the **State** and **Substates** fields enables you to run reports and analyze the information. You can use this information to lower costs.

**Tip:** Generally, state values should not be modified and should remain as-is. If the state values are supported and defined by the process, you can modify substates.

1. Navigate to **Asset > Portfolios > All Assets**.

2. Select an asset.

3. Edit the **State** and **Substate** fields.

#### Asset states and substates definitions

<table>
<thead>
<tr>
<th>State</th>
<th>Available substates</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>On order</td>
<td>None</td>
<td>Asset is ordered but not received.</td>
</tr>
<tr>
<td>In stock</td>
<td>Available, Reserved, Defective, Pending repair, Pending install, Pending disposal, Pending transfer, Pre-allocated</td>
<td>Asset is stored in a stockroom. Substate indicates if it is possible or if you should put the asset into use.</td>
</tr>
<tr>
<td>In transit</td>
<td>Available, Reserved, Defective, Pending install, Pending disposal, Pre-allocated</td>
<td>Asset being transported.</td>
</tr>
</tbody>
</table>
### Create fixed assets

Fixed assets are containers that can hold multiple assets. Fixed assets are commonly tracked at the corporate level by a finance or accounting department, but may contain IT assets such as hardware and software.

The **Fixed Asset** option in the Cost application shows the IT assets related to a fixed asset record. This link can help IT stay coordinated with the corporate asset system. Users with the financial_mgmt_admin and financial_mgmt_user roles can create fixed assets. After creating a fixed asset and adding assets, the residual value can be automatically calculated.

To create a fixed asset:

1. Navigate to **Cost > Fixed Assets**.
2. Click **New**.
3. Enter a name for the fixed asset.
4. Click **Submit**.

To add assets to a fixed asset:

1. Navigate to **Cost > Fixed Assets**.
2. Click a fixed asset.
3. In the **Covered assets** related list, click **Edit**.
4. In the **Collection** list, double-click an asset to add it to the **Covers Assets List**.
5. Click **Save**.

To sum the residual values of all assets in a fixed asset:

1. Navigate to **Cost > Fixed Assets**.
2. Click a fixed asset.
3. Click **Sum Residual Value**.

<table>
<thead>
<tr>
<th>State</th>
<th>Available substates</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>In use</td>
<td>None</td>
<td>Asset is in use. This option is available for both consumables and non-consumables, but you should only use this option for consumables.</td>
</tr>
<tr>
<td>In maintenance</td>
<td>None</td>
<td>Asset being repaired or undergoing maintenance.</td>
</tr>
<tr>
<td>Retired</td>
<td>Disposed, Sold, Donated, Vendor credit</td>
<td>Set the asset to a Retired state when the asset has reached the end of life. Only delete asset records if they were created erroneously.</td>
</tr>
<tr>
<td>Missing</td>
<td>Lost, Stolen</td>
<td>An asset that is missing or lost.</td>
</tr>
</tbody>
</table>
The ServiceNow platform calculates the **Residual Value**, **Total cost**, and **Total depreciation** based on information in the **Financial** and **Depreciation** sections on the individual asset records.

**Use depreciation with fixed assets**

You can calculate depreciation for a fixed asset using a choice of depreciation schedules. Calculating depreciation for a fixed asset can help IT coordinate with the corporate fixed asset system to report correct valuation and book value.

Role required: financial_mgmt_admin or financial_mgmt

When creating a new depreciation schedule, select the **Declining Balance** or **Straight Line** depreciation **Category**. The two categories depreciate an asset by the same overall amount during the asset life cycle, but do so on different schedules.

- **Declining Balance**: depreciates an asset by a greater amount in earlier accounting periods than in later periods.
- **Straight Line**: depreciates an asset by an equal amount each accounting period.

The following example shows depreciated value on a $10,000.00 asset over five years using the two different methods.

**Using depreciation with fixed assets**

<table>
<thead>
<tr>
<th>Year</th>
<th>Declining balance</th>
<th>Straight line</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$5000.00</td>
<td>$8000.00</td>
</tr>
<tr>
<td>2</td>
<td>$2500.00</td>
<td>$6000.00</td>
</tr>
<tr>
<td>3</td>
<td>$1250.00</td>
<td>$4000.00</td>
</tr>
<tr>
<td>4</td>
<td>$625.00</td>
<td>$2000.00</td>
</tr>
<tr>
<td>5</td>
<td>$0</td>
<td>$0</td>
</tr>
</tbody>
</table>

1. To view a depreciation schedule, navigate to **Financial Management** > **Depreciation** and click the **Category**.
2. To create a new depreciation schedule, click **New**.
3. Enter a **Name**.
4. Select a **Category**.
5. Add a **Script** to calculate depreciation value.
Example depreciation schedule script

6. Click Submit. The depreciation schedule is now available in the Depreciation field on the asset record.

Consumables life cycle

Consumables are assets that are not tracked individually, but as a group of the same model. The group of consumables has one or more of the following traits.

- Same location
- Same state
- Consumed by the same asset, typically as accessories or parts

Some common consumable assets include mouse devices, computer keyboards, and pencils. The base ServiceNow system includes the Consumable model category. The first step in working with models is to create a model within the model category for an individual consumable asset. Items such as keyboards and mouse devices are often tracked as consumables. Consumables cannot be pre-allocated.

Consumable assets are stored in the Consumable (aim_consumable) table. Consumables follow a slightly different life cycle from other assets.

Stages of consumables

The consumable lifecycle stages are as follows.

- On order
- In stock
- In transit
- Consumed
- In maintenance
View consumable assets

Consumables are tracked as a group of the same model, but you can view individual consumables in the consumable model record.

Role required: model_manager

1. Navigate to **Product Catalog** > **Product Model** > **Consumable Models**.
2. Open a consumable model record.
3. View individual consumables in the **Consumables** related list.

Create consumable assets

Create a consumable to track an asset as a group of the same model.

Role required: asset

1. Navigate to **Asset** > **Portfolios** > **Consumables** and create a new record (see table for field descriptions).

**Consumable record form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the asset.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model category that controls if an asset is linked to a CI.</td>
</tr>
<tr>
<td>Model</td>
<td>Product model of the asset.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Amount of items the asset represents.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>State of the asset.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent asset. When a parent asset is defined, the <strong>Assignment</strong> and <strong>State</strong> fields of the child asset are automatically populated based on the <strong>Assignment</strong> and <strong>State</strong> fields of the parent asset and are read-only.</td>
</tr>
<tr>
<td>Class</td>
<td>Type of asset. The system automatically sets the <strong>Class</strong> to <strong>Consumable</strong>.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure. Choose from the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Capex</strong>: Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Opex</strong>: Operational expenditure is an ongoing expenditure. For example, toners for the photocopier.</td>
</tr>
<tr>
<td>Substate</td>
<td>Substate of the asset.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Location</td>
<td>Location of the asset.</td>
</tr>
<tr>
<td>Cost</td>
<td>Price that the asset was purchased for.</td>
</tr>
<tr>
<td>Cost Center</td>
<td>Cost center financially responsible for the asset.</td>
</tr>
<tr>
<td>Disposal</td>
<td></td>
</tr>
<tr>
<td>Disposal order number</td>
<td>A unique number assigned to the asset disposal order.</td>
</tr>
<tr>
<td>Disposal vendor</td>
<td>The vendor assigned to carry out the asset disposal order.</td>
</tr>
<tr>
<td>Vendor disposal order ID</td>
<td>Order number assigned by the vendor assigned to carry out the asset disposal order.</td>
</tr>
<tr>
<td>Disposal date</td>
<td>The date when the asset disposal order process is completed.</td>
</tr>
<tr>
<td>Disposal reason</td>
<td>Text explaining why the asset is being retired.</td>
</tr>
<tr>
<td>Beneficiary</td>
<td>Organization that receives the asset when it is retired.</td>
</tr>
<tr>
<td>Resale price</td>
<td>Value of the asset when it is retired. For example, if the asset is donated, the value used when reporting taxes.</td>
</tr>
<tr>
<td>Scheduled retirement</td>
<td>Scheduled date on which the asset is retired.</td>
</tr>
<tr>
<td>Retired date</td>
<td>Actual date on which the asset was retired.</td>
</tr>
</tbody>
</table>

Note: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.
2. Click Submit.

**Consume consumable assets**

To consume consumable assets, they must have a state of **In Stock** and a substate of **Available**.

Role required: asset

1. Navigate to Asset > Portfolios > Consumables.
2. Click the Display Name of a consumable asset with a state of **In Stock** and a substate of **Available**.
3. Click Consume.
4. Enter the Quantity to consume.
5. In Asset, click the lookup icon and select the asset associated with the consumable. For example, a mouse tracked as a consumable asset can be associated with a non-consumable asset such as a computer.
6. In User, click the lookup icon and select a user associated with the consumable.
7. Click OK.

On the Consumable form, the Quantity field shows the reduced number. The Consumables list contains two records for the consumable in the specific stockroom: one with a state and substate of **In Stock** and **Available** (if you did not consume the entire quantity), and one with a state of Consumed. If a consumable is not in the process of being transferred to a different stockroom and information in the data record is the same, similar records merge automatically. After a consumable is consumed, the record remains in the system for reporting purposes.

**Return consumable assets to stockrooms**

Move a consumable asset that is in a consumed state and has completed its life cycle back to an in-stock status.

Role required: Any of these three roles:
- asset
- itil
- itil_admin

1. Navigate to Asset > Consumables.
2. In the consumable record, click Retire. 
   Retire appears only if the consumable asset is currently in a consumed state.
3. In the Retire Asset dialog box, select a stockroom. The quantity gets populated based on the quantity of the consumption of the consumable asset.
4. Update the Quantity field based on the quantity of consumable assets that you want to retire. You can choose to retire the entire quantity of consumable assets or only a part of the quantity.
5. Select a substate and click OK.
You return to the consumable record. A message appears at the top of the form layout with the number of assets that you have retired.

**Dispose of consumable assets**

Dispose of those consumable assets that are no longer required in your stockrooms.

Know that the Planned for disposal column in the Consumable (alm_consumable) table indicates if the consumable asset is marked for disposal or not.

Role required: Any of these three roles:

- asset
- itil
- itil_admin

1. Navigate to **Asset > Consumables**.
2. In the consumable record on the top right of the page, click **Mark for disposal**.
   
   **Mark for disposal** appears only for consumable assets that are in the in-stock state and not marked for disposal.
3. In the Planned for disposal dialog box, enter the total quantity or partial quantity of the consumable asset.

   If you enter a partial quantity, a new consumable record is created with the substate as pending disposal. If you enter a total quantity, the consumable’s record substatus changes to “pending disposal” and you return to the same consumable record.

   After you mark the consumable asset for disposal, **Mark for disposal** no longer appears.

   **Note:** Only a consumable marked for disposal is included in a disposal order. After you mark a consumable for disposal, it does not get merged with another consumable record.

4. Click **Cancel from disposal** to cancel disposing a consumable asset.
   
   **Cancel from disposal** appears if the Planned for disposal column for the consumable is set to true and the **Disposal number** field is blank.
5. In the Cancel from disposal dialog box, select a stockroom.

   If a stockroom is already selected, then the **Stockroom** field is read-only.
6. Select a substate and click **OK**.

   The Planned for disposal column is set to false. If you added this consumable record to a disposal record, the planned asset record is deleted.

**Create pre-allocated assets**

A pre-allocated asset physically exists, but is not yet a financial liability.

Role required: asset

Pre-allocated assets are often assets that the vendor still owns, but has agreed to store in a customer stockroom for just-in-time procurement. For example, a pre-allocated asset could be a pallet of 100 computers ready to be allocated. Allocating the asset generates a configuration item (if required by the category) and enables you to assign the asset. Pre-allocated assets can be components of another asset that is already in use. For example, pre-installed, pre-allocated servers can be set up in server racks next to production servers, but the pre-allocated servers only become a financial liability after they are turned on.
The pre-allocated option can only be used for assets, not consumables or licenses. Pre-allocated assets cannot be comprised of bundles.

**Note:** Warranties are not usually active until an item is installed. Therefore, until an asset is allocated and assigned, it is not under warranty.

1. Navigate to **Asset > Portfolios > All Assets** and create a new record (see table for field descriptions).

**Note:** Category must have the **Allow pre-allocated** option selected.

### Consumable record form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the asset.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model category that controls whether or not an asset is linked to a CI.</td>
</tr>
<tr>
<td>Model</td>
<td>Product model of the asset.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Number of item the asset represents.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>State of the asset.</td>
</tr>
<tr>
<td>Stockroom</td>
<td>Stockroom of the asset. This field is only available if the State field is set to <strong>In stock</strong>.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent asset. When a parent asset is defined, the <strong>Assignment</strong> and <strong>State</strong> fields of the child asset are automatically populated based on the <strong>Assignment</strong> and <strong>State</strong> fields of the parent asset and are read-only.</td>
</tr>
<tr>
<td>Class</td>
<td>Type of asset. The system automatically sets the <strong>Class</strong> to <strong>Consumable</strong>.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure. Choose from the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Capex:</strong> Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Opex:</strong> Operational expenditure is an ongoing expenditure. For example, toners for the photocopier.</td>
</tr>
<tr>
<td>Substate</td>
<td>Substate of the asset.</td>
</tr>
<tr>
<td>Location</td>
<td>Location of the asset.</td>
</tr>
<tr>
<td>Cost</td>
<td>Price that the asset was purchased for.</td>
</tr>
<tr>
<td>Cost Center</td>
<td>Cost center financially responsible for the asset.</td>
</tr>
<tr>
<td>Activities</td>
<td></td>
</tr>
</tbody>
</table>
2. Click Submit.

**Allocate a pre-allocated asset**

Assets can be allocated from pre-allocated asset records, which creates new asset records and reduces the Quantity in the original pre-allocated asset record.

Role required: asset

Allocating an asset makes it a financial liability. After all pre-allocated assets have been allocated, the pre-allocated asset record is removed from the asset list.

1. Navigate to Asset > Portfolios > All Assets.
2. Find the row containing the asset to allocate. You may want to filter the Substate column to show only Pre-allocated assets.
3. Click the reference icon in the row containing the asset to allocate.
4. Click Allocate at the bottom of the form.

![Note: If the glide.asset.create_ci_with_ire property is set to true, a form appears when you click Allocate. On the form, fill in the Asset tag, Serial number, and Reserved for fields, then click OK.]

The system creates and navigates to a new asset record, which has the same model and parent information as the pre-allocated asset. The new asset has a Quantity of one, while the pre-allocated asset’s Quantity is reduced by one.

**Split a pre-allocated asset**

You can split a pre-allocated asset to create a group that can be moved to a different stockroom.

Role required: asset

For example, a group of 100 pre-allocated computers is in Stockroom A. Split the group into two groups of 50 and move one group to Stockroom B. Allocate the computers from the two different stockrooms.

1. Navigate to Asset > Portfolios > All Assets.
2. Find the row containing the asset to split. You may want to filter the Substate column to show only Pre-allocated assets.
3. Click the reference icon in the row containing the asset to split. The asset record is displayed.
4. Click Split.
5. Enter a Quantity to Split and click OK. The pre-allocated asset is split into two groups and the Quantity field on each record indicates the number in each group.
Stockrooms

Stockrooms are places to which assets are assigned.

When stock is low on a particular asset, stock rules can either notify an asset manager or automatically transfer inventory from one stockroom to another.

Stockrooms are separate, standalone entities in the Asset Management application.

Create a stockroom

You can create a stockroom.

Role required: asset or inventory_user

1. Navigate to Inventory > Stock > Stockrooms and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name and identifier of the stockroom.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group that primarily uses the stockroom.</td>
</tr>
<tr>
<td>External</td>
<td>Whether this stockroom is managed internally (check box is cleared) or is managed externally by a third party (check box is selected).</td>
</tr>
<tr>
<td>Location</td>
<td>Physical location of the stockroom.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of stockroom, such as Field Agent or On site.</td>
</tr>
<tr>
<td>Manager</td>
<td>Person in charge of the stockroom. Receives restocking notifications and requests for the stockroom’s stock rules.</td>
</tr>
</tbody>
</table>

2. Click Submit.

Delete a stockroom with assets

You can delete a stockroom. If the stock room has assets, you must remove the assets from the stockroom first.

Role required: inventory_admin

1. Navigate to Asset > All Assets.
2. Personalize the list to add the Stockroom column.
3. Filter the list to show only the assets in the stockroom that you want to delete.
4. Change or remove the stockroom for all of the asset records.
5. After removing assets from the stockroom you want to delete, continue with the instructions for deleting a stockroom with no assets.

Delete a stockroom with no assets

You can delete a stockroom that has no assets.
Role required: inventory_admin

1. Navigate to **Inventory > Stock > Stockrooms**.
2. Select the check box beside the stockroom **Name**.
3. In the **Actions** choice list below the list, select **Delete**.

### Stockroom types

Stockroom types are categories of stockrooms.

The stockroom type has two significant characteristics.

- **Priority**: indicates the order of stockrooms the parts should be sourced from. For example, if a personal stockroom (priority 2) contains the required part, the personal stockroom receives priority over the Central Stockroom (priority 7) because the part in the personal stockroom does not require delivery.

- **Shipment Required**: informs the system if a transfer order needs to be created when the part is sourced from a stockroom of the given type. For example, a part in a personal stockroom does not require shipment, so no transfer order is needed.

### Stockroom types defined in the base system

<table>
<thead>
<tr>
<th>Value</th>
<th>Name</th>
<th>Priority</th>
<th>Shipment Required</th>
<th>Description</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>on_site</td>
<td>On Site</td>
<td>1</td>
<td>False</td>
<td>Stockroom at the customer site.</td>
<td>Close to the users and does not require shipping.</td>
</tr>
<tr>
<td>field_agent</td>
<td>Field Agent</td>
<td>2</td>
<td>False</td>
<td>Virtual, personal stockroom linked with a field service agent (FSA) directly, used for delivery.</td>
<td>Mainly used to indicate to the system that the part has been delivered and is with the FSA.</td>
</tr>
<tr>
<td>fsl</td>
<td>FSL</td>
<td>4</td>
<td>True</td>
<td>Forward Shipping Location.</td>
<td>Small stockrooms where the parts can typically be shipped via overnight delivery.</td>
</tr>
</tbody>
</table>
### Create a new stockroom type

If you need stockroom types that are not included in the base system, you can create a custom stockroom type.

**Role required:** inventory_admin

Check the **priority level** of the stockroom types provided in the base instance to ensure that you assign the correct priority level to any new stockroom types you create. You can also modify the stockroom types included in the base system.

1. Navigate to **Inventory > Stock > Stockroom Types** and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name of the stockroom type.</td>
</tr>
<tr>
<td>Description</td>
<td>General information about the stockroom type.</td>
</tr>
<tr>
<td>External stockroom</td>
<td>Whether stockrooms of this type are managed internally (check box cleared) or managed externally by a third party (check box selected).</td>
</tr>
<tr>
<td>Priority</td>
<td>Level of precedence for this type of stockroom.</td>
</tr>
<tr>
<td>Shipment required</td>
<td>Option that determines if stockrooms of this type require shipment by default.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Value | Internal identifier of the stockroom type.

2. Click **Submit**.

**Stock rules**

Stock rules are defined criteria stating that when inventory of a particular asset in a particular stockroom reaches a specified threshold, a certain number should either be transferred from another stockroom or ordered from a vendor.

For example, a specific model of computer keyboard reaches an inventory of 10 in a particular stockroom and, because a stock rule is in place, a transfer order is automatically created to transfer 50 from a different stockroom. Because there can be multiple assets of a model within a stockroom, stock rules enable you to check all assets fitting the criteria and view a total count.

There are two restocking options:

- An email can be sent to the stockroom manager (user identified in the **Manager** field on the stockroom record) to place a vendor order. A task is automatically created for the stockroom manager or, if Procurement is active, a purchase order and a purchase order line item are created.
- A transfer order can be generated automatically to restock the item from another stockroom.

Stock rules consider existing transfer orders and do not create additional transfer orders if replenishment is already in progress.

A scheduled job named **Stock Rule Runner** runs once per day to create the restocking transfer orders, send email messages to stockroom managers, and create tasks for stockroom managers.

*Note:* If restocking is in progress, the system does not create duplicate email messages or duplicate transfer orders.

If **Procurement** is active when the scheduled job is run, a purchase order and a purchase order line item are automatically created.

*Note:* You must have procurement_user role to access the purchase order and purchase order line item.

**Create a stock rule**

You can create a stock rule to control what happens when inventory of a particular asset in a particular stockroom reaches a specified threshold.

Role required: inventory_admin

1. Navigate to **Inventory > Stock > Stock Rules** and create a new record (see table for field descriptions).

Field | Description
--- | ---
Model | Product model to which the rule applies.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Quantity that the stock must reach to trigger restocking. For example, enter a threshold of 10 for a laptop computer that should be restocked when inventory drops below 10 in the specified stockroom.</td>
</tr>
</tbody>
</table>

**Note:** If a stock rule is created for a hardware or software model reaches the threshold limit, a notification is sent to the stockroom manager and a stock order request is automatically created.

<table>
<thead>
<tr>
<th>Restocking option</th>
<th>Location where additional supplies should come from.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If Procurement is not active, then restocking option is Stockroom only. Otherwise, select one of the following:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Stockroom</strong>: creates a transfer order to obtain the asset from another stockroom.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Vendor</strong>: sends an email to the stockroom manager to order from a vendor. In addition to the email notification, a purchase order and purchase order line item are created.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Active</th>
<th>Whether this stock rule active (check box is selected). Clearing this check box prevents the stock rule from restocking automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stockroom</td>
<td>Current physical location of the asset.</td>
</tr>
<tr>
<td>Order size</td>
<td>Minimum order quantity for stockroom transfers or vendor purchases. ServiceNow calculates the smallest multiple of the order size needed to restock the item above the threshold. For example, there are 3 laptops in stock with a threshold of 10 and the Stockroom option selected. If the order size is set to 4, the system creates a transfer order for 8 laptops to exceed the threshold and satisfy the rule (3 in stock + 8 ordered = 11). When restocking from a vendor, ServiceNow sends an email to the stockroom manager showing the total number of items to order, as multiples of the order size.</td>
</tr>
</tbody>
</table>

2. Click **Submit**.

**Create an inventory stock order request**

Create an inventory stock order request so that you can order new hardware in bulk for your stockrooms. After your request is approved, the Hardware Stock Order flow takes you through the process of requesting, sourcing, and receiving your order.
A stock order is a catalog request to replenish the stock in a stockroom.

You can manually create a hardware inventory stock order request. However, an inventory stock order request is automatically created from a stock rule trigger when the stock rule threshold breaches.

After your stock order request is approved, the Hardware Stock Order flow is triggered. The Flow Designer application is used to create the Hardware Stock Order flow to take you through the entire process of requesting, sourcing, and receiving your order.
Role required: inventory_admin

1. Navigate to Inventory > Submit Stock Order.
2. On the form, fill in the fields.
Hardware Inventory Stock Order form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>New hardware that you want to order.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Amount of the new hardware that you want to order.</td>
</tr>
<tr>
<td>Stockroom</td>
<td>Stockroom where you want to stock the new hardware.</td>
</tr>
<tr>
<td>Comments</td>
<td>Details that are specific to your order request.</td>
</tr>
</tbody>
</table>

3. **Click Order Now.**
   A request is created and the Order Status form appears with all the order details. An existing service catalog request workflow takes care of all the required approvals for the request. You can now source your request.

4. **Click the request number to open the request.**
   The price of the request item is the price of the model. The price of the request is calculated as quantity of the request item multiplied by the price of the request item. The price of the request item that's shown in the Requested Items related list is the price of the model calculated by the quantity.

   Price of the Request Item is the Price of the Model and Price of the Request is calculated as Quantity of Request Item * Price of the Request Item.

   A catalog task is created after the request is approved.

5. **Click Catalog Tasks** and open the catalog task.

6. **Click Source Request.**
   The Source Request form layout lists the model name, the quantity of items to be sourced, and the total quantity of the hardware in stock.

7. **Click Add Transfer Order or Add Purchase Order** to source the request via a transfer order or a purchase order.
   The quantity mentioned in Total in Stock does not include the stock that's available in the destination stockroom.

   If the requested item is not available in any stockroom, then **Add Transfer Order** is disabled. If there are no available vendors for the requested item, then **Add Purchase Order** is disabled.

   To enable **Add Purchase Order**, do one of the following:
   - add a designated vendor by navigating to vendor items.
   - add a catalog item for the requested model with vendor details.

**Transfer orders for Asset Management**

Transfer orders move assets between company stockrooms.

The Asset Management application enables asset managers to create transfer orders for moving assets between company stockrooms.

Consumable assets and non-consumable assets can be transferred as follows:

- If an asset is consumable, it can be transferred and the quantity can be greater than one.

  Consumable parts are tracked by the system qualitatively.
If an asset is non-consumable, it must be transferred as a single entity with a quantity of one. Non-consumable parts correspond to assets defined in the system.

**Transfer order lines**

Transfer Order Lines is a new module under Inventory with Template Tasks and Template Subtasks as the sub modules. Transfer order lines allow the transfer of multiple assets on one transfer order. Actions such as shipment preparation can take place at the transfer order line level. Pre-allocated assets can be included in a transfer order line, but can only be transferred in their full quantity. A business rule prevents the same asset from being transferred on two different transfer orders at the same time.

**Note:** The Transfer Order and the Transfer Order Line workflows have moved from the Procurement plugin to the Asset Management plugin. The Transfer Order Line workflow runs only if no other workflows are matched or running on a specific record.

**Transfer order line tasks**

When you create a transfer order line, based on the model category specified in the asset, a transfer order line task is automatically created. Transfer order line tasks are created to move transfer order lines from one stage to the other. Transfer order line tasks also help you to track service levels and the time frame needed to complete a transfer order.

Default template tasks are available with the Asset Management application. The template tasks are based on model categories. Default template tasks cannot be deleted or modified. If required, you can also create your own customized template tasks. For more information, see Create a customized template task. When you create a transfer order line and select an asset, that asset corresponds to a model category. If a customized template task exists for that model category then that template task is added to the transfer order line as a transfer order line task. If no customized template task match is found for the asset you selected, then the default template task is added as a transfer order line task.

Closing a transfer order line task completes the task and creates the next task in the process. For example, once you close the Ready for fulfillment task, the state for this task appears as Closed Complete and a new task is opened for the next stage, Ready for Shipment. This process continues till you close all the tasks required for completing the transfer order line. As you close a task and as a task moves from one stage to the next, the asset gets automatically updated too. For example, when the transfer order line moves from Ready to Fulfillment to Prepare for Shipment, the asset's status also moves from available to reserved.

**Note:** If you skip a transfer order line task and select Closed Skipped, the asset is not updated automatically. Once the asset is received or delivered, you can make the update manually.

**Note:** If you are upgrading from any previous release to the New York release, and you have an open transfer order line that is still being processed, all the transfer order line tasks associated with that transfer order line are simultaneously created and displayed in the transfer order line form layout. Based on the stage of the transfer order line, the tasks that still need to be processed will be open; all the other tasks that have already been completed will be closed. Based on the order, if you close a later transfer order line task, all the previous tasks, which are currently open, automatically will be Closed Skipped.
Transfer order line subtasks

To further add granularity and efficiency to the process, you can also create subtasks for each transfer order line task. Each transfer order line task can have multiple subtasks. For example, before preparing for shipment, for a computer, you may want to create subtasks for imaging the computer or adding additional software. If subtasks have been defined for a particular transfer order line task, then the subtasks are automatically added to the transfer order line task. Once all the subtasks are closed, the transfer order line task is automatically closed. For more information, see Create a template subtask.

Transfer assets using transfer orders

Transfer assets from one location to the other by moving the assets through the transfer order process. You create a transfer order and move it from its initial Draft status to the final Received status.

Role required: inventory_user.

1. Navigate to Inventory > Transfer Orders > Create Transfer Order.
2. Select values from the From Stockroom and To Stockroom lists.
3. Select a date and time from the Delivery by date date picker.
4. Click Submit.
5. Open the transfer order.
6. Next to Transfer Order Lines, click New.
7. Select a model for the transfer order line.
8. If the model is a consumable, specify a quantity in Quantity Requested.
9. Click Submit. If necessary, add more transfer order lines.

After creating transfer order lines, the transfer order and all of the transfer order lines are in the draft stage. While a transfer order or a transfer order line is in the draft stage, it can be deleted.

When you create a transfer order line, based on the model category specified in the asset, a transfer order line task is automatically created. The transfer order line task helps you to progress through the various stages of the transfer order line. Each transfer order line task represents a particular stage in the transfer process. As you close a task, a new task is created and the transfer process moves to the next stage.

10. Open the transfer order line task and click Close Task.
11. Keep closing each task till you reach the last stage (Received). Once you close the task for the Received stage, the transfer order line is completed and closed.
   All transfer order lines and the transfer order are marked Delivered.

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Summary of transfer order line tasks

As assets move through the transfer process, the stage of a transfer order is always based on the individual transfer order lines tasks.

Transfer order line tasks

<table>
<thead>
<tr>
<th>Transfer order line stages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>When a transfer order line is created.</td>
</tr>
<tr>
<td>Requested</td>
<td>This is the first task created for the transfer order line.</td>
</tr>
<tr>
<td>Shipment Preparation</td>
<td>Once the Requested task is closed, this task is created. This task deals with preparing the transfer order line for shipment. Three new fields are added to the Shipment Preparation task: Vendor, Ship date, and Tracking Number.</td>
</tr>
<tr>
<td>In Transit</td>
<td>Once the Shipment Preparation task is closed, this task is created.</td>
</tr>
<tr>
<td>Received</td>
<td>Once the In Transit task is closed, this task is created.</td>
</tr>
<tr>
<td>Delivered</td>
<td>Once the Received task is closed, this task is created. Once you close the Delivered task, the transfer order line is completed.</td>
</tr>
</tbody>
</table>

Delete a transfer order

You can delete a transfer order only if the transfer order is still in the draft stage.

Role required: inventory_user

1. Navigate to **Inventory Management > Transfer Orders > Transfer Orders**
2. Select the check box beside a transfer order.
3. From the Actions on selected rows menu at the bottom of the list, click Delete.
   - Alternatively, you can cancel a transfer order or a transfer order line while it is in Requested or Shipment Preparation stage.

Delete a transfer order line

You can delete a transfer order line only if it's still in the draft stage.

Role required: inventory_user.

1. Open a transfer order.
2. Select the check box beside a transfer order line.
3. From the Actions on selected rows menu at the bottom of the list, click Delete.
   - Alternatively, you can cancel a transfer order or a transfer order line while it is in Requested or Shipment Preparation stage.
Return items received in a transfer order

When you receive a transfer order and if there is a problem with all or some of the items, you can return the transfer order.

Role required: inventory_user.

Items in a transfer order must be received before they can be returned.

1. Navigate to Inventory Management > Transfer Orders.
2. Select a transfer order that is in the Received stage.
3. Click the transfer order line Number of the item to return.
4. Click Return.
5. Enter a quantity to return.
6. Enter a reason for the return.
7. Select the **Defective** check box to return items that are broken.

   Defective items are returned to the stockroom from which they were delivered, but are not added to available stock. Instead, they are tracked in the separate category named “Defective” so they cannot be requested or transferred again.

8. Click OK.
9. Click Update.

   A new transfer order line is automatically created.

   A new corresponding parent transfer order is also automatically created with the new transfer order line on it.

10. If you are returning a consumable, navigate to the transfer order line record and click the model name to open the model record.

   The model record shows which stockrooms contain the model. The one defective model is listed.

   **Note:** The defective model is still at the stockroom to which it was delivered. The defective model needs to be transferred back to the stockroom where it originated.

11. Move the new transfer order through the regular transfer order process. Items are automatically returned to the stockroom from which they were delivered. A transfer order line item that has been returned cannot be delivered at a later time.

    If you return another defective model from the same, original order, the two defective returns are merged into one line item.

Create a transfer order for Asset Management

Create a transfer order in order to transfer assets from one location to the other.

Role required: inventory_user.

1. Navigate to Inventory Management > Transfer Orders > Create Transfer Order.
2. Click the From stockroom list to select a stockroom from which the item(s) is to be shipped.
3. Click the To stockroom list to select a stockroom where the item(s) is to be shipped.
4. Click Submit.

   Once the transfer order is created, you can create transfer order lines to specify the items that the transfer order comprises of. See Create a transfer order line.
Create a transfer order line

Transfer order lines specify the exact items that comprise a transfer order.

Role required: inventory_user.

A transfer order can contain one or more transfer order lines. Under a single transfer order, all transfer order lines will have the same From location and To location. Each line contains an asset to transfer and the quantity to transfer. The item to transfer is identified by asset name and model name. A transfer order line can involve one quantity of a non-consumable asset or multiple quantities of a consumable asset. A bundled model can be transferred.

- After creating a transfer order, click New in the Transfer Order Lines related list and fill in the fields as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Internal unique number identifying the transfer order line.</td>
</tr>
<tr>
<td>Transfer Order</td>
<td>The transfer order to which the transfer order line belongs.</td>
</tr>
<tr>
<td>Model</td>
<td>Model of the items requested by the transfer order line. For example, a printer. If the Asset field is filled out first, the Model field is automatically filled in with the model corresponding to the asset.</td>
</tr>
<tr>
<td>Quantity requested</td>
<td>Number of items requested by the transfer order line. For example, 3 computers are requested to be transferred.</td>
</tr>
<tr>
<td>Quantity received</td>
<td>Number of items already received. For example, 3 keyboards are transferred, 2 are received.</td>
</tr>
<tr>
<td>Stage</td>
<td>Current stage of the transfer order. Transfer order lines can only be created when a transfer order is in Draft stage.</td>
</tr>
<tr>
<td>Request line</td>
<td>Requested item to associate with the transfer order line.</td>
</tr>
<tr>
<td>Asset</td>
<td>Asset requested by the transfer order line. For example, a specific printer. The asset can filter on stockrooms.</td>
</tr>
<tr>
<td>Quantity remaining</td>
<td>Number of items yet to be received. For example, 3 keyboards had been requested, 2 are received, 1 is remaining.</td>
</tr>
<tr>
<td>Quantity returned</td>
<td>Number of items that already needed to be returned.</td>
</tr>
</tbody>
</table>

Create a customized template task

Create customized template tasks to configure your specific task workflow for transfer order lines. Default template tasks are available with the Asset Management application. You cannot modify or delete a default template task.

Role required: inventory_user.
Template tasks help you progress through the various stages of the transfer order line. Custom template tasks are stored in the Custom Template Task (alm_custom_template_task) table. The template tasks are based on model categories. For example, when you create a customized template task for the Application model category, whenever a transfer order line is created for the Application model category, the template tasks associated with the Application model category are used as transfer order line tasks. When you create customized template tasks, make a copy of the workflow and update the workflow accordingly. For example, if instead of five flows, you need four flows, then delete the flow that you do not need from the workflow.

**Note:** Two template tasks cannot be created if they are based on the same model category, same order number and the same stage. The model category, the order, and the stage have to be unique for each template task. For example, you cannot create two template tasks for Prepare for Shipment, based on the Application model category, order number 200, and the stage as Requested. If you try to create an identical template task as mentioned in the example, an error message appears.

1. Navigate to **Inventory > Transfer Order Lines > Template Tasks**. All the default template tasks that are available with the Asset Management application are listed.
2. Click **New**. You can also customize a template task by copying a default template task. Click **Copy Default Template** and select a model category.
3. Fill out the form fields (as shown in the table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task name</td>
<td>Name of the template task</td>
</tr>
<tr>
<td>Model category</td>
<td>The model category that this template task is based on.</td>
</tr>
<tr>
<td>Order</td>
<td>the order in which the template task is added to the transfer order line.</td>
</tr>
<tr>
<td>Short description</td>
<td>a brief description about this template task.</td>
</tr>
<tr>
<td>Next stage</td>
<td>the stage that this template task gets executed.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Create a template subtask**

Create template subtasks to add granularity to the transfer order line tasks. For example, before preparing for shipment, for a computer, you may want to create sub tasks for imaging the computer or adding additional software.

Role required: inventory_user.

The template subtasks that you create are stored in the Template Subtask (alm_template_subtask) table. When a transfer order line task is created and if subtasks are defined for that transfer order line task, then the subtasks are automatically added to the transfer order line task.

1. Navigate to **Inventory > Transfer Order Lines > Template Subtasks**.
2. Click **New** and fill out the form fields (as shown in the table).
3. Click **Submit**.

**Transfer order line asset tracking**

As transfer order line actions are triggered, the stock information and states of any affected assets are updated. Consumables and non-consumables are tracked differently.

When an asset is included in a transfer order line, the following takes place:

- A substate field on the asset form changes to reflect the transfer order line states
- The **Active TO** option on the asset form is automatically selected to show that the asset is part of a transfer order and cannot be added to multiple transfer orders
- The asset is removed from the pool of available assets and changed to a state of **In Stock Pending Transfer**

**Transfer order line asset tracking of non-consumables**

When transfer order line stages change for non-consumables, it affects asset substates.

<table>
<thead>
<tr>
<th>Transfer order line stage</th>
<th>Affect on asset substate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>Asset moves to <strong>In Stock &gt; Pending Transfer</strong> (from the current stockroom). If the asset is a consumable, the quantity can be edited.</td>
</tr>
<tr>
<td>Requested</td>
<td>Asset stays in <strong>In Stock &gt; Pending Transfer</strong>.</td>
</tr>
<tr>
<td>Shipment Preparation</td>
<td>Asset stays in <strong>In Stock &gt; Pending transfer</strong>.</td>
</tr>
<tr>
<td>In Transit</td>
<td>Asset moves to <strong>In Transit &gt; Reserved</strong>.</td>
</tr>
<tr>
<td>Received</td>
<td>Asset moves to <strong>In Stock &gt; Available</strong> (in the destination stockroom).</td>
</tr>
</tbody>
</table>

**Transfer order line asset tracking consumables**

When a consumable is added to a transfer order line, the stock for the consumable is split into two records and the transfer order links to the newly created stock line.

For example:

1. Stockroom A has ten keyboards in stock.
2. A transfer order line named TOL1 transfers three keyboards from stockroom A to stockroom B.
3. The stock of ten keyboards in A is split into two records: seven shown as **In stock > Available** and three shown as **In Stock > Pending Transfer**.
4. Another transfer order is created with a transfer order line named TOL2 that transfers two keyboards from stockroom A to stockroom B.

5. The seven remaining keyboards are split into another two lines: five **In stock > Available** and two **In stock > Pending Transfer**.

   **Note:** The three **In Stock > Pending Transfer** and the two **In Stock > Pending Transfer** are not merged together because they are not part of the same transfer order line and not necessarily from the same person.

6. As TOL2 for two keyboards moves from Draft to Requested to Shipment Preparation, TOL1 for the three keyboards remains **In Stock > Pending Transfer**.

7. When TOL1 for the three keyboards moves to the **In Transit** stage, the three keyboards are changed to the **In Transit > Reserved** stage. The same happens for TOL2 with two keyboards.

8. When TOL1 is Received, the three keyboards move to **In stock > Available** in stockroom B.

9. When TOL2 is received in stockroom B, the two keyboards move to **In stock > Available** and are merged with the three keyboards that are also **In Stock > Available** in B.

10. At the end, stockroom B shows five keyboards are **In Stock > Available**.

### Create disposal orders for assets

Create a disposal order for hardware or consumable assets. You can create a disposal order for an asset that has reached its end of life cycle or an asset that is no longer functional.

**Note:** Install the Hardware Asset Management application from the ServiceNow Store to use this feature.

Know that the Flow Designer application is used to create the Hardware Asset Disposal flow to take you through the entire hardware disposal order process.

The hardware disposal order goes through various stages before it is completed. Each stage is associated with a hardware disposal task. To move through the various stages, close each task until you reach the last stage. After you complete the last task, the hardware disposal order is complete. See [Hardware disposal order stages](#) for more information.

**Note:** You can cancel a disposal order until it reaches the transit stage in the workflow. Once your disposal order is in the confirmation stage, you can’t cancel that order. You can cancel a task that is in a draft, scheduling, or the transit stage by selecting **Closed Incomplete** from the State list and closing the task.

Role required: asset

1. Navigate to **Inventory > Create Disposal Order**.
2. On the form, fill in the fields.

### Create Disposal Order form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stockroom</td>
<td>Stockroom where the asset is disposed from.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Location</td>
<td>Location of the stockroom where the asset gets disposed from. The location automatically appears after you select a stockroom. If you change the location and there's no location that's associated with the selected stockroom, the stockroom field becomes empty. You can then select a stockroom from the stockroom list for a specified location.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor that you want to dispose the asset to.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Person responsible for disposing of the asset.</td>
</tr>
</tbody>
</table>

3. Click **Submit**. The disposal order is created and the hardware asset disposal workflow is triggered.

4. In the Planned Asset related list, click **Edit** to add the assets that you want to dispose of.

5. In the Edit Members from layout, select the assets that you want to dispose of from the **Collection** box and move them to the **Planned Assets List** box.

   Only the assets in the selected stockroom that haven't yet been disposed of appear in the **Collection** box. Only the consumable assets that are marked for disposal appear in this list.

   You can filter the assets by the state, substate, stockroom, or any other condition. You can also delete all the conditions to list the assets that are in all stockrooms.

6. Click **Save**. The selected assets appear in the Planned Assets related list. You can remove or cancel a planned asset until the asset is in the transit stage. Once the asset is in the confirmation stage, you can't remove or cancel the asset.

**Note:** The ham_admin role can cancel a planned asset at any stage in the disposal process.

You can remove a planned asset from the Planned Asset form layout or click **Edit** and remove it from the Edit Members form layout. If a disposal order is canceled, planned assets are automatically canceled.

7. In the Hardware Disposal Tasks related list, click the **Verify Assets** task.

8. In the Hardware Disposal Tasks form layout, select the assets that you want to dispose of and in the **Actions on selected rows** picker, click **Verify**. The state of the asset changes to retired and the substate changes to pending disposal.

9. Click **Close task**. The draft stage is completed and the scheduling stage is in progress. The next task in the workflow, Schedule pickup, is automatically created and appears in the Hardware Disposal Tasks related list.

10. Click the Schedule pickup task and in the **Vendor** and **Scheduled date** fields, enter the values that you want.

11. Click **Close Task**. The stage changes to transit and the Asset departure task is created.

12. Click the Asset departure task and in the **Vendor order ID** and **Pickup contact name** fields, enter the value that you want.
13. Select the assets that you want to dispose of and in the **Actions on selected rows** picker, click **Depart**.
The state of the asset changes to in transit and the substate changes to pending disposal.

14. Click **Close Task**.
The stage changes to confirmation and the Vendor confirmation task is created. Based on the type of asset (hardware or consumable), the following fields in the **Disposal** tab in the corresponding Hardware or Consumable form layout are automatically populated. For example, if it's a hardware asset, the following fields are populated in the Hardware form layout.
- Disposal order number
- Disposal vendor
- Vendor disposal order ID

15. Click the Vendor confirmation task and then click **Close Task**.
The stage changes to documentation and a Disposal Documentation task is created.

16. Click the Disposal Documentation task and do the following:
   a) Click the Attach File icon to attach disposal documentation for the planned assets.
   b) Select the assets that you want to dispose of.
   c) In the **Actions on selected rows** picker, click **Dispose**.
The state of the asset changes to retired and the sub state changes to disposed.
   d) In the **Certificate of disposal** list, select **Yes**.

17. Click **Close Task**.
All the hardware disposal tasks are complete and the hardware disposal order stage changes to completed. Based on the type of asset, the **Disposal date** field in the **Disposal** tab in the Hardware or Consumable form layout is populated. For any maintenance contracts that are associated with the disposed asset, the **Date removed** field in the **Contracts** tab is populated and the disposed asset is no longer part of the contract. Any entitlements that are associated with the disposed asset are also removed.

**Hardware disposal order stages**
A hardware disposal order goes through various stages in the disposal process before it is completed. With each stage, the task that’s associated with that stage changes too.

Closing a task in the hardware disposal process completes that task and automatically creates the next task in the process. For example, after you close the Schedule Pickup task, the state for that task changes to Closed Complete and the next task, Asset Departure, is created. This process continues until you close all the tasks required for disposing of the selected assets. After you close all the tasks, the disposal order is completed.
### Hardware disposal stages

<table>
<thead>
<tr>
<th>Hardware disposal stages</th>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>Verify Assets</td>
<td>Hardware disposal record is created.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> If a record remains in a draft stage and doesn't get disposed, it automatically gets canceled.</td>
</tr>
<tr>
<td>Scheduling</td>
<td>Schedule Pickup</td>
<td>Scheduling details for the hardware asset disposal order.</td>
</tr>
<tr>
<td>Transit</td>
<td>Asset Departure</td>
<td>Verified assets are ready for departure.</td>
</tr>
<tr>
<td>Confirmation</td>
<td>Vendor Confirmation</td>
<td>Hardware disposal order is confirmed by the vendor.</td>
</tr>
<tr>
<td>Documentation</td>
<td>Disposal Documentation</td>
<td>Documentation for the disposal record is attached.</td>
</tr>
<tr>
<td>Completed</td>
<td></td>
<td>Hardware disposal record request is completed.</td>
</tr>
<tr>
<td>Cancelled</td>
<td></td>
<td>Disposal order can be canceled only until through the transit stage.</td>
</tr>
</tbody>
</table>

### Use a hardware asset request flow

Use a hardware asset request flow for requesting, sourcing, and deploying hardware catalog items from the Service Catalog application.

Role required:
- catalog_admin
- procurement_admin

Create a request for a hardware catalog item from the Service Catalog application. Associate the catalog item with the Standard Hardware Asset Request flow to trigger the flow.

The Flow Designer application is used to create the Standard Hardware Asset Request flow to take you through the process of sourcing, procuring, and deploying your hardware catalog items. As the flow takes you through the various stages, the asset details are automatically updated. You can open the Standard Hardware Asset Request flow to view the status of the stages in the flow.
1. Log in with credentials for the role of catalog_admin and navigate to Service Catalog > Maintain Items.
2. Open the hardware catalog item and in the Flow field, select Standard Hardware Asset Request.
   If the Flow field is not visible, add it to the form layout by right-clicking the menu icon and navigating to Configure > Form layout.
3. Click Save.
   The Standard Hardware Asset Request flow is now associated with the hardware catalog item.
4. Navigate to Service Catalog and click Hardware.
5. Select your catalog item from the list and order it.
6. Log in with credentials for the role of procurement_admin and open the new request.
7. In the Requested Items related list, click the request item.
8. In the Requested Item form layout, click the **Flow Context** related link to view the current stage of the Standard Hardware Asset Request flow.

9. Click the **Catalog Tasks** related list to view the sourcing task for the request.

10. Open the catalog task and click **Source Request**.

11. In the Source Request form layout, click **Add Transfer Order** or **Add Purchase Order** to source the request via a transfer order or a purchase order.

   After you procure the catalog item, a deployment task is created at the requested item level.

12. Close the task.

   In the Standard Hardware Asset Request flow, the action that is associated with deploying the assets is complete. Open the asset record to view the updates made to the **State**, **Assigned**, **Installed**, **Location**, and **Assigned to** fields. Similar updates are also made to the CI that is associated with the asset.

**Hardware Model Normalization**

Asset Management Hardware Model Normalization enables users to normalize the details, such as manufacturer, product, model, and device type, of your hardware and consumable models. Data from the models is compared against the data in the Hardware Model Normalization Content Service.

The Hardware Model Normalization (com.sn_hwnorm) plugin requires ServiceNow personnel to activate it.

The Normalization Data Services Client (com.glide.data_services_canonicalization.client) plugin is also activated when you activate the Hardware Model Normalization plugin.

---

**Note:** This documentation is for Hardware Model Normalization. For additional information on Asset Management, see the [Asset Management documentation](#).

---

**Scheduled jobs**

To standardize your hardware and consumable models, the asset data needs to be normalized. You can manually update the model records with the normalization content, or you can compare your data against the Hardware Asset Management Content Service.

The HAM- Hardware Model Normalization scheduled job runs daily.

Content from the Hardware Model Normalization Content Service is pulled into the Now Platform. If any existing models haven’t been fully normalized, the updates from content service the will update the models normalization status if better data has been provided. Use the Asset Job Log (asset_job_log) table to review the status of the scheduled job.

The normalization status of models can be reverted by clicking **Revert Normalization** on the model. Any normalization that occurred on the model will be reverted and the rule will be deactivated. When the scheduled job runs, the models are processed with the active rules and the status is updated.

The scheduled job generates hardware and consumable model reports. These reports identify the overall status of your models and provide a breakdown of the normalization status.

The following reports are included:

- Hardware Product Overall Normalization Status
- Consumable Product Overall Normalization Status
- Hardware Model Normalization Status
- Consumable Model Normalization Status

Components installed with Hardware Model Normalization

Several types of components are installed with activation of the Hardware Model Normalization plugin, including tables.

**Note:** To view all other components that are installed with this application, see the Application Files table. For instructions on how to access this table, see *Find components installed with an application*.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Type</td>
<td>Type of the device, such as computer, printer, or monitor.</td>
</tr>
<tr>
<td>Hardware Lifecycle Definition</td>
<td>Lifecycle phase of a hardware or consumable model and the associated dates.</td>
</tr>
<tr>
<td>Hardware Manufacturer</td>
<td>Name of the hardware manufacturer.</td>
</tr>
<tr>
<td>Hardware Model Library</td>
<td>Name of the product and model number.</td>
</tr>
<tr>
<td>Hardware Normalization Map</td>
<td>Hardware product and hardware product model IDs.</td>
</tr>
<tr>
<td>Hardware Product</td>
<td>Name of the product and type of device, such as Apple Mac or Lenovo Printer.</td>
</tr>
</tbody>
</table>

Opt-in to the Hardware Asset Management Content Service

Opt in to the Hardware Asset Management Content Service to improve the normalization process by sharing hardware and consumable model data from your organization with ServiceNow.

**Role required:**
- **ham_admin**: for non domain separated instance
- **ham_admin plus domain_admin**: for domain separated instance

By opting in to the Hardware Asset Management Content Service, your data is securely shared with ServiceNow to build the content service repository. Adding to the content service allows more models be normalized automatically. These updates occur weekly.

The content updates are based on data from the hardware and consumable models, lifecycles, and custom hardware product models sent back to the Hardware Asset Management Content Service.

Any data that is retrieved by the content service remains anonymous and secure, following ServiceNow privacy policies. After the data has been reviewed, it is properly disposed of.

1. Navigate to **Asset > Administration > Content Service Setup**.
2. Read the Hardware Asset Management Content Service agreement.
3. Select **Yes, I have read and accept the Opt-In Agreement**.
4. Click **Opt-in**.
5. If there is any hardware model, consumable model, or lifecycle data that you want to exclude, toggle the option on the Content Service Setup form.
6. Click **Save**.

**Example: Opt-in to the Hardware Asset Management Content Service**

Your organization has decided to enable the Hardware Asset Management Content Service.

Navigate to the Content Service Setup module and review the Hardware Asset Management Content Service agreement.
Select **Yes, I have read and accept the Opt-In Agreement** to display the Content Service Setup page.

You decide that you don't want to send hardware model data to the Hardware Asset Management Content Service. Toggle the button next to Hardware Models to opt out of sending the hardware model asset data.
| Model Type | Definition | Details Transformed | | --- | --- | --- | | Hardware Models | A model created to classify and deduplicate hardware models when new models are identified. | Name, Manufacturer, Model number, Short description, Model category, Status, Normalized name, Normalized manufacturer, Normalized model number, Device type, Normalization rule. | | Consumable Models | A model created to classify and deduplicate consumable models when new models are identified. | Name, Manufacturer, Model number, Short description, Model category, Status, Normalized name, Normalized manufacturer, Normalized model number, Device type, Normalization rule. | | Hardware Lifecycle | Lifecycle records representing the status and lifecycle of a hardware product. | Life cycle phase, Status, Phase start date, Phase end date, Risk, Normalized name, Normalized manufacturer, Normalized model number, Device type. | | Consumable Lifecycle | Lifecycle records representing the status and lifecycle of a consumable product. | Life cycle phase, Status, Phase start date, Phase end date, Risk, Normalized name, Normalized manufacturer, Normalized model number, Device type. | | Custom Product Models | A model created to classify custom models provided by custom services. | Details transformed: Name, Manufacturer, Model number, Device type, Product. |
Click **Save**.

Your organization has decided that they don't want to send any of their data and they want to opt-out of the Hardware Asset Management Content Service. To stop sending your data, toggle all the buttons off.

A message appears verifying that you want to opt-out of using the Hardware Asset Management Content Service.

Click **Opt-Out**.

You are returned to the Hardware Asset Management Content Service agreement and you can opt back in at anytime.

**Create a hardware or consumable model**

To begin tracking your hardware and consumable assets, create a hardware or consumable model. Then, add lifecycle information to keep track of the lifecycle phase of your model.

Role required: admin or asset

1. Navigate to one of the following paths.
   - **Product Catalog** > **Product Models** > **Hardware Models**
   - **Product Catalog** > **Product Models** > **Consumable Models**

2. Click **New**.
3. Complete the following steps if you are adding a hardware model.
   a) On the Hardware Model form, fill in the details.
   b) Click **Save**.
   c) To add additional information on the asset, click the **General section**.
   d) To add unit information, click the **Information section**.
   e) To link a compatible model, click the **Compatibles section** and then click **Add Compatible**.
f) To add a model substitution, click the Substitutes section and then click Add Substitution.
g) To manually normalize your hardware model, click the Normalization section.
h) To add a configuration item, click the Configuration item section.
i) To add your model to the Product Catalog, click the Product Catalog section.
j) To publish the model to the Hardware Catalog, click the Publish to Hardware Catalog related link.
k) To add related assets, click the Assets related list.
l) To add a model component, click the Model Component related list.
m) To add vendor information to your model, click the Vendor Catalog Items related link and click New.
n) To add lifecycle information, click the Hardware Model Lifecycle related list, click New. If a lifecycle with the same source, lifecycle type, lifecycle phase, and source exits, an error message appears.

Note: While you can delete lifecycles that you’ve added, you can’t delete lifecycles that are created from the Hardware Asset Management Content Service.

4. Complete the following steps if you are adding a consumable model.
a) On the Consumable Model form, fill in the details.
b) Click Save.
c) To add additional information on the consumable asset, click the General related list.
d) To add your model to the Product Catalog, click the Product Catalog related list.
e) To add vendor information to your model, click the Vendor Items related list.
f) To add lifecycle information, click the Consumable Model Lifecycle related list and click New. If a lifecycle with the same source, lifecycle type, lifecycle phase, and source exits, an error message appears.

Note: While you can delete lifecycles that you’ve added, you can’t delete lifecycles that are created from the Hardware Asset Management Content Service

5. Click Submit.

The model appears in either the Hardware Model or Consumable Model list.

Note: If you want to exclude this model from the Hardware Asset Management Content Service, select the Exclude from content service option.

Create a hardware model

You’ve purchased the ThinkPad T43 and you need to begin tracking the asset. To begin tracking your asset, add the following information to the Hardware form.
Click **Save**.

The **Display name** field is updated with the name of the manufacturer and the name of the hardware.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer</td>
<td>Lenovo</td>
</tr>
<tr>
<td>Name</td>
<td>ThinkPad T43</td>
</tr>
<tr>
<td>General</td>
<td>Information</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Serial No.</td>
<td></td>
</tr>
<tr>
<td>Model number</td>
<td></td>
</tr>
<tr>
<td>Asset tracking strategy</td>
<td>Lower to category</td>
</tr>
<tr>
<td>Asset tracking unit</td>
<td>Individual Unit</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>– New –</td>
</tr>
<tr>
<td>Cost</td>
<td></td>
</tr>
<tr>
<td>Depreciation</td>
<td></td>
</tr>
<tr>
<td>Salvage value</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td></td>
</tr>
</tbody>
</table>
Currently, the Lenovo ThinkPad T43 is generally available. Add the lifecycle status to accurately track the phase of the asset.

Click the Hardware Lifecycle Model related list and click **New**. Add the following information to the Hardware Model Lifecycle form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lifecycle type</td>
<td>General Availability</td>
</tr>
<tr>
<td>Phase start date</td>
<td>2019-10-08</td>
</tr>
<tr>
<td>Phase end date</td>
<td>2019-10-31</td>
</tr>
</tbody>
</table>

Click **Submit**.

The lifecycle is added to the record.

When the general availability phase is over, the ThinkPad T43 will be discontinued. Add the end of life information to the asset to accurately track the lifecycle.

Click the Hardware Lifecycle Model related list and click **New**. Add the following information to the Hardware Model Lifecycle form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lifecycle type</td>
<td>End of Life</td>
</tr>
</tbody>
</table>
Click **Submit**.

The End of Life lifecycle is added to the record and both lifecycle phases are displayed in the Hardware Model Lifecycle related list.

After you've added your hardware or consumable models, you can [normalize the data](#).

### Add a custom product

If you have a product that is not represented in the Asset Management Content Service yet, you can create a custom product.

Role required: **ham_admin**

1. Navigate to **Asset > Administration > Custom Products**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase start date</td>
<td>2019-11-01</td>
</tr>
<tr>
<td>Phase end date</td>
<td>2019-11-30</td>
</tr>
</tbody>
</table>
2. Click **New**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the custom product.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Name of the manufacturer.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the product.</td>
</tr>
<tr>
<td>Device type</td>
<td>Type of device.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that indicates the product is active.</td>
</tr>
<tr>
<td>Exclude from content service</td>
<td>Option that indicates that the product will be excluded from the content service.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

After you’ve created the hardware model, **normalize the model**.

### Add a custom hardware model

If you have a hardware model that isn’t represented in the Asset Management Content Service yet, you can create a custom model.

**Role required:** ham_admin

1. Navigate to **Asset > Administration > Custom Models**.
2. Click **New**.

#### Custom Hardware Model Library form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model number</td>
<td>Number associated with the hardware model.</td>
</tr>
<tr>
<td>Product</td>
<td>Name of the product.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the hardware model.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the model.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that indicates the model is active.</td>
</tr>
<tr>
<td>Exclude from content service</td>
<td>Option that indicates the model is excluded from being sent to the content service.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

After you’ve created the hardware model, **normalize the model**.

### Import and export content data

Import and export content data to the ServiceNow Hardware Asset Management content service to improve the normalization process. On-premise users can use the Manage Hardware Library module to import or export data via a zip file.

**Role required:**

- ham_admin
• domain_admin (if domain separation is enabled)

1. Navigate to Modules and search for Manage Hardware Library.
2. Open the Manage Hardware library form layout and select the Active check box to activate the module.
3. Click Save and refresh the form layout.
4. Navigate to the Manage Hardware Library module.
5. Import the content data to get the new data into your system.
   a) Click Import Hardware Library Content.
   b) Click Attach Content File and then select the zip file that contains the content.
   c) Click Run Import.
      After the data is imported, the content update schedule job, HAM - Apply latest content changes, is triggered to process the content updates.

6. Export content to send the custom data or any hardware models that are not fully normalized to the ServiceNow content service team.
   a) Click Content Service Opt-in: Export Hardware Normalization Content.
   b) If you already haven’t opted in to share the data with ServiceNow content service, click opt-in and refresh the Manage Hardware Library page.
   c) Click Run Export.
   d) After the status changes to Ready for Download, refresh the page.
      A zip file is created and appears at the top of the Manage Hardware Library page. If there is no content to export, an error message appears informing you that no content exists.
   e) Download and send this zip file to the ServiceNow content service team.

**Normalize hardware and consumable models**

After you’ve created your hardware and consumable models, normalize the information of the model.

Role required: admin or asset

**Note:** If you've opt-ed in to the Hardware Asset Management Content Service, you can override any lifecycle values that were added from the schedule job, or you can manually add your own lifecycles.

For a model to be fully normalized, a model number must be added.

If you update the Device Type field, the normalization status is updated.

1. Navigate to one of the following paths.
   • Product Catalog > Product Models > Hardware Models
   • Product Catalog > Product Models > Consumable Models

2. To create a new model, click New.
3. On the Hardware Model or Consumable Model form, fill in the details.
4. Click Save.
The model is compared against the data in the Hardware Normalization Content Service and the model is normalized if the information is available.

**Note:** If the hardware or consumable model is normalized against the Hardware Asset Management Content Service, a lifecycle is added if applicable lifecycles exist in the content service.

5. Based on the details you added, complete the following steps.
   a) If the normalization status of your model is Partially Normalized or Publisher Normalized, click the **Normalized** section and fill in the details to manually normalize the model.
   b) If the normalization status of your model is Fully Normalized, but you don't like the information that was added, click **Revert Normalization**. All normalization fields are cleared and you can manually normalize your model.

**Note:** This option is only available if the model is Fully Normalized, Partially Normalized, or Manufacturer Normalized.

**Revert Normalization** is visible only to users with the ham_admin role in a non-domain separated instance and is visible to users with role ham_admin + domain_admin in a domain separated instance.

6. Click **Save**.
   The **Normalization Status** field is updated.

**Example: Normalize a hardware model**

You've created a hardware model for the Lenovo ThinkPad T43 and you want your asset information to be consistent across the organization.

Review the normalization status of model by clicking the **Normalization** section.
The normalization status is set to Partially Normalized because the name of the model is missing.

In the Model field, enter 2687DTU.

Click Save.

The Normalization Status field now displays Manually Normalized.
Paris  IT Asset Management

![Hardware Configuration](image)

<table>
<thead>
<tr>
<th>General</th>
<th>Information</th>
<th>Compatibility</th>
<th>Substitution</th>
<th>Normalization</th>
<th>Configuration</th>
<th>Product Catalog</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer</td>
<td>Lenovo</td>
<td>Lenovo ThinkPad T43</td>
<td>ThinkPad T43</td>
<td>2087/D71U</td>
<td>Lenovo</td>
<td>Manually Normalized</td>
</tr>
<tr>
<td>Product</td>
<td>ThinkPad T43</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Model</td>
<td>2087/D71U</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Related Links**

Publish to Hardware Catalog

<table>
<thead>
<tr>
<th>Assets</th>
<th>Model Components</th>
<th>Vendor Catalog Items</th>
<th>Hardware Model Lifecycles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model = Lenovo ThinkPad T43 2087/D71U</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

No records to display
Consumable model fields
Consumable Models form and related list field descriptions.

## Consumable Model form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Display name of the model. The display name is generated from the Manufacturer and Name field.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Name of the model manufacturer.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the model.</td>
</tr>
</tbody>
</table>

## General section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Description of the model.</td>
</tr>
<tr>
<td>Model categories</td>
<td>Model categories that the model can be associated with. Model categories are used to create configuration items (CIs) and assets.</td>
</tr>
<tr>
<td>Asset tracking strategy</td>
<td>Asset tracking for the model.</td>
</tr>
<tr>
<td>Asset tracking unit</td>
<td>Unit that is used to measure the asset.</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>Method the assets or CIs were procured.</td>
</tr>
<tr>
<td>Cost</td>
<td>Cost of the an individual model.</td>
</tr>
<tr>
<td>Depreciation</td>
<td>Depreciation scheme of the model.</td>
</tr>
<tr>
<td>Salvage value</td>
<td>An estimate of the residual value of the model.</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments about the model.</td>
</tr>
<tr>
<td>Model number</td>
<td>Number that identifies the model. This number can be defined internally or by the manufacturer of the model.</td>
</tr>
<tr>
<td>Barcode</td>
<td>Barcode that identifies the model.</td>
</tr>
<tr>
<td>Owner</td>
<td>Person responsible for the model.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the model.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>Type of expenditure.</td>
</tr>
<tr>
<td>Certified</td>
<td>Option that indicates if a model is certified for use.</td>
</tr>
</tbody>
</table>
### Normalization section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normalized manufacturer</td>
<td>Normalized name of the model manufacturer.</td>
</tr>
<tr>
<td>Product</td>
<td>Name of the product.</td>
</tr>
<tr>
<td>Model</td>
<td>Name of the model.</td>
</tr>
<tr>
<td>Normalization status</td>
<td>Normalization status of the model.</td>
</tr>
<tr>
<td>Device type</td>
<td>Type of device.</td>
</tr>
<tr>
<td>Exclude from content service</td>
<td>Option that indicates whether or not the normalization information is excluded from the content service.</td>
</tr>
</tbody>
</table>

### Product Catalog section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog Item</td>
<td>Name of the catalog item.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the catalog item.</td>
</tr>
<tr>
<td>Picture</td>
<td>Picture depicting the product model.</td>
</tr>
</tbody>
</table>

### Consumables section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the model that is dependant on name of the asset and the manufacturer.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model category of the asset. The type of category depends if the asset is linked to a CI.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the asset.</td>
</tr>
<tr>
<td>Substate</td>
<td>Current substate of the asset.</td>
</tr>
<tr>
<td>Stockroom</td>
<td>Name of the stockroom where the asset is located if the asset is in stock.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Number of assets.</td>
</tr>
</tbody>
</table>

### Vendor Catalog Item related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name of the vendor catalog item.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Name of the product vendor.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Product Model</td>
<td>Product model associated with the vendor catalog item.</td>
</tr>
<tr>
<td>Out of Stock</td>
<td>Option that indicates if the product is out of stock.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that contains the product record.</td>
</tr>
<tr>
<td>Product ID</td>
<td>Manufacturer product ID.</td>
</tr>
<tr>
<td>List Price</td>
<td>List price of the product before any discounts are applied.</td>
</tr>
<tr>
<td>Vendor Price</td>
<td>Vendor price of the product.</td>
</tr>
<tr>
<td>Rank tier</td>
<td>Vendor rank tier.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Description of the product.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Product Catalog Item</td>
<td>Product catalog item that was created when the item was published.</td>
</tr>
<tr>
<td>UPC</td>
<td>Universal Product Code (UPC) of the product.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the product.</td>
</tr>
<tr>
<td>Picture</td>
<td>Picture of the product.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that indicates if the product is active or not.</td>
</tr>
<tr>
<td>Information</td>
<td></td>
</tr>
<tr>
<td>Specifications</td>
<td>Product specifications that come from the vendor.</td>
</tr>
<tr>
<td>Features</td>
<td>Product features that come from the vendor.</td>
</tr>
</tbody>
</table>

**Consumable Model Lifecycles related list**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>Name of the model.</td>
</tr>
<tr>
<td>Lifecycle type</td>
<td>Type of lifecycle.</td>
</tr>
<tr>
<td>Lifecycle phase</td>
<td>Phase of the lifecycle.</td>
</tr>
</tbody>
</table>

- **Internal**
- **Publisher**
- **General Availability**
- **End of Sale**
- **End of Support**
- **End of Extended support**
- **End of Life**
Hardware model fields

Hardware Models form and related list field descriptions.

Hardware Model form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Display name of the model. The display name is generated from the Manufacturer and Name field.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Name of the model manufacturer.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the model.</td>
</tr>
</tbody>
</table>

General section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Description of the model.</td>
</tr>
<tr>
<td>Model categories</td>
<td>Model categories that the model can be associated with. Model categories are used to create configuration items (CIs) and assets.</td>
</tr>
<tr>
<td>Asset tracking strategy</td>
<td>Asset tracking for the model.</td>
</tr>
<tr>
<td>Asset tracking unit</td>
<td>Unit that is used to measure the asset.</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>Method the assets or CIs were procured.</td>
</tr>
<tr>
<td>Cost</td>
<td>Cost of the an individual model.</td>
</tr>
<tr>
<td>Depreciation</td>
<td>Depreciation scheme of the model.</td>
</tr>
<tr>
<td>Salvage value</td>
<td>An estimate of the residual value of the model.</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments about the model.</td>
</tr>
</tbody>
</table>
## Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model number</td>
<td>Number that identifies the model. This number can be defined internally or by the manufacturer of the model.</td>
</tr>
<tr>
<td>Barcode</td>
<td>Barcode that identifies the model.</td>
</tr>
<tr>
<td>Owner</td>
<td>Person responsible for the model.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the model.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>Type of expenditure.</td>
</tr>
<tr>
<td>Certified</td>
<td>Option that indicates if a model is certified for use.</td>
</tr>
</tbody>
</table>

### Information section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power (watts)</td>
<td>Power consumption of the model in watts.</td>
</tr>
<tr>
<td>Height (U)</td>
<td>Height of the model in rack units.</td>
</tr>
<tr>
<td>Flow Rate (cfm)</td>
<td>Flow rate of the model in cubic feet per minute.</td>
</tr>
<tr>
<td>Sound Power (bels)</td>
<td>Sound power of the model in bels.</td>
</tr>
<tr>
<td>Weight (lbs)</td>
<td>Weight of the model in pounds.</td>
</tr>
</tbody>
</table>

### Compatibles section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>Name of the hardware model.</td>
</tr>
<tr>
<td>Model</td>
<td>Name of the hardware model that is compatible with the hardware model record.</td>
</tr>
</tbody>
</table>

### Substitutes section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>Name of the hardware model.</td>
</tr>
<tr>
<td>Model</td>
<td>Name of the hardware model that can be substituted for the hardware model.</td>
</tr>
</tbody>
</table>
### Normalization section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normalized manufacturer</td>
<td>Normalized name of the model manufacturer.</td>
</tr>
<tr>
<td>Product</td>
<td>Name of the product.</td>
</tr>
<tr>
<td>Model</td>
<td>Name of the model.</td>
</tr>
<tr>
<td>Normalization status</td>
<td>Normalization status of the model.</td>
</tr>
<tr>
<td>Device type</td>
<td>Type of device.</td>
</tr>
<tr>
<td>Exclude from content service</td>
<td>Option that indicates whether or not the normalization information is excluded from the content service.</td>
</tr>
</tbody>
</table>

### Configuration items section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the CI. This name is often the Domain Name System (DNS) or computer host name.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Name of the manufacturer.</td>
</tr>
<tr>
<td>Location</td>
<td>Location of the manufacturer.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the CI.</td>
</tr>
<tr>
<td>Class</td>
<td>Type of asset class.</td>
</tr>
</tbody>
</table>

### Product Catalog section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog Item</td>
<td>Name of the catalog item.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the catalog item.</td>
</tr>
<tr>
<td>Picture</td>
<td>Picture depicting the product model.</td>
</tr>
</tbody>
</table>

### Assets related list

For a detailed description of the Asset related list and Hardware form, see Create an asset.
# Model Components related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model category of component</td>
<td>Model category that the child component will be instantiated as when the asset is created.</td>
</tr>
<tr>
<td>Component</td>
<td>Model that the child component will be instantiated as when the asset is created.</td>
</tr>
<tr>
<td>Component parameter</td>
<td>Component parameter requirement. <strong>Mandatory</strong> • <strong>Optional</strong></td>
</tr>
<tr>
<td>Bundle</td>
<td>Child asset of the instantiated parent model of the model component.</td>
</tr>
<tr>
<td>Main component</td>
<td>Name of the bundle if the model is an abstract model.</td>
</tr>
</tbody>
</table>

**Note:** This field is only used if an abstract model has been defined.

# Vendor Catalog Items related list

For detailed descriptions of the Vendor Catalog Item form and fields, see *Create a vendor catalog item.*

# Hardware Model Lifecycles

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>Name of the hardware model.</td>
</tr>
<tr>
<td>Lifecycle type</td>
<td>Type of lifecycle.</td>
</tr>
<tr>
<td>Lifecycle phase</td>
<td>Phase of the lifecycle. <strong>General Availability</strong> • <strong>End of Sale</strong> • <strong>End of Support</strong> • <strong>End of Extended Support</strong> • <strong>End of Life</strong></td>
</tr>
<tr>
<td>Source</td>
<td>Source of the hardware model.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the hardware model.</td>
</tr>
<tr>
<td>Phase start date</td>
<td>Start date of the lifecycle phase.</td>
</tr>
<tr>
<td>Phase end date</td>
<td>End date of the lifecycle phase.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Risk</td>
<td>Risk associated with the lifecycle.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that indicates if the hardware model lifecycle is active.</td>
</tr>
</tbody>
</table>

**Example Asset Management process**

The best method for managing assets depends on business needs and how your business is organized.

These steps are one possible process for getting started with Asset Management.

1. **Identify assets in your system.** A key component of asset management is the initial and ongoing inventory or discovery of what you own. The ServiceNow platform provides the following options for asset discovery.
   - The separate, robust Discovery tool.
   - A lightweight, native discovery tool, Help the Help Desk lets you scan your network proactively to discover all Windows-based PCs and the software packages installed on those PCs. This WMI-based discovery is included in the base self-service application.
   - For organizations that want to use the discovery technologies they have deployed already, such as SMS, Tally NetCensus, LanDesk, or others, ServiceNow can support integration to those technologies via web services. Scanned data can be mapped directly into the Configuration Management Database (CMDB).

2. **Clean up information in the CMDB.** Remove information that is obsolete or invalid. Ensure that all remaining information is accurate and complete. Add any necessary information.

3. **Create categories of asset models such as computers, servers, printers, and software.**

4. **Create asset models.** Models are specific versions or various configurations of an asset, such as a MacBook Pro 17".

5. **Create individual assets, such as hardware, consumables, and software licenses.** If you used a discovery tool, you may already have many assets identified accurately.

6. **Manage assets by counting software licenses, viewing assets that are in stock, setting asset states and substates, and analyzing unallocated software.**

**Analytics and Reporting Solutions for Hardware Asset Management**

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

**Enabling the Performance Analytics Solution**

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.

**Note:** Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.
To use this Analytics and Reporting Solution, you must be entitled to use Performance Analytics with Hardware Asset Management. For more information about entitlements to Performance Analytics, see Activating your Performance Analytics subscription.

This Out-of-the-box Performance Analytics Solution is available from the ServiceNow Store. To enable this solution, an admin navigates to System Applications > Search ServiceNow Store. When the landing page for the ServiceNow Store opens, search for Hardware Asset Management. When you have found the Solution, follow the instructions in the Store. The ServiceNow Store has its own documentation.

**Domain separation and 'Run As' user**

By default, System Administrator is the Run As user for data collection jobs in the Analytics and Reporting Performance Analytics Solutions. Verify that this user exists on the instance, and whether this user has the appropriate level of access. An inappropriate Run As user can cause errors or limit the data that is collected. This setting only has an effect if domain separation is enabled.

**Hardware Asset dashboard**

View the key metrics on your hardware and consumable models and assets for the entire asset life cycle in the Hardware Asset dashboard.

Access the Hardware Asset dashboard by navigating to Asset > Hardware Asset Dashboard.

The results in all the tabs in the Hardware Asset dashboard are updated in real time. Only the reports that display data in the Lifecycle Overview sections is updated daily based on scheduled jobs. You can save charts in PNG or JPEG formats for sharing or viewing them locally.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Manager: Needs to see patterns in the data all through the asset life cycle.</td>
<td>asset</td>
<td>View reports that provide critical insights on assets such as procurement needs, inventory, and end of life status. You can also view the normalization status and life-cycle overview for hardware and consumable models.</td>
</tr>
</tbody>
</table>

Model Management tab

This tab gives you an overview of hardware and consumable models that are reaching their end of life. You can also view the normalization status, life-cycle overview, and information on the content service library. You can effectively manage your models by viewing their end of life status on a monthly, quarterly, or yearly basis.

<table>
<thead>
<tr>
<th>Report</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware Models up for End of Life</td>
<td>Hardware Model Lifecycle (cmdb_hardware_model_lifecycle)</td>
<td>The beginning phase of the end of life for hardware models. Shows the count of hardware models whose start date of the end of life phase is either the current month, quarter, or year.</td>
</tr>
</tbody>
</table>

Note: Only hardware model life cycle records that are active, model status is in production, and life cycle type is Publisher appear in This month, This quarter, or This year.
<table>
<thead>
<tr>
<th>Report</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Normalization Status</td>
<td>Hardware Product Model (cmdb_hardware_product_model)</td>
<td>Normalization status of all the hardware models. View the count of hardware models that were normalized and those models that didn't get normalized. You can further drill down to view the status of the normalized models: Manually Normalized, Manufacturer Normalized, or Partially Normalized. You can drill down to view the status of non-normalized models too: New and Match Not Found.</td>
</tr>
<tr>
<td>• Lifecycle Overview</td>
<td>Hardware Model Lifecycle (cmdb_hardware_model_lifecycle)</td>
<td>The count of hardware models that are present in each life cycle stage: General availability, end of support, end of extended support, and end of sale.</td>
</tr>
<tr>
<td>Consumption Models up for End of Life</td>
<td>Consumable Model Lifecycle (cmdb_consumable_model_lifecycle)</td>
<td>The beginning phase of the end of life for consumable models. Shows the count of hardware models whose start date of the end of life phase is either the current month, quarter, or year. Note: Only consumable model life cycle records that are currently active, model status is in production, and life cycle type is Publisher appear in This month, This quarter, or This year.</td>
</tr>
<tr>
<td>Report</td>
<td>Source table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Normalization Status</td>
<td>Consumable Product model (cmdb_consumable_product_model)</td>
<td>Normalization status of all the consumable models. You can view the count of consumable models that were normalized and those that didn't get normalized. You can further drill down to see the status of the normalized models: Manually Normalized, Manufacturer Normalized, or Partially Normalized. You can drill down to view the status of non-normalized models too: New and Match Not Found.</td>
</tr>
<tr>
<td>• Lifecycle Overview</td>
<td>Consumable Model Lifecycle (cmdb_consumable_model_lifecycle)</td>
<td>The consumable models that are present in each life-cycle stage: General availability, end of support, end of extended support, and end of sale.</td>
</tr>
<tr>
<td>Product Model Status</td>
<td>Product Model (cmdb_model)</td>
<td>Current count of hardware, consumable, and software models based on the status of the models. Drill down on a model to view the status of that model. For example, click hardware models on the chart to see the current status of all the hardware models: In Production, Retired, or sold.</td>
</tr>
<tr>
<td>Hardware Model Content Service Download</td>
<td></td>
<td>The days since the content service library was last downloaded on your instance and the days remaining for the next download to take place.</td>
</tr>
</tbody>
</table>

**Procurement tab**

This tab gives you a view of the purchase orders for hardware assets that are pending delivery worldwide. You can also view purchase orders that have not yet been sourced and information pertaining to cost of purchase orders per vendor. You can filter the results in this tab by location and year.
<table>
<thead>
<tr>
<th>Report</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchase orders pending delivery</td>
<td>Purchase Order (proc_po)</td>
<td>Purchase orders which are not yet received or canceled. Only purchase orders that have a status of ordered or pending delivery are displayed.</td>
</tr>
<tr>
<td>Expenditure by Vendor</td>
<td>Purchase Order (proc_po)</td>
<td>The cost that you have paid to each of your vendors for procuring inventory. Only purchase orders that have a status of ordered, pending delivery, or received are displayed.</td>
</tr>
<tr>
<td>Orders by Vendor</td>
<td>Purchase Order (proc_po)</td>
<td>Purchase orders that are ordered, pending delivery, or received.</td>
</tr>
<tr>
<td>Requests that Require Sourcing</td>
<td>Request (sc_request)</td>
<td>Requests that have not yet been addressed. Requests for which either a purchase order or a transfer order has not been initiated.</td>
</tr>
</tbody>
</table>

### Inventory tab

This tab shows data regarding your open stock orders. You can also view information about active stock rules, open transfer orders, and requests sourced through stock. You can filter the results in this tab by location and stockroom.

<table>
<thead>
<tr>
<th>Report</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware Requests fulfilled from Stock (YTD)</td>
<td>Transfer Order (alm_transfer_order)</td>
<td>Requests sourced through stock in the current year.</td>
</tr>
<tr>
<td>Open Stock Orders</td>
<td>Requested Item (sc_req_item)</td>
<td>All the stock orders which have not yet been fulfilled. The open stock orders can be viewed as numerical data geographically.</td>
</tr>
<tr>
<td>Active Stock Rules</td>
<td>Stock Rule (alm_stock_rule)</td>
<td>Count of active stock rules grouped by model category. If a model of an item that has an active stock rule falls below the threshold value, a new order is placed.</td>
</tr>
<tr>
<td>Open Transfer Orders</td>
<td>Transfer Order (alm_transfer_order)</td>
<td>Transfer orders not yet delivered or canceled.</td>
</tr>
<tr>
<td>Open Audit Assets</td>
<td>Asset Audits (sn_hamp_asset_audit)</td>
<td>Audits that are currently new or in progress.</td>
</tr>
</tbody>
</table>
# Paris IT Asset Management

## Report

<table>
<thead>
<tr>
<th>Report</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Hardware Assets Found by Audits</td>
<td>Asset (alm_asset)</td>
<td>The distribution of categories the assets belong to for audits conducted in the last year.</td>
</tr>
</tbody>
</table>

## End of life tab

View this tab to monitor your assets that are approaching their end of life stage and the disposal status of your assets. You can filter the results in this tab by location, stockroom, and model category. The Model category filter does not apply to **Hardware Asset Disposal Status**.

<table>
<thead>
<tr>
<th>Report</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware Nearing End of Warranty</td>
<td>Asset (alm_asset)</td>
<td>Hardware and consumable assets whose warranty expiration date falls in the current month, quarter, or year.</td>
</tr>
<tr>
<td><strong>Note:</strong> Only assets that are in the following states appear.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>· in stock</td>
<td></td>
<td></td>
</tr>
<tr>
<td>· in transit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>· in use</td>
<td></td>
<td></td>
</tr>
<tr>
<td>· in maintenance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>· consumed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hardware Asset Disposal Status</td>
<td>Hardware Disposal Order (hamp_hardware_disposal)</td>
<td>Status of requests created for hardware assets disposal. The count of new requests appears in <strong>New</strong>. The count of all hardware disposal requests that are currently in scheduling, transit, and confirmation stages are listed under <strong>In progress</strong>. <strong>Pending Documentation</strong> shows all the disposal requests that are in the Documentation stage.</td>
</tr>
<tr>
<td>Hardware Assets Disposed (YTD)</td>
<td>Asset (alm_asset)</td>
<td>Hardware and consumable assets, based on model category, that have been disposed in the current year.</td>
</tr>
<tr>
<td><strong>Report</strong></td>
<td><strong>Source table</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>End of Life Method (YTD)</td>
<td>Asset (alm_asset)</td>
<td>Count of hardware and consumable assets that are retired, based on their sub states. A hardware asset in a retired state has many sub states (disposed, none, sold, vendor credit, and pending disposal).</td>
</tr>
</tbody>
</table>

**Organization Management**

The Organization Management application provides an easy way to perform such asset management tasks as updating users and adding vendors. It includes managing your vendors and manufacturers, as well as managing locations.

**Create a new vendor or manufacturer**

You can create a new vendor, which is a company that sells assets or services that your organization purchases. You can also create a new manufacturer, which is a company that builds assets that your organization purchases.

Role required: user_admin and asset

1. Navigate to one of the following:
   - Organization > Vendors
   - Organization > Manufacturers
   - Organization > Companies

2. Click **New** and create a new record.
3. Complete the form and select either **Manufacturer** or **Vendor**.

   **Note:** A company can be considered both a vendor and a manufacturer.

4. Click **Submit**.

**Locations module**

The Locations module is the Asset view of the Location table (cmn_location).

In addition to the physical specifics for the location, the Asset view includes the **Stock room** designation and a list of configuration items (CI) in stock at that location.
Asset location

Installed with Model Management

Several types of components are installed with Model Management. Demo data is available with Model Management.

Business rules installed with Model Management

Model Management uses a number of business rules.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abort action if no license type</td>
<td>(cmdb_software_product_model)</td>
<td>Ensures that a license type (not a license type group that cannot be handled by counters) has been selected.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Calculate display_name</td>
<td>Product Model (cmdb_model)</td>
<td>Sets the Display name field when any of the following field values change: Manufacturer, Name, Version, Edition. The display name differs depending on whether the glide.cmdb_model.display_name.shorten property is set to true or false.</td>
</tr>
<tr>
<td>Date validation</td>
<td>(cmdb_m2m_downgrade_model)</td>
<td>Ensures that the Start date is before the End date.</td>
</tr>
<tr>
<td>Enforce CI Rules</td>
<td>(cmdb_model_category)</td>
<td>Ensures that categories that track assets as consumables or software licenses do not have a CI class.</td>
</tr>
<tr>
<td>Flag parent as bundle on creation</td>
<td>(cmdb_m2m_model_component)</td>
<td>Flags a model that has components as a bundle.</td>
</tr>
<tr>
<td>License Type - Fullname</td>
<td>(cmdb_sw_license_calculation)</td>
<td>Computes the full name of the license type.</td>
</tr>
<tr>
<td>License validation</td>
<td>Software Upgrade and Downgrades (cmdb_m2m_downgrade_model)</td>
<td>Prevents software upgrades and downgrades from being duplicated and prevents having duplicate upgrades and downgrades for the same license where duplication also involves having the same dates. Also ensures that both the Upgrade parent and Downgrade child fields are mandatory and that if the License field is not empty, either Upgrade parent or Downgrade child must be equal to the license.model.</td>
</tr>
<tr>
<td>Protect cmdb_ci_class</td>
<td>(cmdb_model_category)</td>
<td>Prevents CI class from being changed after creation.</td>
</tr>
<tr>
<td>Protect cmdb_ci_class on insert</td>
<td>(cmdb_model_category)</td>
<td>Prevents creation of a category if another category already exists for the chosen CI class.</td>
</tr>
<tr>
<td>Protect Contract</td>
<td>(cmdb_model_category)</td>
<td>Prevents changes to the Contract model category record.</td>
</tr>
<tr>
<td>Set parent's main component link</td>
<td>(cmdb_m2m_model_component)</td>
<td>Populates a read-only reference from the bundle to the component when a bundle component is selected as the main component.</td>
</tr>
</tbody>
</table>
## Paris IT Asset Management

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unflag parent on last delete</td>
<td>[cmdb_m2m_model_component]</td>
<td>Removes the bundle flag from a model when the last component is deleted from the bundle.</td>
</tr>
<tr>
<td>Update model category</td>
<td>[cmdb_ci]</td>
<td>Updates the model categories for the associated model if the model is not already associated with the CI's model category.</td>
</tr>
<tr>
<td>Validate record before creation</td>
<td>[cmdb_m2m_model_component]</td>
<td>Ensures that a component is not already in a bundle when an attempt is made to add the component to a bundle.</td>
</tr>
</tbody>
</table>

## Client scripts installed with Model Management

Model Management includes a number of client scripts.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear models not matching license</td>
<td>[cmdb_m2m_downgrade_model]</td>
<td>Clears the Upgrade parent and Downgrade child fields when the License field is changed to a license and neither the upgrade or downgrade fields match the license model.</td>
</tr>
<tr>
<td>Constraints based on asset class</td>
<td>[cmdb_model_category]</td>
<td>Enables or disables bundling options based on the asset class of the category.</td>
</tr>
<tr>
<td>Hide sections when needed</td>
<td>[cmdb_model]</td>
<td>Shows and hides sections according to what is relevant for a given model.</td>
</tr>
<tr>
<td>model_category change</td>
<td>[cmdb_model]</td>
<td>Ensures compatibility of classes between the several categories referenced by the same model (client part).</td>
</tr>
<tr>
<td>Populate downgrade from license</td>
<td>[cmdb_m2m_downgrade_model]</td>
<td>Sets the downgrade child to the software model on the referenced license when an upgrade is selected. Only sets the downgrade to the license if the license is not empty.</td>
</tr>
<tr>
<td>Populate upgrade from license</td>
<td>[cmdb_m2m_downgrade_model]</td>
<td>Sets the upgrade parent to the software model on the referenced license when a downgrade is selected. Only sets the upgrade to the license if the license is not empty.</td>
</tr>
</tbody>
</table>
Properties installed with Model Management

Model Management includes the property `glide.cmdb_model.display_name.shorten`.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>glide.cmdb_model.display_name.shorten</code></td>
<td>When set to <strong>true</strong>, generates shorter display names for models by eliminating duplication of the manufacturer name. Consider the following model, for which <strong>Manufacturer</strong> is set to <strong>Spotify</strong> and <strong>Name</strong> is set to <strong>Spotify Premium</strong>. The <strong>Display name</strong> field is set as follows, based on the property setting.</td>
</tr>
<tr>
<td></td>
<td>• false: Display name is Spotify Premium&lt;br&gt;• true: Display name is Spotify Premium</td>
</tr>
<tr>
<td></td>
<td>For software models, the edition and version are also included in the name, if they are specified.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
</tbody>
</table>

Script includes installed with Model Management

Model Management includes script includes.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ModelAndCategoryFilters</td>
<td>Refines reference qualifiers for models and model categories based on class.</td>
</tr>
<tr>
<td>ModelCategoryCheck</td>
<td>Ensures compatibility of classes between the several categories referenced by the same model.</td>
</tr>
</tbody>
</table>

Tables installed with Model Management

Model Management includes numerous tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Model (cmdb_application_product_model)</td>
<td>Stores models used to describe software application products.</td>
</tr>
<tr>
<td>Consumable Model (cmdb_consumable_product_model)</td>
<td>Describes consumable product models.</td>
</tr>
<tr>
<td>Contract Model (cmdb_contract_product_model)</td>
<td>Stores all contract models.</td>
</tr>
<tr>
<td>Depreciation (cmdb_depreciation)</td>
<td>Stores asset depreciation patterns.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Hardware Model (cmdb_hardware_product_model)</td>
<td>Describes hardware product models.</td>
</tr>
<tr>
<td>Model Category (cmdb_model_category)</td>
<td>Defines groups of assets, consumables, product bundles, and configuration items.</td>
</tr>
<tr>
<td>Model Compatibility (cmdb_m2m_model_compatibility)</td>
<td>Stores many-to-many relationship between two models signifying their compatibility with one another.</td>
</tr>
<tr>
<td>Model Component (cmdb_m2m_model_component)</td>
<td>Stores many-to-many relationship between two models signifying that they form a bundle.</td>
</tr>
<tr>
<td>Product model (cmdb_model)</td>
<td>Describes all kinds of product models.</td>
</tr>
<tr>
<td>Software License Calculation (cmdb_sw_license_calculation)</td>
<td>Defines commonly used software licensing patterns.</td>
</tr>
<tr>
<td>Software Model (cmdb_software_product_model)</td>
<td>Describes software product models.</td>
</tr>
<tr>
<td>Software Suite (cmdb_m2m_suite_model)</td>
<td>Stores many-to-many relationship between two models that defines elements of a software suite.</td>
</tr>
<tr>
<td>Software Upgrade and Downgrades (cmdb_m2m_downgrade_model)</td>
<td>Stores many-to-many relationship between two models signifying that being licensed for one model grants rights to the other as well.</td>
</tr>
</tbody>
</table>

**UI policies installed with Model Management**

Model Management includes UI policies.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide unverified</td>
<td>Model Category (cmdb_model_category)</td>
<td>Shows the Enforce CI verification field if the Asset class and CI class fields are not empty.</td>
</tr>
<tr>
<td>Lock fields for Contract and Work</td>
<td>Model Category (cmdb_model_category)</td>
<td>Sets all fields on the Model Category form to read-only if the Name is Contract or, Work Order or Work Task.</td>
</tr>
<tr>
<td>Lock fields for Contract</td>
<td>Model Category (cmdb_model_category)</td>
<td></td>
</tr>
<tr>
<td>Protect model category</td>
<td>Product Model (cmdb_model)</td>
<td>Makes the Model categories field mandatory and read-only if it contains any of the following values: Software License, Contract, Work Order, Work Task.</td>
</tr>
<tr>
<td>Show is an option if Oracle</td>
<td>Software Model (cmdb_software_product_model)</td>
<td>Shows the Is an option field if the selected Manufacturer name starts with Oracle.</td>
</tr>
</tbody>
</table>
User roles installed with Model Management

Model Management includes user roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>category_manager</td>
<td>model manager</td>
<td>Can create, edit, and delete model categories.</td>
</tr>
<tr>
<td>model_manager</td>
<td>none</td>
<td>Can create new CMDB models. The model manager role can control the base models and any model extensions that are not hardware, software, or consumables. Hardware and consumable models are controlled by the asset manager (asset) role. Software models are controlled by the software asset manager (sam) role.</td>
</tr>
</tbody>
</table>

Installed with Asset Management

A number of tables, user roles, UI policies, script includes, client scripts, and business rules are installed with Asset Management.

Demo data is available with asset management. The demo data provides information such as users, specific assets, and individual stockrooms.

Tables

Asset Management includes the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset (alm_asset)</td>
<td>Stores general, financial, and contractual information about assets.</td>
</tr>
<tr>
<td>Asset Entitlement (alm_entitlement_asset)</td>
<td>Enables ServiceNow to categorize the Asset Entitlement table and enforce how entitlements behave.</td>
</tr>
<tr>
<td>Consumable (alm_consumable)</td>
<td>Stores data about consumable assets (previously known as parts).</td>
</tr>
<tr>
<td>Default Stockroom (alm_user_stockroom)</td>
<td>Stores the relationship between a user and their default stockroom.</td>
</tr>
<tr>
<td>Fixed Assets (alm_fixed_assets)</td>
<td>Stores fixed assets, which are containers that can hold multiple assets.</td>
</tr>
<tr>
<td>Fixed asset to asset (m2m_fixed_asset_to_asset)</td>
<td>Stores associations between fixed assets and assets.</td>
</tr>
</tbody>
</table>
## Table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware (alm_hardware)</td>
<td>Stores general, financial, and contractual information about hardware assets.</td>
</tr>
<tr>
<td>License Entitlement (alm_entitlement)</td>
<td>Stores entitlements that permit users or machines to use a software license.</td>
</tr>
<tr>
<td>Software License (alm_license)</td>
<td>Stores general, financial, and contractual information about software license assets.</td>
</tr>
<tr>
<td>Stock Rule (alm_stock_rule)</td>
<td>Transfers stock or sends an email message to the asset manager when a specified asset drops below a set threshold.</td>
</tr>
<tr>
<td>Stockroom (alm_stockroom)</td>
<td>Stores information about stockrooms.</td>
</tr>
<tr>
<td>Stockroom Model (alm_m2m_stockroom_model)</td>
<td>Tracks all models that have ever been stocked in a stockroom. This table is automatically populated.</td>
</tr>
<tr>
<td>Stockroom Type (alm_stockroom_type)</td>
<td>Stores general information about stockroom types.</td>
</tr>
<tr>
<td>Transfer Order (alm_transfer_order)</td>
<td>Contains data about transfer orders, including the state and stockrooms.</td>
</tr>
<tr>
<td>Transfer Order Line (alm_transfer_order_line)</td>
<td>Contains data about individual assets being shipped with a transfer order.</td>
</tr>
<tr>
<td>User Entitlement (alm_entitlement_user)</td>
<td>Enables ServiceNow to categorize the User Entitlement table and enforce how entitlements behave.</td>
</tr>
</tbody>
</table>

## User roles

Asset Management includes the following user roles.

### Asset Management user roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>asset (Asset Manager)</td>
<td>category manager, contract manager, financial mgmt user, inventory user</td>
<td>Can manage hardware and consumable assets ([alm_hardware] and [alm_consumable]). Asset manager cannot edit asset records that are created and updated automatically, but can read and delete the asset records when needed. Can create requests. Can create and delete stock information.</td>
</tr>
<tr>
<td>Role</td>
<td>Contains roles</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>inventory_admin</td>
<td>inventory user</td>
<td>Can create and delete stock information. Can edit stock rules, stockrooms, and stockroom types.</td>
</tr>
<tr>
<td>inventory_user</td>
<td>none</td>
<td>Can access stock information. Can create and manage transfer orders.</td>
</tr>
<tr>
<td>sam</td>
<td>contract manager, model manager, financial mgmt user</td>
<td>Can create, edit, change, and manage software licenses. Can edit the Software model field on a discovery model. Can approve a model. Has full control of the Software Asset Management application. Controls the Software Asset Management IBM PVU Process Pack, if activated.</td>
</tr>
</tbody>
</table>

**UI policies**

Asset Management includes the following UI policies.

**Asset Management UI policies**

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide asset tag and serial num</td>
<td>(alm_asset)</td>
<td>Hides the asset tag when the asset is pre-allocated and the quantity is greater than 1.</td>
</tr>
<tr>
<td>Hide/show parent stockroom on Stockroom Replenish</td>
<td>(alm_stock_rule)</td>
<td>Shows the Parent stockroom field only when the Restocking option field is set to Stockroom.</td>
</tr>
<tr>
<td>Make allocated to and assigned to mandatory.</td>
<td>License Entitlement (alm_entitlement)</td>
<td>Makes the Allocated to and Assigned to fields mandatory.</td>
</tr>
<tr>
<td>Make substatus read-only when not required</td>
<td>(alm_asset)</td>
<td>Sets the Substatus to read-only if the State is On order, In use, Consumed, or In maintenance.</td>
</tr>
<tr>
<td>Model bundle field hidden but present for UI Policy conditions purposes</td>
<td>(alm_asset)</td>
<td>Hides the Model Bundle field. Exists on page only for use by UI policies and client scripts.</td>
</tr>
<tr>
<td>Pre-allocated constraints</td>
<td>(alm_asset)</td>
<td>Hides unneeded fields and related lists when the asset is pre-allocated.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Quantity readonly until model and category qualify the asset and are not bundle</td>
<td>(alm_asset)</td>
<td>Sets the Quantity field to read-only for assets that are not consumable, software, or pre-allocated. Quantity is also read-only if the model or model category fields are empty.</td>
</tr>
<tr>
<td>Show ‘Assigned to’</td>
<td>(alm_asset)</td>
<td>Shows the Assigned to field if the State field is not On order, In stock, or In transit.</td>
</tr>
<tr>
<td>Show ‘Reserved for’</td>
<td>(alm_asset)</td>
<td>Shows the Reserved for field if the State field is On order, In stock, or In transit.</td>
</tr>
</tbody>
</table>
| Show ‘Stockroom’ | (alm_asset) | Shows the Stockroom field if either of the following conditions is true:  
- The State field is In stock and Substate is not Pre-allocated.  
- The Substate is Pre-allocated and Parent is empty. |

**Script includes**

Asset Management includes the following script includes.

**Asset Management script includes**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AssetandCI</td>
<td>Code for creating and managing the relationship between asset and CI records.</td>
</tr>
<tr>
<td>AssetAndCISynchronizer</td>
<td>Synchronization code between asset and CI records.</td>
</tr>
<tr>
<td>AssetUtils</td>
<td>Utility functions for asset management. Also checks if a license can be merged and then merges licenses if requirements are met.</td>
</tr>
<tr>
<td>AssetUtilsAJAX</td>
<td>AJAX based utility functions for asset management. Call the AssetUtils script include from a client-side UI action.</td>
</tr>
<tr>
<td>Consumables</td>
<td>Code to modify (for example, consume, split, and merge) consumables.</td>
</tr>
<tr>
<td>FixedAssetUtils</td>
<td>Methods for rolling up fixed asset costs.</td>
</tr>
<tr>
<td>PortalFilters</td>
<td>Filters used in the My Assets portal.</td>
</tr>
<tr>
<td>PreAllocatedAssets</td>
<td>Code to modify pre-allocated assets.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>StockRuleFilters</td>
<td>Reference qualifier code for filtering options on reference fields on stock rules.</td>
</tr>
<tr>
<td>StockRuleTransfer</td>
<td>Transfer order creation code for when stock rules are triggered.</td>
</tr>
<tr>
<td>TransferOrderDate TIME Ajax</td>
<td>Date comparison utility for transfer orders.</td>
</tr>
<tr>
<td>TransferOrderFilters</td>
<td>Reference qualifier code for reference field filtering options on transfer orders.</td>
</tr>
<tr>
<td>TransferOrderFinder</td>
<td>Finds an appropriate transfer order to put a transfer order line into.</td>
</tr>
<tr>
<td>TransferOrderHelper</td>
<td>Function that checks if a transfer order has multiple transfer order lines.</td>
</tr>
<tr>
<td>TransferOrderLineFilters</td>
<td>Reference qualifier code for reference field filtering options on transfer order lines.</td>
</tr>
<tr>
<td>TransferOrderReceiver</td>
<td>Code for receiving a transfer order line.</td>
</tr>
<tr>
<td>TransferOrderReturn</td>
<td>Code for returning a transfer order line.</td>
</tr>
<tr>
<td>TransferOrderStageHandler</td>
<td>Code for changing transfer order stages and transfer order line stages.</td>
</tr>
<tr>
<td>TransferOrderStageHelper</td>
<td>Helper method to get numeric stages for transfer orders and transfer order lines.</td>
</tr>
</tbody>
</table>

### Client scripts

Asset Management includes the following client scripts.

**Asset Management client scripts**

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correct substatus</td>
<td>(alm_asset)</td>
<td>Updates the Substatus field when the Status field is modified.</td>
</tr>
<tr>
<td>Ensure no negative quantity</td>
<td>(alm_asset)</td>
<td>Clears the Quantity field when set to less than 1.</td>
</tr>
<tr>
<td>Error on pre-allocated substatus</td>
<td>(alm_consumable)</td>
<td>Prevents Substatus field from being set to Pre-allocated for consumable assets. Also displays an error message.</td>
</tr>
<tr>
<td>Error on pre-allocated substatus</td>
<td>(alm_license)</td>
<td>Prevents Substatus field from being set to Pre-allocated for license assets. Also displays an error message.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Null out allocated_to</td>
<td>(aim_entitlement)</td>
<td>Does the following when the Assigned to field is set:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>· Clears the Allocated to field and makes it not mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>· Makes the Assigned to field mandatory.</td>
</tr>
<tr>
<td>Null out assigned_to</td>
<td>(aim_entitlement)</td>
<td>Does the following when the Allocated to field is set:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>· Clears the Assigned to field and makes it not mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>· Makes the Allocated to field mandatory.</td>
</tr>
<tr>
<td>Salvage must be less than cost</td>
<td>(aim_asset)</td>
<td>Displays a warning if a salvage value greater than the cost of an asset is entered.</td>
</tr>
<tr>
<td>Set Cost of the Asset</td>
<td>(aim_asset)</td>
<td>Populates the Cost field when the Model field is set.</td>
</tr>
<tr>
<td>Set Loc/CC/Dep/Com from assigned to</td>
<td>(aim_asset)</td>
<td>Populates the Location, Cost center, Department, and Company fields when the Assigned to field is set.</td>
</tr>
<tr>
<td>Set Location from stockroom</td>
<td>(aim_asset)</td>
<td>Populates the Location field when the Stockroom field is set.</td>
</tr>
<tr>
<td>Update From Location from Stockroom</td>
<td>(aim_transfer_order)</td>
<td>Populates the From location field when the From stockroom field is set.</td>
</tr>
<tr>
<td>Update Model and Quantity based on Asset</td>
<td>(aim_transfer_order_line)</td>
<td>Populates the Model field when the Asset field is set. If the asset is a pre-allocated asset, this client script also populates the Quantity field.</td>
</tr>
<tr>
<td>Update To Location from Stockroom</td>
<td>(aim_transfer_order)</td>
<td>Populates the To location field when the To stockroom field is set.</td>
</tr>
<tr>
<td>Update UI on load and model change</td>
<td>(aim_transfer_order_line)</td>
<td>Runs checks, and updates the user interface, when the transfer order line form is loaded and when a model is selected.</td>
</tr>
<tr>
<td>Validate Delivery by Date</td>
<td>(aim_transfer_order)</td>
<td>Validates that the delivery date is in the future.</td>
</tr>
<tr>
<td>Verify Stock Available</td>
<td>(aim_transfer_order_line)</td>
<td>Verifies that stock exists to fulfill the quantity requested.</td>
</tr>
</tbody>
</table>
### Business rules

Asset Management includes the following business rules.

**Asset Management business rules**

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocated more licenses than rights</td>
<td>Software License (alm_license)</td>
<td>Prevents creation or update of a license if the number of licenses allocated is larger than the total rights.</td>
</tr>
<tr>
<td>Asset Retirement</td>
<td>Asset (alm_asset)</td>
<td>Clears the Assigned to, Stockroom, and Reserved for fields and sets the retirement date to the current time when the asset is retired.</td>
</tr>
<tr>
<td>Automatically Change TOL State</td>
<td>Transfer Order Line</td>
<td>If a transfer order has the same From stockroom and To stockroom and it is a personal stockroom, this business rule:</td>
</tr>
<tr>
<td></td>
<td>(alm_transfer_order_line)</td>
<td>· Sets the transfer order line Stage to Delivered.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>· Sets the asset Substate to Reserved.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If a transfer order has the same From stockroom and To stockroom and it is not a personal stockroom, this business rule:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>· Sets the transfer order Stage to Received.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>· Sets the asset Substate to Pending transfer.</td>
</tr>
<tr>
<td>Build bundle components on Insert</td>
<td>Asset (alm_asset)</td>
<td>Creates assets for the components related to a bundle if the model of the created asset is a bundle.</td>
</tr>
<tr>
<td>Clear Assigned To on update</td>
<td>Asset (alm_asset)</td>
<td>Clears the Assigned to field if the State field changes to On order, In stock, or In transit.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>---------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Clear fields irrelevant for preallocated</td>
<td>Asset (alm_asset)</td>
<td>Clears the value of fields that are irrelevant for pre-allocated assets.</td>
</tr>
<tr>
<td>Create Asset on insert</td>
<td>Configuration Items (cmdb_ci)</td>
<td>Creates a corresponding asset when a new configuration item with no asset is created.</td>
</tr>
<tr>
<td>Create asset on model change</td>
<td>Configuration Items (cmdb_ci)</td>
<td>Creates a new associated asset when the Model ID field changes.</td>
</tr>
<tr>
<td>Create CI on insert</td>
<td>Asset (alm_asset)</td>
<td>Creates a corresponding configuration item when a new asset with no configuration item is created.</td>
</tr>
<tr>
<td>Create Stockroom Model Relation</td>
<td>Asset (alm_asset)</td>
<td>Creates a record (if none already exists) in the Stockroom Model table indicating the stockroom that holds the model when an asset is created or updated.</td>
</tr>
<tr>
<td>Delete all Transfer Order Lines</td>
<td>Transfer Order (alm_transfer_order)</td>
<td>Deletes all related transfer order lines when a transfer order is deleted.</td>
</tr>
<tr>
<td>Ensure Entitlements do not exceed rights</td>
<td>License Entitlement (alm_entitlement)</td>
<td>Checks that the total number of entitlements for the related license does not exceed the number of rights given by the license when an entitlement is created.</td>
</tr>
<tr>
<td>Generate Assets</td>
<td>Model Categories (cmdb_model_category)</td>
<td>Executes a scheduled script job to create assets for configuration items.</td>
</tr>
<tr>
<td>Inherit information from parent</td>
<td>Asset (alm_asset)</td>
<td>Assigns some parent values to the asset when assigning a new parent to an asset.</td>
</tr>
<tr>
<td>Managed Stockroom for Vendor</td>
<td>Stock Rule (alm_stock_rule)</td>
<td>Validates that a vendor replenishing stock rule has a stockroom selected and the stockroom has an associated manager with a valid email address.</td>
</tr>
<tr>
<td>Mandate allocated to or assigned to</td>
<td>License Entitlement (alm_entitlement)</td>
<td>Makes a value in either the Allocated to field or the Assigned to field mandatory.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Merge Records</td>
<td>Consumable (alm_consumable)</td>
<td>Merges consumables that have matching fields and are not in Transit into one record containing the total count.</td>
</tr>
<tr>
<td>Null out asset on insert and stay</td>
<td>Configuration Items (cmdb_ci)</td>
<td>Clears the Asset field on insert if the field contains an asset that has a CI.</td>
</tr>
<tr>
<td>Null out Ci on insert and stay</td>
<td>Asset (alm_asset)</td>
<td>Nulls out the asset field so a new asset is created for the CI if an insert is performed on an existing CI.</td>
</tr>
<tr>
<td>Populate reserved for field</td>
<td>Transfer Order Line (alm_transfer_order_line)</td>
<td>If the transfer order line has an associated request line, this business rule populates the associated asset’s Reserved for field with the appropriate information from the request line.</td>
</tr>
<tr>
<td>Push Status to Asset/Consumable</td>
<td>Transfer Order Line (alm_transfer_order_line)</td>
<td>Modifies the corresponding asset to reflect the current state of transit when a transfer order line moves to another state.</td>
</tr>
<tr>
<td>Release Asset on TOL cancel/delete</td>
<td>Transfer Order Line (alm_transfer_order_line)</td>
<td>Places the corresponding asset back into stock and unsources the part requirement when a transfer order line in the draft state is canceled or deleted.</td>
</tr>
<tr>
<td>Rollup TOL cancellation to TO</td>
<td>Transfer Order Line (alm_transfer_order_line)</td>
<td>Signals to the corresponding transfer order that the transfer order line has been canceled.</td>
</tr>
<tr>
<td>Salvage value must be less than cost</td>
<td>Asset (alm_asset)</td>
<td>Prevents saving an asset record if the salvage value is greater than the cost.</td>
</tr>
<tr>
<td>Sanity check on pre-allocated</td>
<td>Asset (alm_asset)</td>
<td>Prevents creation or update of pre-allocated assets if they do not satisfy the conditions to be pre-allocated.</td>
</tr>
<tr>
<td>Set Class</td>
<td>License Entitlement (alm_entitlement)</td>
<td>Sets the class for this entitlement depending on if the entitlement is assigned or allocated.</td>
</tr>
<tr>
<td>Set Transfer Order Type</td>
<td>Transfer Order (alm_transfer_order)</td>
<td>Sets the type of the transfer order depending on whether there is a related service order or work order task.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sync model category</td>
<td>Product Models (cmdb_model)</td>
<td>When the model category changes, this business rule creates assets if they did not previously exist for configuration items associated with the model.</td>
</tr>
<tr>
<td>Transfer Order Stockroom Rules</td>
<td>Transfer Order (alm_transfer_order)</td>
<td>Prevents the From stockroom field from being changed if the transfer order has multiple transfer order lines.</td>
</tr>
<tr>
<td>Transition reserved to assigned</td>
<td>Asset (alm_asset)</td>
<td>Populates the Assigned to field with the value from the Reserved for field when the asset is in the appropriate state.</td>
</tr>
<tr>
<td>Trickle information down to components</td>
<td>Asset (alm_asset)</td>
<td>Updates components of an asset to reflect any changes that have been made to the asset record.</td>
</tr>
<tr>
<td>Update Asset fields on change</td>
<td>Configuration Items (cmdb_ci)</td>
<td>Synchronizes fields so changes made on the Configuration Item form trigger the same update on the corresponding Asset form, ensuring consistent reporting. ServiceNow recommends updating statuses on the Asset form.</td>
</tr>
<tr>
<td>Update CI fields on change</td>
<td>Asset (alm_asset)</td>
<td>Synchronizes fields so changes made on the Asset form trigger the same update on the corresponding Configuration Item form, ensuring consistent reporting.</td>
</tr>
<tr>
<td>Update location as needed</td>
<td>Asset (alm_asset)</td>
<td>Updates the location of the asset, if the asset is set to a new stockroom or assigned to a new user.</td>
</tr>
<tr>
<td>Validate Field Agent Type</td>
<td>Stockroom (alm_stockroom)</td>
<td>Ensures you do not create a stockroom of type Field Agent without Work Management or Field Service Management activated. Allows for only one personal stockroom per user.</td>
</tr>
<tr>
<td>Validate TOL and check availability</td>
<td>Transfer Order Line (alm_transfer_order_line)</td>
<td>Validates changes made to the transfer order line and checks availability of the assets to be transferred in the specified stockroom.</td>
</tr>
</tbody>
</table>
### Domain separation and Hardware Asset Management

This is an overview of domain separation and how it works in Hardware Asset Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

#### Support level: Enhanced

- Includes **Basic** and **Standard** levels
- Data-driven process enables service provider customers to modify business logic that is based on defined use cases. These configurations are UI-based and fail-safe so that configurations by one customer cannot affect another.
- Tenants of the instance need to be able to configure minimum viable product (MVP) business logic and data parameters for themselves. This logic and parameters would be expected for the application's normal function.

Use case: Tenant-customers of a shared environment need to be able to make changes to the impact, urgency, or priority matrix to set priority within their domain.
Overview

Domain separation support in the product enables service providers to offer managed services for software and hardware asset management to their customers. This feature also caters to large organizations who manage their subsidiaries as independent domains.

How domain separation works in Hardware Asset Management

In HAM, domain separation occurs in two stages: data separation and process separation. There are two system properties that are used to enable or disable the separation. In the Paris release, both data and process are domain-separated.

Note:
The Recommended practice is to avoid customizing the base system domain configuration record.
Multi-Tenant Support for IT Asset Management

Manage the entire IT Asset Management lifecycle for your customers in a shared ServiceNow instance

Required plugins

- Domain separation extension (com.glide.domain.msp_extensions.installer)
- Performance Analytics – Domain Support (com.snc.pa.domain_support)
- SAMP (com.sn_samp_master)
• HAMP (store app)

Other supported plugins

• Service Catalog – Domain Separation (com.glideapp.servicecatalog.domain_separation)
• Procurement (com.snc.procurement)
• Cost Management (com.snc.cost_management)
• Contract Management (com.snc.contract_management)

To learn more, see Domain separation explained, Contains queries and domain access, and Importance of Default domain.

Quick start tests for Hardware Asset Management

Validate that Hardware Asset Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Hardware Asset Management quick start tests are available when you install the HAM: Hardware Asset Management application from the ServiceNow Store.

Hardware Asset Management test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Lifecycle Automation - Asset Disposal workflow</td>
<td>Validates asset disposal workflow.</td>
<td>Paris</td>
</tr>
<tr>
<td>Asset Lifecycle Automation-Deployment workflow</td>
<td>Validates asset deployment workflow.</td>
<td>Paris</td>
</tr>
</tbody>
</table>

Note: Requires demo data.

Contract Management

Manage and track contracts with the ServiceNow® Contract Management application.

A contract is a binding agreement between two parties. In the ServiceNow platform, contracts contain detailed information such as the following:

• Contract number
• Contract start and end dates
• Active status
• Terms and conditions statements
• Documents
• Renewal information
• Financial terms
Contract Management is active by default. If the Cost Management plugin is activated, the Contract Management application integrates with the Cost Management plugin to associate contracts with costs and determine the total cost of ownership. You can track recurring expenses with expense lines. An administrator can activate the Cost Management plugin.

If you are using the Software Asset Management plugin, use the Software Licenses option.

**Use the Contract Management Overview module**

You can view information about your contract status in the Contract Management Overview module. It displays various contract management reports.

Role required: asset, contract_manager

Because the Contract Management Overview module is a type of homepage, you can add, delete, and rearrange reports on the page.

1. Navigate to **Contract > Overview**.
2. Click elements within the reports to obtain more information.
   For example, click any of the colored bars in the **Contract Expenditure by Type** bar chart to see detailed information.
### Active Contracts by Vendor

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Contract type</th>
<th>Vendor</th>
<th>Starts</th>
<th>Ends</th>
<th>Short description</th>
<th>SL Expiration level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor G</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor H</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor I</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor J</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor K</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor L</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor M</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor N</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor O</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor P</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor Q</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor R</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor S</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor T</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor U</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor V</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor W</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor Z</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Contract Expenditure by Type

- Type A: 50
- Type B: 30
- Type C: 10

### Contract Expenditure by Vendor

- Vendor A: 50%
- Vendor B: 30%
- Vendor C: 10%
- Vendor D: 5%
- Vendor E: 5%
- Vendor F: 0%
- Vendor G: 0%
- Vendor H: 0%
- Vendor I: 0%
- Vendor J: 0%
- Vendor K: 0%
- Vendor L: 0%
- Vendor M: 0%
- Vendor N: 0%
- Vendor O: 0%
- Vendor P: 0%
- Vendor Q: 0%
- Vendor R: 0%
- Vendor S: 0%
- Vendor T: 0%
- Vendor U: 0%
- Vendor V: 0%
- Vendor W: 0%
- Vendor X: 0%
- Vendor Y: 0%
- Vendor Z: 0%
Components installed with Contract Management

Several types of components are installed with Contract Management.
Demo data is available.

Tables installed with Contract Management

Tables are added with Contract Management.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Covered (clm_m2m_contract_asset)</td>
<td>Lists the assets covered by a contract. An asset can be covered by multiple contracts and a contract can have multiple assets.</td>
</tr>
<tr>
<td>Asset Covered (clm_m2m_rate_card_asset)</td>
<td>Lists the rate cards that apply to an asset.</td>
</tr>
<tr>
<td>Condition (clm_condition_checker)</td>
<td>Lists the conditions and values for each condition checker.</td>
</tr>
<tr>
<td>Condition Checks (clm_condition_check)</td>
<td>Stores conditions and values that modify specified condition fields.</td>
</tr>
<tr>
<td>Contract (ast_contract)</td>
<td>Stores contract information.</td>
</tr>
<tr>
<td>Contract History (clm_contract_history)</td>
<td>Stores a copy of the contract when the start date, end date, or terms and conditions change.</td>
</tr>
<tr>
<td>Terms and Conditions (clm_terms_and_conditions)</td>
<td>Lists the terms and conditions used by contracts.</td>
</tr>
<tr>
<td>Terms and Conditions (clm_m2m_contract_and_terms)</td>
<td>Lists all terms and conditions available for use with contracts.</td>
</tr>
<tr>
<td>Users Covered (clm_m2m_contract_user)</td>
<td>Lists the users covered by contracts.</td>
</tr>
</tbody>
</table>

User roles installed with Contract Management

A user role is added with Contract Management.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>contract_manager</td>
<td>financial_mgmt_user</td>
<td>Manages the contract life cycle. Can create, edit, and delete contracts.</td>
</tr>
</tbody>
</table>

Script includes installed with Contract Management

Script includes are added with Contract Management.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConditionChecks</td>
<td>Checks for matching conditions, such as for contract expirations and license compliance, defined in the Condition Checks (clm_condition_check) table.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ContractManagementUtils</td>
<td>Utilities that manage contract management actions, such as state transitions.</td>
</tr>
</tbody>
</table>

**Client scripts installed with Contract Management**

Client scripts are added with Contract Management.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Tax Cost - Base cost</td>
<td>Contract (ast_contract)</td>
<td>Calculates the Tax cost field and the Total cost field on the Contract form when the Payment amount field changes.</td>
</tr>
<tr>
<td>Calculate Tax Cost - Sales tax</td>
<td>Contract (ast_contract)</td>
<td>Calculates the Tax cost field and the Total cost field on the Contract form when the Sales tax field changes.</td>
</tr>
<tr>
<td>Calculate Tax Cost - Tax rate</td>
<td>Contract (ast_contract)</td>
<td>Calculates the Tax cost field and the Total cost field on the Contract form when the Tax rate field changes.</td>
</tr>
<tr>
<td>Ensure discount is valid percent</td>
<td>Contract (ast_contract)</td>
<td>Ensures that the Discount field does not contain a value less than zero or greater than 99.</td>
</tr>
<tr>
<td>Renew Cost Adjustment</td>
<td>Contract (ast_contract)</td>
<td>Sets the Percentage field on the Contract form to zero if the user sets a dollar amount for the cost adjustment.</td>
</tr>
<tr>
<td>Renew Cost Percentage</td>
<td>Contract (ast_contract)</td>
<td>Sets the Amount field on the Contract form to zero if the user enters a percentage for the cost adjustment.</td>
</tr>
<tr>
<td>Tax exempt/ rate</td>
<td>Contract (ast_contract)</td>
<td>Changes all tax-related fields on the Contract form to read-only if the Tax Exempt check box is selected.</td>
</tr>
<tr>
<td>Tax rate/exempt</td>
<td>Contract (ast_contract)</td>
<td>Changes all tax-related fields on the Contract form to writeable if the Sales Tax check box is selected.</td>
</tr>
</tbody>
</table>

**Business rules installed with Contract Management**

Business rules are added with Contract Management.
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate projected costs (Reports)</td>
<td>Contract (ast_contract)</td>
<td>Calculates the projected monthly and annual costs for a contract when costs or payment schedule changes.</td>
</tr>
<tr>
<td>Calculate totals with tax</td>
<td>Contract (ast_contract)</td>
<td>Calculates the <strong>Tax cost</strong> and <strong>Total cost</strong> fields for a contract when the contract is created or updated.</td>
</tr>
<tr>
<td>Contract history</td>
<td>Contract (ast_contract)</td>
<td>Stores history when the start, end, or terms and conditions of a contract change.</td>
</tr>
<tr>
<td>Create approval record</td>
<td>Contract (ast_contract)</td>
<td>Updates contract <strong>Terms and Conditions</strong> and starts the contract approval workflow when a contract is sent for review.</td>
</tr>
<tr>
<td>Flag terms and conditions</td>
<td>Terms and Conditions (clm_m2m_contract_and_terms)</td>
<td>Sets the <strong>Use</strong> flag on a Terms and Conditions record to <strong>true</strong> after the record is associated with a contract or to <strong>false</strong> after the record is disassociated from a contract.</td>
</tr>
<tr>
<td>Activate count for manual licenses</td>
<td>Software License Instance (ast_license_software_instance)</td>
<td>Calculates and updates the number of computers a particular license is installed on when a software license instance is created or deleted.</td>
</tr>
<tr>
<td>Manage contract lifecycle</td>
<td>Contract (ast_contract)</td>
<td>This business rule:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>· Updates the end date of a contract when a contract extension has been approved.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>· Renews the contract, updating its start date, end date, and base cost (if cost adjustments must be applied) when a contract renewal has been approved and the renewal has reached its start date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>· Runs the condition checks to evaluate if dates need to be changed when a contract is approved, or an extension or renewal is approved, or the start or end dates have changed.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Post outage to news</td>
<td>Service (cmdb_ci_service)</td>
<td>Posts a news article on the knowledge table when there is an outage.</td>
</tr>
<tr>
<td>Update contract cost per asset</td>
<td>Asset Covered (clm_m2m_contract_asset)</td>
<td>Updates the cost per unit value based on the total cost and number of assets associated to the contract.</td>
</tr>
<tr>
<td>Update contract lifetime cost</td>
<td>Contract Rate Card (fm_contract_rate_card)</td>
<td>Calculates the lifetime cost of the contract by calculating the sum of the contract expense lines.</td>
</tr>
<tr>
<td>Updates after contract dates change</td>
<td>Contract (ast_contract)</td>
<td>Updates the Date added and Date removed fields for all assets and users associated with a contract if the contract end date changes.</td>
</tr>
<tr>
<td>Updates after rate card dates change</td>
<td>Contract Rate Card (fm_contract_rate_card)</td>
<td>Updates the related contract assets and users linked to the rate card when the end date is changed.</td>
</tr>
<tr>
<td>Verify contract’s start and end dates</td>
<td>Contract (ast_contract)</td>
<td>Validates contract start and end dates and contract renewal start and end dates.</td>
</tr>
<tr>
<td>Verify purchase agreement discount price</td>
<td>Contract (ast_contract)</td>
<td>For contracts with the contract model Purchase Agreement, the business rule validates that the Discount field does not contain a value less than zero or greater than 99.</td>
</tr>
</tbody>
</table>

**Contract Management use**

Users with the contract_manager role can use the Contract Management application to create various types of contracts, such as leases, warranties, maintenance, and service.

You can add the following information to contracts.

- Assets covered by the contract
- Users covered by the contract
- Terms and conditions associated with the contract
- Other documents related to the contract

Track the various stages of a contract from draft to closure by viewing contract history and running reports. Adjust, extend, and renew active contracts.

**Contract life cycle**

From creation until closure, contracts follow a life cycle that determines which fields can be edited.
When a contract is in **Draft** state, almost all fields on the contract record can be edited. After a contract moves past the **Draft** state, certain date, renewal, extension, and financial fields become read-only. The **State** field and **Substate** field are always read-only.

A scheduled job named **Contract Compliance Checks** runs on the Contract (ast_contract) table automatically each night. For more information about the scheduled job, see **Use Condition Check Definitions**. The scheduled job performs the following actions:

- Changes the contract state to **Active** if the contract is approved and reaches the specified start date.
- Renews the contract if the contract is approved for renewal and reaches the specified start date.
- Changes the contract state to **Expired** if the contract state is **Active** and reaches the end date.

Expense lines are only generated from contracts that are active or expired.

### Contract states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>User adds information about the contract and specifies an approver.</td>
</tr>
<tr>
<td>Active</td>
<td>Contract was approved and has reached the specified start date.</td>
</tr>
<tr>
<td>Expired</td>
<td>Contract reached the specified end date. Expired contracts with an active renewal workflow that are waiting for approval have a substate of <strong>Awaiting Review</strong>. Expired contracts with an active renewal workflow where the renewal was approved, but the renewal date has not yet passed, have a substate of <strong>Renewal Approved</strong>. Expired contracts with no active renewal or extension pending workflow have an empty substate.</td>
</tr>
<tr>
<td>Canceled</td>
<td>Contract was discontinued and is no longer active.</td>
</tr>
</tbody>
</table>

In addition to a state, a contract can also have a substate.

### Contract substates

<table>
<thead>
<tr>
<th>Substate</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Awaiting Review</td>
<td>Contract is being prepared for review.</td>
</tr>
<tr>
<td>Under Review</td>
<td>Contract sent to the approver and the approver is reviewing the contract.</td>
</tr>
<tr>
<td>Approved</td>
<td>Contract reviewed and accepted by the approver.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Contract reviewed and declined by the approver.</td>
</tr>
<tr>
<td>Renewal Approved</td>
<td>Contract renewal approved the approver.</td>
</tr>
<tr>
<td>Renewal Rejected</td>
<td>Contract renewal rejected by the approver.</td>
</tr>
<tr>
<td>Extension Approved</td>
<td>Contract extension approved by the approver.</td>
</tr>
</tbody>
</table>
Contracts

A contract is a binding agreement between two parties.

In the Now Platform, contracts contain detailed information such as contract number, start and end dates, active status, terms and conditions statements, documents, renewal information, and financial terms.

Working with contracts includes the following tasks and processes.

Create a contract
You can create various contract models for leases, maintenance, or warranties.

Role required: contract_manager or admin

If a contract has one or more associated rate cards, the fields on the Contract form cannot be edited.

1. Navigate to Contract and select the type of contract, such as Insurance, Maintenance, or Service, or select All.
2. Click New.
3. Complete the form.
   Not all fields appear on all contract type forms.

Contract form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique number identifying the contract record.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor responsible for the contract. This field is required when the contract model selected is NDA or Purchase Agreement.</td>
</tr>
<tr>
<td>Contract model</td>
<td>Model the contract is assigned to. For example Lease, Maintenance, Warranty, or Service Contract.</td>
</tr>
<tr>
<td>Commitment</td>
<td>Amount committed to spend with this vendor during this time period, from the start to the end of the contract.</td>
</tr>
<tr>
<td>Discount</td>
<td>Discount the vendor has agreed to provide.</td>
</tr>
<tr>
<td>Contract number</td>
<td>Number assigned to the contract by the vendor (required).</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the contract: Draft, Active, Expired, or Canceled.</td>
</tr>
<tr>
<td>Substate</td>
<td>Current substate of the contract: For example, Awaiting Review, Under Review, Approved, or Rejected.</td>
</tr>
<tr>
<td>License quantity entitled</td>
<td>Number of licenses included in the contract. This field is available for Maintenance and Software License contracts.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Parent contract</td>
<td>Parent contract of the new contract, if applicable. You can select a parent contract from the contract lookup list.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the contract.</td>
</tr>
<tr>
<td>General section</td>
<td></td>
</tr>
<tr>
<td>Starts</td>
<td>Date on which the contract takes effect. This field is required if the contract model is Purchase Agreement or NDA.</td>
</tr>
<tr>
<td>Ends</td>
<td>Date on which the contract expires. Leave the end date blank to create an open-ended contract. This field is required if the contract model is Purchase Agreement or NDA.</td>
</tr>
<tr>
<td>PO Number</td>
<td>Purchase order number assigned to the contract.</td>
</tr>
<tr>
<td>Vendor account</td>
<td>Vendor account associated with the contract.</td>
</tr>
<tr>
<td>Agreement type</td>
<td>Agreement type of license: Enterprise, SaaS, or Subscription. This field is available for Maintenance and Software License contracts.</td>
</tr>
<tr>
<td>Application model</td>
<td>Application model associated with the contract.</td>
</tr>
<tr>
<td>Location</td>
<td>Location covered by the contract.</td>
</tr>
<tr>
<td>Contract administrator</td>
<td>Person responsible for managing the contract and interacting with the vendor.</td>
</tr>
<tr>
<td>Approver</td>
<td>User who approves or rejects the contract. List is filtered to only show users with the itil role.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the contract.</td>
</tr>
<tr>
<td>Renewal/Extension section</td>
<td></td>
</tr>
<tr>
<td>Automatically renew/extend</td>
<td>Indicates if the contract can be renewed at the end of its term.</td>
</tr>
<tr>
<td>Options</td>
<td>Duration of the contract renewal or extension. For example, 1 year.</td>
</tr>
<tr>
<td>Renewal/Extension date</td>
<td>Date on which the contract renewal or extension takes effect.</td>
</tr>
<tr>
<td>Renewal/Extension end date</td>
<td>Date on which the contract renewal or extension ends.</td>
</tr>
<tr>
<td>Renewal/Extension contact</td>
<td>Individual who works for the vendor and is responsible for renewing the contract.</td>
</tr>
<tr>
<td>Cost adjustment type</td>
<td>Type of cost adjustment applied to the contract: Fixed, Manual, or CPI (consumer price index).</td>
</tr>
</tbody>
</table>
### Field and Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost adjustment amount</td>
<td>Numerical increase or decrease in price of contract. To indicate a decrease in price, enter a negative number. Either a <strong>Cost adjustment</strong> or <strong>Cost adjustment percentage</strong> can be specified, but not both.</td>
</tr>
<tr>
<td>Cost adjustment percentage</td>
<td>Percentage increase or decrease in price of contract. To indicate a decrease in price, enter a negative percentage. Either a <strong>Cost adjustment</strong> or <strong>Cost adjustment percentage</strong> can be specified, but not both.</td>
</tr>
<tr>
<td>Financial section</td>
<td></td>
</tr>
<tr>
<td>Cost center</td>
<td>Cost center that is financially responsible for the asset.</td>
</tr>
<tr>
<td>Tax exempt</td>
<td>Indicates if the contract is exempt from tax.</td>
</tr>
<tr>
<td>Sales tax</td>
<td>Indicates whether or not sales tax is applied to the total cost.</td>
</tr>
<tr>
<td>Effective tax rate</td>
<td>Effective tax rate to apply to the total cost, if applicable. Effective tax rate is usually the average tax rate charged.</td>
</tr>
<tr>
<td>Has rate card</td>
<td>Check box to indicate whether the contract has an associated rate card.</td>
</tr>
<tr>
<td>Invoice payment terms</td>
<td>Terms that explain how to pay the contract. For example, <strong>Net Monthly Account</strong> or <strong>Net 30</strong>.</td>
</tr>
<tr>
<td>Payment schedule</td>
<td>Schedule that defines when to make payments. For example, <strong>Monthly</strong> or <strong>Annually</strong>.</td>
</tr>
<tr>
<td>Payment amount</td>
<td>Amount which has been paid on the contract to date.</td>
</tr>
<tr>
<td>Tax cost</td>
<td>Total cost of the tax.</td>
</tr>
<tr>
<td>Total cost</td>
<td>Final cost of the contract after adjustments have been applied. If a contract has one or more rate cards, this field shows the combined value of all rate cards.</td>
</tr>
</tbody>
</table>

**4.** Right-click the form header and click **Save**.

**5.** Continue entering information in the additional sections and related lists that appear.

### Contract form fields and related lists

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terms and Conditions section</td>
<td></td>
</tr>
<tr>
<td>Terms and conditions</td>
<td>Specific legal information in the contract.</td>
</tr>
<tr>
<td>Related lists</td>
<td></td>
</tr>
<tr>
<td>Assets Covered</td>
<td>Lists all assets covered by this contract.</td>
</tr>
<tr>
<td>Users Covered</td>
<td>Lists all users covered by this contract.</td>
</tr>
<tr>
<td>Contract used by</td>
<td>Lists all configuration items (CI) used in this contract.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terms and Conditions</td>
<td>Lists all terms and conditions of this contract.</td>
</tr>
<tr>
<td>Expense Lines</td>
<td>Lists all expense lines in this contract.</td>
</tr>
<tr>
<td>Contract History</td>
<td>Displays the changes to the start and end dates of this contract and changes to the terms and conditions.</td>
</tr>
<tr>
<td>Approval History</td>
<td>Lists all approvals for this contract.</td>
</tr>
<tr>
<td>Service Offerings</td>
<td>Lists all service offerings from this vendor.</td>
</tr>
<tr>
<td>Service Commitments for Contracts</td>
<td>Activate Service Portfolio Management to see this related list.</td>
</tr>
</tbody>
</table>

6. Perform one of the following actions.

- Click **Update** to save and exit the contract.
- Click **Submit for Review** to send notification to the approver.

Create a software maintenance contract example

One common use case for the Contract Management application is creating a contract to track maintenance payments for enterprise software. You can use this example to learn how to create a software maintenance contract.

**Role required:** contract_manager or admin

The goal of this example is to create a contract that shows the total amount of maintenance that must be paid for the software application, independent of different license purchases made over time. The Software Asset Management plugin must be activated to use this example.

1. Create an **application model**, adding a **Name** and specifying **Software License** in **Model categories**.
2. Create a **software model**, adding a **Name** and **Model Number**, and selecting the application model created in step 1.
3. Follow the steps in **Add a software entitlement** to create a new software entitlement, selecting the software model created in step 2.
4. Navigate to **Contract > Contracts > Maintenance**.
5. Click **New** and enter the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agreement Type</td>
<td>Select <strong>Enterprise</strong>.</td>
</tr>
<tr>
<td>Application Model</td>
<td>Select the application model created in step 1.</td>
</tr>
</tbody>
</table>

6. Right-click the form header and click **Save**.

A number of related lists and sections appear.

7. In the **Asset Covered** related list, click **New** and enter the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset</td>
<td>Select the software license created in step 3.</td>
</tr>
<tr>
<td>Date added</td>
<td>Enter the value.</td>
</tr>
</tbody>
</table>
8. Click **Submit**.
9. Continue completing the form with the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment schedule</td>
<td>Select <strong>Annually</strong>.</td>
</tr>
<tr>
<td>Payment amount</td>
<td>Enter the value.</td>
</tr>
</tbody>
</table>

10. Complete the other fields as appropriate.
11. Click **Update**.
12. **Submit the contract for review.**

Add an asset to a contract
You can associate contracts with specific assets, including software licenses.

Role required: contract_manager or admin

Linking a contract with assets clarifies what the contract legally covers.

1. Navigate to **Contract Management > Contract > All**.
2. Select a contract.
3. In the **Assets Covered** related list, click **New**.
4. In **Asset**, select a specific asset that is covered by the contract.
5. In **Date added**, select the date the asset was added to the contract. The date can be in the past, the present, or the future.
6. Optional: In **Date removed**, select the date the asset was, or will be, removed from the contract. Specifying **Date added** and **Date removed** is useful for reporting.
7. Click **Submit**.

Add a user to a contract
A contract can cover specific users. For example, you may use a contract to hire a group of temporary workers.

Role required: contract_manager or admin

Linking a contract with users clarifies what the contract legally covers.

1. Navigate to **Contract Management > Contract > All**.
2. Select a contract.
3. In the **Users Covered** related list, click **New**.
4. In **User**, select a specific user covered by the contract.
5. In **Date added**, select the date the user was added to the contract. The date can be in the past, the present, or the future.
6. Optional: In **Date removed**, select the date the user was, or will be, removed from the contract. Specifying **Date added** and **Date removed** can be useful for reporting.
7. Click **Submit**.

Add a configuration item to a contract
Contracts can be associated with specific configuration items. You can link a contract with configuration items to clarify what the contract legally covers.

Role required: contract_manager or admin

1. Navigate to **Contract Management > Contract > All**.
2. Select a contract.
3. Optional: In the **Contract used by** related list, click **New** to create a new configuration item.
4. In the **Contract used by** related list, click **Edit**.
5. In the **Collection** configuration items list on the left, double-click a configuration item name.
The item is added to the Contract used by List on the right.

6. Click Save.

Add a document to a contract
Contracts can be associated with documents. Linking a contract to related documents helps keep all relevant information about a contract together and easily accessible.

The Managed Documents plugin must be activated.

Role required: contract_manager or admin

2. Select a contract.
3. In the Documents related list, click Edit.
   All documents stored in the Managed Documents application appear in the Collection list. If the Collection list is long, create a filter of Type is Contract and click Run filter.
4. In the Collection list, double-click a document.
   The item is added to the Documents List.
5. Click Save.

Adjust a contract
After creating a contract, you can change the start date, end date, or payment amount for a contract.

Role required: contract_manager or admin

To adjust a contract, the State should be Active. If the end date of a contract changes, the end date of any associated assets changes to match the new end date.

1. Navigate to Contract > Contracts > All.
2. Select a contract in Active state.
3. Click Adjust.
4. Complete the form (see table for field descriptions).

Adjust the contract values form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract Start Date</td>
<td>Date on which the contract takes effect.</td>
</tr>
<tr>
<td>Contract End Date</td>
<td>Date on which the contract expires.</td>
</tr>
<tr>
<td>Contract Payment Amount</td>
<td>Total amount paid for the contract. If the contract has one or more rate cards, this field shows the total of all rate card base costs.</td>
</tr>
</tbody>
</table>

5. Click Apply changes.

Renew a contract
After you have created a contract or the contract has expired, you can renew the contract.

Role required: contract_manager or admin

Contract information and history is retained when a contract is renewed. If the end date of the contract changes, the end date of any associated assets changes to match. You can renew a contract that meets the following conditions.

- State is Active or Expired
Substate is None or Rejected

1. Navigate to Contract > Contracts > All.
2. Select a contract in Active or Expired state.
3. Click Renew.
4. Complete the form.

**Contract renewal fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Renewal Contact</td>
<td>Individual who works for the vendor and is responsible for renewing the contract.</td>
</tr>
<tr>
<td>Renewal Start Date</td>
<td>Date on which the renewed contract takes effect.</td>
</tr>
<tr>
<td>Renewal Option</td>
<td>Length of time for the renewal, in years.</td>
</tr>
<tr>
<td>Renewal End Date</td>
<td>Date on which the renewed contract expires.</td>
</tr>
<tr>
<td>Cost Adjustment Type</td>
<td>Type of cost adjustment applied to the renewed contract: None, Fixed, Manual, or CPI.</td>
</tr>
<tr>
<td>Approver</td>
<td>User who approves or rejects the contract.</td>
</tr>
<tr>
<td>Cost Adjustment</td>
<td>Numerical increase or decrease in price of the renewed contract. To indicate a decrease in price, enter a negative number. A Cost Adjustment or Cost Adjustment Percentage can be specified, but not both.</td>
</tr>
<tr>
<td>Cost Adjustment Percentage</td>
<td>Percentage increase or decrease in price of the renewed contract. To indicate a decrease in price, enter a negative percentage. A Cost Adjustment or Cost Adjustment Percentage can be specified, but not both.</td>
</tr>
</tbody>
</table>

5. Perform one of the following steps.
   - To save all entered data and change the substate to Under Review, click Submit for Review. The contract is sent to the specified Approver.
   - To save all entered data and change the substate to Awaiting Review, click Save But Do Not Submit. The Renew button is available to submit the renewed contract for review later.

6. Change any information on the Contract form, as necessary.
7. Click Update.

If you selected the Save But Do Not Submit option, ensure that you click Renew when you are ready to submit the contract renewal for approval.

**Extend a contract**

After creating a contract, you can extend it, if necessary. Extending the end date retains contract information and history.

Role required: contract_manager or admin

When you extend a contract, the end date of any associated assets changes to match the new contract end date. All other contract dates, including notification dates, are recalculated.
automatically based on the new end date. You can extend a contract that meets the following conditions.

- **State** must be **Active** or **Expired**
- **Substate** must be **None** or **Rejected**

1. Navigate to **Contract > Contracts > All**.
2. Select a contract in **Active** or **Expired** state.
3. Click **Extend**.
4. Select an option from **Extension Option** or enter an **Extension End Date**.
5. Complete the form.

### Extend the contract

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extension Contact</td>
<td>Individual who works for the vendor and is responsible for extending the contract.</td>
</tr>
<tr>
<td>Extension Option</td>
<td>Length of time for the extension, in years.</td>
</tr>
<tr>
<td>Extension End Date</td>
<td>Date on which the extended contract expires.</td>
</tr>
<tr>
<td>Cost Adjustment Type</td>
<td>Type of cost adjustment to apply to the extended contract: None, Fixed, Manual, or CPI.</td>
</tr>
<tr>
<td>Approver</td>
<td>User with the contract_manager role who approves or rejects the contract extension.</td>
</tr>
<tr>
<td>Cost Adjustment</td>
<td>Numerical increase or decrease in price of the extended contract. To indicate a decrease in price, enter a negative number. A Cost Adjustment or Cost Adjustment Percentage can be specified, but not both.</td>
</tr>
<tr>
<td>Cost Adjustment Percentage</td>
<td>Percentage increase or decrease in price of the extended contract. To indicate a decrease in price, enter a negative percentage. A Cost Adjustment or Cost Adjustment Percentage can be specified, but not both.</td>
</tr>
</tbody>
</table>

6. Perform one of the following tasks.

- To save all entered data and change the substate to **Under Review**, click **Submit For Review**. The contract can be sent to the specified **Approver**.
- To save all entered data and change the substate to **Awaiting Review**, click **Save But Do Not Submit**. The Extend button is available to submit the extended contract for review later.

### Cancel a contract

You can cancel a contract when the **State** is **Active**.

Role required: contract_manager or admin

After a contract is canceled, the following process occurs.

- The contract **State** changes to **Canceled**.
- Condition checkers are changed to inactive.
- **Renew** and **Extend** buttons become inactive.
- Contract rate cards become inactive.

1. Navigate to **Contract > Contracts > All**.
2. Select a contract.
3. Click **Cancel Contract**.
4. Click **Yes** to confirm contract cancellation.

**Verify contract administrator assignment for notification**

An event runs automatically each night to send reminders to contract administrators about contract expiration dates so they can renew or renegotiate the contract. You can verify that the right contract administrator is assigned to the contract.

Role required: contract_manager or admin

When the contract.expiration event runs on the Contract (ast.contract) table each night, an email message is sent to the person identified as the contract administrator. This email is sent at the following times:

- 90 days ahead of the contract expiration date
- 60 days ahead of the contract expiration date
- 30 days ahead of the contract expiration date
- On the contract expiration date

A user with the admin role can edit the contract.expiration condition check that processes contract notifications.

1. Navigate to **Contract > Contracts > All**.
2. Select a contract.
3. Check that the **Contract administrator** field contains the correct name. A single name can be specified.

**Send the contract for approval**

You can send a contract that is in **Draft** state for approval.

Role required: contract_manager or admin

*Note:* Contract approval is only applicable if you are manually adding your contract approvals in the Now Platform. If you have already approved your contracts, you are not required to use this option.

1. Navigate to **Contract > Contracts > All**.
2. Select a contract in **Draft** state.
3. Select an **Approver** for the contract.
4. Click **Submit For Review**.
   An email message is sent to the selected approver and the contract **Substate** changes to **Under Review**.

**Approve or reject a contract**

If you are the contract manager, you can approve or reject a contract.

Role required: contract_manager or admin

1. Navigate to **Contract > My Approvals**.
2. Select a contract in **Requested** state.
3. Perform one of the following tasks.
   - To approve the contract, click Approve. The contract Substate changes to Approved.
   - To reject the contract, click Reject and enter a rejection reason in the Comments field. The contract Substate changes to Rejected.

4. Click Update.
   - A contract with the state set to Draft and a start date set in the future is kept in Draft until the start date is reached. If the contract has a Substate of Approved, the system changes the State to Active and removes the Substate value.
   - When a contract with a State of Draft and a Start Date set to a date in the past is approved, the contract State is automatically set to Active and Substate is left blank.

View approval history on contracts
You can view the approval history for a contract in the Approval History related list on the Contract form.

Role required: workflow_admin or admin

After a contract is sent to an approver for review, the approver name cannot be changed. If the approver rejects a contract, the same approver or a different approver can be specified before the contract is sent for approval again. Once the contract has been reviewed and approved, approval history records are automatically listed in the Approval History related list on the Contract form.

1. Navigate to Contract and select a record.
2. Click the Approval History related list.
3. Click a record to view approval details.

Terms and conditions
You can add terms and conditions to a contract to keep all documentation that is relevant to a contract in one location.

The terms and conditions can be searched and used in reports. If multiple terms and conditions records are added to a single contract, set an order for the records so they appear in a specific sequence. The terms and conditions fields become read-only after a contract is sent for approval.

Users with the contract_manager role can read contract history and add terms and conditions.

There are three procedures involved in adding terms and conditions to a contract:

Create a terms and conditions record
You can create a terms and conditions record to add to a contract.

Role required: contract_manager or admin

1. Navigate to Contract > Contracts > Terms & Conditions and create a new record (see table for field descriptions).

Terms and Conditions form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique ID used for the terms and conditions. This field is automatically generated.</td>
</tr>
<tr>
<td>Name</td>
<td>Name for the terms and conditions.</td>
</tr>
<tr>
<td>Contract</td>
<td>Link to the contract.</td>
</tr>
</tbody>
</table>
Add terms and conditions to a contract
After you create a terms and conditions record, add the record to a contract.

Role required: contract_manager or admin
1. Navigate to **Contract > Contracts > All**.
2. Select a contract.
3. In the **Terms and Conditions** section, double-click **Insert a new row**.
4. Click the reference lookup icon and select a terms and conditions record from the list.
5. Optional: Enter a number in **Order** to specify the sequence in which the record should appear in the terms and condition document.

**Note:** If you attempt to enter a duplicate terms and conditions record for a contract and save the record, an error message appears and the new duplicate record is not added.

Build a terms and conditions document within a contract
After adding one or more terms and conditions records to a contract, you can build a terms and conditions document within the contract.

Role required: contract_manager or admin
The terms and conditions records are added in the sequence specified in the **Order** field.

1. Navigate to **Contract Management > Contract > All**.
2. Select a contract.
3. Ensure that one or more terms and conditions records have been added to the **Terms and Conditions** section.
4. In **Related Links**, click **Build Terms and Conditions**.
    All records from the **Terms and Conditions** related list are added to the Terms and Conditions section of the contract record.
## Terms and Conditions

### Void Terms of Use Modifications

<table>
<thead>
<tr>
<th>Terms and Conditions</th>
<th>Void Terms of Use Modifications</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update</td>
<td>Add</td>
<td>Delete</td>
</tr>
</tbody>
</table>

**Related Links**

Build Terms and Conditions
Click Update.

Create a contract rate card
You can create rate cards to track contract expenses. Rate cards help to record and allocate costs.

You must activate Cost Management to use rate cards.

Role required: financial_mgmt_user, asset, or contract_manager

A contract rate card provides detailed price information for a contract and enables you to generate expense lines for recurring expenses automatically. There can be multiple rate cards for the same contract.

Consider the following case: an organization has a contract with a third-party company, which oversees technical operations in the organization’s data centers. The contract costs to use a specific server model in the New York data center are different from using the same server model in the Madrid data center. There are two rate cards to detail these costs separately.

2. Select a contract.
3. In the Contract Rate Cards related list, click New.
4. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The contract rate card number.</td>
</tr>
<tr>
<td>Contract</td>
<td>The internal contract number.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The contract rate card type. Categorizing rate cards can be useful for reporting. Select Grow Business, Run Business, or Transform Business.</td>
</tr>
<tr>
<td>Name</td>
<td>A descriptive name for the contract rate card.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that indicates whether the rate card is available for use.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the contract rate card.</td>
</tr>
<tr>
<td>Start date</td>
<td>The date on which the contract rate card becomes active. Expense lines are generated for costs incurred beginning on the date specified. For financial calculations to work, the date cannot be before the start date of the contract.</td>
</tr>
<tr>
<td>End date</td>
<td>The date on which the contract rate card becomes inactive. No expense lines are generated for costs incurred after the end date. For financial calculations to work, the date cannot be after the end date of the contract. The date is automatically set to the end date of the contract if no value is entered and the contract has an end date.</td>
</tr>
<tr>
<td>Interval</td>
<td>The amount of time between rate card charges. For example, Monthly, Quarterly, or Annually.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost center</td>
<td>The cost center financially responsible for the rate card.</td>
</tr>
<tr>
<td>Last processed</td>
<td>The most recent date on which the rate card was charged.</td>
</tr>
<tr>
<td>Next process</td>
<td>The next date on which the rate card will be charged.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed information about the rate card.</td>
</tr>
<tr>
<td>Sales tax</td>
<td>Check box that indicates whether to apply sales tax to the total cost.</td>
</tr>
<tr>
<td>Tax rate</td>
<td>The effective tax rate to apply to the total cost. Tax rate is usually the average tax rate charged.</td>
</tr>
<tr>
<td>Distribute cost</td>
<td>The method for distributing the amount listed in Base cost and generating expense lines.</td>
</tr>
<tr>
<td>Value</td>
<td>Type of value to use when Allocate and distribute cost based on value is selected in the Distribute cost field.</td>
</tr>
<tr>
<td>Base cost</td>
<td>The amount that must be paid before taxes.</td>
</tr>
<tr>
<td>Tax cost</td>
<td>The total cost of the tax.</td>
</tr>
<tr>
<td>Total cost</td>
<td>The final cost of the rate card after adjustments, such as taxes, have been applied.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Create a new expense line**

Typically, expense lines are automatically generated based on assets or users, but you can create a new expense line manually if needed.

Role required: asset or contract_manager

1. Navigate to **Contract Management > Contract > All**.
2. Select a contract.
3. In the **Expense Lines** related list, click **New**.
4. Complete the form.

### Expense line table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the expense line.</td>
</tr>
<tr>
<td>Date</td>
<td>The date on which the expense line was created.</td>
</tr>
<tr>
<td>Rate Card</td>
<td>The identification number of the rate card to which the expense line is associated.</td>
</tr>
<tr>
<td>Rate type</td>
<td>The rate type that is considered during the expense line generation. This field is read-only.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source ID</td>
<td>The identification number of the item associated with the expense line. If this field is filled in, corresponding information is automatically added to the Source fields on this form.</td>
</tr>
<tr>
<td>Amount</td>
<td>The monetary value of the item specified in the Source ID field. Enter a negative value to indicate a credit.</td>
</tr>
<tr>
<td>Process date</td>
<td>The date the expense line is processed.</td>
</tr>
<tr>
<td>Inherited</td>
<td>Check box that indicates whether the expense line is on another expense line.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the expense line, either Pending or Processed.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The expense line category: Grow Business, Run Business, or Transform Business. Categorizing expense lines can be useful for reporting.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the expense line.</td>
</tr>
<tr>
<td>Asset</td>
<td>The identification number of the asset associated with the expense line, if any.</td>
</tr>
<tr>
<td>Fixed asset</td>
<td>Fixed asset that contains the asset in this expense line. A fixed asset is a container that holds one or more individual assets, including hardware or software assets. The system auto-populates this field with the appropriate fixed asset if the named Asset is contained within that fixed asset.</td>
</tr>
<tr>
<td>Contract</td>
<td>The identification number (not the contract number) of the contract associated with the Asset, if any.</td>
</tr>
<tr>
<td>User</td>
<td>The name of the user associated with the Asset, if any.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>The name of the configuration item associated with the expense line, if any.</td>
</tr>
<tr>
<td>Task</td>
<td>The identification number of the task associated with the expense line, if any.</td>
</tr>
<tr>
<td>Cost center</td>
<td>The cost center financially responsible for the item identified in Source ID, if any.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Generating expense lines based on assets or users
An expense line is an expense amount at a given point in time and the record that incurred or generated the expense. You can generate expense lines based on assets or users assigned to the contract.

Role required: financial_mgmt_user, asset, or contract_manager

Generating expense lines is a three-step procedure.
Add a user or asset to a contract

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
You can add a user or asset to a contract to generate expense lines.

Role required: financial_mgmt_user, asset, or contract_manager

1. Navigate to **Contract Management > Contract > All**.
2. Create a new contract or select an existing contract.
3. In the **Assets Covered** or **Users Covered** related list, click **New**.
4. Specify an **Asset** or **User**.
5. Specify a **Date Added**.
6. Click **Submit**.
7. Optional: Repeat the previous steps to add more assets or users to the contract.

Create a rate card and assign a user or asset

You can assign a user or asset when you create a rate card. You can only assign the user or asset that is assigned to the contract.

Role required: financial_mgmt_user, asset, or contract_manager

1. Navigate to **Contract Management > Contract > All**.
2. Select a contract with an assigned user or asset.
3. In the **Contract Rate Cards** related list, click **New**.
4. Specify a **Start date**.
   For financial calculations to work, the date cannot be before the start date of the contract.
5. Right-click the header bar and select **Save**.
6. In the **Asset Covered** or **Rate Card Users** related list, click **New**.
7. Select the **Asset** or **User** who is assigned to the contract.
   Only assets and users associated with the parent contract are listed.
8. Specify a **Date Added**.
9. Click **Submit**.

Configure rate card expense generation

After assets or users are added to the rate card, you can use the **Distribute cost** field in the Financial section of the contract to generate rate card expenses.

Role required: financial_mgmt_user, asset, or contract_manager

1. Navigate to **Contract > Contracts > All**.
2. Select the contract to generate expenses.
3. In the **Contract Rate Card** related list, select a rate card.
4. In **Distribute cost**, select one of the following options to distribute the amount listed in **Base cost**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Split expense lines evenly across assets</strong></td>
<td>Select <strong>Allocate and distribute cost per asset</strong>. For example, with a $100 <strong>Base cost</strong> and two assets, two expense lines for $50 are created.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Split expense lines across assets based on asset</td>
<td>Select Allocate and distribute cost based on value:</td>
</tr>
<tr>
<td>value</td>
<td>The <strong>Value</strong> field displays with <strong>Cost</strong> and <strong>Residual Cost</strong> options. The cost is derived from the <strong>Cost</strong> or <strong>Residual Cost</strong> field on an asset record. If there are multiple assets on the rate card, the cost or residual cost is distributed based on the value of the assets. For example, if you select the <strong>Cost</strong> option with a $100.00 Base cost, one asset worth $70, and one asset worth $30, two expense lines are created, one for $70 and one for $30.</td>
</tr>
<tr>
<td>Split expense lines evenly across users</td>
<td>Select Allocate and distribute cost per user.</td>
</tr>
<tr>
<td>Allocate the cost to the contract instead of the</td>
<td>Select Allocate cost to contract.</td>
</tr>
<tr>
<td>individual assets</td>
<td></td>
</tr>
</tbody>
</table>

5. Click **Update**.

Expense lines are automatically generated by a scheduled job for costs incurred between the rate card **Start date** and **End date**. The scheduled job, **Process FM Costs**, runs on the Contract (ast_contract) table once per day. Expense lines are only generated from contracts with the **Active** or **Expired** state. You may want to generate expense lines for expired contracts to track previous expenses.

View contract expense lines
Use the **Expense Lines** related list to view and audit all the expenses recorded for a given contract.

Role required: financial_mgmt_user, asset, or contract_manager

1. Navigate to **Contract > Contracts > All**.
2. Select a contract.
3. Select the **Expense Lines** related list.
4. Select an expense line record to view.
   Information such as expense line details, total cost of the contract, and the contract current value is listed.

Monitor a contract
You can monitor contracts by viewing contract history and creating contract reports.

Role required: asset or contract_manager

If changes are made to a contract start date, end date, or terms and conditions, a copy of the contract is automatically saved and placed in contract history. This is useful for tracking changes to a contract and keeping an audit trail. Configure the **Contract History** related list to include columns for creation and update so you can easily see who edited the contract.

1. Navigate to **Contract > Contracts > All**.
2. Select a contract.
3. View the **Contract History** related list and perform one of the following actions.
• If earlier versions of the contract exist, click a date in the Contract Starts column to view a version.
• If an earlier version of the contract does not exist, change the contract's Start date or End date. Right-click in the header bar and select Save. In the Contract History related list, click a date in the Contract Starts column to view the earlier version.

Run a contract report
A variety of contract reports are available to help track and manage contracts.
role required: contract_manager or admin
1. Navigate to Reports > View / Run.
2. Select one of the following reports to run.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Contracts by Cost Per Unit</td>
<td>All active contracts grouped in ascending order by average cost per unit.</td>
</tr>
<tr>
<td>Active Contracts by Lifetime Cost</td>
<td>All active contracts with an associated rate card grouped in ascending order by total cost. Total cost is measured from the beginning of the contract to the report run date.</td>
</tr>
<tr>
<td>Active Contracts by Monthly Cost</td>
<td>All active contracts grouped in ascending order by cost per month.</td>
</tr>
<tr>
<td>Active Contracts by Vendor</td>
<td>All active contracts alphabetically by vendor.</td>
</tr>
<tr>
<td>Active Contracts by Yearly Cost</td>
<td>All active contracts grouped in ascending order by cost per year.</td>
</tr>
<tr>
<td>All Contracts by State</td>
<td>Contracts grouped by state, such as Draft, Active, or Expired, in bar chart format</td>
</tr>
<tr>
<td>Asset Contracts by Type</td>
<td>All active contracts for assets grouped by type, in pie chart format.</td>
</tr>
<tr>
<td>Asset Contracts List</td>
<td>All active contracts for assets by contract number.</td>
</tr>
<tr>
<td>Contract Expenditure by Type</td>
<td>Total contract expenses by type, such as lease, maintenance, or warranty, in bar chart format.</td>
</tr>
<tr>
<td>Contract Expenditure by Vendor</td>
<td>Total costs of all contracts associated with a specific vendor, in bar chart format.</td>
</tr>
<tr>
<td>Contract Pipeline Report</td>
<td>All contracts with a state of Draft, Active, or Expired and a substate of Awaiting Review or Under Review, in bar chart format.</td>
</tr>
<tr>
<td>Expiring Contracts</td>
<td>All contracts expiring in the next 90 days.</td>
</tr>
</tbody>
</table>
Condition check definitions

Condition check definitions enable you to define logical conditions that indicate when to change a specific field value in a record.

A scheduled job, called **Contract Compliance Checks**, evaluates these condition check definitions nightly by running the condition checker. Use this condition checker to check start dates and end dates and to set expiration levels for contracts.

For example, a contract has a start date of March 1st. When the condition checker runs on March 1st, it verifies that the contract **Substate** is **Approved** and sets the contract **State** to **Active** based on the **Start Date** field.

The nightly condition checker sets the appropriate expiration level for active contracts based on the contract **End Date**. The expiration level can be viewed in the Contracts list. Knowing the expiration level can help contract managers renew or extend a contract before it expires.

Define a condition check

You can define a condition check to change values in a contract when the **Contract Compliance Checks** scheduled job runs each night.

Role required: contract_manager or admin

1. Navigate to **Contract** > **Administration** > **Condition Check Definitions**.
2. Click **New**.
3. Complete the form.

**Condition check definition fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table to which the condition applies. For a contract check definition, select <strong>Contract (ast.contract)</strong>.</td>
</tr>
<tr>
<td>Category</td>
<td>The category for the condition check. Select <strong>Contract</strong> or <strong>None</strong>. The category is used for organizing information and reporting.</td>
</tr>
<tr>
<td>Condition field</td>
<td>The field to be updated, typically <strong>Expiration level</strong> or <strong>State</strong>.</td>
</tr>
<tr>
<td>Event name</td>
<td>The name for the event to be fired when this condition changes the value of the field. Create a name using this syntax: <code>&lt;table_name&gt;.&lt;condition_field&gt;</code>, for example, <code>contract.validation</code>.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the conditions are evaluated.</td>
</tr>
</tbody>
</table>

4. Right-click the header bar and click **Save**. The **Conditions** related list appears.
5. In the **Conditions** related list, click **New**.
6. Complete the form.
## Conditions fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The value the field is set to, if the expiration conditions are met.</td>
</tr>
<tr>
<td>Condition check</td>
<td>The associated condition check.</td>
</tr>
<tr>
<td>Table</td>
<td>The table associated with the condition check.</td>
</tr>
<tr>
<td>Event name</td>
<td>The name of the event this condition triggers.</td>
</tr>
<tr>
<td>Expiration Condition</td>
<td>The condition that must be true for the Condition check field to be set to this value (the Name). Add as many conditions as are needed.</td>
</tr>
<tr>
<td>Compliant state</td>
<td>System field. Do not use.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the conditions are evaluated. The first condition that is found to match, where the Expiration Condition is true, is used, and no others are checked.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.
   The Condition Checks form reopens with the new condition listed in the related list.

8. Optional: Continue adding conditions as needed, following the steps above.

## Domain separation and Contract Management

This is an overview of domain separation and Contract Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: No support**

- The domain field may exist on data tables, but there is no business logic to manage data.
- This level is not considered domain-separated.

For more information, see [Application support for domain separation](#).

## Procurement

Procurement managers can use the ServiceNow® Procurement application to create purchase orders and to obtain items for fulfilling service catalog requests.

Procurement offers the ability to perform the following functions.

- Track service catalog requests
- Create and manage purchase orders
- Create and manage transfer orders
- Receive assets
## Procurement roles

The Procurement application uses the following roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>procurement_admin</td>
<td>procurement_user</td>
<td>Can create purchase orders without a request. Can view requests and requested items. Can view transfer orders. Can create a purchase order or transfer order when sourcing items for a request. Can view the vendor catalog. Can refresh, add, delete, and rearrange gauges in the Procurement Overview module.</td>
</tr>
<tr>
<td>procurement_user</td>
<td>financial_mgmt_user, model_manager</td>
<td>Can create purchase orders without a request. Can view requests and requested items. Can view transfer orders. Can create a purchase order or transfer order when sourcing items for a request. Can view the vendor catalog. Can view and refresh gauges in the Procurement Overview module.</td>
</tr>
</tbody>
</table>

## Procurement workflows

Procurement uses the following workflows.

- In the Service Catalog Request workflow, items ordered from the service catalog that cost over one thousand dollars require approval.
Service catalog request workflow

- In the Source Request workflow, catalog tasks are created so that a procurement manager can source the item by creating a transfer order or purchase order.

Source request workflow

These workflows are provided in the base system. You can edit these workflows in the graphical Workflow Editor or create a workflow to better fit your organization's procurement needs.
Use the Procurement Overview module

Use the gauges on the Procurement Overview homepage to help you track and manage requests, purchase orders, and other important aspects of the procurement process.

Role required: procurement_admin or procurement_user

1. Navigate to Procurement > Overview.
2. Click elements within the gauges to obtain more information.
   For example, click a request number to view the request record.

Activate Procurement

You can activate the Procurement plugin that provides core procurement capabilities.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the Procurement plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Procurement

Several types of components are installed with Procurement.

Demo data is available with Procurement. The demo data provides sample requests, purchase orders, purchase order line items, and receiving slips.

Business rules installed with Procurement

Procurement plugin adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust remaining quantity</td>
<td>Purchase order line items (proc_po_item)</td>
<td>Calculates the remaining quantity of items ordered on a purchase order line items by subtracting the amount received from the amount ordered.</td>
</tr>
<tr>
<td>Can request be sourced</td>
<td>Request (sc_request)</td>
<td>Checks if a request can be sourced.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cancel Procurement Orders</td>
<td>Request (sc_request)</td>
<td>Cancels all unreceived purchase orders and unshipped transfer order lines associated with the request's items if the request state changes to <code>Closed Cancelled</code>.</td>
</tr>
<tr>
<td>Check if req item is sourced</td>
<td>Requested Item (sc_req_item)</td>
<td>Sets the <code>Sourced</code> field on the parent request to <code>true</code> if all requested items have been sourced.</td>
</tr>
<tr>
<td>Check if request is sourceable</td>
<td>Requested Item (sc_req_item)</td>
<td>Checks if the request associated with a requested item can be sourced (obtained from a transfer order or by creating a purchase order to a vendor).</td>
</tr>
<tr>
<td>Create Assets</td>
<td>Receiving Slip Line (proc_rec_slip_item)</td>
<td>If the purchase order line item is available, creates the assets for a receiving slip line when the slip line assets are received.</td>
</tr>
<tr>
<td>Handle roll up states and assets removal</td>
<td>Purchase order line items (proc_po_item)</td>
<td>Manages purchase order line items if they are canceled or received. If a purchase order line is canceled, this business rule deletes any pre-created assets. This business rule also checks the status of other purchase order lines that share the same purchase order and, if necessary, updates the status of the purchase order. For example, when the last purchase order line is received, the status of the purchase order changes to <code>Received</code>.</td>
</tr>
<tr>
<td>Redirect TOL to existing TO-Procurement</td>
<td>Transfer Order Line (alm_transfer_order_line)</td>
<td>Attaches a transfer order line to an existing transfer order if the transfer order is in the <code>Draft</code> stage and has the same <code>From stockroom</code> and <code>To stockroom</code> values as the transfer order line.</td>
</tr>
<tr>
<td>Shipping Cost Changes</td>
<td>Purchase Order (proc_po)</td>
<td>Recalculates the total cost of the purchase order if the shipping rate changes.</td>
</tr>
<tr>
<td>State Change</td>
<td>Transfer Order Line (alm_transfer_order_line)</td>
<td>Marks the requested item as <code>Received</code> if the state of the associated transfer order line changes to <code>Received</code>.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State Change</td>
<td>Purchase order line items</td>
<td>Sets the time at which the purchase order line item is ordered and updates the original requested item when the purchase order line item is received.</td>
</tr>
<tr>
<td></td>
<td>(proc_po_item)</td>
<td></td>
</tr>
<tr>
<td>State Change PO</td>
<td>Purchase Order</td>
<td>Changes the purchase order line item status when the status of the associated purchase order changes.</td>
</tr>
<tr>
<td></td>
<td>(proc_po)</td>
<td></td>
</tr>
<tr>
<td>Total Cost</td>
<td>Purchase order line items</td>
<td>Calculates the total order cost based on the cost of individual items and the quantity ordered.</td>
</tr>
<tr>
<td></td>
<td>(proc_po_item)</td>
<td>When you receive a purchase order line item, this business rule also takes the following steps.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* Populates the List price field with the value from the Cost field unless you enter a different value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* Calculates the Total list price field value by multiplying the List price and Ordered quantity values.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update expected delivery</td>
<td>Purchase order line items</td>
<td>Sets the Expected delivery date for purchase orders to the latest purchase order line Expected delivery date.</td>
</tr>
<tr>
<td>date for PO</td>
<td>(proc_po_item)</td>
<td></td>
</tr>
<tr>
<td>Update expected delivery</td>
<td>Purchase Order</td>
<td>Sets the Expected delivery date of associated purchase order lines to the purchase order's Expected delivery date if at least one of the following conditions is true.</td>
</tr>
<tr>
<td>date for POLs</td>
<td>(proc_po)</td>
<td>* The purchase order line has no expected delivery date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* The purchase order line's expected delivery date is later than the purchase order's expected delivery date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* The purchase order line's expected delivery date is the same as the purchase order's previous delivery date.</td>
</tr>
</tbody>
</table>
### Business rule | Table | Description
--- | --- | ---
Update Ordered Date | Purchase Order (proc_po) | Sets the **Ordered date** field to the date and time at which the status of the purchase order is set to **Ordered**.
Update PO | Purchase order line items (proc_po_item) | Updates the purchase order if the cost of any purchase order line item changes.
Update Purchase Order Line | Receiving Slip Line (proc_rec_slip_item) | Updates the **Quantity received** field on the associated purchase order line item when a receiving slip is received.
Update Request Item CI | Hardware (aim_hardware) | Sets the **Configuration item** field on the catalog task and requested item to the related hardware CI created during the procurement process.

---

**Client scripts installed with Procurement**

Procurement plugin adds the following client scripts.

| Client script | Table | Description |
--- | --- | ---
Hide request item if request is not empty | Catalog Task (sc_task) | Displays the task's **Request item** and the request item's **Requested for** value if the task is associated with a requested item and not directly with a request. Otherwise, if the task is associated with a request, the client script displays the **Request** and the request's **Requested for** value.
Purchase Order Line Mandatory | Receiving Slip Line (proc_rec_slip_item) | Changes the **Purchase Order Line** field on the Receiving Slip Line form to mandatory if the associated receiving slip has a listed purchase order.

---

**Script includes installed with Procurement**

Procurement plugin adds the following script include.

| Script include | Description |
--- | ---
ProcurementUtils | Provides utilities for Procurement.

---

**Tables installed with Procurement**

Procurement plugin adds the following tables.
### Table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchase Order (proc_po)</td>
<td>Stores information about items ordered, cost of items ordered, and users that require the items for orders placed with a vendor.</td>
</tr>
<tr>
<td>Purchase order line items (proc_po_item)</td>
<td>Stores information about items and quantity ordered on purchase orders.</td>
</tr>
<tr>
<td>Receiving Slip (proc_rec_slip)</td>
<td>Stores receiving information for items ordered with a purchase order. Can reference multiple receiving slip lines.</td>
</tr>
<tr>
<td>Receiving Slip Line (proc_rec_slip_item)</td>
<td>Stores receiving information for items ordered on a specific purchase order line, such as the items ordered, quantity ordered, and who ordered them.</td>
</tr>
</tbody>
</table>

### User roles installed with Procurement

Procurement plugin adds the following user roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>procurement_admin</td>
<td>procurement_user</td>
<td>Can create purchase orders without a request. Can view requests and requested items. Can view transfer orders. Can create a purchase order or transfer order when sourcing items for a request. Can view the vendor catalog. Can refresh, add, delete, and rearrange gauges in the Procurement Overview module.</td>
</tr>
<tr>
<td>procurement_user</td>
<td>financial_mgmt_user, model_manager</td>
<td>Can create purchase orders without a request. Can view requests and requested items. Can view transfer orders. Can create a purchase order or transfer order when sourcing items for a request. Can view the vendor catalog. Can view and refresh gauges in the Procurement Overview module.</td>
</tr>
</tbody>
</table>

### Request items source

A request from the service catalog can contain multiple items that must be obtained or sourced. The following diagram illustrates the different methods for sourcing items.
Methods of sourcing requested items

Note: Only items with an assigned model can be sourced. Sourcing bundles is not supported.

Purchase order for sourcing requested items

Items not in a stockroom can be ordered with a purchase order and delivered to a destination stockroom. In the same purchase order, you can order multiple items.
You can choose to create the hardware asset and reserve it for a user after creating the purchase order. You can also do the same after you receive the items. For software items, you cannot pre-create the assets and assign them before they are received.

**Transfer order for sourcing requested hardware items**

To source requested hardware items, create a transfer order. You can choose to transfer the hardware assets from:

- One source stock room to multiple destination stockrooms.
- In case, if one source stock room doesn’t have sufficient stock, you can specify multiple stockrooms so that items can be transferred to single or multiple destination stockrooms.

**Add assignment for sourcing requested software items**

To source software items, add assignments wherein, you must assign rights of the software license. You can assign rights to a user or device so that they are entitled to use the software.

**Create a purchase order from a request**

You can create a purchase order directly from a request. This enables procurement managers to obtain items and fulfill requests from the Service Catalog. You can create multiple purchase orders from a request.

Role required: procurement_admin or procurement_user

1. Navigate to **Procurement > Requests > Requests**.
2. Click the **Number** of a request that has been approved but not sourced.
   Look in the **Request State** and **Sourced** columns.
3. In the **Catalog Tasks** related list, click a **Number**.
4. Click **Source Request**.
   The Source Request screen is displayed with a list of all the requested items.
5. Click **Add Purchase Order** in the requested item section.
6. In the **Vendor** list, select the vendor from which the requested item or items should be delivered.
7. In the **Out of Stock** field, verify if the value is **false**. If the vendor doesn’t has stock, the field value will be **true**.
8. In the **Quantity** field, specify the quantity you want to order.
9. In the **Destination Stockroom** list, select the destination to which the requested item or items should be delivered.
10. Optional: Select the **Consolidate PO** check box to combine the listed items with existing purchase orders.

When you check Consolidate Purchase Orders, all items sourced from the same vendor on the same request are placed on the same purchase order. When you select a vendor, the system automatically searches for purchase orders that have been created for the same request, have the same **Vendor** selected, and have the **Requested** status. If the system finds a match, all items are placed on the same purchase order and can be ordered together. If the system does not find a match, a new purchase order is created.

For example, if you are purchasing 25 phones from Apple and an open purchase order already exists for Apple, the 25 phones are added to the open purchase order. If there are no open purchase orders for the selected vendors, new purchase orders are created. Items
ordered from the same vendor are grouped together. Different items are shown on separate lines on the purchase order.

11. Click Submit.
   The catalog task reopens and you see a message that the purchase order was created. When you view the request, the Sourced check box is selected.

Create a transfer order from a request

You can create a transfer order directly from a request to source hardware items and consumables from stockrooms.

Role required: procurement_admin or procurement_user

1. Navigate to Procurement > Requests > Requests.
2. Click the request Number of a request that has been approved but not sourced.
   Check the Request State and Sourced columns.
3. In the Catalog Tasks related list, click a Number.
4. Click Source Request.
   The Source Request screen appears with a list of all the requested items.
5. Click Add Transfer Order in the requested hardware item section.
6. In the Source Stockroom list, select a stockroom from which the hardware item should be sourced.
7. The In Stock column, displays the total stock available with the selected source stockroom.
8. In the Transfer Quantity field, specify the quantity you want to transfer.
9. In the Destination Stockroom list, select the destination to which the requested item or items should be delivered.
10. Click Submit.
    A transfer order is created to move the item or items from the Source Stockroom location to the Destination Stockroom location. When you view the request, the Sourced check box is selected.

Add an assignment from a request

You can add assignments directly from a request to source rights from software licenses.

Role required: procurement_admin or procurement_user

1. Navigate to Procurement > Requests > Requests.
2. Click the request Number of a request that has been approved but not sourced.
   Check the Request State and Sourced columns.
3. In the Catalog Tasks related list, click a Number.
4. Click Source Request.
   The Source Request screen is displayed with a list of all the requested items.
5. Click Add assignments in the requested software item section.
6. In the License Name list, select a license from which the software rights should be sourced.
7. The Available Rights column, displays the total rights available with the selected license.
8. In the Rights field, specify the rights you want to assign.
9. From the Type list, select whether to assign the rights to a user or device.
10. In the Assigned\Allocated list, select the user or device to whom the requested item should be assigned.
11. Click Submit.
Procurement purchase order management for assets

Accurate purchase order information is important for invoice tracking, receiving, and reporting in the ServiceNow platform.

The Procurement application enables users with an appropriate procurement role to manage purchase order information for assets. It also provides direct access to service catalog requests. You can create purchase orders and transfer orders directly from requests.

Before using the Procurement application, create assignment groups for catalog tasks. Assignment groups are sets of users, filtered by location, who can perform catalog tasks.

Track a request from the service catalog

The Procurement application lets you track a request that was ordered from the service catalog.

Role required: procurement_admin or procurement_user

When a user places an order from the service catalog, a request record is created to track the order. Each ordered item becomes a requested item that is listed on the request record. For example, a single request for one laptop, two monitors, and one keyboard creates the following records.

Request REQ0000001: 4 items
- Requested Item RITM0000001: 1 laptop
- Requested Item RITM0000002: 2 monitors
- Requested Item RITM0000003: 1 keyboard

1. Navigate to Procurement > Requests > Requests.
2. Click a request Number.

The Requested Items related list displays the items that were ordered. You can view the requested item, or view associated Purchase Orders, Transfer Orders, and Assignments on other related lists. A catalog task is automatically generated for each requested item to identify the source of the item, whether it must be purchased or transferred from a stockroom.

Cancel a request from the service catalog

You can cancel a request from the service catalog if, for example, the item is no longer needed or the request was not approved.

Role required: catalog_admin, procurement_admin, or procurement_user

When a service catalog request is canceled, the following actions occur automatically.
- Associated purchase orders that have not been received are canceled.
- All procurement tasks are canceled.
- Associated transfer orders are canceled, if all transfer order lines related to the transfer order are also associated with the service catalog request and the transfer order lines have all been
canceled. If the transfer order contains transfer order lines that are not related to the service catalog request and those lines have not been canceled, the transfer order is not canceled.

Associated transfer order lines that are in the In Transit or Delivered stages are not canceled.

1. Navigate to Procurement > Requests > Requests.
2. Click a request Number.
3. Click Cancel Request.

View and edit a catalog task

Catalog tasks are used to source items and fulfill requests. You can view and edit catalog tasks from a request.

Role required: procurement_admin or procurement_user

If a request requires approval, a catalog task is created automatically when the request is approved. If a request does not require approval, a catalog task is created automatically when the request is created.

Note: If a request contains one requested item and the item has no model specified, a catalog task is not created automatically. If a request has multiple requested items and only some of them have a model specified, catalog tasks are created automatically, but only for the requested items with a model.

1. Navigate to Procurement > Requests > Tasks.
2. Open a catalog task.
3. Edit the fields as necessary.

Catalog task fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the catalog task.</td>
</tr>
<tr>
<td>Request</td>
<td>The number of the request to which the catalog task is associated. The information in this field is derived from the Number field on the Request form.</td>
</tr>
<tr>
<td>Request item</td>
<td>The number of the requested item to which the catalog task is associated. The information in this field is derived from the Number field on the Requested Item form.</td>
</tr>
<tr>
<td>Requested for</td>
<td>The name of the person for whom the associated item was requested. The information in this field is derived from the Request or Request item field.</td>
</tr>
<tr>
<td>Due date</td>
<td>The date by which the catalog task should be completed.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>The configuration item associated with the Request Item.</td>
</tr>
<tr>
<td>Approval</td>
<td>The status of catalog task approval: Not Yet Requested, Requested, Approved, or Rejected.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
State | The current state of the catalog task: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, or Closed Skipped.
Assignment group | The group from which an individual is selected to complete the catalog task.
Assigned to | The individual assigned to complete the catalog task, selected from the Assignment group.
Work notes list | The list of users to receive email notifications when the work notes on the catalog task are updated.
Short description | A brief description of the catalog task.
Description | A detailed description of the catalog task.
Work notes | Information about how the catalog task is resolved.
Additional comments | Additional information about the catalog task that might be helpful for others to know. This is a customer-visible field.

4. **Click Update.**

### Create a purchase order

You can create a purchase order. Purchase orders specify assets to order from a single vendor.

*Role required: procurement_admin or procurement_user*

For example, an organization can create a purchase order to buy 20 laptop computers or 10 servers. Information on a purchase order enables physical and financial tracking of the assets that were ordered.

You can also use a transfer order if an asset is already owned by an organization. A transfer order is used to internally transfer assets from one stockroom to another instead of purchasing the assets.

For example, a company stockroom in New York has five laptops that are needed in Boston. You create a transfer order to move the laptops from the New York stockroom to the Boston stockroom.

After you create a purchase order, the **Receiving Slip** related list is available on the Purchase Order form. A receiving slip is created manually or automatically when the item is received. The **Receiving Slip** related list shows all receiving slips related to the purchase order. After a receiving slip is added to a purchase order, all fields on the purchase order record become read-only.

1. **Navigate to Procurement > Orders > Purchase Orders.**
2. **Click New.**
3. **Complete the form.**

### Purchase order fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the purchase order.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Due by</td>
<td>The date by which the purchase order <em>Total cost</em> must be paid.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The supplier to which the purchase order was issued.</td>
</tr>
<tr>
<td>Ship to</td>
<td>The stockroom to which items on the purchase order should be shipped.</td>
</tr>
<tr>
<td>PO date</td>
<td>The date on which the purchase order was created.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the purchase order: <em>Canceled</em>, <em>Ordered</em>, <em>Received</em>, <em>Requested</em>, or <em>Suspended</em>.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user to whom the purchase order is assigned.</td>
</tr>
<tr>
<td>Bill to</td>
<td>The location responsible for paying the purchase order <em>Total cost</em>.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the purchase order.</td>
</tr>
<tr>
<td>General section</td>
<td></td>
</tr>
<tr>
<td>Shipping</td>
<td>The delivery method to be used when shipping the items on the purchase order.</td>
</tr>
<tr>
<td>Terms</td>
<td>The purchase order payment terms: <em>Credit</em>, <em>Net 30 days</em>, or <em>Net 90 days</em>.</td>
</tr>
<tr>
<td>Ship rate</td>
<td>The amount that must be paid for the delivery method specified in the <em>Shipping</em> field.</td>
</tr>
<tr>
<td>Total cost</td>
<td>The sum of all item costs on the purchase order and the shipping costs.</td>
</tr>
<tr>
<td>Description</td>
<td>A full description of the purchase order contents.</td>
</tr>
<tr>
<td>Details section</td>
<td></td>
</tr>
<tr>
<td>Initial request</td>
<td>The record number of the request that requires the items on the purchase order.</td>
</tr>
<tr>
<td>Requested by</td>
<td>The user requesting the items on the purchase order.</td>
</tr>
<tr>
<td>Requested</td>
<td>The date the user in the <em>Requested by</em> field requested the items on the purchase order.</td>
</tr>
<tr>
<td>Ordered</td>
<td>The date and time the <em>Order</em> button is clicked on the Purchase Order form.</td>
</tr>
<tr>
<td>Expected delivery</td>
<td>The date the items associated with the purchase order are expected to arrive in the stockroom identified in the <em>Ship to</em> field. This field cannot be edited when the purchase order has a <em>Status</em> of <em>Received</em> or <em>Canceled</em>. (For more information about this field, see <em>Purchase order expected delivery date</em>.)</td>
</tr>
<tr>
<td>Received</td>
<td>The date and time at which the purchase order status changed to <em>Received</em>.</td>
</tr>
</tbody>
</table>
Add purchase order line items to specify what you are ordering from this vendor.

*Create a purchase order line item*

After you save a new purchase order, you create purchase order line item records to specify the individual items to order.

**Role required:** procurement_admin or procurement_user

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Open a purchase order.
3. In the **Purchase order line items** related list, click **New**.
4. Complete the form.

### Purchase order line item fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the purchase order line item.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The supplier from which this product should be ordered.</td>
</tr>
<tr>
<td>Product Model</td>
<td>The model of the purchase order line item.</td>
</tr>
<tr>
<td>Product Catalog</td>
<td>The product catalog category to which the product model is assigned. For example, Hardware, Software, or Supplies.</td>
</tr>
<tr>
<td>Part number</td>
<td>The identification number assigned to the product model.</td>
</tr>
<tr>
<td>Request line</td>
<td>The identification number of the requested item record associated with this purchase order line item.</td>
</tr>
<tr>
<td>Ordered</td>
<td>The date and time at which this purchase order line item was ordered.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Expected delivery</td>
<td>The date the purchase order line item is expected to arrive in the stockroom identified in the <strong>Ship to</strong> field on the purchase order record. This field is automatically filled with the value in the <strong>Expected delivery</strong> field on the purchase order record. This field can be edited when the purchase order line item has a <strong>Status</strong> of <strong>Requested</strong>. For more information about this field, see <em>Purchase order expected delivery date</em>.</td>
</tr>
<tr>
<td>Received</td>
<td>The date and time at which the purchase order line item status was changed to <strong>Received</strong>.</td>
</tr>
<tr>
<td>Purchase order</td>
<td>The purchase order record number associated with this purchase order line item.</td>
</tr>
<tr>
<td>Rights per license pack</td>
<td>Rights associated with each pack that is purchased for Microsoft Per Core or Microsoft Per Core with CAL licenses.</td>
</tr>
<tr>
<td>Number of packs</td>
<td>Number of packs for Microsoft Per Core or Microsoft Per Core with CAL licenses.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the purchase order line item: <strong>Canceled</strong>, <strong>Ordered</strong>, <strong>Pending Delivery</strong>, <strong>Received</strong>, or <strong>Requested</strong>.</td>
</tr>
<tr>
<td>Ordered quantity</td>
<td>The number of product models that were ordered.</td>
</tr>
<tr>
<td>Received quantity</td>
<td>The number of product models that were shipped and received. The vendor may have sent multiple shipments. The received quantity can be larger or smaller than the <strong>Ordered quantity.</strong> For example, you may have ordered five laptops but the vendor sent six.</td>
</tr>
<tr>
<td>Remaining quantity</td>
<td>The number of product models that still need to be received to fulfill the <strong>Ordered quantity.</strong></td>
</tr>
<tr>
<td>List price</td>
<td>The price at which the item retails, not including discounts. If the system creates the purchase order from the service catalog ordering process, the purchase order line item inherits the list price from the associated vendor catalog item. If the vendor catalog item does not have a list price value and you have not entered a value, this field is automatically populated with the value from the <strong>Cost</strong> field.</td>
</tr>
<tr>
<td>Cost</td>
<td>The cost of a single product model, including discounts. If the system creates the purchase order from the service catalog ordering process, the purchase order line item inherits the cost from the associated vendor catalog item <strong>Vendor Price</strong>.</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total cost</td>
<td>The cost of a single product model multiplied by the value specified in <strong>Quantity</strong>.</td>
</tr>
<tr>
<td>Stock Order</td>
<td>Read only and selected if the related request is using the bulk stock order workflow.</td>
</tr>
</tbody>
</table>

**Note:** Appears for all purchase order line items when the Hardware Asset Management application is installed from ServiceNow Store.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>A few words or short phrase describing the purchase order line item.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
   The purchase order reopens with the line item listed. The purchase order and line item are in **Requested** status.

6. Optional: Continue adding purchase order line items for this vendor, as needed.
7. After you initiate the order with the vendor and are ready to show that the order was placed, click **Order**.
   The status of the purchase order and line items change to **Ordered**.

**Purchase order status**
Purchase orders follow a specific life cycle. The **Status** field on the purchase order record is always read-only.

![Status life cycle diagram](Diagram)

**Status life cycle**

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested</td>
<td>The status is <strong>Requested</strong> when you create a purchase order.</td>
</tr>
<tr>
<td>Ordered</td>
<td>The status changes to <strong>Ordered</strong> when you add purchase order line items, and click <strong>Order</strong>.</td>
</tr>
<tr>
<td>Pending Delivery</td>
<td>When you create assets before receiving them as a purchase order line item, the status of purchase orders and purchase order line items changes to <strong>Pending Delivery</strong> status.</td>
</tr>
<tr>
<td>Status</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Received</td>
<td>When ordered assets arrive in the specified stockroom and you click <strong>Receive</strong>, the status of purchase orders and purchase order line items changes to <strong>Received</strong>.</td>
</tr>
<tr>
<td>Canceled</td>
<td>You can cancel a purchase order if its status is <strong>Requested</strong>, <strong>Ordered</strong>, or <strong>Pending Delivery</strong>. For more information, see <strong>Cancel a purchase order</strong>.</td>
</tr>
</tbody>
</table>

**Purchase order expected delivery date**

The purchase order record and the purchase order line item record both contain the **Expected delivery** date field.

The **Expected delivery** field can be edited on both records. Editing the field on one record can change the field on the other record.

- If you add an expected delivery date to the purchase order and the expected delivery date field on the purchase order line item is blank, the date on the purchase order is added automatically to the purchase order line item.
- If you add an expected delivery date on the purchase order line item and the expected delivery date field on the purchase order is blank, the date on the purchase order line item is added automatically to the purchase order.
- If the purchase order and the purchase order line item have the same expected delivery date and you change the date on the purchase order, the date is changed automatically on the purchase order line item.
- If you change the date on the purchase order line item to a date that is later than the one specified on the purchase order, the date on the purchase order is changed to the new date. The expected delivery date of a purchase order line item cannot be later than the expected delivery date on the associated purchase order.
- If you change the date on the purchase order line item to a date that is earlier than the date specified on the purchase order, the date on the purchase order remains the same.

**Cancel a purchase order**

You can cancel purchase orders with a status of **Requested**, **Ordered**, or **Pending Delivery**.

Role required: procurement_admin or procurement_user

Purchase order line items can also be canceled from a purchase order.

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Open a purchase order to cancel.
3. Click **Cancel**.
   - All associated purchase order line items that have not been received are canceled. Any assets created for the purchase order are deleted.

**Cancel a purchase order line item**

You can cancel a purchase order line items with a status of **Requested**, **Ordered**, or **Pending Delivery**.

Role required: procurement_admin or procurement_user

Keep the following in mind when you cancel a purchase order line item.

- When a purchase order line item is canceled, if all other line items are also canceled, the purchase order is canceled.
After a purchase order line item is canceled, it can be reordered if the associated purchase order has not been canceled or received.

If you cancel a purchase order line item for which assets were created, the assets are deleted from the system and removed from the purchase order.

If you reorder the same purchase order line item, the assets are recreated for that line if the line has a status of Pending Delivery.

1. Navigate to Procurement > Orders > Purchase Orders.
2. Open a purchase order.
3. In the Purchase order line items related list, select a line item to cancel.
4. Click Cancel.

**Reorder a purchase order**
You can reorder a purchase order that was canceled.

Role required: procurement_admin or procurement_user

1. Navigate to Procurement > Orders > Purchase Orders.
2. Open a purchase order with a status of Canceled.
3. Click Order.
   The status changes to Ordered for the purchase order and all associated purchase order line items.

**Reorder a purchase order line item**
You can reorder a purchase order line item that was canceled.

Role required: procurement_admin or procurement_user

1. Navigate to Procurement > Orders > Purchase Orders.
2. Open a purchase order.
3. In the Purchase order line items related list, select a line item with a status of Canceled.
4. Click Order.
   The purchase order line item Status field changes based on the Status field of the associated purchase order. For example, if the purchase order has a status of Pending Delivery, the purchase order line item status changes to Pending Delivery and the assets for the purchase order line item are created automatically.

**Create an asset and reserve it for the requester**

In the procurement process, hardware assets can be created before the assets are delivered. Creating the asset before they’re delivered allows you to create the asset record with an asset tag and serial number early in the process and reserve the asset for the user who requested it. The receiver can only select the assets to be received as assets are pre-created.

Role required: procurement_admin or procurement_user

Some requests must be approved before items on the request can be sourced. In the base system, requests over $1,000 require approval. To change the $1,000 approval threshold and other workflow attributes, edit the Service Catalog Request workflow.

When the asset state is In stock, the Reserved for field is maintained as the asset is received and placed in a stockroom. When the asset state changes to In use, the Reserved for field is relabeled Assigned to. If there is a name in the Reserved for field, the name is retained when the field is relabeled. A user with the asset role can change the name in the Assigned to field. Changing the name is helpful, for example, if an IT technician orders 10 laptops and must assign them to individual users.
Note: If assets are not created prior to delivery, they are automatically created from line items when purchase orders are received. Also you can enter the asset details and receive them when the purchase orders are received.

1. Navigate to Procurement > Requests > Tasks.
2. Open a task with a State of Open and a Short description of Source Request Items.
3. Click Source Request.
   - If the request is already fulfilled or the items in the request are not sourceable, the Source Request button is hidden.
   - If the requested item does not have an assigned model, the item is not listed on the Source the Request dialog box.
   - Any items on the purchase order that have a remaining quantity of 0 are not listed on the Source the Request dialog box.
4. Select a Destination Stockroom.
5. Select the Create PO option for one or more listed items.
6. For each item requiring a purchase order, select a Vendor.
7. Click OK.
8. Navigate to Procurement > Orders > Purchase Orders.
9. Open the purchase order you just created. If you created a purchase order for more than one item, multiple purchase orders may have been created; select one of them.
10. Click Order. After items are ordered, no additional purchase order line items can be added to the purchase order. The status of all purchase order line items changes to Ordered.
11. Click the Create hardware assets prior to delivery related link to automatically create hardware assets for all purchase order line items. Hardware assets are listed in the Assets related list. Click an asset in the list to view the asset record. Except for consumables, the Reserved for field contains the name of the user who made the original request.

You can also create assets for individual purchase order line items. On a purchase order, go to the Purchase order line items related list and click a specific purchase order line item number. Then, click the Create hardware assets prior to delivery related link. Only the hardware assets included on the purchase order line item are created.

Receive assets

Assets can be received and added to the system when they are delivered to a stockroom.

Users with an appropriate procurement role can receive assets. If one purchase order contains multiple purchase order lines, the lines can be received at different times. This is useful if items arrive at the stockroom in different shipments. The purchase order status does not change to Received until all purchase order lines are received.

As an alternative to receiving assets when they arrive, you can create assets before they arrive and reserve them for the requester.

Receive an asset

When assets are received and delivered to a stockroom, they are added to the system.

Role required: procurement_admin or procurement_user

When you receive assets:
• If you have not pre-created hardware assets, you can enter asset details and reserve them for users.
• You can over receive an order wherein, the received quantity can be higher than the ordered quantity.
• If you have ordered multiple items with different receiving stockrooms, you can receive them at the time.

1. Navigate to Procurement > Orders > Purchase Orders.
2. Select a purchase order with a Status of Ordered or Pending Delivery.
3. Click Receive.
   The Receive Purchase Order screen appears with the list of the products ordered.
4. Select the Received check box for the line items you are receiving.
5. To receive software assets:
   a) Edit the Receiving Stockroom if the items arrived at a different stockroom than the one specified on the purchase order.
   b) Edit the Receiving Quantity if the number of items delivered does not match the number ordered.
   c) Edit the Unit Cost if the price changed between the time the item was ordered and the time it arrived at the stockroom. Enter a number; the number can include decimals.
   d) Click Capture Asset tags to enter asset details. You cannot enter details for assets more than the received rights.
   e) The Capture Asset Tag dialog box, click Insert a new row.
   f) Enter the asset tag, serial number, rights, and License key

6. To receive hardware assets and consumables:
   a) Edit the Receiving Stockroom if the items arrived at a different stockroom than the one specified on the purchase order.
   b) Edit the Receiving Quantity if the number of items delivered does not match the number ordered.
   c) Click the Reserve toggle button to reserve the item.
   When a reserved item is received, the State and Substate fields on the corresponding asset record are automatically set to In stock and Reserved, respectively. If the Reserve button is not clicked for an item, the State and Substate fields on the corresponding asset record are set to In stock and Available.

   Note: You cannot reserve consumables.
   d) From the Reserved for list select a user you want reserve the asset for.
   If a name was specified in the Requested for field on the Purchase order line item form, the name is added automatically but can be changed.
   You can add multiple users in the Capture Asset tags dialog box.
   e) Click Capture Asset tags to enter asset details. You cannot enter details for assets more than the received quantity. You can also reserve assets for a user.

   Note: If you have pre-created the assets, you must select the ones you want to receive.
   f) On the Capture Asset Tag dialog box, click Insert a new row.
g) Enter the asset tag and serial number.

h) From the Reserved for list, select the user for whom the item was ordered. If a name was specified in the Requested for field on the Purchase order line item form, the name is added automatically but you can change it.

i) Edit the Unit Cost if the price changed between the time the item was ordered and the time it arrived at the stockroom. Enter a number; the number can include decimals.

7. Click Submit.
   A confirmation message displays with the details of assets received.

8. Click OK.
   A receiving slip is automatically created and can be viewed in the Receiving Slips related list. If items on a purchase order are received at different times, a new receiving slip is created each time any item on the purchase order is received. For example, if 30 laptop computers were ordered and arrived in three separate shipments, three receiving slips are created.

   Different assets are created for each hardware item. If there is software, one single asset is created for each license if you don’t split the rights. And for consumables, if an asset exists, it is updated, or new assets are created.

Create a receiving slip

Receiving slips are created automatically during the process of receiving assets. You can also create receiving slips manually.

Role required: procurement_admin or procurement_user

After a receiving slip has been created for a purchase order, all fields on the purchase order record are changed to read-only.

1. Navigate to Procurement > Receiving > Receiving Slips.
2. Click New.
   A Number is assigned automatically. The current date and time is added automatically to the Received field.
3. Select a Purchase Order.
   Only purchase orders with a status of Ordered, Pending Delivery, or Requested are listed in the selection window. The Vendor column lists the vendor specified on the purchase order. The Ship to column lists the destination stockroom specified on the purchase order.
4. Select a Receiving Stockroom.
5. Click Submit.

Add a receiving slip line to the receiving slip to identify the items from the purchase order that were received.

Create a receiving slip line

When assets arrive at a stockroom and you receive them, a receiving slip is created on the purchase order. You create a receiving slip line to identify the specific assets and quantities that were received.

Role required: procurement_admin or procurement_user

If the asset already exists, the asset record is updated when you save the receiving slip line. If the asset does not already exist, a new hardware or software asset record is created. The Model category and Configuration item fields are automatically filled in on the new asset record based
on information in the request, purchase order, or receiving slip. If Asset Tag and Serial Number information exists, it is not overwritten.

1. Navigate to Procurement > Receiving > Receiving Slips and open a receiving slip.
2. In the Receiving Slip Lines related list, click New.
   The following fields are completed automatically.
   - A Number is assigned.
   - In Received, the current date and time are added.
   - In Received by, the currently logged in user is added.

3. In Purchase Order Line, click the reference lookup icon and select a purchase order line. The Purchase Order Line field is mandatory if the parent receiving slip has an associated purchase order. Only purchase order lines that are associated with the same purchase order linked to the parent receiving slip are available to select.
4. In Quantity, enter the number of items received. For example, five items were ordered, but only two are being received.
5. Optional: Edit the Received by, Requested for, and Unit cost fields, as needed.
6. Click Submit.
   After you create a receiving slip line, the Receiving stockroom field on the Receiving Slip record becomes read-only.

Consumable assets

A consumable asset is one that is purchased in quantity and distributed. It is assigned to the consumable model category, and the asset record tracks the quantity that is available and total cost. When consumable assets are received, they are merged into an existing consumable record, if available.

For the records to merge, the consumable cannot be listed on an active transfer order and the Model, Location, Model Category, Stockroom, Status, and Substatus fields on the asset record must match.

If consumables are merged into an existing consumable record, the cost of the additional consumables received is added to that of the existing consumables in the record. For example, if 50 computer keyboards arrive and 20 keyboards of the same model exists in the receiving stockroom, the two records are merged showing 70 keyboards in the stockroom with a combined total cost.

If no matching consumable record exists in the receiving stockroom, a record is created. After the consumables are received, the quantity is updated, but individual consumables are no longer tracked within the Procurement application and are not displayed on receiving slip lines.

Domain separation and Procurement

This is an overview of domain separation and Procurement processing. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Standard*

The support level is Standard but has some exceptions or special conditions.
- Includes Basic level
- Business logic: Processes can be created or modified per customer by the service provider (SP). The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The owner of the instance needs to be able to configure minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin needs to be able to make comments mandatory when a record closes for one tenant, but not for another.

How domain separation works in Procurement

To create or edit Purchase Orders (POs) or PO line items that distinguish the domain, customers must be working in the proper domain. When adjusting any configuration, you should be in the domain where you’re doing the work. Use the domain picker to choose the correct domain to work in.

Product Catalog

The product catalog is a set of information about individual models. Models are specific versions or various configurations of an asset. Asset managers use the product catalog as a centralized repository for model information.

A detailed and well-maintained product catalog can coordinate with service catalog, asset, procurement, request, contract, and vendor information.

Models published to the product catalog are automatically published to the Service Catalog. The service catalog includes information about goods (models) and services. If the model is available from multiple vendors, a model can be listed more than once. Models are included with the Asset Management application.

Keep the following in mind when working with the product catalog.
- A product catalog item can be linked to multiple vendor catalog items or to a single model.
- A model can only have one product catalog item.
- A vendor catalog item can only have a single product catalog item.

Components installed with Product Catalog

The following components are installed with the Product Catalog plugin.

Demo data is available with the product catalog. The demo data provides various models, model categories, product catalog items, vendor catalog items, and vendors.

Tables installed with Product Catalog

Product Catalog plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call (new_call)</td>
<td>The base table for Product Catalog that contains all call information.</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stores all hardware catalog items that have been published from the Product Model (cmdb_model) base table. Extends the Product Catalog Item (pc_product_cat_item) table.</td>
</tr>
<tr>
<td>Stores all information for the product catalog. This table extends the Catalog Item (sc_cat_item) table.</td>
</tr>
<tr>
<td>Stores all software catalog items that have been published from the Product Model (cmdb_model) base table. Extends the Product Catalog Item (pc_product_cat_item) table.</td>
</tr>
<tr>
<td>Stores all vendor catalog item information.</td>
</tr>
</tbody>
</table>

### Roles installed with Product Catalog

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>model_manager</td>
<td>Can create CMDB models.</td>
<td>none</td>
</tr>
<tr>
<td>category_manager</td>
<td>Can do everything that model managers can do and can administer model categories.</td>
<td>model_manager</td>
</tr>
</tbody>
</table>

### Script includes installed with Product Catalog

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProductCatalogUtils</td>
<td>Utilities for creating and maintaining product catalog items derived from vendor catalog items and models.</td>
</tr>
</tbody>
</table>

### Client scripts installed with Product Catalog

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Script contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Model Fields</td>
<td>(pc_vendor_cat_item)</td>
<td>Adds the description and price, if they do not exist, when a vendor catalog item is added to the product catalog.</td>
</tr>
</tbody>
</table>
Business rules installed with Product Catalog

Product Catalog plugin adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear model</td>
<td>(pc_product_cat_item)</td>
<td>Clears the link on a model when the link is cleared from the product catalog.</td>
</tr>
<tr>
<td>Create child product catalog</td>
<td>(cmdb_hardware_product_model)</td>
<td>Creates entries in the product catalog for all items in a bundled model when the bundled model is created.</td>
</tr>
<tr>
<td>Sync to Product catalog item</td>
<td>(pc_vendor_cat_item)</td>
<td>Updates the corresponding field in the product catalog when a field is updated.</td>
</tr>
<tr>
<td>Sync to Product catalog item</td>
<td>(cmdb_model)</td>
<td>Updates the corresponding field in the product catalog when a field is updated.</td>
</tr>
</tbody>
</table>

Models

Models are specific versions or various configurations of an asset. Models are used for managing and tracking assets through various ServiceNow platform asset applications, including Product Catalog, Asset Management, and Procurement.

Model definitions can be based on vendor-provided criteria, for example, the manufacturer name Apple MacBook Pro, or on a custom abstraction, for example, Graphic Designer Workstation. All model information is located in the Product Catalog application.

A model can be in one or more model categories. For example, a laptop can be a computer and a server. Model definitions specify whether the model creates an asset, a configuration item, or both. On a hardware model record, compatible hardware models can be added.

Unless otherwise noted, working with product models requires the model_manager role. This role is contained by other roles, such as sam, category_manager, and asset.

Creating models

Models are created in the Product Catalog > Product Model > All Models module.

See Model form fields for a list of the fields that appear on all models, regardless of the type of model.

Model form fields

There are fields on the Model form that apply to all types of models.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the model. A system property called glide.cmdb_model.display_name.shorten controls how software model display names are generated.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>The company that built the model.</td>
</tr>
<tr>
<td>Name</td>
<td>The manufacturer-assigned name of the model or abstract name specified by the model manager, such as Field Agent Laptop.</td>
</tr>
<tr>
<td>Edition</td>
<td>The edition of the software model, such as Professional.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the model.</td>
</tr>
<tr>
<td>Model categories</td>
<td>The categories to which the model is assigned. This field is a glide list and cannot be used to create reports.</td>
</tr>
<tr>
<td>Asset tracking strategy</td>
<td>The process by which the model can be tracked. Choose from the following:</td>
</tr>
<tr>
<td></td>
<td>• Leave to Category: model is transparent and the category defines the asset class.</td>
</tr>
<tr>
<td></td>
<td>• Create Consumable Asset: model forces the asset class to be consumable, regardless of what the category defines as the asset class.</td>
</tr>
<tr>
<td></td>
<td>• Don't create assets: model blocks asset instantiation, regardless of what the category defines as the asset class.</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>The method for purchasing the model. Options are Both, Buy, or Lease.</td>
</tr>
<tr>
<td>Cost</td>
<td>The cost of a single unit of the model.</td>
</tr>
<tr>
<td>Depreciation</td>
<td>The depreciation scheme for the model.</td>
</tr>
<tr>
<td>Salvage value</td>
<td>The estimated value that an asset realizes upon its sale at the end of its useful life. This value must be less than or equal to the cost of the asset.</td>
</tr>
<tr>
<td>Model number</td>
<td>The specific model number assigned to the item by the manufacturer.</td>
</tr>
<tr>
<td>Barcode</td>
<td>The barcode number assigned to the model. Barcodes are assigned by the manufacturer.</td>
</tr>
<tr>
<td>Owner</td>
<td>The person responsible for the model.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the model. Options are In Production, Retired, and Sold.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure. Choose from the following:</td>
</tr>
<tr>
<td></td>
<td>• Capex: Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>• Opex: Operational expenditure is an ongoing expenditure. For example, toners for the photocopier.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Certified</td>
<td>The option that determines whether the model is approved for use.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the model that would be helpful for others to know.</td>
</tr>
<tr>
<td>Assets</td>
<td>The assets created from this model. This creation can have any combination of assets and configuration items. For example, with a single hardware model you can have assets and no configuration items, configuration items and no assets, or have both.</td>
</tr>
<tr>
<td>Configuration Items</td>
<td>The configuration items created from this model. Can have any combination of assets and configuration items.</td>
</tr>
<tr>
<td>Product Catalog</td>
<td>The information about the model as it appears in the product catalog and service catalog. Information only appears if the model has been published to the product catalog.</td>
</tr>
</tbody>
</table>

### Create hardware models

Use hardware models to track equipment assets such as servers and racks. You can create a new hardware model.

Role required: model_manager

1. Navigate to **Product Catalog > Product Model > Hardware Models.**
2. Click **New.**
3. Complete the form.
   - For general field descriptions, see **Model form fields.** The hardware model fields listed are found in the Information section of the form.

#### Model form fields for hardware models

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power (watts)</td>
<td>The electrical power, in watts.</td>
</tr>
<tr>
<td>Height (U)</td>
<td>The total height of the hardware item, in inches.</td>
</tr>
<tr>
<td>Flow Rate (cfm)</td>
<td>The flow rate of the hardware model, expressed in cubic feet per minute.</td>
</tr>
<tr>
<td>Sound Power (bels)</td>
<td>The noise measurement, in bels (1 bel=10 decibels).</td>
</tr>
<tr>
<td>Weight (lbs)</td>
<td>The total weight, in pounds.</td>
</tr>
</tbody>
</table>

4. Click **Update.**

### Add compatible models to a hardware model

On a hardware model record, you can add compatible hardware models, giving you a good method for tracking hardware assets that can work together.
Role required: model_manager

Note: Hardware models included in bundled models cannot be added as compatibles.

1. Navigate to Product Catalog > Product Model > Hardware Models.
2. Click a hardware model Name.
3. Click Add Compatible.
4. Select a compatible model.
5. Click Submit.
   The selected model is listed in the Compatibles related list.

Add substitute models to a hardware model
On a hardware model record, you can add substitutes to track what hardware models can be substituted for another hardware model.

Role required: model_manager

For example, a 19” monitor can be a valid substitute for a 17” monitor. Note that substitutions are directional so, in this case, a 17” monitor is not a substitution for a 19” monitor. Information about valid substitute models is useful when you select models while creating transfer orders.

When you select substitute models, note the following conditions.

- Substitute models can be used with work management transfer orders. Substitute models are not used in procurement part sourcing.
- Hardware models included in bundled models cannot be added as substitutes.

1. Navigate to Product Catalog > Product Model > Hardware Models.
2. Click a hardware model Name.
3. Click Add Substitution.
4. In the Collection list on the left, double-click a hardware model.
   The hardware model is added to the List on the right.
5. Click Save.
   The model is listed in the Substitutes related list.

Create consumable models
Consumables are items that are tracked as a group, not individually. An example of consumable items is computer keyboards.

Role required: model_manager

1. Navigate to Product Catalog > Product Model > Consumable Models.
2. Click New.
3. Complete the form.
   For general field descriptions, see Model form fields. There are no fields specific to consumable models.
   Any consumable assets you create and assign to the new model are displayed in the Consumables related list on the model record.
4. Click Submit.

Create a service model
Create a service model for all the services your organization wants to monitor.
Role required: model_manager

A service model is a class of product models to define Software as a Service (SaaS) products. It defines the service and contains the different attributes, choices, and components that can be configured to a customer’s specifications.

Service models have a specific model category called Application Service, which links a service model to the Application Service CI class.

There are two ways of creating a service model.

1. Perform one of the following actions.
   - Navigate to Product Catalog > Product Models > Service Models > New.
   - Navigate to Product Catalog > Product Models > All Models > New > Service.

2. Fill out the fields on the form.

<table>
<thead>
<tr>
<th>Service Model form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Model categories</td>
</tr>
<tr>
<td>Status</td>
</tr>
<tr>
<td>Short description</td>
</tr>
</tbody>
</table>

3. Click Submit.

Bundled models

A bundled model is a single model comprised of individual models. For example, a laptop, printer, keyboard, and mouse can be combined into a single bundled model. If you assign any one asset from the bundled model to an individual, that person receives all the components in the bundle.

Bundled models can be abstract or concrete.

Abstract

Permits use of one model in multiple bundles. The abstract bundle is created as a container. One asset in the bundle is specified as the main component. Model categories define which assets can be included in a bundle. Model categories also define what can be the main component of a bundle.

Add a main component to make it easier to track the bundle components. For example, create an abstract bundle adding a computer as the main component and a mouse and keyboard as additional components. When the bundle is assigned to a user, the asset record for the computer shows the computer, mouse, and keyboard all assigned to the user. Abstract bundles are used more often than concrete bundles.

Concrete

Is a fixed bundle where the main component is an asset. Specify the main component and the other components to create an exact bundle. Concrete bundles do not allow for a many-to-many relationship with models.

Keep the following tips in mind when creating and using bundled models.
• Bundles can be nested inside bundles.
• Any type of model can be used in a bundle.
• When a parent link is defined, the fields related to assignment and state of the child assets are read-only. They are populated based on the parent’s assignment and state fields.
• If you make a change to the parent bundle, the children in the bundle are affected. For example, if you assign a bundle to an individual, all child asset records show that same individual as the person assigned.
• You cannot pre-allocate bundles.
• In a bundle, consumables are consumed and assets are set to the same state as the master component.
• Only the bundle, not individual components, can be part of a transfer order.
• You control what can go into a bundle through the model category. For example, the model category Servers could be set to never allow servers in bundles.
• To create a collection of software, you must create a suite instead of a bundled model.
• A software license cannot be the master component of a bundle.

To create an abstract model, set the model category to Bundle and add the components. To create a concrete model, create a model in the Product Catalog > Product Model > Bundled Models module and add components.

Add model components to a bundle
Add model components to a model as needed, for example, when you upgrade a bundle to include additional assets.

Role required: model_manager and asset

1. Navigate to Product Catalog > Product Model > Bundled Models.
2. Open a bundle record.
3. In the Model Components related list, click New.
4. Select the Model category of the component, such as Computer.
5. Select the Component, such as Apple Computer MacBook Pro 17”.
6. Select the Is main component check box if this component is the one that other components are attached to.
7. Click Submit.
8. Repeat steps 3–7 to add more components to the bundle.

Any components you add to the bundled model are displayed in the Model Components related list.
### Hardware:

**Developer workstation bundle**

<table>
<thead>
<tr>
<th>Display name</th>
<th>Developer workstation bundle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Developer workstation bundle</td>
</tr>
</tbody>
</table>

#### General Information:

<table>
<thead>
<tr>
<th>Short description</th>
<th>Developer workstation bundle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model categories</td>
<td>Bundle</td>
</tr>
<tr>
<td>Asset tracking strategy</td>
<td>Leave to category</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>-- None --</td>
</tr>
<tr>
<td>Cost</td>
<td>5</td>
</tr>
<tr>
<td>Depreciation</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td></td>
</tr>
</tbody>
</table>

#### Related Links:

**Model Components**

<table>
<thead>
<tr>
<th>Model Components</th>
<th>Go to</th>
<th>Is main component</th>
<th>Model category of component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Developer workstation bundle</td>
<td></td>
<td>True</td>
<td>Computer</td>
</tr>
<tr>
<td>Apple MacBook Pro 13&quot;</td>
<td></td>
<td>True</td>
<td>Bundle</td>
</tr>
<tr>
<td>Standard input bundle</td>
<td></td>
<td>False</td>
<td></td>
</tr>
<tr>
<td>Samsung SyncMaster 22&quot; Class BackLight LED</td>
<td></td>
<td>False</td>
<td>Monitor</td>
</tr>
<tr>
<td>Samsung SyncMaster 22&quot; Class BackLight LED</td>
<td></td>
<td>False</td>
<td>Monitor</td>
</tr>
</tbody>
</table>

**Model number:** DWB-001

**Barcode:** DWB-001

**Owner:**

**Status:** In Production

**Certified:**

© 2020 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Remove model components from a bundle**
Remove a component from a bundled model, for example, when you want to replace it with a different component.

Role required: model_manager

No component history is retained. If you remove a component from a bundled model, no record is saved showing that the component was ever part of a bundle.

1. Navigate to **Product Catalog** > **Product Model** > **Bundled Models**.
2. Open a bundle record.
3. In the **Model Components** related list, select the component you want to remove.
4. In the **Actions** choice list below the list, select **Delete**.
5. Click **OK**.

**Software models**

Software models are created as part of the asset management process. You can create product models for software from the product catalog, but you cannot administer all aspects of the software models.

Software models are used in software counters. For more information about creating software models, see **Add a software model**.

**Create application models**

You can create application models that can be managed and tracked within a Scrum development process.

Role required: model_manager

1. Navigate to **Product Catalog** > **Product Model** > **Application Models**.
2. Click **New**.
3. Complete the form.
   - For general field descriptions, see **Model form fields**. There are no fields specific to application models.
4. Click **Submit**.

**Work order models**

When work management is activated, the ServiceNow platform adds the Work Order Models and Work Task Models modules to the product catalog.

Users with the wmn_admin role can define new model records, which can be used as templates to create work orders for common procedures.

**Models created for VMware support and Amazon EC2**

When you activate Orchestration for VMware or Amazon EC2, the system creates a model (vmware instance or ec2 instance) automatically.

When the virtual machine is terminated, the asset state changes to **Retired**.

**Add skills to a model**

You can associate skills with any model. Creating associations between skills and models is helpful if you are using work management and want to assign tasks to agents based on their skills with specific models.
Role required: skill_admin or model_manager

1. Navigate to Product Catalog > Product Model > All Models.
2. Open a product model.
3. In the Skills related list, click Edit.
4. Add items from the Collection list to the Skills List.
5. Click Save.

Publish models to the hardware or software catalog

You can publish models to the hardware or software catalog to make the models available in the service catalog.

Role required: catalog_admin

1. Navigate to Product Catalog > Product Model > All Models.
2. Open a product model.
3. In Related Links, click Publish to Hardware or Publish to Software Catalog.
4. Select a category.
5. Click OK.

Delete models

If a model is no longer needed, you can delete it as long as no assets or configuration items use the model.

Role required: model_manager

1. Navigate to Product Catalog > Product Model > All Models.
2. Select the check box beside the product model.
3. From the Actions choice list below the list, select Delete.
4. Click OK.

Vendor catalog items

The vendor catalog is a list of goods available from different vendors.

An accurate and complete vendor catalog can make it easier to keep items in stock at the best possible price.

You can link multiple vendor catalog items to a single product catalog item, which allows you to track information about a single item at different vendors.

For example, for an iPhone 5 product catalog item, you can create separate vendor catalog items from Apple and from Amazon. Select the vendor with the best price when you source an item. Users need the model_manager role to work with vendor catalog items.

Synchronize information

Certain information is synchronized between models, product catalog items, and vendor catalog items.

When working with models, product catalog items, and vendor catalog items, keep the following in mind:

- Changes to model record update vendor catalog items automatically only if the vendor catalog items are published, not linked.
- If a model is linked to a vendor catalog item, any changes to the model do not update the vendor catalog item.
- After publishing a vendor catalog item or model to the hardware or software catalog, some fields become read-only on the vendor catalog item or product catalog item record. Information can only be updated on the model record.

List of synchronized fields:
- Description
- Short description
- Name
- Product ID
- Price
- Vendor
- Specs
- Features
- Model
- UPC
- Model number
- Cost
- Manufacturer

Create a vendor catalog item
Create a vendor catalog item to associate product models with a vendor.
Role required: model_manager
1. Navigate to Product Catalog > Catalog Definition > Vendor Items.
2. Click New.
3. Complete the form.

Vendor Catalog Item fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the item is built from information in the Product Model, Vendor, and Product ID fields.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The supplier that provides the item.</td>
</tr>
<tr>
<td>Product model</td>
<td>The specific version or configuration of the item.</td>
</tr>
<tr>
<td>Out of stock</td>
<td>The option that indicates whether the item is unavailable for order. This field is important if you are sourcing request items. Clear this check box if the item is available to order.</td>
</tr>
<tr>
<td>Product ID</td>
<td>The item identification number assigned by your organization.</td>
</tr>
<tr>
<td>List price</td>
<td>The price at which the item retails, excluding vendor discounts.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vendor price</td>
<td>The price at which the item is available in the vendor catalog. If the vendor offers a discount, the vendor price reflects the discounted price.</td>
</tr>
<tr>
<td>Rank tier</td>
<td>Displays the overall ranking for this vendor's products and services, such as Valued Partner or Blacklisted Supplier. Rank tier expresses your organization's opinion of this vendor's performance. It can be used to decide if the vendor's products should be promoted or discontinued. Users with the vendor_manager role can edit this field.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the item.</td>
</tr>
</tbody>
</table>

**General section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product catalog item</td>
<td>Name of the product catalog item, if the item has been added to the product catalog. Leave this field empty if you are going to link a vendor catalog item to the hardware catalog.</td>
</tr>
<tr>
<td>UPC</td>
<td>The barcode number used to uniquely identify and track items for sale.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to list the item in the vendor catalog. Clear this check box to hide the item in the vendor catalog.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the item.</td>
</tr>
</tbody>
</table>

**Information section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifications</td>
<td>Facts about the item such as size, weight, version, or speed.</td>
</tr>
<tr>
<td>Features</td>
<td>Distinct properties or distinguishing characteristics of the item.</td>
</tr>
</tbody>
</table>

4. Click Submit.

*Link an item to the hardware catalog*

After you create a vendor catalog item, link the item to the hardware catalog for viewing.

Role required: model_manager

To see the Link to Hardware Catalog Item related link on the Vendor Catalog Item form, add a hardware model or a consumable model to the Product Model field, and leave the Product Catalog Item field blank.

1. Navigate to Product Catalog > Catalog Definition > Vendor Items.
2. Open a vendor catalog item.
3. In Related Links, click Link to Hardware Catalog Item.
4. Select a Catalog Item.
5. Click OK.

The page refreshes to the selected hardware catalog item. The vendor catalog item is listed in the Vendor Catalog Items related list.
**Link an item to the software catalog**
After you create a vendor catalog item, link the item to the software catalog for viewing.

Role required: model_manager

To see the Link to Software Catalog Item related link on the Vendor Catalog Item form, add a software model or a consumable model to the Product Model field, and leave the Product Catalog Item field blank.

1. Navigate to Product Catalog > Catalog Definition > Vendor Items.
2. Open a vendor catalog item.
3. In Related Links, click Link to Software Catalog Item.
4. Select a Catalog Item.
5. Click OK.
   The page refreshes to the selected software catalog item. The vendor catalog item is listed in the Vendor Catalog Items related list.

**Publish an item to the hardware catalog**
After you create a hardware item for the vendor catalog, publish it to the hardware catalog for viewing. The hardware catalog is a section within the service catalog.

Role required: catalog_admin

To see the Publish to Hardware Catalog Item related link on the Vendor Catalog Item form, add a hardware model or a consumable model to the Product Model field, and leave the Product Catalog Item field blank.

After you publish a vendor catalog item to the hardware catalog, the Publish to Hardware Catalog related link is no longer available. Any changes made on the vendor catalog item record are synchronized with the information in the hardware catalog.

1. Navigate to Product Catalog > Catalog Definition > Vendor Items.
2. Open a vendor catalog item.
3. In Related Links, click Publish to Hardware Catalog.
4. Select a Category.
5. Click OK.
   The Hardware Catalog form opens and the item is listed in the Vendor catalog Items related list.

**Publish an item to the software catalog**
After you create a software item for the vendor catalog, publish it to the software catalog for viewing. The software catalog is a section within the service catalog.

Role required: catalog_admin

To see the Publish to Software Catalog Item related link on the Vendor Catalog Item form, add a software model or a consumable model to the Product Model field, and leave the Product Catalog Item field blank.

After you publish a vendor catalog item to the software catalog, the Publish to Software Catalog related link is no longer available. Any changes made on the vendor catalog item record are synchronized with the information in the software catalog.

1. Navigate to Product Catalog > Catalog Definition > Vendor Items.
2. Open a vendor catalog item.
3. In Related Links, click Publish to Software Catalog.
4. Select a Category.
5. Click OK.
The Software Catalog form opens and the item is listed in the **Vendor catalog Items** related list.

**View a vendor list**

You can view a list of vendors from the product catalog.

Role required: `model_manager`

The list includes every company that has the **Vendor** option selected on its record.

1. Navigate to **Product Catalog > Catalog Definition > Vendors**.
2. Click any vendor **Name** for more information.

**Product catalog items**

Product catalog items are hardware and software that you can track and offer in the service catalog.

The product catalog is an extension of the **Service Catalog** that contains a list of available **Models**. Users with the **catalog_admin** role can create, activate, and deactivate product catalog items.

**Create a product catalog item**

Create hardware and software product catalog items to include in the product catalog and the service catalog.

Role required: `catalog_admin`

You must **activate** the items separately before they appear in the product catalog or service catalog.

1. Navigate to **Product Catalog > Catalog Definition > Hardware and Software Items**.
2. Click **New**.
3. Complete the form.
   - Some of the fields listed do not appear until you save the product catalog item.

**Product catalog item fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the item as you want it displayed in the product catalog.</td>
</tr>
<tr>
<td>Catalogs</td>
<td>The catalog this item is listed in.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The vendor that supplies the item. If the item is purchased from multiple vendors, use the vendor catalog and leave this field empty.</td>
</tr>
<tr>
<td>Rank tier</td>
<td>The overall ranking for the selected vendor’s products and services. This field is only visible in a Product Catalog Item record when the CI class is <strong>Hardware Catalog</strong> or <strong>Software Catalog</strong>.</td>
</tr>
<tr>
<td>Model</td>
<td>The specific version or configuration of the item.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Product ID</td>
<td>The item identification number assigned by your organization.</td>
</tr>
<tr>
<td>Price</td>
<td>The price at which the item is available in the product catalog. Enter a numerical value and select the appropriate currency.</td>
</tr>
<tr>
<td>Recurring price</td>
<td>The item’s recurring price. For example, a subscription to a mobile phone contract could cost $500.00, with an $30.00 monthly recurring price.</td>
</tr>
<tr>
<td>Recurring price frequency</td>
<td>The interval at which the recurring price is accrued.</td>
</tr>
<tr>
<td>List Price</td>
<td>The price at which the item retails. This field is only visible when the Class is Hardware Catalog or Software Catalog.</td>
</tr>
<tr>
<td>Cost</td>
<td>The price at which the item was purchased from the vendor. The cost could be less than the List Price if your organization received a discount from the vendor. This field is only visible in a product catalog item record when the CI class is Hardware Catalog or Software Catalog.</td>
</tr>
<tr>
<td>Omit price in cart</td>
<td>When selected, hides the price when the item is displayed in the service catalog. Clear the check box to show the price in the service catalog. This field is only visible in a product catalog item record when the CI class is Hardware Catalog.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Workflow associated with this item.</td>
</tr>
<tr>
<td>Execution plan</td>
<td>The execution plan associated with this item.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the item.</td>
</tr>
<tr>
<td>Ordered item link</td>
<td>The list of links containing more information about items. The links can be reused across multiple items.</td>
</tr>
<tr>
<td>Class</td>
<td>The catalog item class this item belongs to. Select Hardware Catalog or Software Catalog. This field is visible by default. When you save the record as a hardware or software catalog item, the form is retitled Hardware Catalog or Software, respectively.</td>
</tr>
<tr>
<td>General section</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>The named group of items to which the item belongs.</td>
</tr>
<tr>
<td>Delivery time</td>
<td>The amount of time it takes to deliver the item, starting from when it is ordered from the product catalog.</td>
</tr>
<tr>
<td>UPC</td>
<td>The barcode number used to identify and track items.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the item. The description is displayed in the product catalog listing.</td>
</tr>
<tr>
<td>Product Information</td>
<td></td>
</tr>
<tr>
<td>section</td>
<td></td>
</tr>
<tr>
<td>Cost</td>
<td>The price at which the item was purchased from the vendor. This field is only visible when the Class is Software Catalog.</td>
</tr>
<tr>
<td>Specifications</td>
<td>Facts about the item, such as size, weight, version, or speed.</td>
</tr>
<tr>
<td>Features</td>
<td>Distinct properties or distinguishing characteristics of the item.</td>
</tr>
<tr>
<td>Images section</td>
<td></td>
</tr>
<tr>
<td>Icon</td>
<td>A small image that appears next to the name when the item is displayed in the service catalog. Supported file types are jpg, png, bmp, gif, and jpeg.</td>
</tr>
<tr>
<td>Picture</td>
<td>An image showing the item. Supported file types are jpg, png, bmp, gif, and jpeg.</td>
</tr>
<tr>
<td>Related lists</td>
<td></td>
</tr>
<tr>
<td>Includes</td>
<td>More catalog items provided with this item. This related list is for informational purposes only.</td>
</tr>
<tr>
<td>Variables</td>
<td>Service catalog variables associated with this item. A service catalog variable captures and passes on information about choices a customer makes when ordering an item from the service catalog.</td>
</tr>
<tr>
<td>Vendor Catalog Items</td>
<td>Vendor catalog items associated with this item. Vendor catalog items allow you to track information about this item by its specifications for each vendor.</td>
</tr>
</tbody>
</table>

Hardware catalog item record with an icon and picture of the item.
4. Optional: Click **Try It** to preview the item as it appears in the service catalog.
5. Click **Submit** or **Update**.

**Activate a product catalog item**

Activate a product catalog item to make it available in the product catalog and the service catalog.

Role required: catalog_admin

You can activate the item from either the list view or the record.

1. Navigate to **Product Catalog > Catalog Definition > Hardware and Software Items**.
2. Complete one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate one or more items from the list view</td>
<td>Select the check box next to one or more items in the record list and click <strong>Activate</strong> below the list.</td>
</tr>
<tr>
<td>Activate from the record</td>
<td>Click <strong>Activate</strong> under <strong>Related Links</strong>.</td>
</tr>
</tbody>
</table>

**Deactivate a product catalog item**

Deactivate a product catalog item to remove it from the product catalog and the service catalog.

Role required: catalog_admin

You can deactivate the item from either the list view or the record.

1. Navigate to **Product Catalog > Catalog Definition > Hardware and Software Items**.
2. Complete one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deactivate from the list view</td>
<td>Select the check box next to one or more items in the record list and click <strong>Deactivate</strong> below the list.</td>
</tr>
<tr>
<td>Deactivate from the record</td>
<td>Click <strong>Deactivate</strong> under <strong>Related Links</strong>.</td>
</tr>
</tbody>
</table>

**Model categories**

Model categories associate CI classes with asset classes. Model categories are part of the Product Catalog application.

The model category configuration determines if the ServiceNow platform creates an asset from a CI, and, if so, what class of asset. Asset classes in the base system are **Hardware**, **Software License**, and **Consumable**. You can associate a model category to many models and a model to many model categories. For example, a specific model of a computer can be a **Computer** and a **Server**.
**View model categories**

Default model categories are included with product catalog. You can view a list of default categories and the categories that you created.

Role required: model_manager

1. Navigate to **Product Catalog > Product Model > Model Categories**.
2. Open a model category to view its details.

**Create model categories**

You can add custom model categories for your instance.

Role required: model_manager

When you create model categories, keep the following in mind:

- The base system provides a model category for each CI class in the CMDB. As you create `cmdb_ci` classes, create a corresponding row in the model category table for the model table to be used.
• If you select an **Asset class** on any existing model category, the system automatically creates assets for all configuration items associated with the model category, if configured to do so. If an asset is not created automatically, you can create the asset manually. After an asset class is selected for a model category, the asset class cannot be changed.

• The **Allow pre-allocated, Allow in bundle**, and **Allow as master** options are only available if an asset class is specified for the model category.

• If you select **Consumable** or **Software License** for the asset class, the **Allow in bundle** option is available, but not **Allow pre-allocation** or **Allow as master**.

• When a CI is created from a model category that requires asset tracking, the system automatically creates an asset record for the asset class specified in the model category. It then links that asset record to the CI. If a model is specified, the model category of the CI is determined by a combination of the CI class and the list of categories supported by the model. Asset tracking is specified on the model record.

• When an asset is created from a model category that requires CI tracking, the system automatically creates a CI record of the class specified by the category and links it to the asset.

• The Model Categories list (**Product Catalog** > **Product Model** > **Model Categories**) shows all the CI classes and what asset class is generated on the asset side.

1. Navigate to **Product Catalog** > **Product Model** > **Model Categories** and click **New**.

2. Complete the form.

**Model Category fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for this category.</td>
</tr>
<tr>
<td>CI class</td>
<td>If a CI class is needed, it must be specified when you create the model category. You can't add the CI class the model category later.</td>
</tr>
<tr>
<td>Asset class</td>
<td>Default options and any new asset classes you have created. Setting the asset class triggers the creation of assets depending on the model category selected. You can add an asset class to the model category later, but can't be changed after it is added. If you select <strong>Consumable</strong> or <strong>Software License</strong>, the <strong>CI class</strong> field becomes read-only because consumables and software licenses do not create CIs. If you specify a CI class and then select <strong>Consumable</strong> or <strong>Software License</strong>, the <strong>CI class</strong> field is changed to <strong>None</strong> automatically.</td>
</tr>
</tbody>
</table>

- Asset: An item that can be tracked individually.
- Consumable: An asset not tracked individually, such as keyboards.
- Hardware: A physical piece of computer equipment, such as a laptop or server.
- Software License: A legal statement defining the uses of software, such as the number of installations allowed or the terms of distribution.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow pre-allocation</td>
<td>Add and track items in this category as pre-allocated assets.</td>
</tr>
<tr>
<td>Allow in bundle</td>
<td>Use items in this category in bundles.</td>
</tr>
<tr>
<td>Allow as master</td>
<td>Use items in this category as the master component in a bundle.</td>
</tr>
<tr>
<td>Enforce CI verification</td>
<td>Prevents the system from automatically creating assets in a specific model category when CIs are added manually or found with Discovery. This option enables an administrator to review and verify new CIs before adding them as assets. For example, an administrator can prevent contractors' computers that are discovered as CIs by Help the Help Desk from being added to the asset portfolio.</td>
</tr>
</tbody>
</table>

3. Click Submit.

Create assets manually

The Now Platform does not create an asset automatically under certain conditions. You can create an asset manually as needed.

Role required: model_manager

The conditions under which an asset is not automatically created include the following.

- **Forced CI verification**: If you select the Enforce CI verification check box in the Model Category form, the system does not create an asset automatically when a CI is created or discovered. When Enforce CI verification is enabled, newly created CIs do not trigger an automatic creation of an asset. Instead, these newly created CIs have their Requires verification field automatically set to true, which displays the following UI actions for the CI:
  
  - **Create Asset**: Creates an asset and sets Requires verification to false.
  
  - **Merge CI**: Merges duplicates of a CI. This action is useful if an asset for the CI was created in a separate process, which created an associated CI. Then a second CI was created either manually or via the discovery source - and the duplicate CIs did not properly coalesce.

- **Configuration errors**: In rare cases, the system can fail to create the asset automatically. This failure can occur if you assign the model and model category to the CI in the wrong sequence.

Follow these steps to create an asset manually.

1. Navigate to Product Catalog > Product Model > Model Categories.
2. Open a model category that has no assigned CI class.
3. Click Create Assets.

   This action creates assets from all CIs deferred for verification in this model category. This option is only available for users with the admin role.

Edit model categories

All default model categories can be edited, except for the Contract model category. You can edit any custom model categories that you created at any time.
Role required: model_manager

1. Navigate to Product Catalog > Product Model > Model Categories.
2. Open a model category record.
3. Make changes to the model, as appropriate.
4. Click Update.

Delete model categories

If a model category is no longer needed, you can delete it.

Role required: model_manager

Only model categories that are not referenced by any models can be deleted.

1. Navigate to Product Catalog > Product Model > Model Categories.
2. Select the check box beside the model category Name.
3. From the Actions on Selected Rows menu below the list, click Delete.
4. Click Delete.

Domain separation and Product Catalog

This is an overview of domain separation and the Product Catalog. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Standard

- Includes Basic level support.
- Business logic: Processes can be created or modified per customer by the service provider (SP). The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The owner of the instance needs to be able to configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin needs to be able to make comments mandatory when a record closes for one tenant, but not for another.

How domain separation works in Product Catalog

The domain owner's employees and tenants can use the same processes if the work is done in the correct domain. When adjusting any configuration, you should be in the domain where you're doing the work. Use the domain picker to select the correct domain to work in.
Index

A
add assignments 495
application 458
Asset and CI management 376, 386, 383, 384, 369, 381, 378, 377, 384, 386, 381, 379, 380, 377, 386, 381
asset classes 375
asset state 377
asset substate 377
Asset-CI mapping 370, 371, 370, 369, 371
assets 369

C
consumable assets 383, 381
create 381
view 381
consumables 380
contract management 470, 470, 470, 471, 471, 476, 471
adjust contract 471

Managing Assets 369
model categories
  create 528
  create asset manually 530
  delete 531
  edit 530
  view 528
model management
  business rules 440
  client scripts 442
  installed with 440
  properties 443
  script includes 443
  tables 443
  UI policies 444
  user roles 445
models
  application 518
  bundle
    add model components 516
  bundled 515
  consumables 514
  creating new 511, 518, 518
  delete 519
  fields 511
  hardware
    compatible models 513
    substitute models 514
  publish to catalog 519
  skills 518
  software 518

N
new manufacturer
  create 439
new vendor
  create 439

O
Organization Management
  create new manufacturer 439
  create new vendor 439
  Locations module 439

P
pre-allocated asset
  allocate 386
  split 386
pre-allocated assets
  create 384
procurement
  activate 488
  consumable asset 508
  create 500
  create an asset 504
  create purchase order 498
  edit a catalog task 497
  purchase order
    cancel 503
    reorder 504
  purchase order line item
    cancel 503
    reorder 504
  purchase order management 496
  purchase order status 502
  purchase orders
    expected delivery date 503
  receive assets 506, 505
  receiving slip 507
  receiving slip line 507
  reserve asset 504
  roles 486
  service catalog
    cancel request 496
    track request 496
    view a catalog task 497
    workflows 486
Procurement 488
  procurement overview module
    use 488
product catalog
  activate items 527
  create item 523
  create vendor catalog items 520
  deactivate item 527
  installed components
    business rules 511
    client scripts 510
    roles 510
    script includes 510
    tables 509
  items 523
  link to hardware catalog 521
  link to software catalog 522
  publish to hardware catalog 522
  publish to software catalog 522
  synchronize information 519
  vendor catalog 519
  view vendors 523
Product Catalog 509
  purchase order
    create from a request 494

R
rate card
  expense generation 481
request items
  add assignment 492
  purchase order 492
  source 492
  transfer order 492

S
Software Asset Management
  activate 14
administration 309
Adobe 158
client access 310
content service 23
custom product 311, 312
dashboard 131, 140
Discovery 85
entitlement import errors 44
get started 27
IBM License Metric Tool 168
job result 80
metric attributes 57
Microsoft Office 365 180
migrate 21
migrate software installs 314
migration 20
normalization suggestions 79
optimization and removal 109
overview 12
pattern normalization rule 82
plugin 14
properties 314
reclamation rule 112
reconciliation 92
refresh processor definitions 313
removal candidate 126
roles 317
run reconciliation 101
set up 19
software discovery models 88
software model results 102
software usage 126
Software Asset Management content service
  opt in 26
  opt out 26
software discovery models
eedit 81
software installations
  manual override edition 81
Solutions 130, 431
stockrooms
  create 387
  create stock rules 390
  create types 389
  delete 387, 387
  stock rules 390
  types 388

T
transfer order
  create from request 495
transfer orders
  create 398
  create transfer order line 399
  delete 397
  delete transfer order line 397
  line asset tracking 401, 401, 401
  return items 398
  transfer assets 396
  transfer process 397

V
vendor catalog
  create a catalog item 520
  link to hardware catalog 521
  link to software catalog 522
  publish to hardware catalog 522
  publish to software catalog 522
  synchronize information 519
  view vendors 523